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CHAPTER 1

Preámbulo

Este documento es la guía de usuario original del software descrito QGIS. El software y hardware descritos
en este documento son en la mayoría de los casos marcas registradas y por lo tanto sujetas a requerimientos
legales. QGIS esta sujeto a la Licencia Publica General GNU. Encontrará más información en la página de QGIS,
http://www.qgis.org.

Los detalles, datos y resultados en este documento han sido escritos y verificados con el mejor de los conocimien-
tos y responsabilidad de los autores y editores. Sin embargo, son posibles errores en el contenido.

Por lo tanto, los datos no están sujetos a ningún derecho o garantía. Los autores y editores no aceptan ninguna
responsabilidad u obligación por fallos y sus consecuencias. Siempre será bienvenido a informar posibles errores.

Este documento ha sido compuesto con reStructuredText. Esta disponible como código fuente reST por github
y en línea como HTML y PDF a través de http://www.qgis.org/en/docs/. Las versiones traducidas de este
documento también se pueden descargar en varios formatos a través del área de documentación del proyecto
QGIS. Para mayor información acerca de la contribución de este documento y de la traducción, por favor visite
http://qgis.org/en/site/getinvolved/index.html.

Enlaces en este documento

Este documento contiene enlaces internos y externos. Pulsando un enlace interno navega dentro del documento,
mientras que pulsando un enlace externo abre una dirección de Internet. En formato PDF, los enlaces internos y
externos son mostrados en azul y son manejados por el navegador del sistema. En formato HTML, el navegador
muestra y maneja ambos de manera idéntica.

Autores y Editores de las Guías de Usuario, Instalación y Programación:

The list of the persons who contribute on writing, reviewing and translating the following documentation is avail-
able at Colaboradores.

Copyright (c) 2004 - 2016 QGIS Development Team

Internet: http://www.qgis.org

Licencia de este documento

Se permite la copia, distribución y/o modificación de este documento bajo los términos de la Licencia de Docu-
mentación Libre GNU, Versión 1.3 o cualquier versión posterior publicada por la Fundación de Software Libre;
sin Secciones Invariante, ni Texto de Portada ni de Contracubierta. Se incluye una copia de la licencia en el
Apéndice Licencia de Documentación Libre de GNU.
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CHAPTER 2

Convenciones

Esta sección describe los estilos homogéneos que se utilizarán a lo largo de este manual.

2.1 Convenciones de la Interfaz Gráfica o GUI

Las convenciones de estilo del GUI están destinadas a imitar la apariencia de la interfaz gráfica de usuario. En
general, un estilo reflejará la apariencia simplificada, por lo que un usuario puede escanear visualmente el GUI
para encontrar algo que se parece a lo mostrado en el manual.

• Menú Opciones: Capa → Añadir capa ráster o Preferencias → Barra de Herramientas → Digitalizacion

• Herramienta: Añadir capa ráster

• Boton : [Guardar como]

• Título del Cuadro de Diálogo: Propiedades de capa

• Pestaña: General

• Selección: Renderizar

• Botón de selección: Postgis SRID EPSG ID

• Seleccionar un número:

• Seleccionar una cadena:

• Buscar una archivo:

• Seleccionar un color:

• Barra de desplazamiento:

• Texto de entrada:

El sombreado muestra un componente de la interfaz que el usuario puede pulsar.

2.2 Convenciones de Texto o Teclado

Entes manual también inclue estilos relacionados a textos, comandos de teclado y codificacion para indicar difer-
entes entidades, como las clases o métodos. Estos estilos no corresponden a la apariencia real de cualquier texto o
codificacion dentro de QGIS.

• Hiperenlaces: http://qgis.org

• Combinaciones de Teclas: Pulsar Ctrl+B, significa mantener pulsada la tecla Ctrl y pulsar la letra B.

3
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• Nombre de un Archivo: lakes.shp

• Nombre de una Clase: NewLayer

• Método: classFactory

• Servidor: myhost.de

• Texto para el Usuario: qgis --help

Las líneas de código se muestran con una fuente de ancho fijo:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instrucciones específicas de cada plataforma

GUI sequences and small amounts of text may be formatted inline: Click File QGIS → Quit to close
QGIS. This indicates that on Linux, Unix and Windows platforms, you should click the File menu first, then Quit,
while on macOS platforms, you should click the QGIS menu first, then Quit.

Las cantidades mayores de texto se pueden formatear como listas:

• Hacer esto

• Hacer aquello

• Or do that

o como párrafos:

Hacer esto y esto y esto. Entonces hacer esto y esto y esto, y esto y esto y esto, y esto y esto y esto.

Do that. Then do that and that and that, and that and that and that, and that and that and that, and that and that.

Las capturas de pantalls que aparecen a lo largo de la guía de usuario han sido creadas en diferentes plataformas;
éstas se indicarán por el icono específico para cada una al final del pie de imagen.
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CHAPTER 3

Prólogo

¡Bienvenido al maravilloso mundo de los Sistemas de Información Geográfica (SIG)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and macOS. QGIS is developed using the Qt toolkit
(https://www.qt.io) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS pretende ser un SIG amigable, proporcionando funciones y características comunes. El objetivo inicial
del proyecto era proporcionar un visor de datos SIG. QGIS ha alcanzado un punto en su evolución en el que
está siendo usado por muchos para sus necesidades diarias de visualización de datos SIG. QGIS admite diversos
formatos de datos ráster y vectoriales, con el nuevo formato de ayuda fácilmente agregado usando la arquitectura
del complemento.

QGIS se distribuye bajo la Licencia Pública General GNU (GPL). El desarrollo de QGIS bajo esta licencia sig-
nifica que se puede revisar y modificar el código fuente y garantiza que usted, nuestro feliz usuario, siempre tendrá
acceso a un programa de SIG que es libre de costo y puede ser libremente modificado. Debería haber recibido una
copia completa de la licencia con su copia de QGIS, y también podrá encontrarla en el Apéndice GNU General
Public License.

Truco: Documentación al día
La última versión de este documento siempre se puede encontrar en el área de documentación de la web de QGIS
en http://www.qgis.org/en/docs/.
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CHAPTER 4

Características

QGIS ofrece muchas funcionalidades SIG comunes proporcionado por las características principales y comple-
mentos. Un breve resumen de las seis categorías generales de características y complementos se presenta a con-
tinuación, seguido por las primeras perspectivas sobre la consola de Python integrado.

4.1 Ver datos

Se puede ver y sobreponer datos vectoriales y ráster en diferentes formatos y proyecciones sin convertir a un
formato interno o común. Los formatos admitidos incluyen:

• Tablas y vistas habilitadas para operaciones espaciales utilizando PostGIS, SpatiaLite y MS SQL Spatial,
Oracle Spatial, formatos vectoriales admitidos por la biblioteca OGR instalada, incluyendo archivos shape
de ESRI, MapInfo, SDTS, GML y muchos más. Vea la sección Trabajar con catos vectoriales.

• Ráster y formatos de imagenes admitidos por la biblioteda GDAL (Geospatial Data Abstraction Library)
instalada, por ejemplo GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG y muchos más. Vea la
sección Trabajar con catos raster.

• Ráster GRASS y datos vectoriales de base de datos GRASS (location/mapset). Vea sección Integracion
GRASS SIG.

• Datos espaciales en línea servidos como servicios web OGC incluyendo WMS, WMTS, WCS, WFS, y
WFS-T. Vea la sección Trabajar con datos OGC.

4.2 Explorar datos y componer mapas

Se puede componer mapas y explorar datos espaciales interactivamente con una GUI amigable. Las muy útiles
herramientas disponibles en la GUI incluyen:

• Navegador QGIS

• Reproyección al vuelo

• Gestor de Base de Datos

• Diseñador de mapas

• Panel de vista general

• Marcadores espaciales

• Herramientas de anotaciones

• Identificar/seleccionar objetos espaciales

• Editar/ver/buscar atributos

• Etiquetado de elementos definidos por los datos
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• Vectores definidos por datos y herramientas para simbologia raster.

• Composición del atlas y mapa con capas de cuadricula.

• flecha barra de escala y etiqueta de derechos de autor para mapas

• Apoyo para guardar y restaurar proyectos

4.3 Crear, editar, gestionar y exportar datos

Puede crear, editar, administrar y exportar capas vectoriales y ráster en varios formatos. QGIS ofrece lo siguiente:

• Herramientas de digitalización para formatos reconocidos OGR y capas vectoriales GRASS

• Capacidad para crear y editar archivos shape y capas vectoriales GRASS

• Complemento de georeferenciador para geocodificar imágenes

• Herramienta GPS para importar y exportar formato GPX y convertir otros formatos GPS a GPX o descargar
o subir directo a la unidad GPS (en Linux, usb se agredo a la lista de objetos GPS.)

• Apoyo para visualizar y editar datos de OpenStreetMap

• Capacidad para crear tablas de base de datos espaciales desde archivos shape con el complemento de Ad-
ministrados de BBDD

• Mejor manejo de tablas de bases de datos espaciales

• Herramientas para la gestión de tablas de atributos vectoriales

• Opción para guardar capturas de pantalla como imágenes georeferenciadas

• Herramienta para exportar DXF con capacidades aumentadas de explorar estilos y plugins que realizan
funciones parecidas a CAD.

4.4 Analizar datos

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use the
integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See sec-
tion Integracion GRASS SIG.) Or, you can work with the Processing Plugin, which provides a powerful geospatial
analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA, GRASS and
more. (See section Introducción.)

4.5 Publicar mapas en Internet

QGIS se puede utilizar como un cliente WMS, WMTS, WMS-C o WFS y WFS-T, y como servidor WMS, WCS
o WFS (vea la sección Trabajar con datos OGC.) Además, se pueden publicar sus datos en Internet utilizando un
servidor web con UMN MapServer o GeoServer instalado.

4.6 Extender funcionalidades QGIS a través de complementos

QGIS se puede adaptar a sus necesidades especiales con la arquitectura de complemento extensible y bibliotecas
que se pueden utilizar para crear complementos. Se puede incluso crear nuevas aplicaciones con C++ o Python.
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4.6.1 Complementos del Núcleo

Los complementos del núcleo incluyen:

1. Captura de coordenadas (captura las coordenadas del ratón en diferentes SRCs)

2. Administrador de BBDD (Intercambiar, editar y ver capas y tablas de/para base de datos; ejecute las con-
sultas SQL)

3. Dxf2Shp Converter (convierte DXF a archivos shape)

4. eVIS (Visualizar eventos)

5. GDALTools (Integrar herramientas GDAL en QGIS)

6. Georeferenciador GDAL (Añade información de la proyección para utilizar ráster GDAL)

7. Herramientas GPS (cargar e importar datos de GPS)

8. GRASS (integrar el SIG GRASS)

9. Mapa de calor (Genera ráster de mapa de calor de datos de punto)

10. Complemento de interpolación (Interpolar basada en vértices de una capa vectorial)

11. Cliente de Catálogo de metasearch

12. Edición fuera de línea (permite editar fuera de línea y sincronizar con bases de datos)

13. GeoRaster Espacial de Oracle

14. Procesamiento (antiguamente SEXTANTE)

15. Análisis del Terreno Ráster (Analiza terreno a base de ráster)

16. Complemento Grafo de rutas (Analiza una red de ruta más corta)

17. Complemento de consulta espacial

18. Verificador de Topología (encuentra errores topológicos en una capa vectorial)

19. Complemento estadístico zonal (calcula recuento, suma y media de un ráster por cada polígono de una capa
vectorial)

4.6.2 Complementos externos de Python

QGIS ofrece un número creciente de complementos Python externos que son proporcionados por la comunidad.
Estos se encuentran en el repositorio oficial de complementos y se pueden instalar fácilmente usando el instalador
del complemento Python. Vea la sección El diálogo de complementos.

4.7 Consola de Python

Para scripting, es posible aprovechar la consola de Python integrado, que se puede abrir desde el menú: Comple-
mentos -> Consola de Python. La consola se abre como una ventana de utilidad no modal. Para la interacción con
el ambiente de QGIS, existe la variable qgis.utils.iface, que es una instancia de QgsInterface. Esta
interfaz permite el acceso a la vista del mapa, menús, barras de herramientas y otras partes de la aplicación QGIS.
Se puede crear una script, después, arrastrarlo a la ventana de QGIS y se ejecutará automáticamente.

Para mayor información sobre cómo trabajar con la consola de Python y programar complementos y aplicaciones
QGIS, vea PyQGIS-Developer-Cookbook.
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4.8 Problemas Conocidos

4.8.1 Limitación en el número de archivos abiertos

Si va a abrir un proyecto grande de QGIS y está seguro de que todas las capas son válidas, pero algunas capas
se marcan como malas, es probable que se enfrentará a este problema. Linux (y otros sistemas operativos, así
mismo) tiene un límite de archivos abiertos por proceso. Los límites de recursos son por proceso y heredados. El
ulimit, que es una cáscara integrada, cambia los límites solamente para el proceso actual; el nuevo límite será
heredado por los procesos hijos.

You can see all current ulimit info by typing:

$ ulimit -aS

You can see the current allowed number of opened files per process with the following command on a console:

$ ulimit -Sn

To change the limits for an existing session, you may be able to use something like:

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Para solucionarlo para siempre

En la mayoría de los sistemas Linux, los límites de recursos se establecen al iniciar sesión
por el módulo pam_limits de acuerdo con los ajustes contenidos en:file:/etc/security/limits.conf o
/etc/security/limits.d/*.conf. Debe ser capaz de editar esos archivos si tiene privilegios de root
(también a través de sudo), pero tendrá que volver a iniciar sesión para que los cambios surtan efecto.

Más información:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Novedades de QGIS 2.18

Esta versión contiene nuevas características y se extiende la interfaz de programación con respecto a versiones
anteriores. Le recomendamos que utilice esta versión sobre las versiones anteriores.

Esta versión incluye cientos de correcciones de errores y muchas nuevas características y mejoras QGIS
2.14 que se describirán en este manual. También puede revisar la lista de cambios visuales en
http://qgis.org/en/site/forusers/visualchangelogs.html.
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CHAPTER 6

Comenzar

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Instalación

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and macOS. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Instalación a partir de las fuentes

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html. If you want to build
a particular release, you should replace master by the release branch (commonly in the release-X_Y form)
in the above-mentioned link because instructions may differ.

6.1.2 Instalación en medios extraíbles

QGIS le permite definir una opción --configpath que suplanta la ruta predeterminada para la configuración
de usuario (ej.: ~/.qgis2 bajo Linux) y fuerza a QSettings a usar ese directorio. Esto le permite, por ejemplo,
llevar una instalación de QGIS en una memoria flash junto con todos los complementos y la configuración. Vea la
sección System Settings para información adicional.

6.1.3 Datos de ejemplo

The user guide contains examples based on the QGIS sample dataset.

El instalador de Windows tiene una opción para descargar el conjunto de datos de muestra de QGIS. Si se
marca, los datos se decargarán en su carpeta Mis Documentos y se colocarán en una carpeta llamada GIS
Database. Puede usar el Explorador de Windows para mover esta carpeta a una ubicación adecuada. Si no
marcó la casilla de verificación para instalar el conjunto de datos de muestra durante la instalación inicial de
QGIS, puede hacer algo de lo siguiente:

• Usar datos SIG que ya tenga

• Descargar datos de muestra de http://qgis.org/downloads/data/qgis_sample_data.zip

• Desinstalar QGIS y volver a instalarlo con la opción de descarga de datos marcada (sólo recomendado si las
soluciones anteriores no funcionaron).
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For GNU/Linux and macOS, there are not yet dataset installation packages available as rpm, deb
or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data/ and unzip the archive on your system.

El conjunto de datos de Alaska incluye todos los datos SIG que se usan para los ejemplos y capturas de pantalla
de la guía de usuario; también incluye una pequeña base de datos de GRASS. La proyección del conjunto de datos
de QGIS es Alaska Albers Equal Area con unidades en pies. El código EPSG es 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Si pretende usar QGIS como un visor gráfico para GRASS, puede encontrar una selección de lo-
calizaciones de ejemplo (ej.., Spearfish o Dakota de Sur) en la web oficial de GRASS GIS,
http://grass.osgeo.org/download/sample-data/.

6.2 Lanzando QGIS

6.2.1 Starting and Stopping QGIS

Starting QGIS is done as you usually do for any other application on your platform. It means that you can launch
QGIS by:

• typing qgis at a command prompt, assuming that QGIS is added to your PATH or you’re in its installation
folder

• using the Applications menu if using a precompiled binary, the Start menu or the Dock

• doble clic el ícono en su carpeta de Aplicaciones o atajo de escritorio

• doble clic a un archivo de proyecto QGIS existente (.qgs). Note que esto también abrirá el proyecto

Para detener QGIS, haga click:

• the menu option Project → Exit QGIS or use the shortcut Ctrl+Q

• QGIS → Quit QGIS, or use the shortcut Cmd+Q

• or use the red cross at the right top corner of the main interface of the application.

6.2.2 Opciones de la línea de órdenes

In previous section you learned how to start QGIS. You will see that QGIS also provides further command line
options.
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QGIS supports a number of options when started from the command line. To get a list of the options, enter qgis
--help on the command line. The usage statement for QGIS is:

qgis --help

Returns:

QGIS - 2.16.1-Nødebo ’Nødebo’ (8545b3b)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Truco: Ejemplo usando argumentos de la línea de órdenes
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Opción de la línea de órdenes --snapshot

Esta opción permite crear una captura de pantalla en formato PNG de la vista actual. Esto es práctico cuando tiene
muchos proyectos y quiere generar capturas de pantalla de sus datos.

Actualmente genera un archivo PNG con 800x600 píxeles. Esto se puede ajustar usando los argumentos‘‘–width‘‘
y --height en la línea de órdenes. Se puede añadir un nombre de archivo después de --snapshot.

Opción de la línea de órdenes --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, qgis --lang it starts QGIS in Italian localization.

Opción de la línea de órdenes --project
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También es posible iniciar QGIS con un archivo de proyecto existente. Solamente agregue la opción --project
a la línea de comando, seguida por el nombre de su proyecto y QGIS se abrirá con todas las capas del archivo
indicado cargadas.

Opción de la línea de órdenes --extent

Use esta opción para iniciar con una extensión de mapa específica. Necesita añadir el cuadro delimitador de su
extensión en el siguiente orden, separado por una coma:

--extent xmin,ymin,xmax,ymax

Opción de la línea de órdenes --nologo

This command line argument hides the splash screen when you start QGIS.

command line option --noversioncheck

No revise nueva versión de QGIS al iniciar.

Opción de la línea de órdenes --noplugins

Si tiene problemas con los complementos al iniciar, puede evitar cargarlos con ésta opción. Estarán aún disponibles
después en el administrador de complementos. Opciónde la línea de órdenes --customizationfile

Utilizando este argumento de línea de órdenes puede definir un archivo de personalizacion de la GUI, que se
utilizará al iniciar.

Opción de la línea de órdenes --nocustomization

Utilizando este argumento de línea de órdenes no se aplicará la personalización existente de la GUI.

Opción de la línea de órdenes --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Opciones to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use
option:

--optionspath /path/to/config/

Opción de la línea de órdenes --configpath

Esta opción es similar al anterior, pero además anula la ruta predeterminada para la configuración del usuario
(~/.qgis2) y fuerza QSettings para usar también este directorio. Esto permite a los usuarios, por ejemplo,
llevar la instalación de QGIS en una unidad flash junto con todos los complementos y configuraciones.

Command line option --authdbdirectory

Again, this option is similar to the one above but define the path to the directory where the authentication database
will be stored.

Opción de línea de comandos --código

Esta opción puede ser usada para ejecutar un archivo pyton dado después de que ha iniciado QGIS.

Por ejemplo, cuando se tiene un archivo python llamado load_alaska.py con el siguiente contenido:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

Command line options --dxf-*
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Estas opciones pueden usarse para exportar un proyecto QGIS en un archivo DXF. Varias opciones están
disponibles:

• –dxf-export: the DXF filename into which to export the layers;

• –dxf-extent: the extent of the final DXF file;

• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);

• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: the file encoding;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Panel de capas.

6.3 Sesión de Muestra: Cargar capas ráster y vectorial

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short and simple
QGIS sample session. We will visualize a raster and a vector layer. We will use:

• the landcover raster layer i.e., qgis_sample_data/raster/landcover.img

• and the lakes vector layer i.e., qgis_sample_data/gml/lakes.gml.

1. Iniciar QGIS tal como se ve en Starting and Stopping QGIS

2. Click on the Add Raster Layer icon.

3. Navegue a la carpeta qgis_sample_data/raster/, seleccione el archivo ERDAS IMG
landcover.img y haga clic en [Abrir].

4. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case Erdas Imagine Images (*.img *.IMG).

5. Now click on the Add Vector Layer icon.

6. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.

7. Browse to the folder qgis_sample_data/gml/, select Geography Markup Language [GML]
[OGR] (*.gml *.GML) from the Filter combo box, then select the GML file lakes.gml and
click [Open]. In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog
opens with NAD27 / Alaska Alberts selected, click [OK].

8. Acerque el zoom un poco a la zona que prefiera con algunos lagos.

9. Haga doble clic en la capa lakes en el panel Capas para abrir el diálogo Propiedades.

10. Clic en la pestaña Estilo y seleccionar un azul como color de relleno.

11. Click on the Labels tab and select Show labels for this layer in the drop-down menu to enable labeling.
Then from the Label with list, choose the NAMES field as the field containing labels.

12. To improve readability of labels, you can add a white buffer around them by clicking Buffer in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

13. Haga clik en [Aplicar]. Compruebe si el resultado le gusta y finalmente pulse [Aceptar].

Puede ver lo fácil que es visualizar capas ráster y vectoriales en QGIS. Vayamos a las secciones que siguen para
aprender más sobre las funcionalidades, características y configuración disponibles y cómo usarlas.
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6.4 Proyectos

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opciones). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
As.... If the loaded project file on disk was meanwhile changed, by default, QGIS will ask you if you want to

overwrite the changes into the project file. This behavior is set by checking Prompt to save project and data
source changes when required under Settings → Options → General menu .

Cargar los proyectos guardados en una sesión de QGIS usando Proyecto→ Abrir..., Proyecto → Nuevo a
partir de plantilla o Proyecto → Abrir reciente →.

At startup, a list of screenshot with the name and path of each of the most recent projects (up to ten) is shown
instead of a white and empty map canvas. This is a handy and quicker way to remember what a project was about
and double-click a row opens the selected project. If you’re willing to create a new project, just add new layers
and the list disappears.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

El tipo de información guardada en el archivo de proyecto incluye:

• Las capas añadidas

• Que capas pueden ser consultadas

• Propiedades de la capa, incluyendo simbolización y estilos

• Proyección de la vista del mapa

• Última extensión vista

• Diseñador de impresión

• Elementos de diseñador de impresión con ajustes

• Diseñador de impresión configuración de atlas

• Configuración de digitalización

• Tabla de relaciones

• Proyectos Macros

• Proyecto de estilos predeterminados

• Configuración de complementos

• Configuración de servidor QGIS desde la pestaña de ajustes de OWS en propiedades del proyecto

• Consultas almacenadas en el Administrador de BBDD

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly any more. To be made aware of this, in the General tab under Settings

→ Options you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a project in QGIS a backup of the project file is made with the extension .qgs~.

6.5 Salida

There are several ways to generate output from your QGIS session. We have discussed one already in section
Proyectos, saving as a project file. Here is a sampling of other ways to produce output files:
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• Menu option Project → Save as Image... opens a file dialog where you select the name, path and type
of image (PNG, JPG and many other formats). A world file with extension PNGW or JPGW saved in the
same folder georeferences the image.

• La opción del menú Proyecto →‘Esportar a DXF ... abre un diálogo donde se puede definir el ‘Modo de
simbología’, la ‘Escala de la simbología’ y las capas vectoriales que se desea exportar a DXF. A través de los
símbolos ‘Modo de simbología’ desde la original simbología QGIS puede ser exportado con alta fidelidad.

• La opción del menú Proyecto → Nuevo diseñador de impresión abre un diálogo en donde se puede
diseñar e imprimir el lienzo de mapa actual (vea sección Diseñadores de impresión).
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CHAPTER 7

IGU QGIS

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: QGIS GUI with Alaska sample data

Nota: Las decoraciones de las ventanas (barra de título, etc.) pueden ser distintas dependiendo de su sistema
operativo y su gestor de ventanas.

The QGIS GUI is divided into five components:

1. Barra de Menú

2. Barras de herramientas

3. Paneles

4. Vista del mapa

5. Barra de Estado

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.

21



QGIS User Guide, Publicación 2.18

7.1 Barra de Menú

La barra de menú permite el acceso a varias características de QGIS mediante un menú jerárquico estándar. Los
menús de nivel superior y un resumen de algunas opciones de menú se enumeran a continuación, junto con
los iconos asociados a medida que aparecen en la barra de herramientas, y los atajos de teclado. Los atajos
de teclado presentados en esta sección son los predeterminados; sin embargo, los atajos de teclado también se
pueden configurar manualmente utilizando el diálogo Configurar atajos del teclado, abrir desde Configuración →
Configurar atajos de teclado....

Aunque la mayoría de las opciones tiene una herramienta correspondiente y viceversa, los menús no están orga-
nizados exactamente como las barras de herramientas. La barra de herramientas que contiene la herramienta esta
listada después de cada opción de menú como una entrada de casilla de verificación. Algunas opciones de menú
sólo aparecen si se carga el complemento correspondiente. Para obtener más información acerca de herramientas
y barra de herramientas, ver la sección Barras de herramientas.

Nota: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Proyecto

Menú Opción Atajos Referencia Barra de herramietas

New Ctrl+N ver Proyectos Proyecto

Open Ctrl+O ver Proyectos Proyecto
Nuevo a partir de plantilla → ver Proyectos
Abrir recientes → ver Proyectos

Save Ctrl+S ver Proyectos Proyecto

Save As... Ctrl+Shift+S ver Proyectos Proyecto

Save as Image... ver Salida
DXF Export... ver Salida
DWG/DXF Import...

Project Properties... Ctrl+Shift+P ver Proyectos

New Print Composer Ctrl+P ver Diseñadores de impresión Proyecto

Composer manager... ver Diseñadores de impresión Proyecto
Diseñadores de impresión → ver Diseñadores de impresión

Exit QGIS Ctrl+Q

Under macOS, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Editar

Menú Opción Atajos Referencia Barra de
herramietas

Undo Ctrl+Z ver Digitalización avanzada Digitalización
Avanzada

Redo Ctrl+Shift+Zver Digitalización avanzada Digitalización
Avanzada

Cut Features Ctrl+X ver Digitalizando una capa
existente

Digitalización

Copy Features Ctrl+C ver Digitalizando una capa
existente

Digitalización

Pegar objetos espaciales Ctrl+V ver Digitalizando una capa
existente

Digitalización

Pegar objetos espaciales como → ver Trabajar con la tabla de
atributos

Add Feature Ctrl+. ver Digitalizando una capa
existente

Digitalización

Add Circular String ver Digitalizando una capa
existente

Digitalización

Add Circular String by Radius ver Digitalizando una capa
existente

Digitalización

Move Feature(s) ver Digitalizando una capa
existente

Digitalización

Delete Selected ver Digitalizando una capa
existente

Digitalización

Modify Attributes of Selected
Features

ver Editar valores de atributo Digitalización

Rotate Feature(s) ver Digitalización avanzada Digitalización
Avanzada

Simplify Feature ver Digitalización avanzada Digitalización
Avanzada

Add Ring ver Digitalización avanzada Digitalización
Avanzada

Add Part ver Digitalización avanzada Digitalización
Avanzada

Fill Ring ver Digitalización avanzada Digitalización
Avanzada

Delete Ring ver Digitalización avanzada Digitalización
Avanzada

Delete Part ver Digitalización avanzada Digitalización
Avanzada

Reshape Features ver Digitalización avanzada Digitalización
Avanzada

Offset Curve ver Digitalización avanzada Digitalización
Avanzada

Split Features ver Digitalización avanzada Digitalización
Avanzada

Split Parts ver Digitalización avanzada Digitalización
Avanzada

Merge Selected Features ver Digitalización avanzada Digitalización
Avanzada

Merge Attr. of Selected
Features

ver Digitalización avanzada Digitalización
Avanzada

Node Tool ver Digitalizando una capa
existente

Digitalización

Rotate Point Symbols ver Digitalización avanzada Digitalización
Avanzada

Offset Point Symbols ver Digitalización avanzada Digitalización
Avanzada
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Edición (extra)

Menú Opción Atajos Referencia Barra de herramietas

Add Feature ver Digitalizando una capa existente Digitalización

Add Feature ver Digitalizando una capa existente Digitalización

Añadir objeto espacial ver Digitalizando una capa existente Digitalización

7.1.4 Ver

Menú Opción Atajos Referencia Barra de herramietas

Pan Map ver:ref:zoom_pan Navegación de mapas

Pan Map to Selection Navegación de mapas

Acercar zum Ctrl+Alt++ ver:ref:zoom_pan Navegación de mapas

Alejar zum Ctrl+Alt+- ver:ref:zoom_pan Navegación de mapas
Seleccionar → ver Selecting features Atributos

Identify Features Ctrl+Shift+I see Identificar objetos espaciales Atributos
Medir → ver Mediciones Atributos

Statistical Summary see Panel de resumen estadístico Atributos

Zum General Ctrl+Shift+F Navegación de mapas

Zoom To Layer Navegación de mapas

Zum a la selección Ctrl+J Navegación de mapas

Zoom Last Navegación de mapas

Zum siguiente Navegación de mapas

Zoom To Native Resolution Navegación de mapas
Ilustraciones → ver Elementos decorativos
Modo Vista previa →

Map Tips see Propiedades a mostrar Atributos

New Bookmark... Ctrl+B ver Marcadores espaciales Atributos

Show Bookmarks Ctrl+Shift+B ver Marcadores espaciales Atributos

Refresh F5 Navegación de mapas
Paneles → ver Paneles y Barras de Herramientas
Barras de herramientas→ ver Paneles y Barras de Herramientas
Toggle Full Screen Mode F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under macOS.
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7.1.5 Capa

Menú Opción Atajos Referencia Barra de
herramietas

Crear capa → ver Creating new vector layers Administrar Capas
Añadir capa → see Exploring Data Formats and

Fields
Administrar Capas

Embed Layers and
Groups...

ver Anidar proyectos

Add from Layer Definition
File...

Copy style ver Save and Share Layer Properties

Paste style ver Save and Share Layer Properties

Open Attribute Table F6 ver Trabajar con la tabla de atributos Atributos

Toggle Editing ver Digitalizando una capa existente Digitalización

Save Layer Edits ver Digitalizando una capa existente Digitalización

Current Edits → ver Digitalizando una capa existente Digitalización
Guardar como... ver Creating new layers from an

existing layer
Save As Layer Definition
File...

Remove Layer/Group Ctrl+D

Duplicate Layer(s)
Set Scale Visibility of
Layer(s)
Set CRS of Layer(s) Ctrl+Shift+C
Set Project CRS from Layer
Properties... see El Dialogo de las Propiedades del

Vector
Filter... Ctrl+F ver Constructor de Consulta

Etiquetado ver Propiedades de etiquetas

Añadir a la vista
general

Ctrl+Shift+O Administrar Capas

Añadir todo a la vista
general

Remove All From
Overview

Mostrar todas las capas Ctrl+Shift+U Administrar Capas

Ocultar todas las capas Ctrl+Shift+H Administrar Capas

Show selected Layers

Hide selected Layers
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7.1.6 Configuración

Menú Opción Ata-
jos

Referencia Barra de
herramietas

SRC Personalizado .. ver Sistema de referencia de coordenadas
personalizada

Style Manager... ver El Administrador de estilos
Configurar atajos de

teclado ...
see Atajos de teclado

Customization... ver Personalización
Options... ver Opciones

Snapping Options... ver Configurar la tolerancia del autoensamblado y
radio de búsqueda

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars
→ and Toggle Full Screen Mode.

7.1.7 Complementos

Menú Opción Atajos Referencia Barra de
herramietas

Administrar e Instalar
complementos ...

ver El diálogo de
complementos

Python Console Ctrl+Alt+P

When starting QGIS for the first time not all core plugins are loaded.

7.1.8 Vectorial

Menú Opción Atajos Referencia Barra de herramietas
OpenStreetMap → see Importing OpenStreetMap Vectors

Herramientas de análisis → ver Menu Vectorial

Herramientas de investigación → ver Menu Vectorial

Herramientas de Geoproceso → ver Menu Vectorial

Herramientas de geometría → ver Menu Vectorial

Herramientas de gestión de datos → ver Menu Vectorial

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.
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7.1.9 Ráster

Menú Opción Atajos Referencia Barra de herramietas
Calculadora ráster... see Calculadora Ráster
Align Raster... ver Raster Alignment

Analysis → see Complemento Herramientas de GDAL

Projection → see Complemento Herramientas de GDAL

Conversion → see Complemento Herramientas de GDAL

Miscellaneous → see Complemento Herramientas de GDAL

Extraction → see Complemento Herramientas de GDAL

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.

7.1.10 Base de datos

Menú Opción Atajos Referencia Barra de herramietas
Base de datos→ ver Complemento administrador de BBDD Base de datos

When starting QGIS for the first time not all core plugins are loaded.

7.1.11 Web

Menú Opción Atajos Referencia Barra de herramietas
Metasearch ver metabuscador Web

When starting QGIS for the first time not all core plugins are loaded.

7.1.12 Procesado

Menú Opción Atajos Referencia Barra de
herramietas

Caja de herramientas de
procesado

ver La caja de herramientas

Graphical Modeler... ver Modelador gráfico

History and log... ver El administrador del historial

Options... ver Configurar el entorno de trabajo de
procesamiento

Results viewer... ver Configurar aplicaciones externas

Comandos Ctrl+Alt+Mver La línea de órdenes de QGIS

When starting QGIS for the first time not all core plugins are loaded.
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7.1.13 Ayuda

Menú Opción Atajos Referencia Barra de herramietas

Help Contents F1 Ayuda

¿Qué es esto? Shift+F1 Ayuda
API Documentation
Reportar un problema
Need commercial support?

QGIS Home Page Ctrl+H

Check QGIS Version

Acerca de

Patrocinadores de QGIS

7.1.14 QGIS

This menu is only available under macOS and contains some OS related commands.

Menú Opción Atajos Referencia
Preferencias
Acerca de QGIS
Hide QGIS
Mostrar todo
Hide Others
Quit QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.

7.2 Paneles y Barras de Herramientas

From the View menu (or Settings), you can switch on and off QGIS widgets (Panels →) or toolbars (Toolbars
→). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item you want.
Each panel or toolbar can be moved and placed wherever you feel comfortable within QGIS interface. The list
can also be extended with the activation of Core or external plugins.

7.2.1 Barras de herramientas

La barra de herramientas proporciona acceso a la mayoría de las mismas funciones como las de los menús, y
herramientas adicionales para interactuar con el mapa. Cada elemento de la barra de herramientas tiene ayuda
emergente disponible. Mantenga el puntero del ratón sobre el elemento y una breve descripción del propósito de
la herramienta se mostrará.

Every toolbar can be moved around according to your needs. Additionally, they can be switched off using the
right mouse button context menu, or by holding the mouse over the toolbars.

Truco: Restauración de barras de herramientas
If you have accidentally hidden a toolbar, you can get it back by choosing menu option View → Toolbars →

(or Settings → Toolbars →). If for some reason a toolbar (or any other widget) totally disappears from the
interface, you’ll find tips to get it back at restoring initial GUI.
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Figure 7.2: The Toolbars menu

7.2.2 Paneles

Besides toolbars, QGIS provides by default many panels to work with. Panels are special widgets that you can
interact with (selecting options, checking boxes, filling values...) in order to perform a more complex task.

Below are listed default panels provided by QGIS:

• the Panel de capas

• the Browser Panel

• the Advanced Digitizing Panel

• the Spatial Bookmarks Panel

• the GPS Information Panel

• the Tile Scale Panel

• the Identify Panel

• the User Input Panel

• the Layer Order Panel

• el Layer Styling Panel

• el Panel de resumen estadístico

• the Panel de vista general de QGIS

• the Panel de mensajes de registro

• the Panel de deshacer/rehacer

• the Processing Toolbox
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Figure 7.3: El menú de paneles

7.3 Vista del mapa

Also called Map canvas, this is the “business end” of QGIS — maps are displayed in this area. The map displayed
in this window will depend on the vector and raster layers you have chosen to load.

When you add a layer (see e.g. Opening Data), QGIS automatically looks for its Coordinate Reference System
(CRS) and zooms to its extent if you work in a blank QGIS project. The layer’s CRS is then applied to the project.
If there are already layers in the project, and in the case the new layer has the same CRS as the project, its features
falling in the current map canvas extent will be visualized. If the new layer is in a different CRS from the project’s,
you must Enable on-the-fly CRS transformation from the Project → Project Properties → CRS (see Define On
The Fly (OTF) CRS Transformation). The added layer should now be visible if data are available in the current
view extent.

The map view can be panned, shifting the focus of the map display to another region, and it can be zoomed in and
out. Various other operations can be performed on the map as described in the Barras de herramientas description.
The map view and the legend are tightly bound to each other — the maps in view reflect changes you make in the
legend area.

Truco: Zum al mapa con la rueda del ratón
Puede utilizar la rueda del ratón para acercar y alejar zum en el mapa. Coloque el cursor del ratón dentro del mapa
y gire la rueda hacia adelante (hacia la derecha) para acercar y hacia atrás (hacia usted) para alejarlo. El zum se
centra en la posición del cursor del ratón. Puede personalizar el comportamiento del zum de la rueda del ratón
usando la pestaña Herramientas del mapa bajo el menú Configuración→ Opciones

Truco: Desplazar el mapa con las teclas de dirección y barra de espaciadora
Puede utilizar las teclas de flechas para desplazar el mapa. Coloque el cursor dentro del mapa y haga clic en la
tecla de flecha a la derecha para desplazarse al este, tecla de flecha izquierda para el oeste, flecha arriba para el
norte y flecha abajo al sur. Puede también desplazar el mapa utilizando la barra espaciadora o al hacer clic en la
rueda del ratón: basta con mover el ratón mientras mantiene pulsada la barra espaciadora o haga clic en la rueda
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del ratón.

7.4 Barra de Estado

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

On the right side of the scale display you can define a current magnification level for your map view. This allows
to zoom in to a map without altering the map scale, making it easier to accurately tweak the positions of labels
and symbols. The magnification level is expressed as a percentage. If the Magnifier has a level of 100%, then
the current map is not magnified. Additionally, a default magnification value can be defined within Settings →
Options → Rendering → Rendering behaviour, which is very useful for high resolution screen to avoid too small
symbols.

To the right of the magnifier tool you can define a current clockwise rotation for your map view in degrees.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Renderizado).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Truco: Calcular la escala correcta de su lienzo de mapa
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Herramientas generales

8.1 Ayuda de contexto

Cuando necesite ayuda sobre un tema especifico, puede acceder a la ayuda de contexto mediante el botón [Ayuda]
disponible en la mayoría de diálogos – tenga en cuenta que los complementos de terceros pueden apuntar a paginas
web dedicadas.

8.2 Paneles

QGIS provides by default many panels to work with. Some of these panels are described below while others may
be found in different parts of the document. A complete list of default panels provided by QGIS is available at
Paneles.

8.2.1 Panel de capas

The layers Panel lists all the layers in the project and helps you manage their visibility. A layer can be selected
and dragged up or down in the legend to change the Z-ordering. Z-ordering means that layers listed nearer the top
of the legend are drawn over layers listed lower down in the legend.

Nota: The Z-ordering behavior can be overridden by the Layer Order panel.

At the top of the Layers panel, a toolbar allows you to:

• Open the layer styling dock: toggle the layer styling panel on and off.

• Añadir nuevo grupo

• Manage Visibility: control visibility of layers and preset layers combination.

• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.

• Expand All or Collapse All layers and groups in the layers panel.

• and Remove Layer/Group currently selected.
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Figure 8.1: Barra de herramientas de capa en panel de capas

Nota: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Preset the layers visibility

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

All the added presets are also present in the map composer in order to allow you to create a map layout based on
your specific views (see Propiedades principales).

Overview of the context menu of the Layers panel

At the bottom of the toolbar, the main component of the Layers panel is the frame listing vector or raster layers
added to the project and, those layers can be organized in groups. Depending on the item selected in the panel, a
right-click shows a dedicated set of options presented below.
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Opción Capa vectorial Capa Ráster Grupo

Zum a capa/grupo

Mostrar vista general

Zum a resolución nativa (100%)

Extender utilizando extensión actual

Eliminar

Duplicar

Establecer escala de visibilidad de capa

Zum a la escala visible

Establecer SRC de la capa/grupo

Establecer SRC del proyecto a partir de la capa

Estilos →
Copiar estilo

Pegar estilo

Abrir tabla de atributos

Conmutar edición

Ediciones actuales → (en modo Edición)

Guardar como...

Guardar como archivo de definición de capa...

Filtrar...

Mostrar número de objetos espaciales

Propiedades

Mover al nivel superior

Cambiar nombre

Grupo seleccionado

Establecer grupo de datos WMS

Grupo Mutuamente Exclusivo

Añadir grupo

Tabla: Menú contextual de los elementos del panel de Capas

For GRASS vector layers, Toggle editing is not available. See section Digitalizar y editar una capa vectorial
GRASS for information on editing GRASS vector layers.

Interactúe con grupos y capas

Layers in the legend window can be organized into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Select some layers, right click in the legend window and choose Group Selected. The selected layers will
automatically be placed in a new group.

To bring a layer out of a group, you can drag it out, or right click on it and choose Move to top-level; the layer is
placed at the same level than the group it was inside. Groups can also be nested inside other groups.

The checkbox for a group will show or hide all the layers in the group with one click.
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Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

It is possible to select more than one layer or group at the same time by holding down the Ctrl key while selecting
the layers with the left mouse button. You can then move all selected layers to a new group at the same time.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Editing vector layer style

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles → in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer

• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Nota: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the El Selector de Símbolo dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Selector de color widget with a Color Wheel from which you can click a color and have it automatically
update the symbol fill color. For convenience, Recent colors are available at the bottom of the color wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Truco: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

8.2.2 Working with the Legend independent layer order

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate
it in the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your
layers in order of importance, but still display them in the correct order (see figure_layer_order; you can notice
that the airports features are displayed over the alaska polygon despite their layers placement in the Layers

panel). Unchecking the Control rendering order box underneath the list of layers will cause a revert to default
behavior.

8.2.3 Layer Styling Panel

This panel is somehow a shortcut to some of the features of the layer properties dialog. It indeed offers you a quick
and handy way to define the rendering and the behavior of a layer, and to visualize its effects without opening the
layer properties dialog.
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Figure 8.2: Define a legend independent layer order

Besides avoiding you dealing with the modal and blocking dialog of the layer properties, it also avoids you
cluttering the screen with features dialogs given that it embeds most of them (color selector, effects properties,
rule edit, label substitution...): e.g., clicking color buttons inside the layer style panel causes the color selector
dialog to be opened inside the layer style panel itself rather than as a separate dialog.

From a drop-down list of current layers in the layer panel, select an item and:

• set its symbology, transparency, and histogram in case of raster layer. These options are the same available
in Dialogo de Propiedades Raster

• set its symbology, and labels. These options are the same available in El Dialogo de las Propiedades del
Vector

• manage the associated style(s) as described in Managing Custom Styles

• follow the whole history of changes you applied to the layer style in the current project; you can therefore
cancel or restore to any state by selecting it in the list and hit [Apply] button.

Another powerful feature of this panel is the Live update checkbox. Tick it and your changes are automatically
rendered in the map canvas as you go on. You no longer need to hit the [Apply] button.

Truco: Add custom tabs to the Layer Styling panel
Using PyQGIS, you can set new tabs to manage layer properties in the Layer Styling Panel. See
https://nathanw.net/2016/06/29/qgis-style-dock-part-2-plugin-panels/ for an example.

8.2.4 Panel de resumen estadístico

Este panel puede mostrar algunas estadísticas de capas vectoriales especificas. El panel permite al usuario elegir:

• la capa vectorial;

• la columna o la expresión

• filtrar estadísticas a elementos seleccionados;
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Figure 8.3: Definir una simbología de capa desde el panel de diseño de capa
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• refrescar la información;

• la información estadística para desplegar con el botón interior derecho.

Información estadística disponible es (depende del tipo de campo)

Estadísticas Cadena Entero Coma flotante Fecha

Número

Contar valores distintos

Contar valores faltantes

Suma

Media

Desviación estándar

Desviación estándar en ejemplo

Valor mínimo

Valor máximo

Rango

Minoría

Mayoría

Variedad

Primer cuartil

Tercer cuartil

Rango intercuartil

Longitud mínima

Longitud máxima

Tabla: Estadística disponible para cada tipo de campo

8.2.5 Panel de vista general de QGIS

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

8.2.6 Panel de mensajes de registro

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

8.2.7 Panel de deshacer/rehacer

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above. More details at Undo and Redo edits.
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Figure 8.4: Mostrar estadística en un campo
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8.3 Renderizado

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Añadir una capa

• Desplazar o hacer zoom

• Redimensionando la ventana QGIS

• Cambiar la visibilidad de una o varias capas

QGIS le permite controlar el proceso de representación de varias maneras.

8.3.1 Renderizado dependiente de la escala

Scale-dependent rendering allows you to specify the minimum and maximum scales at which a layer (raster or
vector) will be visible. To set scale-dependent rendering, open the Properties dialog by double-clicking on the

layer in the legend. On the General tab, tick the Scale dependent visibility checkbox and enter the Minimum
(exclusive) and Maximum (inclusive) scale values.

You can also activate the scale dependent visibility on a layer from the Layers panel. Right-click on the layer and
in the context menu, select Set Layer Scale Visibility.

The Set to current canvas scale button helps you use the current map canvas scale as boundary of the range visibility.

Nota: When a layer is not rendered in the map canvas due to the map scale out of its visibility scale range, the
layer is greyed in the Layers panel and a new option Zoom to Visible Scale appears in the layer context menu.
Select it and the map is zoomed to the layer’s nearest visibility scale.

8.3.2 Controlar el renderizado del mapa

Map rendering can be controlled in various ways, as described below.

Suspender el renderizado

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Renderizado. Examples of when you might want to suspend rendering include:

• Añadir muchas capas y simbolizarlas antes de dibujar

• Añadir una o más capas grandes y establecer la dependencia de escala antes de dibujar

• Añadir una o más capas grandes y hacer zoom a una vista específica antes de dibujar

• Cualquier combinación de la anteriores

Marcar la casilla Renderizar habilita el renderizado y origina un refresco inmediato del lienzo del mapa.

Configurar la opción de añadir una capa

Puede establecer una opción para cargar siempre las nuevas capas sin dibujarlas. Esto significa que las capas se
añadirán al mapa pero su casilla de visibilidad en el panel Capas no estará marcada de forma predeterminada.
Para establecer esta opción, seleccione la opción de menú Configuración → Opciones y haga clic en la pestaña

Representación. Desmarque la casilla Por omisión, las nuevas capas añadidas al mapa se deben visualizar.
Cualquier capa añadida posteriormente al mapa estará desactivada (invisible) por omisión.
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Detener el renderizado

Para detener el dibujado del mapa, presione la tecla ESC. Esto detendrá el refresco del lienzo del mapa y dejará el
mapa parcialmente dibujado. Puede que tarde un poco desde que se presiona la tecla ESC hasta que se detenga el
dibujado del mapa.

Nota: Actualmente no es posible detener la representación — esto se desactivó en el paso a Qt4 debido a
problemas y cuelgues de la Interfaz de Usuario (IU).

Influir en la calidad del renderizado

QGIS has an option to influence the rendering quality of the map. Choose menu option Settings → Options, click

on the Rendering tab and select or deselect Make lines appear less jagged at the expense of some drawing
performance.

Acelerar renderizado

There are some settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Usar cacheado de representación cuando sea posible para acelerar redibujados

• Render layers in parallel using many CPU cores and then set the Max cores to use.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Save and Share Layer Properties

8.4.1 Managing Custom Styles

When a vector layer is added to map canvas, QGIS uses by default a random symbol/color to render its features.
You can however set a default symbol in Project → Project Properties → Default styles that will be applied to
each newly added layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings) for vector layer, or the pixels (band or color rendering, trans-
parency, pyramids, histogram ...) for raster.

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Add: A new style is created using the current options. By default, it will be saved in the QGIS project file.
See below to save the style in another file or a database

• Remove: delete unwanted style, in case you have more than one style defined for the layer.
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Figure 8.5: Vector layer style combobox options

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Truco: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style.

8.4.2 Storing Style in a File or a Database

While created styles from the Style combobox are by default saved inside the project and can be copied and pasted
from layer to layer in the project, it’s also possible to save them outside the project so that they can be loaded in
another project.

Save in plain text file

Clicking the Style → Save Style, you can save the style as a:

• QGIS layer style file (.qml)

• or SLD file (.sld), only available for vector layers.

Used on file based format layers (.shp, .tab...), Save as Default generates a .qml file along the layer (with
the same name). SLDs can be exported from any type of renderer – single symbol, categorized, graduated or
rule-based – but when importing an SLD, either a single symbol or rule-based renderer is created. That means that
categorized or graduated styles are converted to rule-based. If you want to preserve those renderers, you have to
stick to the QML format. On the other hand, it can be very handy sometimes to have this easy way of converting
styles to rule-based.
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Save in database

Vector layer style can also be stored in a database if the layer datasource is a database provider. Supported
formats are PostGIS, GeoPackage, SpatiaLite, MSSQL and Oracle. The layer style is saved inside a table (named
layer_styles) of the database. Click on Save Style → Save in database item then fill in the dialog to define a
style name, add a description, a .ui file if applicable and check if the style should be the default style.

You can save several styles for a single table in the database. However each table can have only one default
style. Default style can be saved in the layer database or in the QGIS local database, a SQLite database in the
~/.qgis2/ directory (where QGIS stores its local settings).

Figure 8.6: Save Style in database Dialog

Truco: Sharing style files between databases
You can only save your style in a database if the layer comes from such a database. You can’t mix databases (layer
in Oracle and style in MSSQL for instance). Use instead a plain text file if you want the style to be shared among
databases.

Nota: You may encounter issues to restore the layer_styles table from a PostgreSQL database backup.
Follow QGIS layer_style table and database backup to fix that.

Cargar estilos

When loading a layer in QGIS, if a default style already exists for this layer, QGIS loads the layer with this style.
Also Style → Restore Default looks for and loads that file when pressed, replacing current style of the layer.

The Style → Load Style helps you apply any saved style to a layer. While plain text file style (.sld or .qml) can
be applied to any layer whatever its format is, loading styles stored in database is only possible if the layer is from
the same database or the style is stored in the QGIS local database.

The Load Style from Database dialog displays a list of related styles to the layer found in the database and all the
other styles saved in it, with name and description.

Truco: Quickly share a layer style within the project
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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8.5 Selector de color

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

Truco: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the Settings → Options → General menu to have the
color applied to your items as soon as you pick it in the color chooser dialog.

The custom color chooser dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. The color is also identifiable as a HTML notation. Finally, there is an
opacity slider to set transparency level.

Modifying a color is as simple as clicking in the color wheel or ramp or in any of the color parameters sliders. You
can adjust such parameters with the spinbox beside or, handy, scrolling the mouse wheel over the corresponding
slider. You can also typeset the color html notation.

The dialog also provides a visual comparison between the current (applied to widget) and the new (being selected)
colors. Thanks to drag-and-drop, any of these colors can be saved in a slot for an easy access.

Figure 8.7: Color selector ramp tab

With color ramp or color wheel tab, you can browse to all possible color combinations and apply it to the item.

In the color swatches tab, you can choose from a preselected list of color palettes:

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.
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The latest palettes can be modified thanks to the and buttons at the bottom of the frame. The ... button
nearby the palette combobox also offers several options to:

• copy, paste, import or export colors

• create, import or remove color palettes. Check the Show in Color Buttons option to add the custom palette
to the color selector widget (see figure_color_selector).

Figure 8.8: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by macOS.

Truco: Quick color modification

Click the drop-down arrow at the right of the color box button to display a widget for a quick
color selection, either in the color wheel or from existing color palettes. You can also use it to copy or paste a
color.

8.6 Modos de Mezcla

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with the
pixel beneath it. The colors aren’t mixed.

• Iluminado: Este selecciona el máximo de cada componente del primer y segundo plano de píxeles. Tenga
en cuenta que los resultados tienden a ser irregulares y rigurosos.

• Pantalla: píxeles de luz de la fuente se pintan sobre el destino, mientras que los píxeles oscuros no lo son.
Este modo es muy útil para la mezcla de la textura de una capa con otra (por ejemplo, puede utilizar un
sombreado para texturizar otra capa).

• Esquivar: aclarará y saturar píxeles subyacentes en base a la ligereza del punto de imagen superior. Así, los
píxeles superiores más brillantes provocan la saturación y el brillo de los píxeles subyacentes a aumentar.
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Figure 8.9: Menú seleccionador rápido de color
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Esto funciona mejor si los píxeles superiores no son demasiado brillantes; de lo contrario el efecto sera
demasiado extremo.

• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

• Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.

8.7 Zum y paneo

QGIS provides tools to zoom and pan to your area of interest.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys. A Zoom factor can be set under the Settings →
Options → Map tools menu to define the scale behavior while zooming.

8.7.1 With the mouse wheel

You can press the mouse wheel to pan inside of the main window (on macOS, you may need to hold cmd key).
You can roll the mouse wheel to zoom in and out on the map; the mouse cursor position will be the center of the
zoomed area of interest. Holding down Ctrl while rolling the mouse wheel results in a finer zoom.

8.7.2 With the arrow keys

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow key to pan
south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out following the zoom factor set. Pressing Ctrl
+ or Ctrl - also performs an immediate zoom in/out on the map canvas.

When certain map tools are active (Identify, Measure...), you can perform a zoom by holding down Shift and
dragging a rectangle on the map to zoom to that area. This is enabled for the map tools which are not selection
tools (since they use Shift for adding to selection) nor edit tools.
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8.8 Mediciones

8.8.1 Información general

QGIS provides four means of measuring geometries:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Identificar objetos espaciales tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. The first three measuring
tools behave equally to global project settings:

• If “on the fly” CRS transformation (see Define On The Fly (OTF) CRS Transformation) is enabled, the
default measurement metric is - different from most other GIS - ellipsoidal, using the ellipsoid defined in
File → Project properties → General. This is true both when geographic and projected coordinate systems
are defined for the project.

• If you want to calculate the projected / planimetric area or distance using cartesian maths, the measure-
ment ellipsoid has to be set to “None / Planimetric” (File → Project properties → CRS). However, with a
geographic (= unprojected) CRS defined for the data and project, area and distance measurement will be
ellipsoidal.

• If “on the fly” CRS transformation is disabled, the measurement metric is planimetric when the project co-
ordinate system is projected and ellipsoidal when the project coordinate system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.

8.8.2 Measure length, areas and angles interactive

Click the icon in the Attribute toolbar to begin measurements. The downward arrow near the icon helps you

switch to the convenient tool to measure length, area or angle. The default unit used in the dialog is
the one set in Project → Project Properties → General menu.

Nota: Configuring the measure tool
While measuring length or area, clicking the Configuration button at the bottom of the widget helps you define
in menu Settings → Options → Map Tools the rubberband color, the precision of the measurements and the unit
behavior. You can also choose your preferred measurement or angle units but keep in mind that those values are
superseded in the current project by options made in Project → Project Properties → General menu.

All measuring modules use the snapping settings from the digitizing module (see section Configurar la tolerancia
del autoensamblado y radio de búsqueda). So, if you want to measure exactly along a line feature, or around a
polygon feature, first set its layer snapping tolerance. Now, when using the measuring tools, each mouse click
(within the tolerance setting) will snap to that layer.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
The tool then allows you to click points on the map. Each segment length, as well as the total, shows up in the
measure window. To stop measuring, click your right mouse button.

Note that you can use the drop-down list near the total to interactively change the measurement units while mea-
suring. This unit is kept for the widget until a new or another project is opened.
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The Info section in the dialog explains how calculations are made according to CRS settings available.

Figure 8.10: Medir Distancia

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. Right-
click to stop drawing. The Info section is also available as well as the ability to switch between different area
units.

Figure 8.11: Medir Área

Medir ángulo: Se pueden también medir ángulos. El cursor se convierte en forma de cruz. Se debe hacer clic para
dibujar el primer segmento del ángulo que se desea medir y a continuación mover el cursor para dibujar el ángulo
deseado. La medida se mostrará en el diálogo emergente.

Figure 8.12: Medir Ángulo

8.9 Selecting features

QGIS provides several tools to select features in the map canvas. Selection tools are available in View → Select
menu or in the Attributes toolbar.

Nota: Selection tools work with the currently active layer.

8.9.1 Selecting manually in the map canvas

To select one or several features with the mouse, you can use one of the following tools:

• Select Features by area or single click
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• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

Nota: Except the Select Features by Polygon tool, these manual selection tools allow you to select feature(s) in the
map canvas with a single click.

While using the Select Feature(s) tool, holding Shift or Ctrl toggles whether feature is selected (ie either
adds to the current selection or remove from it).

For the other tools, different behaviors can be performed holding:

• Shift: add features to the current selection

• Ctrl: substract features from the current selection

• Ctrl + Shift: intersect with current selection, ie only keep overlapping features from the current se-
lection

• Alt: select features that are totally within the selection shape. Combined to Shift or Ctrl keys, you can
add or substract features to/from the current selection.

8.9.2 Selección automática

The other selection tools, also available from the Attribute table, perform a selection based on feature’s attribute or
its selection state (note that attribute table and map canvas show the same information, so if you select one feature
in attribute table, it will be selected in map canvas also):

• Select By Expression... allows user to select features using expression dialog.

• Select Features By Value... or press F3

• Deselect Features from All Layers or press Ctrl+Shift+A to deselect all selected features in all layers.

• Select All Features or press Ctrl+A to select all features in the current layer.

• Invert Feature Selection to invert the selection in the current layer.

For example, if you want to find regions that are boroughs from regions.shp of the QGIS sample data, you

can use the Select features using an Expression icon. Then, you open the Fields and Values menu and choose the field
that you want to query. Double-click the field ‘TYPE_2’ and also click [Load all unique values] in the right
panel. From the list, choose and double-click ‘Borough’. In the Expression field, then you’d write the following
query:

"TYPE_2" = ’Borough’

From the expression builder dialog, you can also use the Function list → Recent (Selection) to make a selection
that you used before. The dialog remembers the last 20 used expressions. See Expresiones chapter for more
information and some example.

Truco: Save your selection into a new file
Users can save selected features into a New Temporary Scratch Layer or a New Vector Layer using Edit →
Copy Features and Edit → Paste Features as in the wanted format.
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8.9.3 Select Features By Value

This selection tool opens the layer’s feature form allowing the user to choose, for each field, which value to look
for, if the search should be case sensitive, and the operation that should be used.

Figure 8.13: Filter/Select features using form dialog

Alongside each field, there is a drop-down list with the operation options to control the search behaviour. The
common options are:

• Exclude Field - The field will not be used for searching

• Igual a (=)

• No igual a

• Falta (nulo)

• No Falta (no nulo)

Para campos numéricos y fecha, las opciones adicionales son:

• Mayor que (>)

• Menor que (<)

• Mayor que o igual a (>=)

• Menor que o igual a (<=)

• Entre (inclusivo)

• No está entre (inclusivo)

Para campos de texto, las opciones adicionales son:

• Contiene

• No contiene

For the text options above, it is also possible to use the Case sensitive option.

After setting all search options, you can use the Select features button to select the matching features. The drop-
down options are:

• Seleccionar objetos espaciales

• Añadir a una selección actual

• Filtrar la selección actual

• Eliminar de la selección actual

También puede limpiar todas las opciones utilizando el botón Restablecer formulario.

52 Chapter 8. Herramientas generales



QGIS User Guide, Publicación 2.18

8.10 Configuración de anulación definida por datos

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows following entries:

• Description... that indicates if the option is enabled, which input is expected, the valid input type and the
current definition. Hovering over the widget also pops up these information;

• Tipo de campo: una entrada para seleccionar entre los campos de la capa que coincidan con el tipo de
entrada válido;

• una entrada a la lista de Variable disponibles;

• botón Editar... para crear o editar la expresión a usar;

• botones de Pegar y Copiar;

• botón de Limpiar para eliminar la configuración.

Parámetros que se pueden utilizar con herramientas de definición de datos son:

• Estilo y parámetros de simbología

• Parámetros de Etiquetas

• Parámetros del diseñador

Truco: Use right-click to (de)activate the data overriding

You can enable or disable a configured data-defined override button by simply clicking the widget with the mouse
right button.

Nota: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken, the
icon is red or .

8.11 Identificar objetos espaciales

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.
To identify features, use:

• View → Identify Features menu,

• or press Ctrl + Shift + I (or Cmd + Shift + I),

• or click the Identify Features icon on the Attributes toolbar.

8.11.1 Using the Identify Features tool

QGIS offers two ways to identify features with the Identify Features tool:

• left click will identify features according to the mode set in the Identify Results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.
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Truco: Filter the layers to query with the Identify Features tool

Uncheck the Identifiable column in Project → (or Settings →), Project Properties → Identify layers menu in

front of a layer to avoid it being queried when using the Identify Features in a mode other than Current Layer.
This is a handy way to return features from only layers that are of interest for you.

If you click on feature(s), the Identify Results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Layer Properties →
Display. Then follows all the other information about the feature.

8.11.2 Feature informations

The Identify Results dialog can be customized to display custom fields, but by default it will display three kinds
of information:

• Actions: Actions can be added to the identify feature windows. The action is run by clicking on the action
label. By default, only one action is added, namely View feature form for editing. You can define
more actions in the layer’s properties dialog (see Propiedades de acciones).

• Derived: This information is calculated or derived from other information. This includes:

– general information about the feature and its geometry: feature id, length or perimeter and area in map
units depending on its geometry, the count of spatial parts and the number of the clicked part in case
of multi-geometry, the count of vertices in the feature and the number of the closest one to the point
clicked

– coordinates information: the X and Y (and Z/M if available) coordinate values of the clicked point,
the feature closest vertex and its first and last vertices. In case you click on a curved line using the info
tool, QGIS will also display the radius of that section in the panel result.

• Data attributes: This is the list of attribute fields and values for the feature that has been clicked.

Nota: Links in feature’s attributes are clickable from the Identify Results panel and will open in your default web
browser.

Figure 8.14: Identify Results dialog

8.11.3 The Identify Results dialog

At the top of the window, you have seven icons:
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• Expand tree

• Collapse tree

• Default behavior to define whether next identified features information should be collapsed or expanded

• View the feature form

• Clear Results

• Copy selected feature to clipboard

• Print selected HTML response

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• Current layer : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• Top down, stop at first: for only features from the upper visible layer.

• Top down: for all features from the visible layers. The results are shown in the panel.

• and Layer selection: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

Nota: Identify tool configuration
You can configure the identify feature in Project → Project Properties in the Identify layers tab. The table allows
user to select layer(s) that can be used by this tool to identify features (column Identifiable). You can also put this
layer in read-only mode with the checkbox in the last column.

The View can be set as Tree, Table or Graph. ‘Table’ and ‘Graph’ views can only be set for raster layers.

The identify tool allows you to Auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Otras funciones se pueden encontrar en el menú contextual del elemento identificado. Por ejemplo, del menú
contextual se puede:

• Ver el formulario del objeto espacial

• Zum a objeto espacial

• Copiar objeto espacial: Copiar toda la geometría y atributos del objeto espacial

• Toggle feature selection: Adds identified feature to selection

• Copiar el valor del atributo: copiar solo el valor del atributo sobre el cual se hizo clic

• Copiar atributos del objeto espacial: Copiar atributos del objeto espacial

• Limpiar resultados: quitar resultados de la ventana

• Limpiar resaltados: Deseleccionar los objetos espaciales en el mapa

• Resaltar todo

• Resaltar capa

• Activar capa: Elegir una capa para ser activada

• Propiedades de la capa: Abrir la ventana de propiedades de la capa.

• Expandir todo

• Colapsar todo
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8.12 Herramientas de anotaciones

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.15: Diálogo de texto de anotación

Haciendo doble clic sobre el elemento se abre un cuadro de diálogo con varias opciones. Hay un editor de texto
para escribir el texto con formato y otros ajustes de elementos. Por ejemplo, existe la opción de tener el elemento
colocado en una posición del mapa (mostrado por el símbolo del marcador) o tener el elemento en una posición
de la pantalla (no relacionado con el mapa). El elemento se puede mover por la posición del mapa (al arrastrar el
marcador del mapa) o moviendo solo el globo. Los iconos son parte del tema de los SIG, y se utilizan de forma
predeterminada en otros temas también.

The Move Annotation tool allows you to move the annotation on the map canvas.

8.12.1 Anotaciones HTML

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.12.2 Anotaciones SVG

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.12.3 Anotaciones de formulario

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.
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Figure 8.16: Customized qt designer annotation form

Nota: Si presiona Ctrl+T mientras está activa una herramienta Anotación (mover anotación, anotación de texto,
anotación de formulario), se invierten los estados de visibilidad de los elementos.

8.13 Marcadores espaciales

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later. By default, bookmarks
are saved on the computer, meaning that they are available from any project in the same computer. If you wish to
store the bookmark in the project file (.qgs) then you can do this by selecting the In Project checkbox.

8.13.1 Crear un marcador

Para crear un marcador:

1. Hacer zoom o desplazarse al área de interés.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Introduzca un nombre descriptivo para el marcador (hasta 255 caracteres).

4. Check the In Project box if you wish to save the bookmark in the project file.

5. Press Enter to add the bookmark or click elsewhere.

Tenga en cuenta que puede tener múltiples marcadores con el mismo nombre.

8.13.2 Trabajar con marcadores

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Zoom to a Bookmark: select the desired bookmark and then click Zoom To Bookmark. You can also zoom
to a bookmark by double-clicking on it.
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• Delete a Bookmark: select the bookmark and click Delete Bookmark. Confirm your choice.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.14 Anidar proyectos

Sometimes, you’d like to keep in different projects a bunch of layers with the same style. You can either create a
default style for these layers or embed them from another project to save you tons of work.

Embed layers and groups from an existing project has some advantages over styling:

• all types of layers (vector or raster, local or online...) can be added

• fetching groups and layers, you can keep the same tree structure of the “background” layers in your different
projects

• While the embedded layers are editable, you can’t change their properties such as symbology, labels, forms,
default values, actions... This ensures homogeneity throughout the projects

• modify the items in the original project and changes are propagated to all the other projects.

If you want to embed content from other project files into your project, select Layer → Embed Layers and Groups
and:

1. Press to look for a project; you can see the content of the project (see figure_embed_dialog).

2. Press Ctrl ( or Cmd) and click on the layers and groups you wish to retrieve.

3. Press [OK]. The selected layers and groups are embedded in the Layer panel and can be visualized in the
map canvas now. Names of embedded items appear in italic to distinguish them from regular layers and
groups.

Figure 8.17: Seleccionar capas y grupos para empotrar

Like any other layer, an embedded layer can be removed from the project by right-click on the layer and choose
Remove.

Truco: Change rendering of an embedded layer
It’s not possible to change rendering of an embedded layer, unless you make the changes in the original project
file. However, right-click on a layer and select Duplicate creates a layer which is fully-featured and not dependent
to the original project. You can then safely remove the linked layer.

8.15 Elementos decorativos

Las Ilustraciones de QGIS incluyen la Cuadrícula, Etiqueta de Copyright, Flecha de Norte y Barra de Escala. Se
usan para ‘adornar’ el mapa al agregar elementos cartográficos
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8.15.1 Cuadrícula

Cuadrícula permite agregar una rejilla de coordenadas y anotaciones a la vista del mapa.

Figure 8.18: El Diálogo Cuadrícula

1. Select from menu View → Decorations → Grid. The dialog starts (see figure_decorations_grid).

2. Activar la casilla Activar cuadrícula y establecer la definición de la cuadrícula de acuerdo con las capas
cargadas en la vista del mapa.

3. Activar la casilla Dibujar anotaciones y establecer la definición de las anotaciones de acuerdo con las
capas cargadas en la vista del mapa.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.15.2 Etiqueta de derechos de autor

Copyright label adds a copyright label using the text you prefer to the map.

Figure 8.19: El Diálogo de Derechos de Autor
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1. Select from menu View → Decorations → Copyright Label. The dialog starts (see fig-
ure_decorations_copyright).

2. Comprobar que la casilla de verificación Activar etiqueta de copyright este marcada.

3. Escribir el texto que se quiera colocar en el mapa. Se puede usar HTML como se muestra en el ejemplo.

4. Elegir la ubicación de la etiqueta en la lista desplegable Ubicación

5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.15.3 Flecha del Norte

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.

Figure 8.20: El Diálogo Flecha Norte

8.15.4 Barra de escala

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labelling of the bar.

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Para añadir una barra de escala:

1. Select from menu View → Decorations → Scale Bar. The dialog starts (see figure_decorations_scale).

2. Comprobar que la casilla de verificación Habilitar barra de escala esté marcada.

3. Elegir el estilo de la caja desplegable Estilo de la barra de escala
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Figure 8.21: El Diálogo Barra de Escala

4. Select the color for the bar Color of bar or use the default black color.

5. Set the Size of bar .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Elegir la ubicación de la lista desplegable Ubicación .

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Truco: Configuración de elementos decorativos
Al guardar un proyecto .qgs, cualquiera de los cambios que se hayan hecho a la cuadrícula, flecha de norte, barra
de escala y copyright se guardarán en el proyecto y se restaurán la próxima vez que cargue el proyecto.

8.16 Autenticación

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Sistema de autenticación.

A master password needs to be set up when initializing the authentication system and its portable database.

8.17 Variables

In QGIS, you can use variables to store useful recurrent values (e.g. the project’s title, or the user’s full name) that
can be used in expressions. Variables can be defined at the application’s global level, project level, layer level,
composition level, and composer’s item level. Just like CSS cascading rules, variables can be overwritten - e.g., a
project level variable will overwrite any application’s global level variables set with the same name. You can use
these variables to build text strings or other custom expressions using the @ character before the variable name.
For example in composer creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]
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Will render the label like this:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

Besides the preset read-only variables, you can define your own custom variables for any of the levels mentioned
above. You can manage:

• global variables from the Settings → Options menu;

• project’s variables from Project properties (see Propiedades del proyecto);

• vector layer’s variables from the Layer Properties dialog (see El Dialogo de las Propiedades del Vector);

• composition’s variables from the Composition panel in the Print composer (see Composition Panel);

• and composer item’s variables from the Item properties panel in the Print composer (see Opciones comunes
en los elementos del diseñador).

To differentiate from editable variables, read-only variable’s names and values are emphasized in italic. On the
other hand, higher level variables overwritten by lower level ones are strike through.

Figure 8.22: Variables editor at the project’s level

Nota: You can read more about variables and find some examples in Nyall Dawson’s Exploring variables in
QGIS 2.12, part 1, part 2 and part 3 blog posts.
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CHAPTER 9

Configuración QGIS

QGIS is highly configurable through the Settings menu. Choose between Options, Project Properties and Cus-
tomization.

Nota: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Opciones

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. You can modify the options according to your needs. Some of the changes may require a restart of QGIS
before they will be effective.

The tabs where you can customize your options are described below.

9.1.1 Configuración general

Aplicación

• Select the Style (QGIS restart required) and choose between ‘Oxygen’, ‘Windows’, ‘Motif’, ‘CDE’,
‘Plastique’ and ‘Cleanlooks’.

• Define the Icon theme . It can be ‘default’ or ‘Night Mapping’.

• Define the Icon size .

• Define the Font and its Size. The font can be Qt default or a user-defined one.

• Cambiar el Límite de tiempo para mensajes o diálogos con tiempo .

• Ocultar la pantalla de bienvenida al iniciar la aplicación

• Mostrar consejos al iniciar

• Check QGIS version at startup to keep you informed if a newer version is released

• Cajas de grupo al estilo QGIS

• Use native color chooser dialogs (see Selector de color)

• Use live-updating color chooser dialogs (see Selector de color)

• Canvas rotation support (restart required)
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Los archivos de proyecto

• Open project on launch (choose between ‘New’, ‘Most recent’, ‘Welcome Page’, and ‘Specific’).

When choosing ‘Specific’ use the to define the project to use by default. The ‘Welcome Page’ displays
a list of recent projects with screenshot.

• Crear nuevo proyecto desde el proyecto predeterminado. Tiene la posibilidad de presionar Establecer
el actual proyecto como predeterminado o sobre Restablecer el predeterminado. Puede navegar a través de
sus archivos y definir un directorio donde se encuentra las plantillas definidas por el usuario. Esto se añadirá

a Proyecto → Nueva plantilla de formulario. Si activa primero Crear nuevo proyecto desde proyecto
predeterminado y entonces guarde un proyecto en l la carpeta de las plantillas de proyecto.

• Solicitar guardar proyectos y fuentes de datos modificadas cuando sea necesario

• Pedir confirmación cuando se va a eliminar una capa

• Avisar cuando se abra un proyecto guardado con una versión anterior de QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.1.2 System Settings

SVG paths

Add or Remove Path(s) to search for Scalable Vector Graphic (SVG) symbols. These SVG files are then available
to symbolize features or decorate your map composition.

Rutas de complemento

Add or Remove Path(s) to search for additional C++ plugin libraries

QSettings

It helps you Reset user interface to default settings (restart required) if you made any customization.

Entorno

Variables de entorno del sistema ahora se puede ver, y muchos lo configuran en el grupo Entorno (ver fig-
ure_environment_variables). Esto es útil para las plataformas, como Mac, donde una aplicación GUI no heredan
necesariamente entorno del casco del usuario. También es útil para configurar y visualizar las variables de en-
torno para los conjuntos de herramientas externas controladas por la caja de herramientas de procesamiento (por
ejemplo, SAGA, GRASS), y para activar la salida de depuración para secciones específicas del código fuente.

• Utilizar variables personalizadas (requiere reiniciar - incluir separadores). Puede [Añadir] y [Borrar]
variables. Las variables de entorno ya definidas se muestran en Variables de entorno actuales, y es posible

filtrarlos activando Mostrar sólo variables de QGIS específicas.

9.1.3 Data Sources Settings

Atributos de entidades espaciales y tabla

• Open attribute table in a dock window

• Copy features as ‘Plain text, no geometry’, ‘Plain text, WKT geometry’, or ‘GeoJSON’ when pasting fea-
tures in other applications.

• Attribute table behavior : set filter on the attribute table at the opening. There are three possibilities:
‘Show all features’, ‘Show selected features’ and ‘Show features visible on map’.
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Figure 9.1: Variables del ambiente del sistema en QGIS

• Default view: define the view mode of the attribute table at every opening. It can be ‘Remember last view’,
‘Table view’ or ‘Form view’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representación de valores NULOS. Aquí, puede definir un valor para los datos de campos que tienen un
valor NULO.

Truco: Improve opening of big data attribute table
When working with layers with big amount of records, opening the attribute table may be slow as the dialog
request all the rows in the layer. Setting the Attribute table behavior to Show features visible on map will make
QGIS request only the features in the current map canvas when opening the table, allowing a quick data loading.

Note that data in this attribute table instance will be always tied to the canvas extent it was opened with, meaning
that selecting Show All Features within such a table will not display new features. You can however update the
set of displayed features by changing the canvas extent and selecting Show Features Visible On Map option in
the attribute table.

Manejo de fuente de datos

• Scan for valid items in the browser dock . You can choose between ‘Check extension’ and ‘Check file
contents’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Solicitar subcapas raster al abrir. Algunas subcapas raster soportadas — se les llama subdataset en GDAL.
Un ejemplo son los archivos netCDF — si hay muchos variables netCDF, GDAL ve cada variable como un
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subconjunto de datos. La opción le permite controlar cómo lidiar con subcapas cuando se abre un archivo
con subcapas. Dispone de las siguientes opciones:

– ‘Siempre’: Siempre preguntar (Si hay subcapas existentes)

– ‘Si es necesario’: Preguntar si la capa no tiene bandas, pero tiene subcapas

– ‘Nunca’: Nunca preguntar, no se cargará nada

– ‘Cargar todo’: Nunca preguntar, pero cargar todas las subcapas

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Añadir capas PostGIS con doble clic y seleccionar en modo extendido

• Añadir capas de Oracle con doble clic y seleccionar en modo extendido

• Ejecutar expresiones en el lado del servidor si es posible

Hidden Browser Path

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.1.4 Rendering Settings

Figure 9.2: Rendering tab of Project Properties dialog

Comportamiento de presentación

• Por defecto las nuevas capas añadidas al mapa se deben mostrar

• Utilizar el cacheo de presentación en lo posible a la velocidad de regeneración
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• Representación de capas en paralelo utilizando muchos núcleos CPU

• Máximo de núcleos a utilizar

• Intervalo de actualización del mapa (por defecto 250 ms)

• Habilitar simplificación de objetos espaciales por defecto a las nuevas capas añadidas

• Simplificación del umbral

• Simplification algorithm: This option performs a local “on-the-fly” simplification on feature’s and speeds
up geometry rendering. It doesn’t change the geometry fetched from the data providers. This is important
when you have expressions that use the feature geometry (e.g. calculation of area) - it ensures that these
calculations are done on the original geometry, not on the simplified one. For this purpose, QGIS provides
three algorithms: ‘Distance’ (default), ‘SnapToGrid’ and ‘Visvalingam’.

• Simplify on provider side if possible: the geometries are simplified by the provider (PostGIS, Oracle...)
and unlike the local-side simplification, geometry-based calculations may be affected

• Escala máxima a la que la capa se debe simplificar

• Magnification level (see the magnifier)

Nota: Besides the global setting, feature simplification can be set for any specific layer from its Layer properties
→ Rendering menu.

Calidad de representación

• Hacer que las líneas se muestren menos quebradas a expensas del rendimiento de la representación

Curve segmentation

• Segmentation tolerance: this setting controls the way circular arcs are rendered. The smaller maximum an-
gle (between the two consecutive vertices and the curve center, in degrees) or maximum difference (distance
between the segment of the two vertices and the curve line, in map units), the more straight line segments
will be used during rendering.

• Tolerance type: it can be ‘Maximum angle’ or ‘Maximum distance’

Rásters

• Con Selección de la banda RGB, puede definir el numero para la banda Roja, Verde y Azul.

Mejora de contraste

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Límites (mínimo/máximo) . Las opciones son ‘Corte del conteo acumulativo’, ‘Min/Máx’, ‘Media +/-
desviación estándar’.

• Límite para corte del conteo acumulativo de píxeles

• Multiplicador de la desviación estándar

Depuración

• Refrescar lienzo de mapa
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9.1.5 Colors Settings

Este menú le permite añadir algunos colores personalizados que puede encontrar en cada ventana de diálogo de
color de la representación. Verá un conjunto de colores predefinidos en la pestaña: se puede eliminar o editar
todos ellos. Por otra parte se puede añadir el color que se desea y realizar algunas operaciones de copiar y pegar.
Finalmente se puede exportar el conjunto de colores como un archivo gpl o importarlos.

9.1.6 Canvas and Legend Settings

Apariencia del mapa predeterminado (anulado por las propiedades del proyecto)

• Definir un Color de selección y un Color de fondo.

Leyenda de capa

• Double click action in legend . You can either ‘Open layer properties’, ‘Open attribute table’ or ‘Open
layer styling dock’ with the double click.

• Lo siguiente es posible Estilos de elementos de la leyenda:

– Comenzar el nombre de las capas con mayúsculas

– Poner en negrita los nombres de la capa

– Poner en negrita los nombres de grupo

– Mostrar nombres de atributos de clasificación

– Crear iconos de ráster (puede ser lento)

– you can also set the WMS getLegendGraphic Resolution

9.1.7 Map tools Settings

This tab offers some options regarding the behavior of the Identify tool.

• Search radius for identifying and displaying map tips is a tolerance distance within which the identify tool
will depict results as long as you click within this tolerance.

• Highlight color allows you to choose with which color should features being identified be highlighted.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.

• Minimum width determines how thick should the outline of a highlighted object be.

Herramienta de medición

• Definir Color de la banda de medida para herramienta de medida

• Definir Lugares decimales

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Kilometers’, ‘Feet’, ‘Yards’, ‘Miles’, ‘Nautical Miles’, ‘Degrees’ or
‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square kilometers’, ‘Square feet’, ‘Square yards’, ‘Square miles’,
‘Hectares’, ‘Acres’, ‘Square nautical miles’, ‘Square degrees” or ‘Map Units’)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’, ‘Seconds of arc’ or
‘Turns/revolutions’)

Mover y zum

• Define a Zoom factor for zoom tools or wheel mouse
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Escalas predefinidas

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.1.8 Composer Settings

Predeterminados de la composición

You can define the Default font used within the print composer.

Apariencia de la cuadrícula

• Definir el Estilo de cuadrícula (‘Sólido, ‘Puntos’, ‘Cruces’)

• Definir el Color de la cuadrícula

Valores predeterminados de la cuadrícula y guía

• Define the Grid spacing

• Definir el Desplazamiento de cuadrícula para x y y

• Define the Snap tolerance

Composer Paths

• Define Path(s) to search for extra print templates: a list of folders with custom composer templates to use
while creating new one.

9.1.9 Digitizing Settings

This tab helps you configure general settings when editing vector layer (attributes and geometry).

Creación de entidades espaciales

• Suppress attribute form pop-up after feature creation

• Reutilizar últimos valores de atributos introducidos

• Validar geometrías. Editar lineas y polígonos complejos con muchos nodos puede resultar a una repre-
sentación muy lenta. Esto se debe a los procesos de validación por defecto en QGIS puede tomar mucho
tiempo. Para acelerar la representación, es posible seleccionar la validación de geometría GEOS (a partir de
GEOS 3.3) o a pagarlo. La validación de geometría GEOS es mucho más rápido, pero la desventaja es que
sólo el primer problema de geometría será reportado.

Banda de medición

• Define Rubberband Line width, Line color and Fill color

• Don’t update rubberband during node editing

Autoensamblado

• Abrir opciones de autoensamblado en una ventana adosada(requiere reiniciar QGIS)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Definir Tolerancia de autoensamblado predeterminado en unidades de mapa o píxeles

• Definir el Radio de búsqueda para edición de vértices en unidades de mapa o píxeles

Marcar vértices

• Mostrar marcadores sólo para los objetos espaciales seleccionados
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• Definir vértice Estilo de marcador (‘Cruz’ (predeterminado), ‘Círculo semitransparente’ o ‘Nada’)

• Definir vértice Tamaño de marcador

Herramienta de desplazamiento de curva

The next 3 options refer to the Offset Curve tool in Digitalización avanzada. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Join style: ‘Round’, ‘Mitre’ or ‘Bevel’

• Segmentos del cuadrante

• Límite Miter

9.1.10 Configuración de GDAL

GDAL is a data exchange library for raster files. In this tab, you can Edit create options and Edit Pyramids Options
of the raster formats. You can define which GDAL driver is to be used for a raster format, as in some cases more
than one GDAL driver is available.

9.1.11 CRS Settings

SRC predeterminado para nuevos proyectos

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Seleccionar un SRC y Empezar siempre nuevos proyectos con este SRC

SRC para nuevas capas

Esta área permite definir la acción a realizar cuando una nueva capa es creada, o cuando una capa sin SRC es
cargada.

• Prompt for CRS

• Use project CRS

• Use default CRS

Por defecto transformación de datum

• Preguntar por la trasformación del datum cuando el predeterminado no este definido

• With the ‘on-the-fly’ CRS transformation enabled and the above option checked, adding layers of different
CRS opens the Select datum transformations dialog. This offers you to select the most appropriate trans-
formation settings. Validating this dialog with the ‘Remember selection’ option checked populates the table
under CRS → Default datum transformations with information about ‘Source CRS’ and ‘Destination CRS’
as well as ‘Source datum transform’ and ‘Destination datum transform’. From now, QGIS automatically

uses the selected datum transformation for further transformation between these two CRSs until you
remove it from the list.

You can use the button to add a datum transformation if you know its parameters (source and destination
ellipsoids and the numbers from the transformation table). You then need to manually enter each setting.

Nota: For more information on how QGIS handles layers projection, please read the dedicated section at Trabajar
con Proyecciones.
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9.1.12 Locale Settings

• Override system locale and Locale to use instead

• Información acerca del idioma del sistema

9.1.13 Authentication Settings

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Sistema de
autenticación for more details.

9.1.14 Network Tab

General

• Definir Dirección de búsqueda de WMS, por omisión es http://geopole.org/wms/search?search=\%1\&type=rss

• Definir Expiró el tiempo para solicitudes de red - por omisión 60000

• Define Default expiration period for WMS Capabilities (hours) - default is 24

• Definir Periodo de expiración predeterminada para teselas WMS-C/WMTS (en horas) - por omisión 24

• Define Max retry in case of tile or feature request errors

• Definir Agente- Usuario

Configuración de caché

Definir la configuración del caché Directorio y un Tamaño.

• Usar proxy para acceso web y definir ‘Servidor’, ‘Puerto’, ‘Usuario’, y ‘Contraseña’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy se determina con base en el proxy de aplicación que establece el uso

– Socks5Proxy: Proxy genérico para cualquier tipo de conexión. Soporta TCP, UDP, unión a un puerto
(conexiones entrantes) y autenticación.

– HttpProxy: Implementado con el comando “CONNECT”, sólo admite conexiones TCP salientes; ad-
mite la autenticación.

– HttpCachingProxy: Implementando el uso de comandos HTTP normales, es útil sólo en el contexto
de peticiones HTTP.

– FtpCachingProxy: Implementar el uso de un proxy FTP, es útil sólo en el contexto de las peticiones
FTP.

Excluir algunas URLs se puede agregar a la caja de texto debajo los valores del proxy (ver Figure_Network_Tab).

If you need more detailed information about the different proxy settings, please refer to the manual of the under-
lying QT library documentation at http://doc.qt.io/qt-4.8/qnetworkproxy.html#ProxyType-enum

Truco: Utilizar proxies
Using proxies can sometimes be tricky. It is useful to proceed by ‘trial and error’ with the above proxy types, to
check if they succeed in your case.
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Figure 9.3: Configurar proxy en QGIS
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9.1.15 Variables Settings

The Variables tab lists all the variables available at the global-level.

It also allows the user to manage global-level variables. Click the button to add a new custom global-level

variable. Likewise, select a custom global-level variable from the list and click the button to remove it.

More information about variables in the Variables section.

9.1.16 Advanced Settings

Depending on your OS, all the settings related to QGIS (UI, tools, data providers, default values, plugins options...)
are saved:

• in a text file: $HOME/.config/QGIS/QGIS2.conf

• in the properties list file: $HOME/Library/Preferences/org.qgis.qgis.plist

• in the registry under: HKEY\CURRENT_USER\Software\QGIS\qgis

The Advanced tab offers you in a single place, regardless your OS, means to manage these settings through the
Advanced Settings Editor. After you promise to be careful, the widget is populated with a tree of all QGIS settings,
which you can directly edit.

Advertencia: Avoid using the Advanced tab settings blindly
Be careful while modifying items in this dialog given that changes are automatically applied. Doing changes
without knowledge can break your QGIS installation in various ways.

9.2 Propiedades del proyecto

In the properties window for the project under Project → Project Properties (or Settings → Project Proper-
ties), you can set project-specific options.

The project-specific options overwrite their equivalent in the options described above.

• In the General tab, the general settings let you:

– dé un texto al título del proyecto aparte de la ruta del archivo del proyecto

– escoge el color a usar para objetos espaciales cuando son seleccionados

– escoger el color de fondo: el color a usar para la tela de fondo del mapa

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:
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* Attribute table field update bar

* Cálculos de calculadora de campo

* Identify tool derived length, perimeter and area values

* Default unit shown in measure dialog

The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.4: General tab of Project Properties dialog

• The CRS tab enables you to choose the Coordinate Reference System for this project, and to enable on-
the-fly re-projection of raster and vector layers when displaying layers from a different CRS. For more
information on projection’s handling in QGIS, please read Trabajar con Proyecciones section.

• With the Identify layers tab, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

You can also set whether a layer should appear as read-only, meaning that it can not be edited by the
user, regardless of the data provider’s capabilities. Although this is a weak protection, it remains a quick
and handy configuration to avoid end-users modifying data when working with file-based layers.

• The Default Styles tab lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.
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• The tab OWS Server allows you to configure your project in order to publish it online. Here you can
define information about the QGIS Server WMS and WFS capabilities, extent and CRS restrictions. More
information available in section Prepare a project to serve and subsequent.

• The Macros tab is used to edit Python macros for projects. Currently, only three macros are available:
openProject(), saveProject() and closeProject().

Figure 9.5: Definición macro en QGIS

• The Relations tab is used to define 1:n relations. The relations are defined in the project properties dialog.
Once relations exist for a layer, a new user interface element in the form view (e.g. when identifying a
feature and opening its form) will list the related entities. This provides a powerful way to express e.g. the
inspection history on a length of pipeline or road segment. You can find out more about 1:n relations support
in Section Creating one or many to many relations.

• In the Data Sources tab, you can:

– Evaluate default values on provider side: When adding new features in a PostGreSQL table, fields
with default value constraint are evaluated and populated at the form opening, and not at the commit
moment. This means that instead of an expression like nextval(’serial’), the field in the Add
Feature form will display expected value (e.g., 25).

– Automatically create transaction groups where possible: When this mode is turned on, all (post-
gres) layers from the same database are synchronised in their edit state, i.e. when one layer is put into
edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which
gets committed when the user clicks save layer. Note that you can (de)activate this option only if no
layer is being edited in the project.

• The Variables tab lists all the variables available at the project’s level (which includes all global variables).

Besides, it also allows the user to manage project-level variables. Click the button to add a new custom

project-level variable. Likewise, select a custom project-level variable from the list and click the button
to remove it. More information on variables usage in the General Tools Variables section.

9.3 Personalización

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
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panels they need.

Nota: Antes de aplicar los cambios, debe reiniciar QGIS.

Figure 9.6: El diálogo de Personalización

Ticking the Enable customization checkbox is the first step on the way to QGIS customization. This enables
the toolbar and the widget panel from which you can uncheck and thus disable some GUI items.

The configurable item can be:

• a Menu or some of its sub-menus from the Barra de Menú

• a whole Panel (see Paneles y Barras de Herramientas)

• the Status bar described in Barra de Estado or some of its items

• a Toolbar: the whole bar or some of its icons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.

Truco: Easily restore predefined QGIS
The initial QGIS GUI configuration can be restored by one of the methods below:

• unchecking Enable customization option in the Customization dialog or click the Check All button

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• launching QGIS at a command prompt with the following command line qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab (see the warning).

In most cases, you need to restart QGIS in order to have the change applied.
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9.4 Atajos de teclado

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra de Menú. Addi-
tionally, the menu option Settings → Configure Shortcuts... allows you to change the default keyboard shortcuts
and add new keyboard shortcuts to QGIS features.

Figure 9.7: Define shortcut options

Configuration is very simple. Just select a feature from the list and click on :

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

Proceed as above for any other tools you wish to customize. Once you have finished your configuration, simply
[Close] the dialog to have your changes applied. You can also [Save] the changes as an .XML file and [Load]
them into another QGIS installation.
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CHAPTER 10

Trabajar con Proyecciones

QGIS allows users to define a global and project-wide CRS (coordinate reference system) for layers without a
pre-defined CRS. It also allows the user to define custom coordinate reference systems and supports on-the-fly
(OTF) projection of vector and raster layers. All of these features allow the user to display layers with different
CRSs and have them overlay properly.

10.1 Vista general de la ayuda de proyección

QGIS tiene ayuda para aproximadamente 2 700 SRC conocidos. Las definiciones para cada SRC esta almacenada
en una base de datos SQLite que esta instalada con QGIS. Normalmente, no se necesita manipular la base de datos
directamente. De hecho, si lo hace podría provocar que la ayuda de la proyección falle. Los SRC personalizados
estan almacenados en una base de datos de usuario. Consulte la sección Sistema de referencia de coordenadas
personalizada para obtener información sobre la gestión de su sistema de referencia de coordenadas personalizada.

Los SRC disponibles en QGIS se basan en los definidos por el European Petroleum Search Group (EPSG) y el
Instituto Geográfico Nacional de Francia (IGNF) y se abstraen en gran parte de las tablas de referencia espaciales
utilizados en GDAL. Los identificadores EPSG están presentes en la base de datos y se pueden utilizar para
especificar un SRC en QGIS.

Para utilizar la proyección OTF, o bien sus datos deben contener información sobre su sistema de referencia de
coordenadas o tendrá que definir un SRC mundial, capa o para todo el proyecto. Para las capas de PostGIS,
QGIS utiliza el identificador de referencia espacial que se especificó cuando se creó la capa. Para los datos
reconocidos por OGR, QGIS se basa en la presencia de un medio reconocido de la especificación del SRC. En
el caso de archivos shape, esto significa un archivo que contiene el texto well-known (WKT) especificación del
SRC. Este archivo de proyección tiene el mismo nombre base que el archivo shape y una extensión .prj Por
ejemplo, un archivo shape denominado alaska.shp tendría un archivo de proyección correspondiente llamado
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project

Properties dialog under the Project (or Settings) menu.

10.2 Especificar proyección global

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This

default can be changed via the Select CRS button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_options. This choice will be saved for use in
subsequent QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

The options shown in figure_projection_options are:
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Figure 10.1: CRS tab in the QGIS Options Dialog

• Prompt for CRS

• Use project CRS

• Usar SRC por omisión mostrado abajo

If you want to define the coordinate reference system for a certain layer without CRS information, you can also
do that in the General tab of the raster and vector properties dialog (see Propiedades Generales for rasters and
Propiedades Generales for vectors). If your layer already has a CRS defined, it will be displayed as shown in
Pestaña General en cuadro de diálogo de propiedades de las capas vectoriales.

Truco: CRS in the Layers Panel
Right-clicking on a layer in the Layers Panel (section Panel de capas) provides two CRS shortcuts. Set layer CRS
takes you directly to the Coordinate Reference System Selector dialog (see figure_projection_project). Set project
CRS from Layer redefines the project CRS using the layer’s CRS.

10.3 Define On The Fly (OTF) CRS Transformation

QGIS supports on the fly CRS transformation for both raster and vector data. However, OTF is not activated by
default. When OTF is off, each layer is drawn using the coordinates as read from the data source. When OTF is
on, each layer’s coordinates are transformed to the CRS of the project.

There are three ways to enable On The Fly CRS Transformation:

• Select Project Properties → CRS from the Project ( or Settings) menu. You can then activate the

Enable on the fly CRS transformation (OTF) checkbox in the CRS tab and select the CRS to use
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(see Coordinate Reference System Selector)

• Click on the CRS status icon in the lower right-hand corner of the status bar, leading you to the previous
dialog.

• Turn OTF on by default in the CRS tab of the Settings → Options dialog by selecting Enable ‘on
the fly’ reprojection by default or Automatically enable ‘on the fly’ reprojection if layers have different CRS.

If you have already loaded a layer and you want to enable OTF reprojection, the best practice is to open the

CRS tab of the Project Properties dialog, activate the Enable ‘on the fly’ CRS transformation checkbox, and

select a CRS. The CRS status icon will no longer be greyed out, and all layers will be OTF projected to the CRS
shown next to the icon.

Figure 10.2: Project Properties Dialog

10.4 Coordinate Reference System Selector

This dialog helps you assign a Coordinate Reference System to a project or a layer, provided a set of projection
databases. Items in the dialog are:

• Filter: If you know the EPSG code, the identifier, or the name for a coordinate reference system, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

• Recently used coordinate reference systems: If you have certain CRSs that you frequently use in your
everyday GIS work, these will be displayed in this list. Click on one of these items to select the associated
CRS.

• Coordinate reference systems of the world: This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

• PROJ.4 text: This is the CRS string used by the PROJ.4 projection engine. This text is read-only and
provided for informational purposes.

Truco: Looking for a layer CRS? Use the CRS selector.
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Sometimes, you receive a layer and you don’t know its projection. Assuming that you have another layer with a
valid crs that should overlaps with it, enable the OTF reprojection and, in the General tab of the Layer properties
dialog, use the Coordinate Reference System selector to assign a projection. Your layer position is then moved
accordingly. You may have to do some trial and error in order to find the right position, hence its original CRS.

Nota: When operating across layers, for example, computing intersections between two layers, it is important
that both layers have the same CRS. To change the projection of an existing layer, it is insufficient to simply
change the CRS in that layer’s properties. Instead you must save the layer as a new layer, and choose the desired
CRS for the new layer.

10.5 Sistema de referencia de coordenadas personalizada

Si QGIS no provee el sistema de referencia por coordenadas que necesita, puede definir un CRS predeterminado.

Para definir un CRS, elegir Custom CRS... del menú Ajustes. CRSs personalizados se almacenan en su base
de datos de usuario lqgl. A más del CRS personalizado, esta base de datos también contiene sus separadores
espaciales y otros datos personalizados.

Figure 10.3: Diálogo SRC Personalizado

Definir un CRS personalizado en QGIS requiere un buen entendimiento de la librería de proyección PROJ.4. Para
comenzar, referir a “Procedimientos de Proyección Cartográfica para el Entorno UNIX - Un Manual de Usuario”
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por Gerald I Evenden, Reporte de Encuesta Geológica de Archivo Abierto U.S. 90-284, 1990 (disponible en
ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

This manual describes the use of the proj.4 and related command line utilities. The cartographic parameters
used with proj.4 are described in the user manual and are the same as those used by QGIS.

El diálogo Definición del Sistema de Referencia de Coordenadas personalizada sólo necesita dos parámetros para
definir un usuario de SRC:

1. Un nombre descriptivo

2. Los parámetros cartográficos en el formato PROJ.4

To create a new CRS, click the Add new CRS button and enter a descriptive name and the CRS parameters.

Note que :guilaber:‘Parámetros‘ debe empezar con un bloque “+proj=”, para repersentar el nuevo sistema de
referencia por coordenadas.

Usted puede evaluar sus parámetros CRS para ver si dan resultados sensatos. Para hacer esto, ingresar valores de
longitud y latitud conocidos WGS 84 en campos Norte :guilable:‘Este‘, respectivamente. Clic en [Calcular], y
comparar los resultados con valores conocidos en su sistema de referencia por coordenadas.

10.6 Transformaciones de datos perdeterminadas

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

En la pestaña CRS bajo Settings → Options se puede:

• Hacer qu QGIS le pida cuando necesite definir una transformación usando Pedir transformación de
datos cuando no se defina una predeterminación

• editar una lista de predeterminaciones de usuarios para transformaciones.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

Administrar el origen de datos

11.1 Opening Data

As part of an Open Source Software ecosystem, QGIS is built upon different libraries that, combined with its own
providers, offer capabilities to read and often write a lot of formats:

• Vector data formats include ESRI formats (shapefiles, geodatabases...), MapInfo and MicroStation file for-
mats, AutoCAD DWG/DXF, GeoPackage, GeoJSON, GRASS, GPX, KML, Comma Separated Values, and
many more... Read the complete list of OGR vector supported formats;

• Raster data formats include ArcInfo Binary Grid, ArcInfo ASCII Grid, JPEG, GeoTIFF, ERDAS IMAGINE,
MBTiles, R or Idrisi rasters, ASCII Gridded XYZ, GDAL Virtual, SRTM, Sentinel Data, and many more...
Read the complete list of raster supported formats;

• Database formats include PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, DB2 or MSSQL Spatial,
MySQL...;

• Support of web data services (WM(T)S, WFS, WCS, CSW, ArcGIS Servers...) is also handled by QGIS
providers (see QGIS como Cliente de Datos OGC);

• You can also read supported files from archived folders and use QGIS native formats such as virtual and
memory layers.

As of the date of this document, more than 80 vector and 140 raster formats are supported by the GDAL/OGR and
QGIS native providers.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
proprietary libraries, or the GDAL/OGR installation of your OS may not have been built to support the format you
want to use. To have a list of available formats, run the command line ogrinfo --formats (for vector) or
check settings → Options → GDAL menu (for raster) in QGIS.

11.1.1 The Browser Panel

QGIS Browser is one of the main panels of QGIS that lets you quickly and easily add your data to projects. It
helps you navigate in your filesystem and manage geodata, regardless the type of layer (raster, vector, table), or
the datasource format (plain or compressed files, database, web services).

To add a layer into a project:

1. right-click on QGIS toolbar and check Browser Panel to activate it or select it from the menu View →

Panels (or Settings → Panels);

2. a browser tree with your filesystem, databases and web services is displayed;

3. find the layer in the list;
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4. right-click on its name and select Add selected layer(s). Your layer is now added to the Layers Panel and
can be viewed in the map canvas.

Nota: You can also add a layer or open a QGIS project directly from the Browser panel by double-clicking its
name or by drag-and-drop into the map canvas.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the
legend and choosing Properties from the context menu. See section Propiedades de Estilo for more information
on setting symbology of vector layers.

At the top of the Browser panel, you find some icons that help you to:

• Add Selected Layers: you can also add data into the map canvas by selecting Add selected layer(s) from the
layer’s context menu;

• Refresh the browser tree;

• Filter Browser to search for specific data. Enter a search word or wildcard and the browser will filter the tree
to only show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed.
See the Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or
not. It can also be set to:

– normal: return any item containing the search text;

– using wildcard(s): fine tune the search using ? and/or * characters to specify the position of the
search text;

– using a regular expression.

• Collapse All the whole tree;

• Enable/disable properties widget: when toggled on, a new widget is added at the bottom of the panel showing, if
applicable, metadatas of the selected item.

Right-click an item in the browser tree helps you to:

• in case of file or table, display its metadata or open it in your project. Tables can even be renamed, deleted
or truncated;

• in case of folder, bookmark it into your favourites, hide it from the browser tree. Hidden folders can be
managed from the Settings → Options → Data Sources tab;

• create connection to databases or web servers;

• refresh, rename or delete schema.

You can also import files into databases or copy tables from one schema/database to another one with a simple
drag-and-drop. There is a second browser panel available to avoid long scrolling while dragging. Just select the
file and drag-and-drop from one panel to the other.

Truco: Add layers to QGIS by simple drag-and-drop from your OS file browser
You can also add file(s) to the project by drag-and-dropping them from your operating system file browser to the
Layers Panel or the map canvas.

11.1.2 El gestor de Base de Datos

The DB Manager Plugin is another one of the main and native tools to integrate and manage spatial database
formats supported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, MSSQL, DB2, Virtual layers) in
one user interface. It can be activated from the Plugins → Manage and Install Plugins... menu.
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Figure 11.1: QGIS Browser panels side-by-side

The DB Manager Plugin provides several features:

• connect to databases and display its structure and contents;

• preview tables of databases;

• add layers to map canvas, either by double-click or drag-and-drop;

• add layers to a database from the QGIS Browser or from another database;

• create and add output of SQL queries to the map canvas;

• create virtual layers.

More information on DB Manager capabilities are exposed in Complemento administrador de BBDD.

11.1.3 Provider-based loading tools

Beside Browser Panel and DB Manager, the main tools provided by QGIS to add layers regardless the format,
you’ll also find tools that are specific to data providers.

Nota: Some external plugins also propose tools to open specific format files in QGIS.

Loading a layer from a file

To load a layer from a file, you can:

• for vector data (like Shapefile, Mapinfo or dxf layer), click on Add Vector Layer toolbar button, select the

Layer → Add Layer → Add Vector Layer menu option or press Ctrl+Shift+V. This will bring up a
new window (see figure_vector_add) from which you can check File and click on [Browse]. You can
also specify the encoding for the file if desired.
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Figure 11.2: Diálogo del complemento administrador de BBDD

Figure 11.3: Diálogo de Añadir capa vectorial
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• for raster layers, click on the Add Raster Layer icon, select the Layer → Add Layer → Add Raster Layer
menu option or type Ctrl+Shift+R.

That will bring up a standard open file dialog (see figure_vector_open), which allows you to navigate the file

system and load a shapefile, a geotiff or other supported data source. The selection box Filter allows you
to preselect some supported file formats. Only the formats that have been well tested appear in the list. Other
untested formats can be loaded by selecting All files (*.*).

Figure 11.4: Abre un Diálogo de Capa Vectorial Soportada por OGR

Selecting a file from the list and clicking [Open] loads it into QGIS. More than one layer can be loaded at the same
time by holding down the Ctrl or Shift key and clicking on multiple items in the dialog. Figure_vector_loaded
shows QGIS after loading the alaska.shp file.

Nota: Because some formats like MapInfo (e.g., .tab) or Autocad (.dxf) allow mixing different types of
geometry in a single file, loading such format in QGIS opens a dialog to select geometries to use in order to have
one geometry per layer.

Using the Add Vector Layer tool:

• You can also load specific formats like ArcInfo Binary Coverage, UK. National Transfer
Format, as well as the raw TIGER format of the US Census Bureau or OpenfileGDB. To do that,
you’d need to select Directory as Source type. In this case a directory can be selected in the dialog after
pressing [Browse].

• With the Database source type you can select an existing database connection or create one to
the selected database type. Available database types are ODBC, OGDI Vectors, Esri Personal
Geodatabase, MySQL as well as PostgreSQL or MSSQL.

Pressing the [New] button opens the Create a New OGR Database Connection dialog whose parameters are
among the ones you can find in Crear una conexión almacenada. Pressing [Open] you can select from the
available tables for example of the PostGIS enabled database.

• The last source type, Protocol, enables to open data from the web using for example GeoJSON or
CouchDB format. After selecting the type you have to fill URI of the source.

Truco: Load layers and projects from mounted external drives on macOS

11.1. Opening Data 89



QGIS User Guide, Publicación 2.18

Figure 11.5: QGIS con archivo shape de Alaska cargado

On macOS, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open Project. We are working on a more macOS-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.

Importing a delimited text file

Delimited text file (e.g. .csv, .txt) can be loaded in QGIS using the tools described above. However, loaded
this way, it’ll show up like a simple table data. Sometimes, delimited text files can contain geometric data you’d

want to visualize; this is what the Add Delimited Text Layer is designed for.

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To enable
QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter by
activating:

• CSV (comma separated values);

• Custom delimiters, choosing among some predefined delimiters like comma, space, tab,
semicolon...;

• or Regular expression delimiter and entering text into the Expression field. For example, to change the
delimiter to tab, use \t (this is a regular expression for the tab character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.
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Figure 11.6: Delimited Text Dialog

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

There is also a helper option that allows you to trim leading and trailing spaces from fields — Trim fields.

Also, it is possible to Discard empty fields. If necessary, you can force a comma to be the decimal separator

by activating Decimal separator is comma.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionally, you can enable:

• Use spatial index to improve the performance of displaying and spatially selecting features;

• Use subset index;

• Watch file to watch for changes to the file by other applications while QGIS is running.

Importing a DXF or DWG file

DXF files can be added to QGIS by simple drag-and-drop from the common Browser Panel. You’ll be prompted
to select the sublayers you’d like to add to the project. Layers are added with random style properties.

Nota: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

To keep the dxf/dwg structure and its symbology in QGIS, you may want to use the dedicated DWG/DXF Import...
tool.

Importing OpenStreetMap Vectors

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
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from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides support for OSM
data.

Using the Browser Panel, you can load a .osm file to the map canvas, in which case you’ll get a dialog to select
sublayers based on the geometry type. The loaded layers will contain all the data of that geometry type in the file
and keep the osm file data structure.

To avoid working with a such complex data structure, and be able to select only features you need based on their
tags, QGIS provides a core and fully integrated OpenStreetMap import tool:

• To connect to the OSM server and download data, open the menu Vector → OpenStreetMap → Download
data.... You can skip this step if you already obtained an .osm XML file using JOSM, Overpass API or any
other source;

• The menu Vector → OpenStreetMap → Import Topology from XML... will convert your .osm file into a
SpatiaLite database and create a corresponding database connection;

• The menu Vector → OpenStreetMap → Export Topology to SpatiaLite... then allows you to open the
database connection, select the type of data you want (points, lines, or polygons) and choose tags to im-

port. This creates a SpatiaLite geometry layer that you can add to your project by clicking on the
Add SpatiaLite Layer toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu
(see section SpatiaLite Layers).

GPS

Loading GPS data in QGIS can be done using the core plugin: GPS Tools. Instructions are described in Section
Plugin de GPS.

GRASS

Working with GRASS vector data is described in Section Integracion GRASS SIG.

SpatiaLite Layers

The first time you load data from a SpatiaLite database, begin by:

• clicking on the Add SpatiaLite Layer toolbar button;

• selecting the Add SpatiaLite Layer... option from the Layer → Add Layer menu;

• or by typing Ctrl+Shift+L.

This will bring up a window that will allow you either to connect to a SpatiaLite database already known to QGIS,
which you can choose from the drop-down menu, or to define a new connection to a new database. To define a
new connection, click on [New] and use the file browser to point to your SpatiaLite database, which is a file with
a .sqlite extension.

QGIS also supports editable views in SpatiaLite.

Database related tools

Crear una conexión almacenada

In order to read and write tables from the many database formats QGIS supports you’ll need to create a connection
to that database. While QGIS Browser Panel is the simplest and recommanded way to connect and use databases
within, QGIS provides specific tools you can use to connect to each of them and load their tables:

92 Chapter 11. Administrar el origen de datos



QGIS User Guide, Publicación 2.18

• Add PostGIS Layer... or by typing Ctrl+Shift+D

• Add MSSQL Spatial Layer or by typing Ctrl+Shift+M

• Add Oracle Spatial Layer... or typing Ctrl+Shift+O

• Add DB2 Spatial Layer... or typing Ctrl+Shift+2

These tools are accessible either from the Manage Layers Toolbar or the Layer → Add Layer → menu. Connecting
to SpatiaLite database is described at SpatiaLite Layers.

Truco: Create connection to database from the QGIS Browser Panel
Select the corresponding database format in the Browser tree, right-click and choose connect will provide you
with the database connection dialog.

Most of the connection dialogs follow a common basis that will be described below using the PostGreSQL
database tool as example.

The first time you use a PostGIS data source, you must create a connection to a database that contains the data.
Begin by clicking the appropriate button as exposed above, opening an Add PostGIS Table(s) dialog (see fig-
ure_add_postgis_tables). To access the connection manager, click on the [New] button to display the Create a
New PostGIS Connection dialog.

Figure 11.7: Create a New PostGIS Connection Dialog

The parameters required for a PostGIS connection are exposed below. For the other database types, see their
differences at Particular Connection requirements.

• Name: A name for this connection. It can be the same as Database.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can be
defined in pg_service.conf. Check the PostgreSQL Service connection file section for more details.

11.1. Opening Data 93



QGIS User Guide, Publicación 2.18

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
TCP/IP connection or ping the host. If the database is on the same computer as QGIS, simply enter localhost
here.

• Port: Port number the PostgreSQL database server listens on. The default port for PostGIS is 5432.

• Database: Name of the database.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speed-ups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Disable: Only try an unencrypted SSL connection;

– Allow: Try a non-SSL connection. If that fails, try an SSL connection;

– Prefer (the default): Try an SSL connection. If that fails, try a non-SSL connection;

– Require: Only try an SSL connection.

• Username: User name used to log in to the database.

• Password: Password used with Username to connect to the database.

You can save any or both of the username and password parameters, in which case they will be used by
default each time you need to connect to this database. If not saved, you’ll be prompted to fill the missing
credentials to connect to the database in next QGIS sessions; meanwhile the connection parameters you
entered are stored in a temporary internal cache and returned whenever a username/password for the same
database is requested, until you close the current QGIS process.

Advertencia: QGIS User Settings and Security
In the Authentication tab, saving username and password will keep unprotected credentials in the con-
nection configuration. Those credentials will be visible if, for instance, you shared the project file with
someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(Configurations tab - See Sistema de autenticación for more details) or in a service connection file (see
PostgreSQL Service connection file for example).

Optionally, depending on the type of database, you can activate the following checkboxes:

• Only show layers in the layer registries

• Don’t resolve type of unrestricted columns (GEOMETRY)

• Only look in the ‘public’ schema

• Also list tables with no geometry

• Use estimated table metadata

Truco: Use estimated table metadata to speed up operations
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Once all parameters and options are set, you can test the connection by clicking on the [Test connection] button
or apply it hitting [OK]. From the Add PostGIS Table(s), click now on [Connect] and the dialog is filled with
tables from the selected database (as shown in figure_add_postgis_tables).
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Particular Connection requirements

Because of database type particularities, provided options are all the same for all the databases. Below are exposed
these connection specificities.

PostgreSQL Service connection file The service connection file allows PostgreSQL connection parameters to
be associated with a single service name. That service name can then be specified by a client and the associated
settings will be used.

It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Nota: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Nota: You can find all the parameters here

Nota: If you don’t want to save the passwords in the service file you can use the .pg_pass option.

On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing the .pg_service.conf
file at pg_config --sysconfdir or by adding the PGSYSCONFDIR environment variable to specify the
directory containing the service file. If service definitions with the same name exist in the user and the system file,
the user file takes precedence.

Advertencia: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit → EOL Conversion → UNIX Format → File save.
• You can add environmental variables in various ways; a tested one, known to work reliably, is Control

Panel → System and Security → System → Advanced system settings → Environment Variables adding
PGSERVICEFILE and the path of the type C:\Users\John\pg_service.conf

• After adding an environment variable you may also need to restart the computer.
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Connecting to Oracle Spatial The spatial features in Oracle Spatial aid users in managing geographic and
location data in a native type within an Oracle database. In addition to some of the options in Crear una conexión
almacenada, the connection dialog proposes:

• Database: SID or SERVICE_NAME of the Oracle instance;

• Port: Port number the Oracle database server listens on. The default port is 1521;

• Workspace: Workspace to switch to.

Optionally, you can activate following checkboxes:

• Only look in metadata table: restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables;

• Only look for user’s tables: when searching for spatial tables, restrict the search to tables that are owned
by the user;

• Also list tables with no geometry: indicates that tables without geometry should also be listed by default;

• Use estimated table statistics for the layer metadata: when the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations
are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table;

• Only existing geometry types: only list the existing geometry types and don’t offer to add others;

• Include additional geometry attributes.

Truco: Oracle Spatial Layers
Normally, an Oracle Spatial layer is defined by an entry in the USER_SDO_METADATA table.

Connecting to DB2 Spatial In addition to some of the options described in Crear una conexión almacenada,
the connection to a DB2 database (see DB2 Spatial Layers for more information) can be specified using either a
Service/DSN name defined to ODBC or using the driver, host and port information.

An ODBC Service/DSN connection requires the service name defined to ODBC.

A driver/host/port connection requires:

• Driver: Name of the DB2 driver. Typically this would be IBM DB2 ODBC DRIVER.

• DB2 Host: Name of the database host. This must be a resolvable host name such as would be used to
open a TCP/IP connection or ping the host. If the database is on the same computer as QGIS, simply enter
localhost here.

• DB2 Port: Port number the DB2 database server listens on. The default DB2 LUW port is 50000. The
default DB2 z/OS port is 446.

Truco: DB2 Spatial Layers
A DB2 Spatial layer is defined by a row in the DB2GSE.ST_GEOMETRY_COLUMNS view.

Nota: In order to work effectively with DB2 spatial tables in QGIS, it is important that tables have an INTEGER
or BIGINT column defined as PRIMARY KEY and if new features are going to be added, this column should also
have the GENERATED characteristic.
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It is also helpful for the spatial column to be registered with a specific spatial reference identifier (most often 4326
for WGS84 coordinates). A spatial column can be registered by calling the ST_Register_Spatial_Column
stored procedure.

Connecting to MSSQL Spatial In addition to some of the options in Crear una conexión almacenada, creating
a new MSSQL connection dialog proposes you to fill a Provider/DSN name. You can also display available
databases.

Loading a Database Layer

Once you have one or more connections defined to a database (see section Crear una conexión almacenada),
you can load layers from it. Of course, this requires having available data. See e.g. section Importing Data into
PostgreSQL for a discussion on importing data into a PostGIS database.

To load a layer from a database, you can perform the following steps:

1. Open the “Add <database> table(s)” dialog (see Crear una conexión almacenada),

2. Choose the connection from the drop-down list and click [Connect].

3. Select or unselect Also list tables with no geometry.

4. Optionally, use some Search Options to reduce the list of tables to those matching your search. You can
also set this option before you hit the [Connect] button, speeding this way the database fetching.

5. Find the layer(s) you wish to add in the list of available layers.

6. Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.

7. If applicable, use the [Set Filter] button (or double-click the layer) to start the Query builder dialog (See
section Constructor de Consulta) and define which features to load from the selected layer. The filter
expression appears in the sql column. This restriction can be removed or edited in the Layer Properties →
General → Provider Feature Filter frame.

8. The checkbox in the Select at id column that is activated by default gets the features ids without the
attributes and speed in most cases the data loading.

9. Click on the [Add] button to add the layer to the map.

Truco: Load database table(s) from the Browser Panel
Like simple files, connected database are also listed in the Browser Panel. Hence, you can load tables from
databases using the Browser:

1. Find the layer to use with the Filter Browser tool at the top the browser panel (see The Browser Panel for
the search options);

2. select and drag-and-drop it in the map canvas.

11.1.4 Formato personalizados QGIS

QGIS proposes two custom formats you can load in the application using their own loading tool:

• Temporary Scratch Layer: a memory layer that is bound to the project it’s opened with (see Crear una nueva
capa temporal for more information)

• Virtual Layers: a layer resulting from a query on other layer(s) (see Creating virtual layers for more infor-
mation)
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Figure 11.8: Add PostGIS Table(s) Dialog

11.1.5 Connecting to web services

With QGIS you can have access to different types of OGC web services (WM(T)S, WFS(-T), CSW ...). Thanks
to QGIS Server, you can also publish these services. Description of these capabilities and how-to are provided in
chapter Trabajar con datos OGC.

11.2 Creando capaa

Layers can be created in many ways, including:

• empty layers from scratch;

• layers from existing layers;

• layers from the clipboard;

• layers as a result of an SQL-like query based on one or many layers: the virtual layer.

QGIS also provides tools to import/export different formats.

11.2.1 Creating new vector layers

QGIS allows you to create new Shapefile layers, new SpatiaLite layers, new GPX layers and new Temporary
Scratch layers. Creation of a new GRASS layer is supported within the GRASS plugin. (Please refer to section
Crear una nueva capa vectorial GRASS for more information on creating GRASS vector layers.)

Crear una nueva capa de archivo shape

To create a new Shapefile layer, choose Create Layer → New Shapefile Layer... from the Layer menu. The
New Shapefile Layer dialog will be displayed as shown in figure_create_shapefile. Choose the type of layer (point,
line or polygon) and the CRS (coordinate reference system).
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Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 11.9: Creating a new Shapefile layer dialog

To complete the creation of the new Shapefile layer, add the desired attributes by specifying a name and type
for each attribute and clicking on the [Add to fields list] button. A first ‘id’ column is added by default but

can be removed, if not wanted. Only Decimal number , Whole number , Text data and Date

attributes are supported. Additionally, depending on the attribute type, you can also define the length and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the Shapefile. QGIS will automatically add the .shp extension to the name you specify. Once the Shapefile has
been created, it will be added to the map as a new layer, and you can edit it in the same way as described in section
Digitalizando una capa existente.

Crear una nueva capa SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_create_spatialite.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitalizando una capa existente.

Further management of SpatiaLite layers can be done with the DB Manager. See Complemento administrador de
BBDD.
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Figure 11.10: Creating a New SpatiaLite layer dialog
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Creating a new GeoPackage layer

To create a new GeoPackage layer go to Layer → New → New GeoPackage Layer.... The New GeoPackage
Layer dialog will be displayed as shown in figure_create_geopackage.

The first step is to select an existing GeoPackage or create a new one. This can be done by pressing the ellipses
[...] button at the right of the Database field. Then, give a name for the new layer, define the layer type and specify
the coordinate reference system with [Specify CRS].

To define an attribute table for the new GeoPackage layer, add the names of the attribute columns you want to
create with the corresponding column type, and click on the [Add to fields list] button. Once you are happy with
the attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitalizando una capa existente.

Creating a new GPX layer

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, choose where to save the new file and press [Save]. Three new layers are added to the Layers
Panel: waypoints, routes and tracks with predefined structure.

Crear una nueva capa temporal

Temporary Scratch Layers are in-memory layers, meaning that they are not saved on disk and will be discarded
when QGIS is closed. They can be handy to store features you temporarily need or as intermediate layers during
geoprocessing operations.

Empty, editable temporary scratch layers can be defined using Layer → Create Layer → New Temporary Scratch
Layer. Here you can create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon layers.

You can also create Temporary Scratch Layers from the clipboard. See Creating new layers from the clipboard.

11.2.2 Creating new layers from an existing layer

Both raster and vector layers can be saved in a different format and/or reprojected to a different coordinate refer-
ence system (CRS) using the Save As... function in the layer context menu (by right-clicking in the layer in the
layer tree) or in the Layer → Save As... menu.

Common parameters

The Save As dialog shows several parameters to change the behavior when saving the layer. Common parameters
for raster and vector are:

• Format

• File name

• CRS can be changed to reproject the data

• Add saved file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or user-defined extent)

However, some parameters are specific to raster and vector formats:
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Figure 11.11: Creating a New GeoPackage layer dialog
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Raster specific parameters

• Output mode (it can be raw data or rendered image)

• Resolution

• Create Options: advanced options (file compression, block sizes, colorimetry...) to fine tune the output file.
See the gdal-ogr driver documentation.

• Pyramids creation

• VRT Tiles

• No data values

Figure 11.12: Saving as a new raster layer

Vector specific parameters

Depending on the format of export, some of these options are available or not:

• Encoding

• Save only selected features

• Select fields to export and their export options. In case you set your fields behavior with some Edit widgets,

e.g. value map, you can keep the displayed values in the layer by checking Replace all selected raw
fields values by displayed values.

• Symbology export: can be used mainly for DXF export and for all file formats who manage OGR feature
styles (see note below) as DXF, KML, tab file formats:

– No symbology: default style of the application that reads the data

– Feature symbology: save style with OGR Feature Styles (see note below)
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– Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used

– A Scale value can be applied to the latest options.

Nota: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some formats
can handle this kind of information. KML, DXF and TAB file formats are such formats. For advanced users, you
can read the OGR Feature Styles specification document.

• Geometry: you can configure the geometry capabilities of the output layer

– geometry type: keep the original geometry of the features when set to Automatic, otherwise removes
or overrides it with any type. You can add an empty geometry column to an attribute table, remove the
geometry column of a spatial layer.

– Force multi-type: force creation of multi-geometry features in the layer

– Include z-dimension to geometries.

Truco: Overriding layer geometry type makes it possible to do things like save a geometryless table (e.g. .csv
file) into a shapefile WITH any type of geometry (point, line, polygon), so that geometries can then be manually

added to rows with the Add Part tool .

• Datasources Options, Layer Options or Custom Options which allow you to configure some advanced pa-
rameters. See the gdal-ogr driver documentation.

Figure 11.13: Saving as a new vector layer

When saving a vector layer into an existing file, depending on the capabilities of the output format (Geopackage,
SpatiaLite, FileGDB...), the user can decide whether to:
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• overwrite the whole file

• overwrite only the target layer (the layer name is configurable)

• append features to the existing target layer

• append features, add new fields if there are any.

For formats like ESRI Shapefile, MapInfo .tab, feature append is also available.

11.2.3 Creating new DXF files

Besides the Save As... dialog which provides options to export a single layer to another format, including *.DXF,
QGIS provides another tool to export multiple layers as a single DXF layers. It’s accessible in the Project → DXF
Export... menu.

The DXF Export dialog allows the user to:

• indicate the destination layer file;

• choose the symbology mode and scale (see the OGR Feature Styles note);

• select the encoding and CRS;

• check the loaded layers to include in the DXF files or pick them from an existing visibility preset.

For each layer, you can choose a field whose values are used to split features in generated destination layers

in the DXF output. You can also choose to Use the layer title as name if set and keep features grouped.

• choose to only Export features intersecting the current map extent.

11.2.4 Creating new layers from the clipboard

Features that are on the clipboard can be pasted into a new layer. To do this, Select some features, copy them to
the clipboard, and then paste them into a new layer using Edit → Paste Features as → and choosing:

• New Vector Layer...: you need to select the layer CRS, poping up the Save vector layer as... dialog from
which you can select any supported data format (see Creating new layers from an existing layer for param-
eters);

• or Temporary Scratch Layer...: you need to select the layer CRS and give a name.

A new layer, filled with selected features and their attributes is created and added to map canvas if asked.

Nota: Creating layers from clipboard applies to features selected and copied within QGIS and also to features
from another source defined using well-known text (WKT).

11.2.5 Creating virtual layers

Virtual layers are a special kind of vector layer. They allow you to define a layer as the result of an SQL query in-
volving any number of other vector layers that QGIS is able to open. Virtual layers do not carry data by themselves
and can be seen as views to other layers.

To create a virtual layer, open the virtual layer creation dialog by clicking on Add Virtual Layer in the Layer menu
or from the corresponding toolbar.

The dialog allows you to specify a Layer name and an SQL Query. The query can use the name (or id) of loaded
vector layers as tables, as well as their field names as columns.

For example, if you have a layer called airports, you can create a new virtual layer called
public_airports with an SQL query like:
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SELECT *
FROM airports
WHERE USE = "Civilian/Public"

The SQL query will be executed, regardless of the underlying provider of the airports layer, even if this
provider does not directly support SQL queries.

Figure 11.14: Create virtual layers dialog

Joins and complex queries can also be created, for example, to join airports and country information:

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name

Nota: It’s also possible to create virtual layers using the SQL window of Complemento administrador de BBDD.

Embedding layers for use in queries

Besides the vector layers available in the map canvas, the user can add layers to the Embedded layers list, which
he can use in queries without the need to have them showing in the map canvas or Layers panel.

To embed a layer, click Add and provide the Local name, Provider, Encoding and the path to the Source.

The Import button allows adding layers loaded in the map canvas into the Embedded layers list. This allows to
later remove those layers from the Layers panel without breaking any existent query.

Supported query language

The underlying engine uses SQLite and SpatiaLite to operate.

It means you can use all of the SQL your local installation of SQLite understands.
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Functions from SQLite and spatial functions from SpatiaLite can also be used in a virtual layer query. For instance,
creating a point layer out of an attribute-only layer can be done with a query similar to:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.

Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

Problemas de Rendimiento

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

The creation dialog allows to specify different parameters:

• Unique identifier column: this option allows specifying which field of the query represents unique integer
values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used. Defining
a unique identifier column allows to speed up the selection of rows by id.

• No geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• Geometry Column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• Geometry Type: this option allows to specify the type of the geometry of the virtual layer.

• Geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

Special comments

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

The type of a particular column can be specified directly in the query by using some special comments.

The syntax is the following: /*:type*/. It has to be placed just after the name of a column. type can be either
int for integers, real for floating point numbers or text.

For instance:

SELECT id+1 as nid /*:int*/
FROM table

The type and coordinate reference system of the geometry column can also be set thanks to special comments
with the following syntax /*:gtype:srid*/ where gtype is the geometry type (point, linestring,
polygon, multipoint, multilinestring or multipolygon) and srid an integer representing the
EPSG code of a coordinate reference system.

Use of indexes

When requesting a layer through a virtual layer, indexes of this source layer will be used in the following ways:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)
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• for any other predicates (>, <=, !=, etc.) or on a column without a primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.

A specific syntax exists to handle spatial predicates in requests and triggers the use of a spatial index: a hidden
column named _search_frame_ exists for each virtual layer. This column can be compared for equality to a
bounding box. Example:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are significantly sped up when used in conjunction with this
spatial index syntax.

11.3 Exploring Data Formats and Fields

11.3.1 Datos Raster

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid has the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

11.3.2 Vector Data

Many of the features available in QGIS work the same, regardless the vector data source. However, because of the
differences in formats specifications (ESRI shapefiles, MapInfo and MicroStation file formats, AutoCAD DXF,
PostGIS, SpatiaLite, DB2, Oracle Spatial and MSSQL Spatial databases, and many more), QGIS may handle
differently some of their properties. This section describes how to work with these specificities.

Nota: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some drivers don’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

Archivos shape de ESRI

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library.

A shapefile actually consists of several files. The following three are required:

1. .shp file containing the feature geometries

2. .dbf file containing the attributes in dBase format

3. archivo del índice .shx
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Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details, see the ESRI technical specification at http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Use these steps to create the index:

• Load a shapefile (see The Browser Panel);

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the context menu.

• En la pestaña General, hacer clic sobre el botón [Crear Índice Espacial].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

Delimited Text Files

Tabular data is a very common and widely used format because of its simplicity and readability – data can be
viewed and edited even in a plain text editor. A delimited text file is an attribute table with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.

Such data files can also contain positional information in two main forms:

• As point coordinates in separate columns

• As well-known text (WKT) representation of geometry

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. The file must have a delimited header row of field names. This must be the first line in the text file.

2. The header row must contain field(s) with geometry definition. These field(s) can have any name.

3. The X and Y coordinates (if geometry is defined by coordinates) must be specified as numbers. The coor-
dinate system is not important.

4. If you have any data that is not a string (text) and the file is a CSV file, you must have a CSVT file (see
section CSVT Files).

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Datos de ejemplo):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Algunos elementos a tener en cuenta sobre el archivo de texto:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.
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2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The X coordinates are contained in the X field.

5. The Y coordinates are contained in the Y field.

CSVT Files

When loading CSV files, the OGR driver assumes all fields are strings (i.e. text) unless it is told otherwise. You
can create a CSVT file to tell OGR (and QGIS) what data type the different columns are:

Tipo Nombre Ejemplo
Número entero Entero 4
Número decimal Real 3.456
Fecha Date (YYYY-MM-DD) 2016-07-28
Tiempo Time (HH:MM:SS+nn) 18:33:12+00
Fecha y hora DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00

The CSVT file is a ONE line plain text file with the data types in quotes and separated by commas, e.g.:

"Integer","Real","String"

You can even specify width and precision of each column, e.g.:

"Integer(6)","Real(5.5)","String(22)"

This file is saved in the same folder as the .csv file, with the same name, but .csvt as the extension.

You can find more information at GDAL CSV Driver.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

PostGIS Layers

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are its spatial indexing, filtering
and querying capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Truco: PostGIS Layers
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. QGIS can load layers that do
not have an entry in the geometry_columns table. This includes both tables and views. Defining a spatial view
provides a powerful means to visualize your data. Refer to your PostgreSQL manual for information on creating
views.
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This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

Clave primaria

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases.

View

If the PostgreSQL layer is a view, the same requirement exists, but views do not always have primary keys or
columns with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS
dialog before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer.
If this occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either
a primary key or with a unique constraint, preferably indexed).

As for table, a checkbox Select at id is activated by default (see above for the meaning of the checkbox). It can
make sense to disable this option when you use expensive views.

QGIS layer_style table and database backup

If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

SET XML OPTION DOCUMENT;

Filter database side

QGIS allows to filter features already on server side. Check the Settings → Options → Data Sources →
Execute expressions on postgres server-side if possible checkbox to do so. Only supported expressions will be sent
to the database. Expressions using unsupported operators or functions will gracefully fallback to local evaluation.

Support of PostgreSQL data types

Most of common data types are supported by the PostgreSQL provider: integer, float, varchar, geometry and
timestamp.

Array data types are not supported.

Importing Data into PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the DB Manager plugin and the
command line tools shp2pgsql and ogr2ogr.
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Administrador de BBDD

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Complemento administrador de BBDD for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import shapefiles into a PostGIS-enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

This creates a new layer named lakes_new in the gis_data database. The new layer will have a spatial
reference identifier (SRID) of 2964. See section Trabajar con Proyecciones for more information on spatial
reference systems and projections.

Truco: Exporting datasets from PostGIS
Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Besides shp2pgsql and DB Manager, there is another tool for feeding geodata in PostGIS: ogr2ogr. This is part
of your GDAL installation.

To import a shapefile into PostGIS, do the following:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS database postgis using the user postgres with the
password topsecret on host server myhost.de.

Note that OGR must be built with PostgreSQL to support PostGIS. You can verify this by typing (in )

ogrinfo --formats | grep -i post

If you prefer to use PostgreSQL’s COPY command instead of the default INSERT INTO method, you can export

the following environment variable (at least available on and ):

export PG_USE_COPY=YES

ogr2ogr does not create spatial indexes like shp2pgsl does. You need to create them manually, using the nor-
mal SQL command CREATE INDEX afterwards as an extra step (as described in the next section Mejorar el
rendimiento).

Mejorar el rendimiento

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Truco: You can use the DBManager to create an index to your layer. You should first select the layer and click
on Table → Edit table, go to Indexes tab and click on [Add spatial index].
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The syntax for creating a GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Tenga en cuenta que para tablas grandes, crear el índice puede tomar un largo tiempo. Una vez que el índice
es creado, se debe realizar un VACUUM ANALYZE. Vea la documentación de PostGIS (POSTGIS-PROJECT
Referencias bibliográficas y web) para mayor información.

The following is an example of creating a GiST index:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

Vector layers crossing 180° longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_crossing, the tiny point on the far left of the map canvas (Chatham Islands) should be within the
grid, to the right of the New Zealand main islands.

Figure 11.15: Map in lat/lon crossing the 180° longitude line

A work-around is to transform the longitude values using PostGIS and the ST_Shift_Longitude function. This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-
nate is < 0°, it adds 360° to it. The result is a 0° - 360° version of the data to be plotted in a 180°-centric map.

Uso

• Import data into PostGIS (Importing Data into PostgreSQL) using, for example, the DB Manager plugin.

• Use the PostGIS command line interface to issue the following command (in this example,
“TABLE” is the actual name of your PostGIS table): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);
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Figure 11.16: Crossing 180° longitude applying the ST_Shift_Longitude function

• If everything went well, you should receive a confirmation about the number of features that were updated.
Then you’ll be able to load the map and see the difference (Figure_vector_crossing_map).

SpatiaLite Layers

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as..., define the name of the output file, and select ‘SpatiaLite’ as format and the CRS. Also,
you can select ‘SQLite’ as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

If you want to create a new SpatiaLite layer, please refer to section Crear una nueva capa SpatiaLite.

Truco: SpatiaLite data management Plugins
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

DB2 Spatial Layers

IBM DB2 for Linux, Unix and Windows (DB2 LUW), IBM DB2 for z/OS (mainframe) and IBM DashDB products
allow users to store and analyse spatial data in relational table columns. The DB2 provider for QGIS supports the
full range of visualization, analysis and manipulation of spatial data in these databases.

User documentation on these capabilities can be found at the DB2 z/OS KnowledgeCenter, DB2 LUW Knowl-
edgeCenter and DB2 DashDB KnowledgeCenter.

For more information about working with the DB2 spatial capabilities, check out the DB2 Spatial Tutorial on IBM
DeveloperWorks.

The DB2 provider currently only supports the Windows environment through the Windows ODBC driver.

The client running QGIS needs to have one of the following installed:

• DB2 LUW

• IBM Data Server Driver Package

• IBM Data Server Client
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If you are accessing a DB2 LUW database on the same machine or using DB2 LUW as a client, the DB2 executa-
bles and supporting files need to be included in the Windows path. This can be done by creating a batch file like
the following with the name db2.bat and including it in the directory %OSGEO4W_ROOT%/etc/ini.

@echo off
REM Point the following to where DB2 is installed
SET db2path=C:\Program Files (x86)\sqllib
REM This should usually be ok - modify if necessary
SET gskpath=C:\Program Files (x86)\ibm\gsk8
SET Path=%db2path%\BIN;%db2path%\FUNCTION;%gskpath%\lib64;%gskpath%\lib;%path%
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CHAPTER 12

Trabajar con catos vectoriales

12.1 La librería Símbolo

12.1.1 El Administrador de estilos

The Style Manager is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• crear, editar, eliminar símbolos

• organize symbols in custom groups

• export and import symbols.

Figure 12.1: El Administrador de estilos

Grupos y grupos inteligentes

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_smart_group:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
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a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.

Figure 12.2: Creating a Smart Group

To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

Adicionar, Editar, Eliminar Símbolo

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and Rampa de color.

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See El Selector de Símbolo for further information.

Compartir símbolos

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exportar símbolos

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importar símbolos
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You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :

• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Note that import and export options are also available through right-click.

Figure 12.3: Importar símbolos

Rampa de color

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type:

• Gradient: given a start and end colors, generate a color ramp which can be continuous or discrete. With
double-clicking the ramp preview, you can add as many intermediate color stops as you want.

• Random: creates a random set of colors based on range of values for hue, saturation, value and opacity and
a number of colors (classes)

• ColorBrewer: a set of predefined discrete color gradients you can custom the number of colors in the ramp

• or cpt-city: an access to a whole catalog of color gradients to locally save as gradient color.

Truco: Easily custom the color stops of the gradient color ramp
Double-clicking the ramp preview or drag-and-drop a color from the color spot onto the ramp preview adds a
new color stop. Each color stop can be tweaked using the Selector de color widgets or by plotting each of its
parameters. You can also reposition it using the mouse, the arrow keys (combine with Shift key for a larger
move) or the Relative position spinbox. Pressing Delete stop as well as DEL key removes the selected color stop.

You can use the Invert option while classifying the data with a color ramp. See figure_color_custom_ramp for
an example of a custom color ramp and figure_color_cpt_city for the cpt-city Colors dialog.

La opción cpt-city abre un nuevo diálogo con cientos de temas incluidos ‘fuera de la caja’.
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Figure 12.4: Ejemplo de rampa de color gradiente personalizado con pasos múltiples
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Figure 12.5: cpt-city dialog with hundreds of color ramps
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12.1.2 El Selector de Símbolo

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Figure 12.6: Diseñar un símbolo Marcador

Two main components structure the symbol selector dialog:

• the symbol tree, showing symbol layers that are combined afterwards to shape a new global symbol

• and settings to configure the selected symbol layer in the tree.

The symbol layer tree

A symbol can consist of several Symbol layers. The symbol tree shows the overlay of these symbol layers that are
combined afterwards to shape a new global symbol. Besides, a dynamic symbol representation is updated as soon
as symbol properties change.

A set of tools is available to manage the symbol tree items and according to the level selected, you’ll get enabled
different tools at the bottom of the dialog to:

• add new symbol layer: you can stack as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level

• duplicate a (group of) symbol layer(s)

122 Chapter 12. Trabajar con catos vectoriales



QGIS User Guide, Publicación 2.18

• move up or down the symbol layer

Configuring a symbol

In QGIS, configuring a symbol is done in two steps: the symbol and then the symbol layer.

The symbol

At the top level of the tree, it depends on the layer geometry and can be of Marker, Line or Fill type. Each
symbol can embed one or more symbols (including, of any other type) or symbol layers.

You can setup some parameters that apply to the global symbol:

• Unit: it can be Millimeter, Pixels or Map unit

• Transparencia

• Color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols color

• Size and Rotation for marker symbols

• Width for line symbols

Nota: The Data-defined override button beside the last layer-related parameters is inactive when setting the
symbol from the Style manager dialog. When the symbol is connected to a map layer, this button offers access to
the size assistant dialog which helps to create proportional or multivariate analysis rendering.

The symbols used at this level are items you can pick from the symbols library. A list of available symbols of the
same type from your symbol library is shown and can be filtered by selecting a group in the drop-down list just
above. Click the Save button to add the designed symbol to your symbol library.

With the Advanced option, you can:

• set the symbol levels: defining the way symbol layers are connected to each other in the map canvas (see
Niveles de símbolos for more information)

• and for line and fill symbols, clip features to canvas extent.

Truco: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size (for marker symbols) or the Width (for line symbols) menu in the first level
again. The size of the lower levels changes accordingly, while the size ratio is maintained.

The symbol layer

At a lower level of the tree, you can customize the symbol layers. The available symbol layer types depend on the

upper symbol type. You can apply on the symbol layer paint effects to enhance its rendering.

Because describing all the options of all the symbol layer types would not be possible, only particular and signi-
ficative ones are mentioned below.

Common parameters Some common options and widgets are available to build a symbol layer, regardless it’s
of marker, line or fill sub-type:

• the color selector widget to ease color manipulation

• Units: it can be Millimeter, Pixels or Map unit

• the data-defined override widget near almost all options, extending capabilities of customizing each symbol
(see Configuración de anulación definida por datos for more information)
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Nota: While the description below assumes that the symbol layer type is bound to the feature geometry, keep
in mind that you can embed symbol layers in each others. In that case, the lower level symbol layer parameter
(placement, offset...) might be bound to the upper-level symbol, and not to the feature geometry itself.

Símbolos de marcador Appropriate for point geometry features, marker symbols have several Symbol layer
types:

• Simple marker (default);

• Ellipse marker: a simple marker symbol layer, with customizable width and height;

• Filled marker: similar to the simple marker symbol layer, except that it uses a fill sub symbol to render the
marker. This allows use of all the existing QGIS fill (and outline) styles for rendering markers, e.g. gradient
or shapeburst fills;

• Font marker: use installed fonts as marker symbols;

• Geometry generator (see The Geometry Generator);

• Vector Field marker (see The Vector Field Marker);

• SVG marker: provides you with images from your SVG paths (set in Settings → Options → System menu)
to render as marker symbol. Each SVG file colors and outline can be adapted.

Nota: Requirements for a customizable SVG marker symbol

To have the possibility to change the colors of a SVG marker, you have to add the placeholders
param(fill) for fill color, param(outline) for outline color and param(outline-width) for
stroke width. These placeholders can optionally be followed by a default value, e.g.:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width="param(stroke-width) 10" width="100" height="100">
</rect>
</svg>

For each marker symbol layer type, you can set some of the following properties:

• Color for the fill and/or stroke, using all the capabilities of the Selector de color widget;

• Tamaño

• Estilo de línea exterior

• Anchura de línea exterior

• Estilo de unión

• Rotation

• Offset X,Y: You can shift the symbol in the x- or y- direction;

• Anchor point.

In most of the marker symbols dialog, you also have a frame with previews of predefined symbols you can choose
from.

Símbolos línea Appropriate for line geometry features, line marker symbols have following symbol layer types:

• Simple line (default): available settings are:

– Color

– Anchura de plumilla

– Estilo de plumilla
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– Estilo de unión

– Estilo de mayusculas

– Desplazamiento

– Use custom dash pattern: overrides the Pen style setting with a custom dash.

• Arrow: draws lines as curved (or not) arrows with a single or a double head with configurable width, length
and thickness. To create a curved arrow the line feature must have at least three vertices. It also uses a fill
symbol such as gradients or shapeburst to render the arrow body. Combined with the geometry generator,
this type of layer symbol helps you representing flow maps;

• Geometry generator (see The Geometry Generator);

• Marker line: displays a marker symbol along the line. It can be at a regular distance or based on its
geometry: first, last or each vertex, on central point or on every curve point. You can set an offset along the
line for the marker symbol, or offset the line itself. The Rotate marker option allows you to set whether the
marker symbol should follow the line orientation or not.

Fill Symbols Appropriate for polygon geometry features, fill symbols have also several symbol layer types:

• Simple fill (default): the following settings are available:

– Fill color

– Outline color

– Estilo de relleno

– Estilo de línea exterior

– Anchura de línea exterior

– Estilo de unión

– Desplazamiento X, Y

• Centroid fill: places a marker symbol at the centroid of the visible feature. The position of the marker may
however not be the real centroid of the feature because calculation takes into account the polygon(s) clipped
to area visible in map canvas for rendering and ignores holes. Use The Geometry Generator if you want the
exact centroid.

The marker can be placed on every part of a multi-part feature or only on its biggest part, and forced to be
inside the polygon;

• Geometry generator (see geometry_generator_symbol);

• Gradient fill: uses a radial, linear or conical gradient, based on either simple two color gradients or a
predefined gradient color ramp to fill polygon layers. Gradient can be rotated and applied on a single
feature basis or across the whole map extent. Also start and end points can be set via coordinates or using
the centroid (of feature or map);

• Line pattern fill: fills the polygon with a hatching pattern of line symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Point pattern fill: fills the polygon with a hatching pattern of marker symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Raster image fill: you can fill polygons with a tiled raster image. Options include (data defined) file name,
opacity, image size (in pixels, mm or map units), coordinate mode (feature or view) and rotation;

• SVG fill: fills the polygon using SVG markers;

• Shapeburst fill: this option buffered a gradient fill, where a gradient is drawn from the boundary of a
polygon towards the polygon’s centre. Configurable parameters include distance from the boundary to
shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets;

• Outline: Arrow: uses a line arrow symbol layer to represent the polygon boundary;
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• Outline: Marker line: uses a marker line symbol layer to represent the polygon boundary;

• Outline: simple line: uses a simple line symbol layer to represent the polygon boundary. The Draw line
only inside polygon option helps polygon borders inside the polygon and can be useful to clearly represent
adjacent polygon boundaries.

Nota: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (e.g. centroid fills where the centroid
must always be the actual feature’s centroid).

The Geometry Generator Available with all types of symbols, the geometry generator symbol layer allows to
use expression syntax to generate a geometry on the fly during the rendering process. The resulting geometry does
not have to match with the original geometry type and you can add several differently modified symbol layers on
top of each other.

Some examples:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( ’layer2’, ’id2’, attribute(
$currentfeature, ’layer2_id’) ) )

)

The Vector Field Marker The vector field marker is used to display vector field data such as earth deformation,
tidal flows, and the like. It displays the vectors as lines (preferably arrows) that are scaled and oriented according
to selected attributes of data points. It can only be used to render point data; line and polygon layers are not drawn
by this symbology.

The vector field is defined by attributes in the data, which can represent the field either by:

• cartesian components (x and y components of the field)

• or polar coordinates: in this case, attributes define Length and Angle. The angle may be measured either
clockwise from north, or Counterclockwise from east, and may be either in degrees or radians.

• or as height only data, which displays a vertical arrow scaled using an attribute of the data. This is appro-
priate for displaying the vertical component of deformation, for example.

The magnitude of field can be scaled up or down to an appropriate size for viewing the field.

12.2 El Dialogo de las Propiedades del Vector

El cuadro de diálogo Propiedades de la capa para una capa vectorial proporciona una configuración general para
administrar la apariencia de los elementos de la capa en el mapa (simbología, etiquetas, diagramas), interacción
con el mouse (acciones, textos de aviso del mapa, diseño de formularios). También proporciona información de
la capa.

Para acceder al cuadro de diálogo Propiedades de la capa, haga doble clic sobre la capa en la leyenda o haga clic
derecho sobre la capa y seleccione Propiedades del menú emergente.

Nota: Dependiendo de los Plugins <plugins> externos que ha instalado, nuevas pestañas podrían ser añadidas al
cuadro de diálogo de la capa. Esos no se presentan a continuación.
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Truco: ** Renderizado de actualización en vivo**

The Layer Styling Panel provides you with some of the common features of the Layer properties dialog and is a
good modeless widget that you can use to speed up the configuration of the layer styles and automatically view
your changes in the map canvas.

Nota: Because properties (symbology, label, actions, default values, forms...) of embedded layers (see Anidar
proyectos) are pulled from the original project file and to avoid changes that may break this behavior, the layer
properties dialog is made unavailable for these layers.

12.2.1 Propiedades Generales

Use this tab to make general settings for the vector layer. There are several options available:

Información de Capa

• Set the Layer name to display in the Layers Panel

• Display the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file

Sistema de coordenadas de referencia

• Displays the layer’s Coordinate Reference System (CRS) as a PROJ.4 string. You can change the layer’s

CRS, selecting a recently used one in the drop-down list or clicking on Select CRS button (see Coordinate
Reference System Selector). Use this process only if the CRS applied to the layer is a wrong one or if none
was applied. If you wish to reproject your data into another CRS, rather use layer reprojection algorithms
from Processing or Save it into another layer.

• Create a Spatial Index (only for OGR-supported formats)

• Actualizar extensiones información para una capa.

Visibilidad dependiente de escala

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which features

will be visible. Out of this range, they are hidden. The Set to current canvas scale button helps you use the current map
canvas scale as boundary of the range visibility. See Renderizado dependiente de la escala for more information.

Constructor de Consulta

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

The Query Builder is accessible through the eponym term at the bottom of the General tab in the Layer Properties.
Under Feature subset, click on the [Query Builder] button to open the Query builder. For example, if you have
a regions layer with a TYPE_2 field, you could select only regions that are borough in the Provider specific
filter expression box of the Query Builder. Figure_vector_querybuilder shows an example of the Query Builder
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Figure 12.7: Pestaña General en cuadro de diálogo de propiedades de las capas vectoriales

Figure 12.8: Constructor de Consulta
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populated with the regions.shp layer from the QGIS sample data. The Fields, Values and Operators sections
help you to construct the SQL-like query.

La Lista de campos contiene todos las columnas de atributos de la tabla de atributos a ser buscados. Para agregar
una columna de atributos al campo de la clausula SQL WHERE, haga doble clic en el nombre de la lista de
campos. En general puede usar varios campos, valores y operadores para construir la consulta, o simplemente
puede escribirlo en la caja SQL.

La Lista de valores lista los valores de una tabla de atributos. Para listar todos los valores posibles de un atributo,
seleccione el atributo en la lista de campos y haga clic en el botón [Todos]. Para listar los primeros 25 valores
únicos de una columna de atributos, seleccione la columna de atributos en la lista de campos y haga clic en el
botón [Muestra]. Para añadir un valor al campo de la clausula WHERE de SQL, haga doble clic en el nombre en
la lista de valores.

La Sección de Operadores contiene todos los operadores utilizables. Para añadir un operador al campo de la
clausula WHERE, haga clic en el botón correspondiente. Los operadores relacionales ( = , > , ...), operador de
comparación de cadenas (COMO), y los operadores lógicos (Y, O, ...) están disponibles.

El botón [Probar] muestra un cuadro de mensaje con el numero de objetos espaciales que satisfacen la consulta
actual, que es útil en el proceso de construcción de consultas. El botón [Limpiar] limpia el texto en el campo de
texto de la clausula WHERE de SQL. El botón [Aceptar] cierra la ventana y selecciona los objetos espaciales que
satisfacen la consulta. El botón [Cancelar] cierra la ventana sin cambiar la selección actual.

QGIS treats the resulting subset acts as if it were the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

La única excepción es que a menos que su capa sea parte de la base de datos, el uso del subconjunto evitará que
usted edite su capa.

12.2.2 Propiedades de Estilo

The Style tab provides you with a comprehensive tool for rendering and symbolizing your vector data.
You can use tools that are common to all vector data, as well as special symbolizing tools that were designed
for the different kinds of vector data. However all types share the following dialog structure: in the upper part,
you have a widget that helps you prepare the classification and the symbol to use for features and at the bottom
the:ref:layer_rendering widget.

Truco: Exportar simbología vector
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files.
Just open the right mouse menu of the layer and click on Save As... to specify the name of the output file and its
format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology → or as
Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Representación de elementos

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted polygons and 2.5 D renderers.

There is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The
categorized and graduated renderers can be created by specifying a symbol and a color ramp - they will set the
colors for symbols appropriately. For each data type (points, lines and polygons), vector symbol layer types are
available. Depending on the chosen renderer, the dialog provides different additional sections.

Nota: If you change the renderer type when setting the style of a vector layer the settings you made for the
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symbol will be maintained. Be aware that this procedure only works for one change. If you repeat changing the
renderer type the settings for the symbol will get lost.

Representador de Símbolo Único

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. See
El Selector de Símbolo for further information about symbol representation.

Figure 12.9: Propiedades de línea con símbolo único

Truco: Edit symbol directly from layer panel
If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and

choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.

Sin representación de símbolos

The No Symbols renderer is a special use case of the Single Symbol renderer as it applies the same rendering
to all features. Using this renderer, no symbol will be drawn for features, but labeling, diagrams and other non-
symbol parts will still be shown.

Selections can still be made on the layer in the canvas and selected features will be rendered with a default symbol.
Features being edited will also be shown.
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This is intended as a handy shortcut for layers which you only want to show labels or diagrams for, and avoids the
need to render symbols with totally transparent fill/border to achieve this.

Representador Categorizado

The Categorized Renderer is used to render the features of a layer, using a user-defined symbol whose aspect
reflects the discrete values of a field or an expression. The Categorized menu allows you to

• select an existing field (using the Column listbox) or

• type or build an expression using the Set column expression. The expression used to classify features can be
of any type; it can for example:

– be a comparison, e.g. myfield >= 100, $id = @atlas_featureid, myfield % 2 = 0,
within( $geometry, @atlas_geometry ). In this case, QGIS returns values 1 (True) and
0 (False).

– combine different fields, e.g. concat( field1, ’ ’, field2 ) particularly useful when you
want to process classification on two or more fields simultaneously.

– be a calculation on fields, e.g. myfield % 2, year( myfield ) field_1 + field_2.

– be used to transform linear values in discrete classes, e.g.:

CASE WHEN x > 1000 THEN ’Big’ ELSE ’Small’ END

– combine several discrete values in one single category, e.g.:

CASE
WHEN building IN (’residence’, ’mobile home’) THEN ’residential’
WHEN building IN (’commercial’, ’industrial’) THEN ’Commercial and Industrial’
END

Nota: While you can use any kind of expression to categorize features, for some complex expressions it
might be simpler to use rule-based rendering.

• the symbol (using the El Selector de Símbolo dialog) which will be used as base symbol for each class;

• the range of colors (using the Color ramp listbox) from which color applied to the symbol is selected.

Then click on [Classify] button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_categorized_symbology shows the category rendering dialog used for the rivers layer of
the QGIS sample dataset.

Truco: Elegir y cambiar símbolos múltiples
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Truco: Hacer coincidir las categorías con el nombre de símbolo
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.
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Figure 12.10: Opciones de simbolización categorizadas

Representador Graduado

The Graduated Renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, it allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• The symbol (using the Symbol selector dialog)

• El formato de leyenda y la precisión

• The method to use to change the symbol: color or size

• The colors (using the color Ramp list) if the color method is selected

• The size (using the size domain and its unit)

Then you can use the Histogram tab which shows an interactive histogram of the values from the assigned field or
expression. Class breaks can be moved or added using the histogram widget.

Nota: You can use Statistical Summary panel to get more information on your vector layer. See Panel de resumen
estadístico.

Back to the Classes tab, you can specify the number of classes and also the mode for classifying features within
the classes (using the Mode list). The available modes are:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;
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• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

The listbox in the center part of the Style tab lists the classes together with their ranges, labels and symbols that
will be rendered.

Click on Classify button to create classes using the chosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_graduated_symbology shows the graduated rendering dialog for the rivers layer of the
QGIS sample dataset.

Figure 12.11: Graduated Symbolizing options

Truco: Thematic maps using an expression
Categorized and graduated thematic maps can be created using the result of an expression. In the properties dialog

for vector layers, the attribute chooser is extended with a Set column expression function. So you don’t need to write
the classification attribute to a new column in your attribute table if you want the classification attribute to be a
composite of multiple fields, or a formula of some sort.
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Proportional Symbol and Multivariate Analysis

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Crear símbolo proporcional

Proportional rendering is done by first applying to the layer the Representador de Símbolo Único. Once you set

the symbol, at the upper level of the symbol tree, the Data-defined override button available beside Size or
Width options (for point or line layers respectively) provides tool to create proportional symbology for the layer.

An assistant is moreover accessible through the menu to help you define size expression.

Figure 12.12: Asistente de tamaño variable

El asistente te permite definir:

• The attribute to represent, using the Field listbox or the Set column expression function (see Expresiones)

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• El tamaño mínimo y máximo del símbolo

• The range of values to represent: The down pointing arrow helps you fill automatically these fields with the
minimum (or zero) and maximum values returned by the chosen attribute or the expression applied to your
data.

• Un tamaño único para representar valores NULOS

To the right side of the dialog, you can preview the features representation within a live-update widget. This
representation is added to the layer tree in the layer legend and is also used to shape the layer representation in the
print composer legend item.

The values presented in the varying size assistant above will set the size ‘Data-defined override’ with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Crear análisis multivariable

A multivariate analysis rendering helps you evaluate the relationship between two or more variables e.g., one can
be represented by a color ramp while the other is represented by a size.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the El Selector de Símbolo dialog from which, as seen above, you can activate
and set the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.
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Figure 12.13: Ejemplo de multivariado

Representación basada en reglas

The Rule-based Renderer is used to render all the features from a layer, using rule-based symbols whose
aspect reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements.
The dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use
only the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expresiones). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style tab of the layer properties appears showing the rule that is the background for the
symbol in the tree.

The example in figure_rule_based_symbology shows the rule-based rendering dialog for the rivers layer of the
QGIS sample dataset.

Desplazamiento de punto

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Nota: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.
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Figure 12.14: Opciones de simbología basada en reglas

Figure 12.15: Cuadro de diálogo de desplazamiento de punto
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Polígono Invertido

The Inverted Polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As
above you can select subrenderers, namely Single symbol, Graduated, Categorized, Rule-Based or 2.5D renderer.

Figure 12.16: Inverted Polygon dialog

Mapa de calor

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

2.5D

Using the 2.5D renderer it’s possible to create a 2.5D effect on your layer’s features. You start by choosing a
Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate
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Figure 12.17: Diálogo Mapa de calor

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Truco: Using 2.5D effect with other renderers
Once you have finished setting the basic style on the 2.5D renderer, you can convert this to another renderer (single,
categorized, graduated). The 2.5D effects will be kept and all other renderer specific options will be available for
you to fine tune them (this way you can have for example categorized symbols with a nice 2.5D representation
or add some extra styling to your 2.5D symbols). To make sure that the shadow and the “building” itself do not
interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol levels...). The
2.5D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the variables tab of
the layer’s properties dialog.

Reproduccion de Capas

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modos de Mezcla.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define Order
dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.
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Figure 12.18: Diálogo 2.5D

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Figure 12.19: Layer rendering options

Otras Configuraciones

Niveles de símbolos

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below
the saved symbols list and choosing Symbol levels. For the Representación basada en reglas the option is directly
available through [Symbols levels] button, while for Desplazamiento de punto renderer the same button is inside
the Rendering settings dialog.

To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.
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Figure 12.20: Symbol levels dialog

Nota: If symbols levels are deactivated, the complete symbols will be drawn according to their respective features
order. Overlapping symbols will simply obfuscate to other below. Besides, similar symbols won’t “merge” with
each other.

Figure 12.21: Symbol levels activated (A) and deactivated (B) difference

Efectos de dibujo

In order to improve layer rendering and avoid (or at least reduce) the resort to other software for final rendering of

maps, QGIS provides another powerful functionality: the Draw Effects options, which adds paint effects for
customizing the visualization of vector layers.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
that will open the Effect Properties Dialog (see figure_effects_source). The following effect types, with custom
options are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.
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Figure 12.22: Efectos de dibujo: cuadro de diálogo Fuente

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.

There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Reproduccion de Capas and can be used in all draw effects except for the transform
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Figure 12.23: Efectos de dibujo: cuadro de diálogo Difuminar

Figure 12.24: Efectos de dibujo: cuadro de diálogo Dar Color
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Figure 12.25: Efectos de dibujo: cuadro de diálogo Sombra exterior

Figure 12.26: Efectos de dibujo: cuadro de diálogo Sombra interior
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Figure 12.27: Efectos de dibujo: cuadro de diálogo Brillo interior

Figure 12.28: Efectos de dibujo: cuadro de diálogo Brillo exterior
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Figure 12.29: Efectos de dibujo: cuadro de diálogo Transformar

one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.2.3 Propiedades de etiquetas

The Labels properties provides you with all the needed and appropriate capabilities to configure smart labeling
on vector layers. This dialog can also be accessed from the Layer Styling panel, or using the Layer Labeling Options

icon of the Labels toolbar.

Configurar una etiqueta

The first step is to choose the labeling method from the drop-down list. There are four options available:

• Sin etiquetas

• Mostrar etiquetas para esta capa

• Etiquetado basado en reglas
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• and Blocking: allows to set a layer as just an obstacle for other layer’s labels without rendering any labels
of its own.

The next steps assume you select the Show labels for this layer option, enabling following tabs that help you
configure the labeling:

• Texto

• Formateo

• Buffer

• Fondo

• Sombra

• Ubicación

• Representación

It also enables the Label with drop-down list, from which you can select an attribute column to use. Click if
you want to define labels based on expressions - See Definir etiquetas basadas en expresiones.

The following steps describe simple labeling without using the Data defined override functions, which are situated
next to the drop-down menus - see Using data-defined override for labeling for a use case.

Figure 12.30: Configuración del etiquetado de capa - Pestaña de Texto
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Pestaña de Texto

In the Text tab, you can define the Font, Style, and Size of your labels’ text (see Figure_labels). There are options
available to set the labels’ Color and Transparency. Use the Type case option to change the capitalization style of
the text. You have the possibility to render the text as ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
In Spacing, you can change the space between words and between individual letters. Finally, use the Blend mode
option to determine how your labels will mix with the map features below them (see more about it in Modos de
Mezcla).

The Apply label text substitutes option gives you ability to specify a list of texts to substitute to texts in feature
labels (e.g., abbreviating street types). Replacement texts are thus used to display labels in the map canvas. Users
can also export and import lists of substitutes to make reuse and sharing easier.

Pestaña de formato

In the Formatting tab, you can define a character for a line break in the labels with the Wrap on character option.
You can also format the Line Height and the alignment. For the latter, typical values are available (left, right, and
center), plus Follow label placement for point layers. When set to this mode, text alignment for labels will be
dependent on the final placement of the label relative to the point. E.g., if the label is placed to the left of the point,
then the label will be right aligned, while if it is placed to the right, it will be left aligned.

For line vector layers you can include Line directions symbols to help determine the lines directions. They work
particularly well when used with the curved or Parallel placement options from the Placement tab. There are
options to set the symbols position, and to reverse direction.

Use the Formatted numbers option to format numeric labels. You can set the number of Decimal places. By

default, 3 decimal places will be used. Use the Show plus sign if you want to show the plus sign in positive
numbers.

Pestaña de buffer

To create a buffer around the labels, activate the Draw text buffer checkbox in the Buffer tab. You can set the

buffer’s Size, color, and Transparency. The buffer expands from the label’s outline , so, if the color buffer’s fill
checkbox is activated, the buffer interior is filled. This may be relevant when using partially transparent labels or

with non-normal blending modes, which will allow seeing behind the label’s text. Deactivating color buffer’s
fill checkbox (while using totally transparent labels) will allow you to create outlined text labels.

Pestaña de Fondo

In the Background tab, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Modos de Mezcla).

Pestaña de Sombra

Use the Shadow tab for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
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shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.

Pestaña de Colocación

Choose the Placement tab for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Ubicación para capas punto With the Cartographic placement mode, point labels are generated with a
better visual relationship with the point feature, following ideal cartographic placement rules. Labels can be
placed at a set Distance either from the point feature itself or from the bounds of the symbol used to represent the
feature. The latter option is especially useful when the symbol size isn’t fixed, e.g. if it’s set by a data defined size
or when using different symbols in a categorized renderer.

By default, placements are prioritised in the following order:

1. arriba derecha

2. arriba izquierda

3. abajo derecha

4. abajo izquierda

5. al medio derecha

6. al medio izquierda

7. arriba, ligeramente derecha

8. abajo, ligeramente izquierda

Placement priority can, however, be customized or set for an individual feature using a data defined list of priori-
tised positions. This also allows only certain placements to be used, so e.g. for coastal features you can prevent
labels being placed over the land.

The Around point setting places the label in an equal radius (set in Distance) circle around the feature. The
placement of the label can even be constrained using the Quadrant option.

With the Offset from point, labels are placed at a fixed offset from the point feature. You can select the Quadrant
in which to place your label. You are also able to set the Offset X,Y distances between the points and their labels
and can alter the angle of the label placement with the Rotation setting. Thus, placement in a selected quadrant
with a defined rotation is possible.

Ubicación para capas línea Label options for line layers include Parallel, Curved or Horizontal.

For the Parallel and Curved options, you can set the position to Above line, On line and Below
line. It’s possible to select several options at once. In that case, QGIS will look for the optimal label position.
For Parallel and curved placement options, you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_placement_line).

For all three placement options, in Repeat, you can set up a minimum distance for repeating labels. The distance
can be in mm or in map units.

Ubicación para capas polígono You can choose one of the following options for placing labels in polygons
(see figure_labels_placement_polygon):

• Desplazamiento desde el centroide,

• Horizontal (lento),

• Al rededor del centroide,
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Figure 12.31: Label placement examples in lines

• Libre (lento),

• Usando perímetro,

• and Usando perímetro (curved).

In the Offset from centroid settings you can specify if the centroid is of the visible polygon or whole polygon.
That means that either the centroid is used for the polygon you can see on the map or the centroid is determined
for the whole polygon, no matter if you can see the whole feature on the map. You can place your label within a
specific quadrant, and define offset and rotation.

The Around centroid setting places the label at a specified distance around the centroid. Again, you can define
visible polygon or whole polygon for the centroid.

With the Horizontal (slow) or Free (slow) options, QGIS places at the best position either a horizontal or a rotated
label inside the polygon.

With the Using perimeter option, the label will be drawn next to the polygon boundary. The label will behave like

the parallel option for lines. You can define a position and a distance for the label. For the position, Above

line, On line, Below line and Line orientation dependent position are possible. You can specify the
distance between the label and the polygon outline, as well as the repeat interval for the label.

The Using perimeter (curved) option helps you draw the label along the polygon boundary, using a curved labeling.
In addition to the parameters available with Using perimeter setting, you can set the Maximum angle between
curved characters polygon, either inside or outside.

In the priority section you can define the priority with which labels are rendered for all three vector layer types
(point, line, polygon). This placement option interacts with the labels from other vector layers in the map canvas.
If there are labels from different layers in the same location, the label with the higher priority will be displayed
and the others will be left out.

Pestaña de Renderizado

In the Rendering tab, you can tune when the labels can be rendered and their interaction with other labels and
features.

Under Label options, you find the scale-based and the Pixel size-based visibility settings.

The Label z-index determines the order in which labels are rendered, as well in relation with other feature labels in
the layer (using data-defined override expression), as with labels from other layers. Labels with a higher z-index
are rendered on top of labels (from any layer) with lower z-index.

Additionally, the logic has been tweaked so that if 2 labels have matching z-indexes, then:

• if they are from the same layer, the smaller label will be drawn above the larger label
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Figure 12.32: Ejemplos de colocación de etiqueta en polígonos

• if they are from different layers, the labels will be drawn in the same order as their layers themselves (ie
respecting the order set in the map legend).

Note that this setting doesn’t make labels to be drawn below the features from other layers, it just controls the
order in which labels are drawn on top of all the layer’s features.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.

For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:
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• over the feature’s interior: avoids placing labels over the interior of the polygon (prefers placing labels
totally outside or just slightly inside the polygon)

• or over the feature’s boundary: avoids placing labels over boundary of the polygon (prefers placing labels
outside or completely inside the polygon). E.g., it can be useful for regional boundary layers, where the
features cover an entire area. In this case, it’s impossible to avoid placing labels within these features, and
it looks much better to avoid placing them over the boundaries between features.

Etiquetado basado en reglas

With rule-based labeling multiple label configurations can be defined and applied selectively on the base of ex-
pression filters and scale range, as in Rule-based rendering.

To create a rule, select the Rule-based labeling option in the main drop-down list from the Labels tab and click

the button at the bottom of the dialog. Then fill the new dialog with a description and an expression to filter
features. You can also set a scale range in which the label rule should be applied. The other options available in
this dialog are the common settings seen beforehand.

Figure 12.33: Configuración de reglas

A summary of existing rules is shown in the main dialog (see figure_labels_rule_based). You can add multiple

rules, reorder or imbricate them with a drag-and-drop. You can as well remove them with the button or edit

them with button or a double-click.

12.2. El Dialogo de las Propiedades del Vector 151



QGIS User Guide, Publicación 2.18

Figure 12.34: Panel de etiquetado basado en reglas

Definir etiquetas basadas en expresiones

Whether you choose simple or rule-based labeling type, QGIS allows using expressions to label features.

Click the icon near the Label with drop-down list in the Labels tab of the properties dialog. In fig-
ure_labels_expression, you see a sample expression to label the alaska regions with name and area size, based on
the field ‘NAME_2’, some descriptive text, and the function $area in combination with format_number()
to make it look nicer.

Figure 12.35: Usar expresiones para etiquetado

Expression based labeling is easy to work with. All you have to take care of is that:

• You need to combine all elements (strings, fields, and functions) with a string concatenation function such
as concat, + or ||. Be aware that in some situations (when null or numeric value are involved) not all of
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these tools will fit your need.

• Strings are written in ‘single quotes’.

• Fields are written in “double quotes” or without any quote.

Let’s have a look at some examples:

1. Label based on two fields ‘name’ and ‘place’ with a comma as separator:

"name" || ’, ’ || "place"

Devuelve:

John Smith, Paris

2. Label based on two fields ‘name’ and ‘place’ with other texts:

’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

Devuelve:

My name is John Smith and I live in Paris

3. Label based on two fields ‘name’ and ‘place’ with other texts combining different concatenation functions:

concat(’My name is ’, name, ’ and I live in ’ || place)

Devuelve:

My name is John Smith and I live in Paris

Or, if the field ‘place’ is NULL, returns:

My name is John Smith

4. Multi-line label based on two fields ‘name’ and ‘place’ with a descriptive text:

concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")

Devuelve:

My name is John Smith
I live in Paris

5. Label based on a field and the $area function to show the place’s name and its rounded area size in a
converted unit:

’The area of ’ || "place" || ’ has a size of ’
|| round($area/10000) || ’ ha’

Devuelve:

The area of Paris has a size of 10500 ha

6. Create a CASE ELSE condition. If the population value in field population is <= 50000 it is a town,
otherwise it is a city:

concat(’This place is a ’,
CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

Devuelve:

This place is a town
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As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Expresiones chapter for more information and examples on
expressions.

Using data-defined override for labeling

With the Data defined override functions, the settings for the labeling are overridden by entries in the attribute table.
It can be used to set values for most of the labeling options described above. See the widget’s description and
manipulation in Configuración de anulación definida por datos section.

La Barra de Herramientas Etiqueta

The Label Toolbar provides some tools to manipulate label or diagram properties, but only if the
corresponding data-defined option is indicated (otherwise, buttons are disabled). Layer might also need to be in
edit mode.

Figure 12.36: La barra de herramientas Etiqueta

While for readability, label has been used below to describe the Label toolbar, note that when mentioned in
their name, the tools work almost the same way with diagrams:

• Pin/Unpin Labels And Diagrams that has data-defined position. By clicking or draging an area, you pin label(s).
If you click or drag an area holding Shift, label(s) are unpinned. Finally, you can also click or drag an
area holding Ctrl to toggle the pin status of label(s).

• Highlight Pinned Labels And Diagrams. If the vector layer of the label is editable, then the highlighting is green,
otherwise it’s blue.

• Move Label And Diagram that has data-defined position. You just have to drag the label to the desired place.

• Show/Hide Labels And Diagrams that has data-defined visbility. If you click or drag an area holding Shift,
then label(s) are hidden. When a label is hidden, you just have to click or drag an area around the feature’s
point to restore its visibility.

• Rotate Label. Click the label and move around and you get the text rotated.

• Change Label. It opens a dialog to change the clicked label properties; it can be the label itself, its coordi-
nates, angle, font, size... as long as this property has been mapped to a field.

Advertencia: Label tools overwrite current field values
Using the Label toolbar to customize the labeling actually writes the new value of the property in the mapped
field. Hence, be careful to not inadvertently replace data you may need later!

Customize the labels from the map canvas

Combined with the Label Toolbar, the data defined override setting helps you manipulate labels in the map canvas

(move, edit, rotate). We now describe an example using the data-defined override function for the Move label

function (see figure_labels_data_defined).

1. Import lakes.shp from the QGIS sample dataset.
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2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
xlabel for X and ylabel for Y. The icons are now highlighted in yellow.

Figure 12.37: Labeling of vector polygon layers with data-defined override

4. Acercamiento a un lago

5. Set editable the layer using the Toggle Editing button.

6. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_move). The new position of the label is saved in the xlabel and ylabel columns of
the attribute table.

7. Using The Geometry Generator with the expression below, you can also add a linestring symbol layer to
connect each lake to its moved label:

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

Figure 12.38: Moved labels
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12.2.4 Propiedades de campos

The Fields tab helps you organize the fields of the selected dataset and the way you can interact with the

feature’s attributes. The buttons New field and Delete field can be used when the dataset is in Editing mode.

You can rename fields by double-clicking in the fields name (note that you should switch to editing mode to edit
the field name). This is only supported for data providers like PostgreSQL, Oracle, Memory layer and some OGR
layer depending the OGR data format and version.

You can define some alias to display human readable fields in the feature form or the attribute table. In this case,
you don’t need to switch to editing mode. Alias are saved in project file.

Comments can be added by clicking in the comment field of the column but if you are using a PostgreSQL layer,
comment of the column could be the one in the PostgreSQL table if set. Comments are saved in the QGIS project
file as for the alias.

The dialog also lists read-only characteristics of the field such as its type, type name, length and
precision. When serving the layer as WMS or WFS, you can also check here which fields could be retrieved.

Figure 12.39: Pestaña de propiedades de campos

Configurar el comportamiento del campo

Within the Fields tab, you also find an Edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. It also helps to set the type of widget
used to fill or display values of the field, in the attribute table or the feature form. If you click on the [Edit widget]
button, a dialog opens, where you can define different widgets.

Configuración común

Regardless the type of widget applied to the field, there are some common properties you can set to control whether
and how a field can be edited:

• Editable: uncheck this to set the field read-only (not manually modifiable) when the layer is in edit mode.
Note that checking this setting doesn’t override any edit limitation from the provider.
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Figure 12.40: Dialog to select an edit widget for an attribute column
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• Label on top: places the field name above or beside the widget in the feature form

• Default value: for new features, automatically populates by default the field with a predefined value or an
expression-based one. For example, you can:

– use $x, $length, $area to populate a field with the feature’s x coordinate, length, area or any
geometric information at its creation;

– incremente a field by 1 for each new feature using maximum("field")+1;

– save the feature creation datetime using now();

– use variables in expressions, making it easier to e.g. insert the operator name (@user_full_name),
the project file path (@project_path), ...

A preview of the resulting default value is displayed at the bottom of the widget.

Nota: The Default value option is not aware of the values in any other field of the feature being
created so it won’t be possible to use an expression combining any of those values i.e using an expression
like concat(field1, field2) may not work.

• Constraints: you can constrain the value to insert in the field. This constraint can be:

– Not null: force the user to provide a value

– based on a custom expression: e.g. regexp_match(col0,’A-Za-z’) to ensure that the value
of the field col0 has only alphabetical letter.

A short description of the constraint can be added and will be displayed at the top of the form as a
warning message when the value supplied does not match the constraint.

Modo de edición

Los widgets disponibles son:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Clasificación: Muestra una lista desplegable con los valores utilizados para clasificación, si ha elegido
‘valor único’ como tipo de leyenda en la pestaña Estilo del cuadro de diálogo de propiedades.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• External Resource: Uses a “Open file” dialog to store file path in a relative or absolute mode. It can also
be used to display a hyperlink (to document path), a picture or a web page.

• File Name: Simplifies the selection by adding a file chooser dialog.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Foto: El campo contiene un nombre de archivo para una imagen. Lo ancho y lo alto de un campo se puede
definir.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one or many to many relations.

• Text Edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.
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• Unique Values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• UUID Generador: Genera un campo de solo lectura UUID (Identificador único universal), si esta vacío.

• Value Map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Web View: Field contains a URL. The width and height of the field is variable.

Nota: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

Truco: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a .qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

Personalizar un formulario para sus datos

By default, when you click on a feature with the Identify Features tool or switch the attribute table to the form view
mode, QGIS displays a form with tabulated textboxes (one per field). This rendering is the result of the default
Autogenerate value of the Layer properties → Fields → Attribute editor layout setting. Thanks to the widget
setting, you can improve this dialog.

You can furthermore define built-in forms (see figure_fields_form), e.g. when you have objects with many at-
tributes, you can create an editor with several tabs and named groups to present the attribute fields.

El diseñador de arrastrar y soltar

Choose Drag and drop designer from the Attribute editor layout combobox to layout the features form
within QGIS. Then, drag and drop rows from the Fields frame to the Label panel to have fields added to your
custom form.

You can also use categories (tab or group frames) to better structure the form. The first step is to use the icon
to create a tab in which fields and groups will be displayed (see figure_fields_layout). You can create as many

categories as you want. The next step will be to assign to each category the relevant fields, using the icon.
You’d need to select the targeted category beforehand. You can use the same fields many times.

You can configure tabs or groups with a double-click. QGIS opens a form in which you can:

• elegir ocultar o mostrar el elemento etiqueta

• Renombrar la categoría

• set over how many columns the fields under the category should be distributed

• enter an expression to control the category visibility. The expression will be re-evaluated everytime values
in the form change and the tab or groupbox shown/hidden accordingly.

• show the category as a group box (only available for tabs)
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Figure 12.41: Resulting built-in form with tabs and named groups

Figure 12.42: El cuadro de diálogo para crear categorías con el Diseño del editor de atributos
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With a double-click on a field label, you can also specify whether the label of its widget should be visible or not
in the form.

In case the layer is involved in one to many relations (see Creating one or many to many relations),
referencing layers are listed in the Relations frame and their form can be embedded in the current layer form by
drag-and-drop. Like the other items, double-click the relation label to configure some options:

• elegir ocultar o mostrar el elemento etiqueta

• mostrar el botón de vínculo

• Mostrar el botón de desvinculación

Proporciona un archivo-ui

The Provide ui-file option allows you to use complex dialogs made with Qt-Designer. Using a UI-file
allows a great deal of freedom in creating a dialog. Note that, in order to link the graphical objects (textbox,
combobox...) to the layer’s fields, you need to give them the same name.

Use the Edit UI to define the path to the file to use.

You’ll find some example in the Creating a new form lesson of the QGIS-training-manual-index-reference.
For more advanced information, see http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-
logic/.

Enhance your form with custom functions

QGIS forms can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment: use a function, for example in startup.py or from an installed
plugin)

• load from an external file: a file chooser will appear in that case to allow you to select a Python
file from your filesystem

• provide code in this dialog: a Python editor will appear where you can directly type the func-
tion to use.

In all cases you must enter the name of the function that will be called (open in the example below).

An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: open

12.2.5 Propiedades de unión

The Joins tab allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins).
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Figure 12.43: Join an attribute table to an existing vector layer

Additionally, the add vector join dialog allows you to:

• 74%matchCachear capa de unión en memoria virtual

• Crear índice de atributo en el campo de combinación

• Choose which fields are joined

• Create a Custom field name prefix

12.2.6 Propiedades de diagrama

The Diagrams tab allows you to add a graphic overlay to a vector layer (see figure_diagrams_attributes).

The current core implementation of diagrams provides support for:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

Truco: Switch quickly between types of diagrams
Given that the settings are almost common to the different types of diagram, when designing your diagram, you
can easily change the diagram type and check which one is more appropriate to your data without any loss.

For each type of diagram, the properties are divided into several tabs:

• Atributos

• Apariencia

• Tamaño

• Colocación
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• Opciones

• Leyenda

Atributos

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expresiones can also be used.

You can move up and down any row with click and drag, sorting how attributes are displayed. You can also change
the label in the ‘Legend’ column or the attribute color by double-clicking the item.

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.44: Propiedades de diagrama - pestaña de Atributos

Apariencia

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• la transparencia de la gráfica, el ancho del borde y color

• el ancho de la barra en caso de histograma

• the circle background color in case of text diagram, and the font used for texts

• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

En la pestaña, también puede administrar la visibilidad del diagrama:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by selecting a field with Data defined visibility to precisely tune which diagrams should be rendered

• by setting the scale visibility
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Figure 12.45: Propiedades de diagrama - pestaña de Apariencia

Tamaño

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.

Figure 12.46: Propiedades de diagrama - pestaña de tamaño

Ubicación

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.
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• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Figure 12.47: Vector properties dialog with diagram properties, Placement tab

Opciones

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.

Leyenda

From the Legend tab, you can choose to display items of the diagram in the Panel de capas, besides the layer
symbology. It can be:

• los atributos representados:color y texto de leyenda establecer en la pestaña pestaña Atributos

• si es aplicable, el tamaño del diagrama, cuyo símbolo puede personalizar.

When set, the diagram legend items are also available in the print composer legend, besides the layer symbology.

Estudio de Caso

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Datos de
ejemplo).

1. Primero haga clic sobre el icono Añadir capa vectorial, navegue a la carpeta del conjunto de datos de ejemplo
de QGIS y cargue las dos capas vectoriales alaska.shp y climate.shp.

2. pulsar doble en la capa “climate” en la leyenda del mapa para abrir el diálogo de la :guilabel: “Propiedades
de la capa”

3. Click on the Diagrams tab and from the Diagram type combo box, select ‘Text diagram’.
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4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

So, in the Attributes tab first select T_F_JAN and click the button, then repeat with T_F_JUL and
finally T_F_MEAN.

7. Ahora pulse [Aplicar] para mostrar el diagrama en la ventana principal de QGIS.

8. You can adapt the chart size in the Size tab. Activate the Scaled size and set the size of the diagrams on
the basis of the maximum value of an attribute and the Size option. If the diagrams appear too small on the

screen, you can activate the Increase size of small diagrams checkbox and define the minimum size of
the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_mapped gives an idea of the result.

10. Finalmente pulse [Aceptar]

Figure 12.48: Gráfico de temperatura sobrepuesto en un mapa

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression. See Expresiones
chapter for more information and example.

Utilice suplantación definida por datos

As mentioned above, you can use some custom data-defined to tune the diagrams rendering:

• position in Placement tab by filling X and Y fields

• visibility in Appearance tab by filling the Visibility field

Vea Using data-defined override for labeling para más información.
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12.2.7 Propiedades de acciones

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Figure 12.49: Overview action dialog with some sample actions

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Las acciones genéricas, Mac, Windows inician un proceso externo.

• Las acciones Python ejecutan una expresión Python.

• Las acciones genéricas y Python son visibles en todos lados.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Create default actions].
To edit any of the examples, double-click its row. One example is performing a search based on an attribute value.
This concept is used in the following discussion.

Definir Acciones

To define an attribute action, open the vector Layer Properties dialog and click on the Actions tab. In the Actions

tab, click the Add a new action to open the Edit Action dialog.

Select the action Type and provide a descriptive name for the action. The action itself must contain the name of
the application that will be executed when the action is invoked. You can add one or more attribute field values as
arguments to the application. When the action is invoked, any set of characters that start with a % followed by the
name of a field will be replaced by the value of that field. The special characters %% will be replaced by the value
of the field that was selected from the identify results or attribute table (see using_actions below). Double quote
marks can be used to group text into a single argument to the program, script or command. Double quotes will be
ignored if preceded by a backslash.
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If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by proceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.

Empleando Acciones

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the feature and choose the action from the pop-up menu (they
should have been enabled to be displayed in the attribute table). Actions are listed in the popup menu by the name
you assigned when defining the action. Click on the action you wish to invoke.

Si se esta invocando una acción que utilice la notación ‘‘‘‘ , haga clic derecho en el valor del campo en el cuadro
de diálogo Resultados de la Identificación o en Tabla de atributos que desee pasar de la aplicación o script

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Después de seleccionar algunas localidades y ejecutar la acción en cada una, al abrir el archivo de salida mostrará
algo como esto:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Asegure que la capa de lakes este cargada.
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2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Haga clic en la pestaña Acciones

4. haga clic Añadir una nueva acción.

5. Ingrese un nombre para la acción , por ejemplo Búsqueda de Google.

6. Para la acción, se necesita proporcionar el nombre del programa externo a ejecutar. En este caso, podemos
utilizar Firefox. Si el programa no esta en su ruta, se necesita proporcionar la ruta completa.

7. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

8. El texto en el campo Acción debería lucir como: firefox http://google.com/search?q=

9. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert] button.

10. From the drop-down box, select ‘NAMES’ and click [Insert].

11. Su texto de acción ahora se ve así:

firefox http://google.com/search?q=%NAMES

12. To finalize and add the action, click the [OK] button.

Figure 12.50: Edit action dialog configured with the example

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

Ahora podemos utilizar la acción. Cierre el cuadro de diálogo Propiedades de la capa y acérquese a un área de
interés. Asegure que la capa capa lakes este activa e identifique un lago. En la caja de resultados, ahora verá
que su acción es visible.

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
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Figure 12.51: Seleccionar objetos espaciales y elegir una acción

tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

You can also invoke actions from the attribute table by selecting a row and right-clicking, then choosing the action
from the pop-up menu.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.

We can also make more complex examples, for instance, using Python actions.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command = "firefox"
imagerelpath = "images/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
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path = os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)

Para añadir un ráster (una imagen TIF en este ejemplo), se vuelve:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.2.8 Propiedades a mostrar

This tab is specifically created for map tips: display a message in the map canvas when hovering over a feature
of the active layer. This message can either be the value of a Field or a more complex and full HTML text
mixing fields, expressions and html tags (multiline, fonts, images, hyperlink ...).

To activate Map Tips, select the menu option View → Map Tips or click on the Map Tips icon. Map tip is a
cross-session feature meaning that once activated, it stays on and apply to any set layer in any project, even in
future QGIS sessions until it’s toggled off.

Figures Display Code and Mapped show an example of HTML code and how it behaves in map canvas.

Figure 12.52: Código HTML para textos de aviso del mapa

12.2.9 Propiedades de representación

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a global setting that enables generalisation by default for newly added
layers (see global simplification for more information).

Nota: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.
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Figure 12.53: Textos de aviso del mapa con código HTML

Figure 12.54: cuadro de diálogo de Simplificación de Geometría de capa
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While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.2.10 Propiedades de metadatos

The Metadata tab consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalog. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalog.

In MetadataUrl, you can define the general path to the XML metadata catalog. This information will be saved in
the QGIS project file for subsequent sessions and will be used for QGIS server.

In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Pestaña de metadatos en el cuadro de diálogo de las propiedades de la capa vectorial

Truco: Switch quickly between different layer representations
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
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simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.2.11 Propiedades de variables

The Variables tab lists all the variables available at the layer’s level (which includes all global and project’s
variables).

It also allows the user to manage layer-level variables. Click the button to add a new custom layer-level

variable. Likewise, select a custom layer-level variable from the list and click the button to remove it.

Más información sobre el uso de variables en la sección de herramientas Generales Variables

12.2.12 Propiedades de la leyenda

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel.
The idea is to have a way to quickly access some actions that are often used with the layer (setup transparency,
filtering, selection, style or other stuff...).

By default, QGIS provides transparency widget but this can be extended by plugins registering their own widgets
and assign custom actions to layers they manage.

12.3 Expresiones

Based on layer data and prebuilt or user defined functions, Expressions offer a powerful way to manipulate
attribute value, geometry and variables in order to dynamically change the geometry style, the content or position
of the label, the value for diagram, the height of a composer item, select some features, create virtual field ...

12.3.1 The Expression string builder

Main dialog to build expressions, the Expression string builder is available from many parts in QGIS and, can
particularly be accessed when:

• clicking the button;

• selecting features with the Select By Expression... tool;

• editing attributes with e.g. the Field calculator tool;

• manipulating symbology, label or composer item parameters with the Data defined override tool (see Config-
uración de anulación definida por datos);

• building a geometry generator symbol layer;

• doing some geoprocessing.

The Expression builder dialog offers access to the:

• Expression tab which, thanks to a list of predefined functions, helps to write and check the expression to
use;

• Function Editor tab which helps to extend the list of functions by creating custom ones.

Some use cases of expressions:
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• From Field Calculator, calculate a “pop_density” field using existing “total_pop” and “area_km2” fields:

"total_pop" / "area_km2"

• Update the field “density_level” with categories according to the “pop_density” values:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Apply a categorized style to all the features according to whether their average house price is smaller or
higher than 10000C per square metre:

"price_m2" > 10000

• Using the “Select By Expression...” tool, select all the features representing areas of “High population
density” and whose average house price is higher than 10000C per square metre:

"density_level" = ’High population density’ and "price_m2" > 10000

Likewise, the previous expression could also be used to define which features should be labeled or shown
in the map.

Using expressions offers you a lot of possibilities.

Truco: Use named parameters to improve the expression reading
Some functions require many parameters to be set. The expression engine supports the use of named parameters.
This means that instead of writing the cryptic expression clamp( 1, 2, 9), you can use clamp( min:=1,
value:=2, max:=9). This also allows arguments to be switched, e.g. clamp( value:=2, max:=9,
min:=1). Using named parameters helps clarify what the arguments for an expression function refer to, which
is helpful when you are trying to interpret an expression at a later date!

12.3.2 Lista de funciones

The Expression tab provides the main interface to write expressions using functions, layer’s fields and values. It
contains widgets to:

• type expressions using functions and/or fields. At the bottom of the dialog, is displayed the result of the
expression evaluated on the first feature of the layer.

• select the appropriate function among a list, organized in groups. A search box is available to filter the list
and quickly find a particular function or field. Double-clicking on the item’s name adds it to the expression
being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.

Operadores

This group contains operators (e.g., +, -, *). Note that for most of the mathematical functions below, if one of the
inputs is NULL then the result is NULL.

12.3. Expresiones 175



QGIS User Guide, Publicación 2.18

Figure 12.56: The Expression tab

Función Descripción
a + b Addition of two values (a plus b)
a - b Subtraction of two values (a minus b).
a * b Multiplication of two values (a multiplied by b)
a / b División de dos valores (a dividido entre b)
a % b Remainder of division of a by b (eg, 7 % 2 = 1, or 2 fits into 7 three times with remainder

1)
a ^ b Power of two values (for example, 2^2=4 or 2^3=8)
a < b Compares two values and evaluates to 1 if the left value is less than the right value (a is

smaller than b)
a <= b Compares two values and evaluates to 1 if the left value isless than or equal to the right

value
a <> b Compara dos valores y evalúa a 1 si no son iguales
a = b Compara dos valores y evalúa a 1 si son iguales.
a != b a and b are not equal
a > b Compara dos valores y evalúa como 1 si el valor izquierdo es mayor que el valor derecho

(a es mayor que b)
a >= b Compara dos valores y evalúa a 1 si el valor de la izquierda es mayor que o igual que el

valor de la derecha
a ~ b a matches the regular expression b
|| Joins two values together into a string. If one of the values is NULL the result will be

NULL
‘\n’ Inserta una nueva línea en una cadena
LIKE Devuelve 1 si el primer parámetro coincide con el patrón provisto
ILIKE Returns 1 if the first parameter matches case-insensitive the supplied pattern (ILIKE can

be used instead of LIKE to make the match case-insensitive)
a IS b Tests whether two values are identical. Returns 1 if a is the same as b
a OR b Returns 1 when condition a or condition b is true
a AND b Returns 1 when conditions a and b are true
NOT Niega una condición
column name
“column name”

Value of the field column name, take care to not be confused with simple quote, see
below

‘cadena’ a string value, take care to not be confused with double quote, see above
NULL valor nulo
a IS NULL a no tiene valor
a IS NOT NULL a tiene valor
a IN
(value[,value])

a esta debajo de los valores listados

a NOT IN
(valor[,valor])

a no está debajo de los valores listados
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Nota: About fields concatenation
You can concatenate strings using either || or +. The latter also means sum up expression. So if you have an
integer (field or numeric value) this can be error prone. In this case, you should use ||. If you concatenate two
string values, you can use both.

Algún ejemplo:

• Une una cadena de texto y un valor de un nombre de columna:

’My feature’’s id is: ’ || "gid"
’My feature’’s id is: ’ + "gid" => triggers an error as gid is an integer
"country_name" + ’(’ + "country_code" + ’)’
"country_name" || ’(’ || "country_code" || ’)’

• Test if the “description” attribute field starts with the ‘Hello’ string in the value (note the position of the %
character):

"description" LIKE ’Hello%’

Condicionales

Este grupo contiene funciones para menejar comprobaciones condicionales en expresiones.

Función Descripción
CASE WHEN ... THEN ...
END

Evalúa una expresión y devuelve un resultado si es verdadera. Puede probar
múltiples condiciones

CASE WHEN ... THEN ...
ELSE ... END

Evalúa una expresión y devuelva un resultado diferente sea verdadero o falso.
Puede probar múltiples condiciones

coalesce Devuelve el primer valor no-NULO de la lista de expresión
si Prueba una condición y devuelve un resultado diferente dependiendo de la

comprobación condicional
regexp_match Devuelve verdadero si cualquier parte de una cadena coincide con la

expresión regular proporcionada

Algún ejemplo:

• Send back a value if the first condition is true, else another value:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Funciones Matemáticas

Este grupo contiene funciones matemáticas,por ejemplo raíz cuadrada, seno y coseno
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Función Descripción
abs Devuelve el valor absoluto de un número
arcos Devuelve la inversa del coseno de un valor en radianes
arcsen Devuelve la inversa del seno de un valor en radianes
atan Returns the inverse tangent of a value in radians
atan2(y,x) Returns the inverse tangent of y/x by using the signs of the two arguments to determine the

quadrant of the result
az-
imuth(a,b)

Returns the north-based azimuth as the angle in radians measured clockwise from the vertical
on point a to point b

ceil Rounds a number upwards
clamp Restricts an input value to a specified range
cos Devuelve el coseno de un valor en radianes
grados Convierte de radianes a grados
exp Devuelve la exponencial de un valor
floor Rounds a number downwards
ln Returns the natural logarithm of the passed expression
log Returns the value of the logarithm of the passed value and base
log10 Returns the value of the base 10 logarithm of the passed expression
máx Returns the largest value in a set of values
mín Returns the smallest value in a set of values
pi Returns the value of pi for calculations
radianes Convierte de grados a radianes
rand Returns the random integer within the range specified by the minimum and maximum argument

(inclusive)
randf Returns the random float within the range specified by the minimum and maximum argument

(inclusive)
round Rounds to number of decimal places
scale_exp Transforma un valor dado de un dominio de entrada a un rango de salida usando una curva

exponencial
scale_linear Transforma un valor dado de un dominio de entrada a un rango de salida usando interpolación

lineal
sen Returns the sine of an angle
raíz
cuadrada

Returns the square root of a value

tan Returns the tangent of an angle

Aggregates Functions

This group contains functions which aggregate values over layers and fields.
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Función Descripción
agregar Returns an aggregate value calculated using features from another layer
concatenate Returns the all aggregated strings from a field or expression joined by a delimiter
count Returns the count of matching features
count_distinct Returns the count of distinct values
count_missing Returns the count of missing (null) values
iqr Returns the calculated inter quartile range from a field or expression
mayoría Returns the aggregate majority of values (most commonly occurring value) from a field or

expression
max_length Returns the maximum length of strings from a field or expression
máximo Returns the aggregate maximum value from a field or expression
media Returns the aggregate mean value from a field or expression
mediana Returns the aggregate median value from a field or expression
min_length Returns the minimum length of strings from a field or expression
mínimo Returns the aggregate minimum value from a field or expression
minoría Returns the aggregate minority of values (least commonly occurring value) from a field or

expression
q1 Returns the calculated first quartile from a field or expression
q3 Returns the calculated third quartile from a field or expression
intervalo Returns the aggregate range of values (maximum - minimum) from a field or expression
rela-
tion_aggregate

Returns an aggregate value calculated using all matching child features from a layer
relation

stdev Returns the aggregate standard deviation value from a field or expression
sum Returns the aggregate summed value from a field or expression

Ejemplos:

• Return the maximum of the “passengers” field from features in the layer grouped by “station_class” field:

maximum("passengers", group_by:="station_class")

• Calculate the total number of passengers for the stations inside the current atlas feature:

aggregate(’rail_stations’,’sum’,"passengers",
intersects(@atlas_geometry, $geometry))

• Return the mean of the “field_from_related_table” field for all matching child features using the
‘my_relation’ relation from the layer:

aggregate_relation(’my_relation’, ’mean’, "field_from_related_table")

or:

aggregate_relation(relation:=’my_relation’, calculation := ’mean’,
expression := "field_from_related_table")

Funciones de Color

This group contains functions for manipulating colors.
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Función Descripción
color_cmyk Devuelve una representación en forma de cadena de un color en base a sus componentes cian,

magenta, amarillo y negro
color_cmykaReturns a string representation of a color based on its cyan, magenta, yellow, black and alpha

(transparency) components
color_hsl Returns a string representation of a color based on its hue, saturation, and lightness attributes
color_hsla Devuelve una representación en forma de cadena de un color en base a sus atributos de matiz,

saturación, luminosidad y canal alfa (transparencia).
color_hsv Returns a string representation of a color based on its hue, saturation, and value attributes
color_hsva Devuelve una representación en forma de cadena de un color en base a sus atributos de matiz,

saturación, valor y canal alfa (transparencia)
color_part Devuelve un componente específico de la cadena de un color, por ejemplo el componente rojo o

el alfa
color_rgb Returns a string representation of a color based on its red, green, and blue components
color_rgba Returns a string representation of a color based on its red, green, blue, and alpha (transparency)

components
más
oscuro

Devuelve una cadena de color más oscura (o más clara)

más
claro

Devuelve una cadena de color más clara (o más oscura)

project_colorDevuelve un color del esquema de color del proyecto
ramp_color Devuelve una cadena que representa un color de una rampa de color
set_color_partSets a specific color component for a color string, eg the red component or alpha component

Funciones de conversión

This group contains functions to convert one data type to another (e.g., string to integer, integer to string).

Función Descripción
to_date Convierte una cadena de texto en un objeto fecha
to_datetime Converts a string into a datetime object
to_int Convierte una cadena de texto a número entero
to_interval Converts a string to an interval type (can be used to take days, hours, months, etc. of a date)
to_real Convierte una cadena de texto en número real
to_string Convierte un número en cadena.
to_time Converts a string into a time object

Funciones personalizadas

This group contains functions created by the user. See Editor de Funciones for more details.

Funciones de Fecha y Hora

Este grupo contiene funciones para manipular datos de fecha y hora.

Función Descripción
edad Returns as an interval the difference between two dates or datetimes
día Extracts the day from a date or datetime, or the number of days from an interval
day_of_week Returns a number corresponding to the day of the week for a specified date or datetime
hora Extracts the hour from a datetime or time, or the number of hours from an interval
minuto Extracts the minute from a datetime or time, or the number of minutes from an interval
mes Extracts the month part from a date or datetime, or the number of months from an interval
now Returns current date and time
segundo Extracts the second from a datetime or time, or the number of seconds from an interval
semana Extrae el número de la semana de una fecha o el número de semanas de un intervalo.
year Extracts the year part from a date or datetime, or the number of years from an interval
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This group also shares several functions with the Funciones de conversión ( to_date, to_time, to_datetime,
to_interval) and Funciones de cadena (format_date) groups.

Algún ejemplo:

• Get today’s month and year in the “month_number/year” format:

format_date(now(),’MM/yyyy’)
-- Returns ’03/2017’

Besides these functions, subtracting dates, datetimes or times using the - (minus) operator will return an interval.

Adding or subtracting an interval to dates, datetimes or times, using the + (plus) and - (minus) operators, will
return a datetime.

• Get the number of days until QGIS 3.0 release:

to_date(’2017-09-29’) - to_date(now())
-- Returns <interval: 203 days>

• The same with time:

to_datetime(’2017-09-29 12:00:00’) - to_datetime(now())
-- Returns <interval: 202.49 days>

• Get the datetime of 100 days from now:

now() + to_interval(’100 days’)
-- Returns <datetime: 2017-06-18 01:00:00>

Nota: Storing date and datetime and intervals on fields
The ability to store date, time and datetime values directly on fields may depend on the data source’s provider (e.g.,
shapefiles accept date format, but not datetime or time format). The following are some suggestions to overcame
this limitation.

date, Datetime and time can be stored in text type fields after using the to_format() function.

Intervals can be stored in integer or decimal type fields after using one of the date extraction functions (e.g.,
day() to get the interval expressed in days)

Campos y Valores

Contains a list of fields from the layer.

Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.

To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

También se puede acceder a datos de muestra vía clic derecho. Seleccione el nombre del campo de la lista,
luego haga clic derecho para acceder al menú contextual con opciones para cargar valores de muestra del campo
seleccionado.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Funciones Concordancia aproximada

This group contains functions for fuzzy comparisons between values.
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Función Descripción
ham-
ming_distance

Returns the number of characters at corresponding positions within the input strings where
the characters are different

levensheim Returns the minimum number of character edits (insertions, deletions or substitutions)
required to change one string to another. Measure the similarity between two strings

longest_common_substringReturns the longest common substring between two strings
soundex Returns the Soundex representation of a string

Funciones Generales

Este grupo contiene funciones generales variadas.

Función Descripción
eval Evaluates an expression which is passed in a string. Useful to expand dynamic parameters

passed as context variables or fields
layer_propertyReturns a property of a layer or a value of its metadata. It can be layer name, crs, geometry

type, feature count...
var Returns the value stored within a specified variable. See variable functions below

Funciones de Geometría

This group contains functions that operate on geometry objects (e.g., length, area).

Función Descripción
$area Returns the area size of the current feature
$geometry Returns the geometry of the current feature (can be used for processing with other functions)
$length Returns the length of the current line feature
$perimeter Returns the perimeter of the current polygon feature
$x Returns the x coordinate of the current feature
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Devuelve la coordenada Y del objeto actual
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
angle_at_vertex Returns the bisector angle (average angle) to the geometry for a specified vertex on a linestring geometry. Angles are in degrees clockwise from north
area Devuelve el perímetro de un objeto de geometría poligonal. Los cálculos están en el Sistema de Referencia Espacial de esta geometría
azimuth Returns the north-based azimuth as the angle in radians measured clockwise from the vertical on point_a to point_b
contorno Returns the closure of the combinatorial boundary of the geometry (ie the topological boundary of the geometry).
límites Returns a geometry which represents the bounding box of an input geometry. Calculations are in the Spatial Reference System of this geometry
bounds_height Returns the height of the bounding box of a geometry. Calculations are in the Spatial Reference System of this geometry
bounds_width Returns the width of the bounding box of a geometry. Calculations are in the Spatial Reference System of this geometry
buffer Returns a geometry that represents all points whose distance from this geometry is less than or equal to distance. Calculations are in the Spatial Reference System of this geometry
centroid Devuelve el centro geométrico de una geometría
closest_point Returns the point on a geometry that is closest to a second geometry
combinar Devuelve la combinación de dos geometrías
contains(a,b) Returns 1 (true) if and only if no points of b lie in the exterior of a, and at least one point of the interior of b lies in the interior of a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
cruza Returns 1 (true) if the supplied geometries have some, but not all, interior points in common
difference(a,b) Returns a geometry that represents that part of geometry a that does not intersect with geometry b
inconexo Returns 1 (true) if the geometries do not share any space together
distance Returns the minimum distance (based on Spatial Reference System) between two geometries in projected units
distance_to_vertex Returns the distance along the geometry to a specified vertex
end_point Devuelve el último nodo de una geometría
exterior_ring Returns a line string representing the exterior ring of a polygon geometry, or null if the geometry is not a polygon
extrude(geom,x,y) Returns an extruded version of the input (Multi-) Curve or (Multi-)Linestring geometry with an extension specified by x and y
geom_from_gml Returns a geometry created from a GML representation of geometry
geom_from_wkt Returns a geometry created from a well-known text (WKT) representation
geom_to_wkt Returns the well-known text (WKT) representation of the geometry without SRID metadata

Continúa en la página siguiente
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Table 12.1 – proviene de la página anterior
Función Descripción
geometry Devuelve la geometría de un objeto
geometry_n Returns the nth geometry from a geometry collection, or null if the input geometry is not a collection
interior_ring_n Returns the geometry of the nth interior ring from a polygon geometry, or null if the geometry is not a polygon
intersección Returns a geometry that represents the shared portion of two geometries
intersecta Tests whether a geometry intersects another. Returns 1 (true) if the geometries spatially intersect (share any portion of space) and 0 if they don’t
intersects_bbox Tests whether a geometry’s bounding box overlaps another geometry’s bounding box. Returns 1 (true) if the geometries spatially intersect (share any portion of space) their bounding box, or 0 if they don’t
is_closed Returns true if a line string is closed (start and end points are coincident), false if a line string is not closed, or null if the geometry is not a line string
longitud Returns length of a line geometry feature (or length of a string)
line_interpolate_angle Returns the angle parallel to the geometry at a specified distance along a linestring geometry. Angles are in degrees clockwise from north.
line_interpolate_point Returns the point interpolated by a specified distance along a linestring geometry.
line_locate_point Returns the distance along a linestring corresponding to the closest position the linestring comes to a specified point geometry.
line_merge Returns a (Multi-)LineString geometry, where any connected LineStrings from the input geometry have been merged into a single linestring.
m Returns the m value of a point geometry
make_line Crea una geometría de línea a partir de una serie de geometrías de puntos
make_point(x,y,z,m) Returns a point geometry from x and y (and optional z or m) values
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Crea una geometría de polígono a partir de un anillo exterior y series opcionales de geometrías interiores de anillo
nodes_to_points Devuelve una geometría multipunto consistente en cada nodo de la geometría de entrada
num_geometries Devuelve el número de geometrías en una colección de geometrías o nulo si la geometría de entrada no es una colección
num_interior_rings Devuelve el número de anillos interiores de un polígono o una colección de geometrías o nulo si la geometría de entrada no es un polígono o una colección
num_points Devuelve el número de vértices de una geometría.
num_rings Devuelve el número de anillos (incluidos los anillos exteriores) de un polígono o una colección de geometrías o nulo si la geometría de entrada no es un polígono o una colección
order_parts Ordena las partes de una MultiGeometría por los criterios dados
solapa Comprueba si una geometría solapa con otra. Devuelve 1(verdadero) si las geometrías comparten espacio, son de la misma dimensión, pero no están contenidas en la otra.
perímetro Devuelve el perímetro de un objeto de geometría poligonal. Los cálculos están en el Sistema de Referencia Espacial de esta geometría.
point_n Returns a specific node from a geometry
point_on_surface Devuelve un punto garantizando que cae en la superficie de una geometría
proyecto Returns a point projected from a start point using a distance and bearing (azimuth) in radians
relate Prueba o devuelve la representación del Modelo de Intersección 9 Extendido Dimensional (DE-9IM) de la relación entre dos geometrías.
invertir Reverses the direction of a line string by reversing the order of its vertices
segments_to_lines Returns a multi line geometry consisting of a line for every segment in the input geometry
shortest_line Returns the shortest line joining two geometries. The resultant line will start at geometry 1 and end at geometry 2
start_point Devuelve el primer nodo de una geometría
sym_difference Devuelve una geometría que representa las partes de dos geometrías que no intersectan
toca Tests whether a geometry touches another. Returns 1 (true) if the geometries have at least one point in common, but their interiors do not intersect
Transformar Returns the geometry transformed from the source CRS to the destination CRS
Convertir Returns a translated version of a geometry. Calculations are in the Spatial Reference System of this geometry
unión Devuelve una geometría que representa el conjunto unión de los puntos de las geometrías.
entre(a,b) Tests whether a geometry is within another. Returns 1 (true) if geometry a is completely inside geometry b
x Devuelve la coordenada X de una geometría de tipo punto o la coordenada X del centroide de una geometría que no sea de puntos.
x_min Devuelve la coordenada X mínima de una geometría. Los cálculos están en el Sistema de Referencia Espacial de esta geometría
x_max Devuelve la coordenada X mínima de una geometría. Los cálculos están en el Sistema de Referencia Espacial de esta geometría
y Devuelve la coordenada Y de una geometría de tipo punto o la coordenada Y del centroide de una geometría que no sea de puntos.
y_min Devuelve la coordenada Y mínima de una geometría. Los cálculos están en el Sistema de Referencia Espacial de esta geometría
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Devuelve la coordenada Z de una geometría de punto

Algún ejemplo:

• You can manipulate the current geometry with the variable $geometry to create a buffer or get the point on
surface:

buffer( $geometry, 10 )
point_on_surface( $geometry )

• Devuelve la coordenada X del centroide del objeto actual:
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x( $geometry )

• Send back a value according to feature’s area:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Registro Funciones

Este grupo contiene funciones que operan sobre identificadores de registros.

Función Descripción
$cur-
rentfea-
ture

Devuelve el objeto espacial que está siendo evaluado. Se puede usar con la función ‘attribute’
para evaluar los valores de atributo del objeto actual.

$id Devuelve el ID del objeto de la fila actual
$map Devuelve la ID del elemento actual del mapa si se está dibujando el mapa en una composición o

“lienzo” si el mapa se está dibujando dentro de la ventana principal de QGIS
$rownum Devuelve el número de la fila actual
$scale Devuelve la escala actual de la vista del mapa
atributo Returns the value of a specified attribute from a feature
get_feature Returns the first feature of a layer matching a given attribute value
uuid Generates a Universally Unique Identifier (UUID) for each row. Each UUID is 38 characters long.

Algún ejemplo:

• Return the first feature in layer “LayerA” whose field “id” has the same value as the field “name” of the
current feature (a kind of jointure):

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Calculate the area of the joined feature from the previous example:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Funciones de cadena

This group contains functions that operate on strings (e.g., that replace, convert to upper case).
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Función Descripción
char Returns the character associated with a unicode code
concat Concatenates several strings to one
format Da formato a una cadena usando los argumentos proporcionados.
for-
mat_date

Formats a date type or string into a custom string format

for-
mat_number

Devuelve un número formateado con el separador local de miles (también trunca el número al
número de decimales indicado)

left(string,
n)

Returns a substring that contains the n leftmost characters of the string

longitud Returns length of a string (or length of a line geometry feature)
lower Convierte una cadena a letras minúsculas.
lpad Devuelve una cadena en la que se ha remplazado la cadena proporcionada usando un carácter

de relleno.
reg-
exp_replace

Returns a string with the supplied regular expression replaced

reg-
exp_substr

Devuelve la parte de una cadena que coincide con una expresión regular proporcionada

remplazar Devuelve una cadena en la que se ha remplazado la cadena proporcionada.
right(cadena,
n)

Devuelve una subcadena que contiene los n caracteres más a la derecha de la cadena.

rpad Devuelve una cadena en la que se ha remplazado la cadena proporcionada usando un carácter
de relleno.

strpos Returns the index of a regular expression in a string
substr Devuelve una parte de una cadena.
Título Convierte todas las palabras de una cadena a formato de título (todas las palabras en minúscula

con la primera letra en mayúscula)
trim Elimina todos los espacios en blanco (espacios, tabuladores, etc.) de comienzo y final de una

cadena.
upper Convierte una cadena a letras mayúsculas.
wordwrap Devuelve una cadena ajustada un número de caracteres máximo/mínimo

Funciones recientes

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Variables Functions

This group contains dynamic variables related to the application, the project file and other settings. It means that
some functions may not be available according to the context:

• from the Select by expression dialog

• from the Field calculator dialog

• from the layer properties dialog

• desde el diseñador de impresión

To use these functions in an expression, they should be preceded by @ character (e.g, @row_number). Are
concerned:

Función Descripción
atlas_feature Devuelve el objeto del atlas actual (como objeto espacial)
atlas_featureid Devuelve el ID de objeto del atlas actual.
atlas_featurenumber Devuelve el número de páginas de la composición

Continúa en la página siguiente
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Table 12.2 – proviene de la página anterior
Función Descripción
atlas_filename Devuelve el nombre de archivo del atlas actual.
atlas_geometry Devuelve la geometría de objeto del atlas actual
atlas_pagename Devuelve el nombre de la página del atlas actual
atlas_totalfeatures Devuelve el número total de objetos en el atlas.
grid_axis Devuelve el eje de la anotación de la cuadrícula actual (ej.: ‘x’ para longitud, ‘y’ para latitud).
grid_number Devuelve el valor de anotación de la cuadrícula actual.
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Devuelve el ID único del elemento del diseñador
layer_id Devuelve el ID de la capa actual
layer_name Devuelve el nombre de la capa actual
layout_dpi Devulve la resolución de la composición (DPI).
layout_numpages Devuelve el número de páginas de la composición.
layout_pageheight Devuelve la anchura de la composición en mm.
layout_pagewidth Devuelve la anchura de la composición en mm.
map_extent_center Returns the point feature at the center of the map
map_extent_height Devuelve la altura actual del mapa
map_extent_width Devuelve el ancho actual del mapa
map_id Devuelve el ID del destino actual del mapa. Será ‘lienzo’ para renderizadores de la vista del mapa y la ID del elemento para renderizadores del diseñador de mapas.
map_rotation Devuelve la rotación actual del mapa
map_scale Devuelve la escala actual del mapa
project_filename Devuelve el nombre del proyecto actual
project_folder Devuelve la carpeta del proyecto actual.
project_path Devuelve la ruta completa (incluido el nombre de archivo) del proyecto actual.
project_title Devuelve el Título del proyecto actual.
qgis_os_name Devuelve el nombre del sistema operativo, ej. ‘Windows’, ‘Linux’ o ‘OSX’.
qgis_platform Devuelve la plataforma de QGIS, ej. ‘Escritorio’ o ‘Servidor’.
qgis_release_name Devuelve el nombre de la versión actual de QGIS
qgis_version Devuelve la versión actual de QGIS como cadena
qgis_version_no Devuelve la versión actual de QGIS como número
symbol_angle Devuelve el ángulo del símbolo usado para representar el objeto (solo válido para símbolos de marcador).
symbol_color Returns the color of the symbol used to render the feature
user_account_name Devuelve el nombre de la cuenta del sistema operativo del usuario actual.
user_full_name Devuelve el nombre de usuario del sistema operativo del usuario actual.
row_number Guarda el número de la fila actual.
Valor Devuelve el valor actual

12.3.3 Editor de Funciones

With the Function Editor, you are able to define your own Python custom functions in a comfortable way.

The function editor will create new Python files in .qgis2\python\expressions folder and will auto load
all functions defined when starting QGIS. Be aware that new functions are only saved in the expressions
folder and not in the project file. If you have a project that uses one of your custom functions you will need to also
share the .py file in the expressions folder.

Here’s a short example on how to create your own functions:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

The short example creates a function myfunc that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number
of arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:
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Figure 12.57: The Function Editor tab

myfunc(’test1’, ’test2’)

Your function will be implemented in the Custom functions group of the Expression tab after using the Run Script
button.

Further information about creating Python code can be found in the PyQGIS-Developer-Cookbook.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions.

‘ ‘

12.4 Trabajar con la tabla de atributos

The attribute table displays information on features of a selected layer. Each row in the table represents a feature
(with geometry or not), and each column contains a particular piece of information about the feature. Features in
the table can be searched, selected, moved or even edited.

12.4.1 Tablas no espaciales

QGIS allows you to load spatial and non-spatial layers. This currently includes tables supported by OGR and
delimited text, as well as the PostgreSQL, MSSQL, SpatiaLite, DB2 and Oracle provider. When loaded in QGIS,
they are listed in the Layers Panel. Whether the layer you are working with is spatially enabled or not doesn’t
change features you can have access to, except map canvas interaction.

Non spatial tables can be used for field lookups or just generally browsed and edited using the table view. As
an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Propiedades de campos to find out more.
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12.4.2 Manipulate the Attribute table interface

Vista general del diálogo

To open the attribute table for a vector layer, make the layer active by clicking on it in the Panel de capas. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right-click on the layer and

choose Open Attribute Table from the drop-down menu, or to click on the Open Attribute Table button in
the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_table). According
to the setting in Settings → Options → Data sources menu, the attribute table will open in a docked window or
not. The total number of features in the layer and the number of currently selected/filtered features are shown in
the attribute table title as well as if the layer is spatially limited.

Figure 12.58: Tabla de atributos de la capa regiones

Los botones de la parte superior de la ventana de la tabla de atributos proporcionan la siguiente funcionalidad:
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Icono Etiqueta Propósito Atajo de teclado
predeterminado

Conmutar el modo de edición Habilitar funciones de edición Ctrl+E

Conmutar el modo multiedición Actualizar múltiples campos de
muchos objetos

Guardar ediciones Guardar las modificaciones actuales Ctrl+S

Recargar la tabla

Añadir objeto espacial Añadir nuevo objeto sin geometría

Borrar objetos seleccionados Eliminar los objetos seleccionados
de la capa

Seleccionar objetos usando una
expresión

Seleccionar todo Seleccionar todos los objetos de la
capa

Ctrl+A

Invertir selección Invertir la selección actual de la
capa

Ctrl+R

Deseleccionar todo Deseleccionar todos los objetos de
la capa actual

Ctrl+Shift+A

Filter/Select features using
form

Ctrl+F

Mover la selección arriba del
todo

Move selected rows to the top of the
table

Desplazar el mapa a las filas
seleccionadas

Ctrl+P

Zoom map to the selected rows Ctrl+J

Copy selected rows to clipboard Ctrl+C

Paste features from clipboard Insert new features from copied
ones

Ctrl+V

New field Add a new field to the data source Ctrl+W

Borrar campo Remove a field from the data source Ctrl+L

Open field calculator Update field for many features in a
row

Ctrl+I

Conditional formatting Enable table formatting

Table Attribute 1: Available Tools

Nota: Depending on the format of the data and the OGR library built with your QGIS version, some tools may
not be available.

Below these buttons is the Quick Field Calculation bar (enabled only in edit mode), which allows to quickly apply

calculations to all or part of the features in the layer. This bar uses the same expressions as the Field Calculator

(see Editar valores de atributo).

Truco: Omitir geometría WKT

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard but-

ton. You can copy the information without vector geometries if you deactivate the Copy geometry in WKT
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representation from attribute table option in Settings → Options → Data Sources menu.

Table view vs Form view

QGIS provides two view modes to easily manipulate data in the attribute table:

• the Table view, displaying values of multiple features in a tabular mode, each row representing a feature
and each column a field;

• and the Form view which shows identifiers of features in a first panel and displays only the attributes of
the clicked identifier in the second one. Form view uses the layer fields configuration (see Propiedades de
campos).

You can switch from one mode to the other by clicking the convenient icon at the bottom right of the dialog.

You can also specify the Default view mode at the opening of the attribute table in Settings → Options → Data
Sources menu. It can be ‘Remember last view’, ‘Table view’ or ‘Form view’.

Figure 12.59: Attribute table in form view (top) vs table view (bottom)
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Configure the columns

Right-click in a column header when in table view to have access to tools that help you configure what can be
displayed in the attribute table and how.

Hide, organize columns and enable actions

By right-clicking in a column header, you can choose to hide it from the attribute table. To change several columns
behavior at once, unhide a column or change the order of the columns, choose Organize columns .... In the new
dialog, you can:

• check/uncheck columns you want to show or hide

• drag-and-drop items to reorder the columns in the attribute table. Note that this change is for the table
rendering and does not alter the fields order in the layer datasource

• enable a new virtual Actions column that displays in each row a drop-down box or button list of actions for
each row, see Propiedades de acciones for more information about actions.

Resize columns width

Columns width can be set through a right-click on the column header and select either:

• Set width... to enter the desired value. By default, the current value is displayed in the widget

• Autosize to resize at the best fit the column.

It can also be changed by dragging the boundary on the right of the column heading. The new size of the column
is maintained for the layer, and restored at the next opening of the attribute table.

Sort columns

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort
order (downward pointing means descending values from the top row down, upward pointing means ascending
values from the top row down). You can also choose to sort the rows with the sort option of the column header
context menu and write an expression, e.g. to sort the row using multiple columns you can write concat(col0,
col1).

In form view, features identifier can be sorted using the Sort by preview expression option.

Formateo condicional de Celdas de Tablas

The conditional formatting settings can be used to highlight in the attribute table features you may want to put a
particular focus on, using custom conditions on feature’s:

• geometry (e.g., identifying multi-parts features, small area ones or in a defined map extent...);

• or field value (e.g., comparing values to a threshold, identifying empty cells...)

You can enable the conditional formatting panel clicking on at the top right of the attributes window in table
view (not available in form view).

The new panel allows user to add new rules to format rendering of Field or Full row. Adding new rule opens
a form to define:

• the name of the rule;

• a condition using any of the expression builder functions;

• the formatting: it can be choosen from a list of predefined formats or created based on properties like:
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– background and text colors;

– use of icon;

– bold, italic, underline, or strikeout;

– tipo de letra.

Figure 12.60: Formateo Condicional de una tabla de atributos

12.4.3 Interacting with features in an attribute table

Selecting features

In table view, each row in the attribute table displays the attributes of a unique feature in the layer. Selecting a row
selects the feature and likewise, selecting a feature in the map canvas (in case of geometry enabled layer) selects
the row in the attribute table. If the set of features selected in the map canvas (or attribute table) is changed, then
the selection is also updated in the attribute table (or map canvas) accordingly.

Los registros se pueden seleccionar haciendo clic en el número de registros del lado izquierdo del registro. Múlti-
ples registros se pueden marcar al mantener la tecla Ctrl. Una selección continua se puede hacer al mantener la
tecla Shift y haciendo clic en varios encabezados de registros del lado izquierdo del registro. Todos los registros
entre la posición actual del cursos y el registro donde se hace clic son seleccionados. Mover la posición del cursos
en la tabla de atributos, al hacer clic en una celda de la tabla, no cambia el registro seleccionado. Cambiar la
selección en el lienzo principal no mueve la posición del cursos en la tabla de atributos.

In form view of the attribute table, features are by default identified in the left panel by the value of their displayed
field (see Propiedades a mostrar). This identifier can be replaced using the drop-down list at the top of the panel,
either by selecting an existing field or using a custom expression. You can also choose to sort the list of features
from the drop-down menu.

Click a value in the left panel to display the feature’s attributes in the right one. To select a feature, you need to
click inside the square symbol at the left of the identifier. By default, the symbol turns into yellow. Like in the
table view, you can perform multiple feature selection using the keyboard combinations previously exposed.

Beyond selecting features with the mouse, you can perform automatic selection based on feature’s attribute using
tools available in the attribute table toolbar, such as (see section Selección automática and following one for more
information and use case):

• Select By Expression...
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• Select Features By Value...

• Deselect Features from All Layers

• Select All Features

• Invert Feature Selection.

It is also possible to select features using the Filter/Select features using form.

Filtering features

Once you have selected features in the attribute table, you may want to display only these records in the table.
This can be easily done using the Show Selected Features item from the drop-down list at the bottom left of the
attribute table dialog. This list offers the following filters:

• Show All Features

• Show Selected Features

• Show Features visible on map

• Show Edited and New Features

• Field Filter - allows the user to filter based on value of a field: choose a column from a list, type a value and
press Enter to filter. Then, only the matching features are shown in the attribute table.

• Advanced filter (Expression) - Opens the expression builder dialog. Within it, you can create complex
expressions to match table rows. For example, you can filter the table using more that one field. See
Expresiones for more information.

It is also possible to filter features using the Filter/Select features using form.

Nota: Filtering records out of the attribute table does not filter features out of the layer; they are simply momen-
taneously hidden from the table and can be accessed from the map canvas or by removing the filter. For filters that
do hide features from the layer, use the Query Builder.

Truco: Update datasource filtering with Show Features Visible on Map

When for performance reasons, features shown in attribute table are spatially limited to the canvas extent at its
opening (see Data Source Options for a how-to), selecting Show Features Visible on Map on a new canvas extent
updates the spatial restriction.

Filter/Select features using form

Clicking the Filter/Select features using form or pressing Ctrl+F the attribute table dialog will switch to form view
and all widgets are replaced with their search variant.

From this point onwards, this tool functionality is similar to the one described in the Select Features By Value,
where you can find descriptions of all operators and selecting modes.

Moreover, in the attribute table case, there is also a Filter features button that allows filtering features instead of
selecting them (by creating an Advanced Filter (Expression) for the user).

If there are already filtered features, you can refine the filter using the drop-down list next to the Filter features
button. The options are:

• Filter within (“AND”)

• Extend filter (“OR”)
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Figure 12.61: Attribute table filtered by the filter form

To clear the filter, either select Show all features option mentioned in Filtering features, or click the clear the
expression and click [Apply].

12.4.4 Action on features

Users have several possibilities to manipulate feature with the contextual menu like:

• Select all (Ctrl+A) the features

• Copy the content of a cell in the clipboard with Copy cell content.

• Zoom to feature without having to select it beforehand

• Open form. It toggles attribute table into form view with a focus on the clicked feature

Figure 12.62: Copy cell content button

If you want to use attribute data in external programs (such as Excel, LibreOffice, QGIS or a custom web applica-

tion), select one or more row(s) and use the Copy selected rows to clipboard button or press Ctrl+C. In Settings →
Options → Data Sources menu you can define the format to paste to with Copy features as dropdown list:

• Plain text, no geometry,

• Plain text, WKT geometry,

• GeoJSON
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You can also display a list of actions in this contextual menu. This is enabled in the Layer properties → Actions
tab. See Propiedades de acciones for more information on actions.

Guardar objetos espaciales seleccionados como nueva capa

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). In the contextual menu of the layer, from the Layers Panel, click on Save as to
define the name of the output file, its format and CRS (see section Creating new layers from an existing layer).

To save the selection ensure that the Save only selected features is selected. It is also possible to specify OGR
creation options within the dialog.

12.4.5 Editar valores de atributo

Editing attribute values can be done by:

• typing the new value directly in the cell, whether the attribute table is in table or form view. Changes are
hence done cell by cell, feature by feature;

• using the field calculator: update in a row a field that may already exist or to be created but for multiple
features; it can be used to create virtual fields.

• using the quick field calculation bar: same as above but for only existing field

• or using the multi edit mode: update in a row multiple fields for multiple features.

Calculadora de Campos

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

The field calculator is available on any layer that supports edit. When you click on the field calculator icon the
dialog opens (see figure_field_calculator). If the layer is not in edit mode, a warning is displayed and using the
field calculator will cause the layer to be put in edit mode before the calculation is made.

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.

If you choose to add a new field, you need to enter a field name, a field type (integer, real, date or string) and if
needed, the total field length and the field precision. For example, if you choose a field length of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Load the shapefile railroads.shp in QGIS and press Open Attribute Table.

2. Click on Toggle editing mode and open the Field Calculator dialog.

3. Select the Create a new field checkbox to save the calculations into a new field.

4. Add length as Output field name and real as Output field type, and define Output field length to be 10
and Precision, 3.

5. Now double click on function $length in the Geometry group to add it into the Field calculator expression
box.

6. Complete the expression by typing / 1000 in the Field calculator expression box and click [Ok].
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Figure 12.63: Calculadora de Campos

7. Ahora puede encontrar un nuevo campo longitud en la tabla de atributos.

Crear campo virtual

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Nota: Uso de Campos Virtuales
• Virtual fields are not permanent in the layer attributes, meaning that they’re only saved and available in the

project file they’ve been created.

• Un campo puede definirse como virtual sólo al momento de su creación y la expresión usado no puede
cambiarse luego: necesitará borrar y recrear el campo.

The Quick Field Calculation Bar

While Field calculator is always available, the quick field calculation bar on top of the attribute table is only visible
if the layer is in edit mode. Thanks to the expression engine, it offers a quicker access to edit an already existing
field.

In quick field calculation bar, you simply need to:

• select the existing field name in the drop-down list

• fill the textbox with an expression you directly write or build using the expression button

• and click on [Update All], [Update Selected] or [Update Filtered] button according to your need.

196 Chapter 12. Trabajar con catos vectoriales



QGIS User Guide, Publicación 2.18

Edit multiple fields

Unlike the previous tools, multi edit mode allows multiple attributes of different features to be edited simultane-
ously. When the layer is toggled to edit, multi edit capabilities are accessible:

• using the Toggle multi edit mode button from the toolbar inside the attribute table dialog,

• or selecting Edit → Modify attributes of selected features menu.

In order to edit multiple fields in a row:

1. select the features you want to edit;

2. from the attribute table toolbar, click the button. This will toggle the dialog to its form view. Feature
selection could also be made at this step;

3. at the right side of the attribute table, fields (and values) of selected features are shown. New widgets appear
next to each field allowing for display of the current multi edit state:

• the field contains different values for selected features. It’s shown empty and each feature will
keep its original value. You can reset the value of the field from the drop-down list of the widget.

• all selected features have the same value for this field and the value displayed in the form will be
kept.

• the field has been edited and the entered value will be applied to all the selected features. A
message appears at the top of the dialog, inviting you to either apply or reset your modification.

Clicking any of these widgets allows you to either set the current value for the field or reset to original value,
meaning that you can roll back changes on a field-by-field basis.

4. make the changes to the fields you want and click on Apply changes in the upper message text or any other
feature in the left panel.

Changes will apply to all selected features. If no feature is selected, the whole table is updated with your changes.

Modifications are made as a single edit command. So pressing Undo will rollback the attribute changes for all
selected features at once.

Nota: Unlike the tool from the attribute table, hitting the Edit → Modify Attributes of Selected Features option
provides you with a modal dialog to fill attributes changes. Hence, features selection is required before execution.

Nota: Multi edit mode is only available for auto generated and drag and drop forms (see Personalizar un formu-
lario para sus datos); it is not supported by custom ui forms.

12.4.6 Creating one or many to many relations

Relations are a technique often used in databases. The concept is that features (rows) of different layers (tables)
can belong to each other.

Relación 1 a N

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the regions layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.
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Figure 12.64: Editing fields of multiple features

Figure 12.65: Región de Alaska con aeropuertos

198 Chapter 12. Trabajar con catos vectoriales



QGIS User Guide, Publicación 2.18

Capas

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So you can add your table as a vector layer. To demonstrate the 1-n relation, you can load the regions shapefile
and the airports shapefile which has a foreign key field (fk_region) to the layer regions. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Claves foráneas

In addition to the already existing attributes in the airports attribute table, you’ll need another field fk_region
which acts as a foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for editing and QGIS takes care of the setup. It works with different
providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the relations
between your tables.

Definición (Administrador de relaciones)

The first thing we are going to do is to let QGIS know about the relations between the layers. This is done in
Project → Project Properties.... Open the Relations tab and click on [Add Relation].

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say Airports in this case.

• referencing layer also considered as child layer, is the one with the foreign key field on it. In our case, this
is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer also considered as parent layer, is the one with the primary key, pointed to, so here it is
the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms. If you
leave it empty, one will be generated for you but you can assign one yourself to get one that is easier to
handle.

Formularios

Ahora que QGIS conoce la relación, se utilizará para mejorar el formulario generado. Como no hemos cambiado
el método de formulario predeterminado (autogenerado) simplemente se añadirá un nuevo control a nuestro for-
mulario. Así que vamos a seleccionar la capa Regiones en la leyenda y a utilizar la herramienta de identificación.
Dependiendo de la configuración, el formulario se puede abrir directamente o se tendrá que abrir desde el diálogo
de identificación, dentro de las acciones.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.
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Figure 12.66: Administrador de relaciones

Figure 12.67: Identification dialog regions with relation to airports
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• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• Los dos botones situados a la derecha alternan entre la vista de tabla y la vista de formulario, en la que se
pueden ver todos los aeropuertos en su propio formulario.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.68: Identification dialog airport with relation to regions

Relación N a M

N-M relation is a many-to-many relation between two tables. For instance, the airports and airlines
layers: an airport receives several airline companies and an airline company flies to several airports.

In such case, we need a pivot table to list all airlines for all airports. In QGIS, you should setup two one-to-many
relations as explained above:

• a relation between airlines table and the pivot table;

• and a second one between airports table and the pivot table.

When we add a new child (i.e. a company to an airport), QGIS will add a new row in the pivot table and in the
airlines table. If we link a company to an airport, QGIS will only add a row in the pivot table.

In case you want to remove a link, an airline or an airport, QGIS won’t remove the row in the pivot table. The
database administrator should add a ON DELETE CASCADE instruction in the foreign key constraint:

ALTER TABLE location.airlines
ADD CONSTRAINT location_airlines_airports_id_fkey

FOREIGN KEY (id)
REFERENCES location.airports(id)

ON DELETE CASCADE;

Nota: Combine N-M relation with automatic transaction group
You should enable the transaction mode in Project Properties → Data Sources → when working on such context.
QGIS should be able to add or update row(s) in all tables (airlines, airports and the pivot tables).
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Finally, adding such relations in a form is done in the same way that for a one-to-many relation. The Relations
panel in the Fields properties of the vector layer will let the user add the relation in the form. It will appear as a
Many to many relation.

12.5 Editar

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Nota: El procedimiento para edición de capas GRASS es diferente - vea la sección Digitalizar y editar una capa
vectorial GRASS para más detalles.

Truco: Las ediciones simultáneas
This version of QGIS does not track if somebody else is editing the same feature at the same time as you are. The
last person to save its edits wins.

12.5.1 Configurar la tolerancia del autoensamblado y radio de búsqueda

For an optimal and accurate edit of the vector layer geometries, we need to set an appropriate value of snapping
tolerance and search radius for features vertices.

Tolerancia de autoensamblado

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_snapping ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.

• Advanced: if you need to edit a layer and snap its vertices to another layer, ensure the target layer
is checked and increase the snapping tolerance to a greater value. Furthermore, snapping will never
occur to a layer that is not checked in the snapping options dialog, regardless of the global snapping
tolerance. So be sure to mark the checkbox for those layers that you need to snap to.

Truco: Control the list of layers to snap
The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.
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Figure 12.69: Editar opciones de autoensamblado en base a una capa (modo Avanzado)

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.

Radio de búsqueda

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. Snap
tolerance and search radius are set in map units or pixels, so you may find you need to experiment to get them set
right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are dealing with
a large number of vertices in close proximity. Set search radius too small, and it won’t find anything to move.

El radio de búsqueda para edición de vértices en las unidades de capa se pueden definir en la pestaña Digitalizar
bajo Configuración→ Opciones. Este es el mismo lugar donde se define lo general, proyecto de tolenancia de
autoensamblado.

12.5.2 Edición topológica

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Habilitar edición topológica

The option Enable topological editing is for editing and maintaining common boundaries in features mosaics.
QGIS ‘detects’ shared boundary by the features, so you only have to move a common vertex/segment once, and
QGIS will take care of updating the neighboring features.

Evitar intersecciones de nuevos polígonos

A second topological option called Avoid intersections prevents you to draw new features that overlap an
existing one. It is for quicker digitizing of adjacent polygons. If you already have one polygon, it is possible
with this option to digitize the second one such that both intersect, and QGIS then cuts the second polygon to
the boundary of the existing one. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Nota: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.
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Advertencia: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.

Habilitar autoensamblado en intersecciones

Otra opción es utilizar Habilitar autoensamblado en intersección. Le permitirá que se ajuste a una intersección
de las capas de fondo, incluso si no hay ningún vértice en la intersección.

Comprobador de Geometría

A core plugin can help the user to find the geometry invalidity. You can find more information on this plugin at
Complemento Comprobador de geometría.

12.5.3 Digitalizando una capa existente

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a slip
of the mouse. However, you can choose to edit any layer as long as the data provider supports it (see Exploring
Data Formats and Fields), and the underlying data source is writable (i.e., its files are not read-only).

Truco: Restrict edit permission on layers within a project
From the Project → Project properties → Identify tab, You can choose to set any layer read-only regardless
the provider permission. This can be a handy way, in a multi-users environment to avoid unauthorized users to
mistakenly edit layers (e.g., shapefile), hence potentially corrupt data. Note that this setting only applies inside
the current project.

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitalización avanzada. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Icono Propósito Icono Propósito

Ediciones actuales Conmutar edición

Adicionar Característica: Capturar Punto Añadir objeto espacial: Capturar línea

Add Feature: Capture Polygon Mover objeto espacial

Agregar Cadena Circular Add Circular String By Radius

Herramienta de nodos Borrar lo seleccionado

Cortar objetos espaciales Copiar objetos espaciales

Pegar objetos espaciales Guardar cambios de la capa

Edición de tabla: Barra de herramientas de edición básica de capa vectorial

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.

Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.
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Truco: Guardar regularmente

Remember to Save Layer Edits regularly. This will also check that your data source can accept all the changes.

Añadir objetos espaciales

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Nota: Curved geometries are stored as such only in compatible data provider
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Truco: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_values
shows setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• Suppress attributes pop-up windows after each created feature to avoid the form opening

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

Figure 12.70: Enter Attribute Values Dialog after digitizing a new vector feature

With the Move Feature(s) icon on the toolbar, you can move existing features.
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Herramienta de nodos

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.

Truco: Marcadores vértices
La actual versión de QGIS reconoce tres tipos de marcadores de vértices: ‘Círculo semitransparente’, ‘Cruz’ y
‘Nada’. Para cambiar el estilo del marcador, seleccione Opciones del menú Configuración, haga clic en la
pestaña Digitalización y seleccione la entrada apropiada.

Operaciones básicas

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selección de vértices: Se pueden seleccionar los vértices al hacer clic sobre ellos uno a la vez, al hacer clic
en un borde para seleccionar los vértices en ambos extremos, o haciendo clic y arrastrando un rectángulo
alrededor de algunos vértices. Cuando se selecciona un vértice, su color cambia a azul. Para añadir más
vértices a la selección actual, mantenga pulsado la tecla Ctrl mientras se hace clic. Mantenga pulsada
la tecla Ctrl cuando haga clic para cambiar el estado de selección de vértices (los vértices que no están
actualmente seleccionados serán seleccionados como de costumbre y los vértices que ya están seleccionados
se convertirán en no seleccionado).

• Añadir vértices: Para añadir un vértice, sólo haga doble clic cerca de un borde y un nuevo vértice aparecerá
en el borde cerca del cursor. Tome en cuenta que el vértice aparecerá en el borde, no el la posición del cursor;
por lo tanto se debe mover si es necesario.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Truco: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.

El Editor de Vértice

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
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select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Figure 12.71: Vertex editor panel showing selected nodes

Cortar, copiar, y pegar objetos espaciales

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Truco: Transform polygon into line and vice-versa using copy/paste
Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT and GeoJSON features
from outside QGIS can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

Como un ejemplo, copiaremos algunos lagos a una nueva capa:

1. Cargar la capa desde donde desee copiar (capa fuente)

2. Cargar o crear la capa a la que desee copiar (capa destino)

3. Comenzar a editar la capa destino

4. Hacer la capa de fuente activa haciendo clic sobre ella en la leyenda

5. Use the Select Features by area or single click tool to select the feature(s) on the source layer

6. Click on the Copy Features tool

7. Hacer la capa de destino activa haciendo clic en la leyenda.

8. Click on the Paste Features tool

9. Detener edición y guardar los cambios

12.5. Editar 207



QGIS User Guide, Publicación 2.18

¿Qué pasa si la capa de origen y destino tienen diferentes esquemas (los nombres de campo y tipo no son los
mismos)? QGIS poblará los que coinciden e ignorará el resto. Si no son importantes los atributos que se copian a
la capa de destino, no importa la forma de diseñar los campos y tipos de datos. Si desea asegurarse de que todo -
el objeto espacial y sus atributos - se copia, asegúrese de que los esquemas coincidan.

Nota: Congruencia del pegado de objetos espaciales
Si su capa de origen y destino utilizan la misma proyección, entonces el pegado de objetos espaciales tendrá la
geometría idéntica a la capa origen. Sin embargo, si el destino tiene una proyección diferente, entonces QGIS no
puede garantizar que la geometría sea idéntica. Esto es simplemente porque hay pequeños errores de redondeo
involucrados en la conversión entre las proyecciones.

Truco: Copiar atributos de texto en otro
If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accommodate for the length of the data to be inserted.

Borrar objetos espaciales seleccionados

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

La herramienta Cortar objetos espaciales en la barra de herramientas de digitalización también se puede utilizar para
borrar objetos espaciales. Este efectivamente borra el objeto espacial pero también lo coloca en un “portapapeles

espacial”. Por lo tanto, cortamos el objeto espacial para borrar. Entonces podríamos utilizar la herramienta
Pegar objetos espaciales para colocarlo de nuevo, nos da una capacidad de deshacer de un nivel. Cortar, copiar y pegar
funcionan sobre los objetos espaciales seleccionados, lo que significa que podemos operar más de una a la vez.

Guardar capas editadas

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

Si los cambios no se pueden guardar (por ejemplo, disco lleno, o los atributos tienen valores que están fuera de
rango), el estado de memoria de QGIS es preservado. Esto le permite ajustar sus ediciones e intentar de nuevo.

Truco: Integridad de datos
Siempre es buena idea respaldar sus datos fuente antes de iniciar la edición. Mientras los autores de QGIS han
hecho todo el esfuerzo para preservar la integridad de sus datos, nosotros no ofrecemos garantía en este sentido.

Saving multiple layers at once

Este objeto espacial permite la digitalización de múltiples capas. Elegir Guardar las capas seleccionadas para

guardar todos los cambios que se hicieron en múltiples capas. Se tiene la oportunidad para Revertir las capas
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seleccionadas, así que la digitalización puede ser retirada de todas las capas seleccionadas. Si se desea detener la

edición de las capas seleccionadas, Cancelar para la capa(s) seleccionada(s) es una forma fácil.

Las mismas funciones están disponibles para editar todas las capas del proyecto.

Truco: Use transaction group to edit, save or rollback multiple layers changes at once
When working with layers from the same PostGreSQL database, activate the Automatically create transaction
groups where possible option in Project → Project Properties → Data Sources to sync their behavior (enter or
exit the edit mode, save or rollback changes at the same time).

12.5.4 Digitalización avanzada

Icono Propósito Icono Propósito

Habilitar herramientas de digitalización avanzada Habilitar Trazado

Deshacer Rehacer

Rotar objeto(s) espacial(es) Simplificar objeto espacial

Añadir anillo Añadir parte

Rellenar anillo

Borrar anillo Borrar parte

Desplazar curva Remodelar objetos espaciales

Dividir partes Dividir objetos espaciales

Combinar atributos de objetos espaciales seleccionados Combinar objetos espaciales seleccionados

Rotar símbolos de puntos Offset Point Symbols

Edición avanzada de tabla: la barra de herramientas de edición avanzada de capa vectorial

Deshacer y rehacer

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_undo). This widget is not displayed
by default; it can be displayed by right-clicking on the toolbar and activating the Undo/Redo Panel checkbox. The
Undo/Redo capability is however active, even if the widget is not displayed.

Figure 12.72: Rehacer y deshacer pasos digitalizados

When Undo is hit or Ctrl+Z (or Cmd+Z) pressed, the state of all features and attributes are reverted to the
state before the reverted operation happened. Changes other than normal vector editing operations (for example,
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changes done by a plugin) may or may not be reverted, depending on how the changes were performed.

Utilizar el widget de historial de deshacer/rehacer, sólo haga clic para seleccionar la operación en la lista del
histórico. Todos los objetos espaciales se revertirán al estado que tenían después de la operación de seleccionada.

Rotar objeto(s) espacial(es)

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

Si se habilita la herramienta del mapa con objeto(s) seleccionados, su (ellos) centroide aparecerá y será el punto
de delimitación de rotación. Si se desea mover el punto de delimitación, mantenga el botón Ctrl y haga clic en
el mapa para colocarlo.

Si se mantiene Shift antes de hacer clic en el mapa, la rotación se hará en pasos de 45 grados, que pueden ser
modificados después en el widget de entrada del usuario.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Simplificar objeto espacial

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Nota: Unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool permanently modifies feature’s geometry in data source.

Añadir parte

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the

attribute table and digitize the new geometry with the Add Part tool.

Borrar parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.
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Añadir anillo

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Rellenar anillo

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Borrar anillo

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Remodelar objetos espaciales

You can reshape line and polygon features using the Reshape Features tool on the toolbar. For lines, it replaces the
line part from the first to the last intersection with the original line.

Figure 12.73: Reshape line

Truco: Extend linestring geometries with reshape tool

Use the Reshape Features tool to extend existing linestring geometries: snap to the first or last vertex of the line
and draw a new one. Validate and the feature’s geometry becomes the combination of the two lines.

For polygons, it will reshape the polygon’s boundary. For it to work, the reshape tool’s line must cross the
polygon’s boundary at least twice. To draw the line, click on the map canvas to add vertexes. To finish it, just
right-click. Like with the lines, only the segment between the first and the last intersections is considered. The
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reshape line’s segments that are inside the polygon will result in cropping it, where the ones outside the polygon
will extend it.

Figure 12.74: Remodelar polígono

With polygons, reshaping can sometimes lead to unintended results. It is mainly useful to replace smaller parts
of a polygon, not for major overhauls, and the reshape line is not allowed to cross several polygon rings, as this
would generate an invalid polygon.

Nota: La herramienta de remodelar podría alterar la posición inicial de un anillo de polígono o una linea cerrada.
Por lo tanto, el punto que está representado ‘dos veces’ no será más el mismo. Esto puede no ser un problema
para la mayoría de las aplicaciones, pero es algo a considerar.

Desplazar curva

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input

widget. Your changes may then be saved with the Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.

Dividir objetos espaciales

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Dividir partes

En QGIS ahora es posible dividir las partes de un objeto espacial múlti-parte, de modo que se incrementa el

número de partes. Sólo se tiene que dibujar una línea en la parte que se desea dividir utilizando el icono
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Dividir partes

Truco: Split a polyline feature in one-click

A single click on a snapped vertex of a line feature with the Split Features or Split Parts tool is enough to have
it split into new features or parts.

Combinar objetos espaciales seleccionados

The Merge Selected Features tool allows you to create a new feature by merging existing ones: their ge-
ometries are merged to generate a new one. If features don’t have common boundaries, a multipoly-
gon/multipolyline/multipoint feature is created.

First, select several features. Then press the Merge Selected Features button. In the new dialog, you can select at the
top of the dialog which value to apply to each field of the new feature. That value can be:

• picked from the attributes of the initial features,

• an aggregation of the initial features attributes (Minimum, Maximum, Median, Sum, Count Concatenation...
depending on the type of the field. see Panel de resumen estadístico for the full list of functions),

• skipped, meaning that the field will be empty,

• or manually entered, at the bottom of the rows.

Combinar atributos de objetos espaciales

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their
boundaries. The dialog is the same as the Merge Selected Features tool’s except that unlike that tool,
selected objects are kept with their geometry while some of their attributes are made identical.

Rotar símbolos de puntos

The Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. First of all, you

must apply to the symbol a data-defined rotation: in the Layer Properties → Style dialog, click the Data-
defined override widget near the Rotation option of the highest level (preferably) of the symbol layers and choose
a field in the Field Type combobox. Values of this field are hence used to rotate each feature’s symbol accordingly.

Nota: As a global option, setting the rotation field at the first level of the symbol applies it to all the underlying
levels while setting it at a lower level will rotate only this symbol layer (unless you have a single symbol layer).

Figure 12.75: Rotar símbolos de puntos
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To change the rotation of a symbol, click on a point feature in the map canvas with the Rotate Point Symbols and
move the mouse around, holding the left button pressed. A red arrow with the rotation value will be visualized (see
Figure_rotate_point). When you release the left mouse button again, the symbol is defined with this new rotation
and the rotation field is updated in the layer’s attribute table.

Truco: Si se mantiene presionada la tecla Ctrl, la rotación se realiza en pasos de 15 grados.

Offset Point Symbols

The Offset Point Symbols allows you to interactively change the rendered position of point symbols in the map

canvas. This tool behaves like the Rotate Point Symbols tool except that it requires you to connect a field to the
data-defined Offset (X,Y) property of the symbol, field which will then be populated with the offset coordinates
while moving the symbol in the map canvas.

Nota: The Offset Point Symbols tool doesn’t move the point feature itself; you should use the Node Tool or
Move Feature tool for this purpose.

Advertencia: Ensure to assign the same field to all symbol layers
If at least two layers of the symbol have different fields assigned to their data-defined property (e.g. rotation),
the corresponding tool will consider that no field is assigned to the symbol property and won’t perform the
action.

Rastreo Automático

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Nota: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.

Truco: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.5.5 El panel de Digitalización Avanzada

When capturing, reshaping, splitting new or existing geometries you also have the possibility to use the Advanced
Digitizing panel. You can digitize lines exactly parallel or perpendicular to a particular angle or lock lines to
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specific angles. Furthermore, you can enter coordinates directly so that you can make a precise definition of your
new geometry.

Figure 12.76: El panel de Digitalización Avanzada

Nota: Las herramientas no están habilitadas si la vista del mapa esta en coordenadas geográficas.

The Advanced Digitizing panel can be open either with a right-click on the toolbar and choose Advanced Dig-

itizing panel or in View → Panels → Advanced Digitizing Panel. Once the panel is visible, click the
enable advanced digitizing tool button to activate the Advanced Digitizing tool.

Conceptos

The aim of the Advanced Digitizing tool is to lock coordinates, lengths, and angles when moving the mouse during
the digitalizing in the map canvas.

You can also create constraints with relative or absolute reference. Relative reference means that the next vertex
constraints’ values will be relative to the previous vertex or segment.

Opciones de autoensamblado

Click the button to set the Advanced Digitizing Tool snapping settings. You can make the tool snap to common
angles. The options are:

• Do not snap to common angles

• Ajustar a ángulos 30º

• Ajustar a ángulos 45º

• Snap to 90º angles

You can also control the snapping to features. The options are:

• Do not snap to vertices or segments

• Snap according to project configuration

• Snap to all layers
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Atajos de teclado

To speed up the use of Advanced Digitizing Panel, there are a couple of keyboard shorcuts available:

Key Simple Ctrl + o Alt + Shift +
d Establecer distancia Bloquear distancia
a Establecer ángulo Bloquear ángulo Toggle relative angle to last segment
x Establecer coordenada X Lock x coordinate Toggle relative x to last vertex
y Establecer coordenada Y Bloquear la coordenada Y Toggle relative y to last vertex
c Toggle construction mode
p Toggle perpendicular and parallel modes

Absolute reference digitizing

When drawing a new geometry from scratch, it is very useful to have the possibility to start digitizing vertexes at
given coordinates.

For example, to add a new feature to a polygonal layer, click the button. You can choose the X and Y
coordinates where you want to start editing the feature, then:

• Click the x text box (or use the x keyboard shortcuts).

• Type the X coordinate value you want and press Enter or click the button to their right to lock the
mouse to the X axis on the map canvas.

• Click the y text box (or use the y keyboard shortcuts).

• Type the Y coordinate value you want and press Enter or click the button to their right to lock the
mouse to the Y axis on the map canvas.

Two blue dotted lines and a green cross identify the exact coordinates you entered. Start digitizing by clicking on
the map canvas; the mouse position is locked at the green cross.

Figure 12.77: Start drawing at given coordinates

You can continue digitizing by free hand, adding a new pair of coordinates, or you can type the segment’s length
(distance) and angle.

If you want to draw a segment of a given length, click the d (distance) text box (keyboard shortcut d), type the

distance value (in map units) and press Enter or click the button on the right to lock the mouse in the map
canvas to the length of the segment. In the map canvas, the clicked point is surrounded by a circle whose radius is
the value entered in the distance text box.
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Figure 12.78: Fixed length segment

Finally, you can also choose the angle of the segment. As described before , click the a (angle) text box (keyboard

shortcut a), type the angle value (in degrees), and press Enter or click the buttons on the right to lock it. In
this way the segment will follow the desired angle:

Figure 12.79: Fixed angle segment

Relative reference digitizing

Instead of using absolute values of angles or coordinates, you can also use values relative to the last digitized
vertex or segment.

For angles, you can click the button on the left of the a text box (or press Shift + a) to toggle relative
angles to the previous segment. With that option on, angles are measured between the last segment and the mouse
pointer.

For coordinates, click the buttons to the left of the x or y text boxes (or press Shift + x or Shift + y) to
toggle relative coordinates to the previous vertex. With these options on, coordinates measurement will consider
the last vertex to be the x and y axes origin.
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Continuous lock

Both in absolute or relative reference digitizing, angle, distance, x and y constraints can be locked continuously by

clicking the Continuous lock buttons. Using continuous lock allows you to digitize several points or vertexes
using the same constraints.

Parallel and perpendiculars line

All the tools described above can be combined with the Perpendicular and Parallel tools. These two tools allow
drawing segments perfectly perpendicular or parallel to another segment.

To draw a perpendicular segment, during the editing click the Perpendicular icon (keyboard shortcut p) to ac-
tivate it. Before drawing the perpendicular line, click on the segment of an existing feature that you want to be
perpendicular to (the line of the existing feature will be colored in light orange); you should see a blue dotted line
where your feature will be snapped:

Figure 12.80: Perpendicular digitizing

To draw a parallel feature, the steps are the same: click on the Parallel icon (keyboard shortcut p twice), click
on the segment you want to use as reference and start drawing your feature:

These two tools just find the right angle of the perpendicular and parallel angle and lock this parameter during
your editing.

Modo de construcción

You can enable and disable construction mode by clicking on the Construction icon or with the c keyboard
shortcut. While in construction mode, clicking the map canvas won’t add new vertexes, but will capture the
clicks’ positions so that you can use them as reference points to then lock distance, angle or x and y relative
values.

As an example, the construction mode can be used to draw some point at an exact distance from an existing point.

With an existing point in the map canvas and the snapping mode correctly activated, you can easily draw other

points at given distances and angles from it. In addition to the button, you have to activate also the construction

mode by clicking the Construction icon or with the c keyboard shortcut.
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Figure 12.81: Parallel digitizing

Click next to the point from which you want to calculate the distance and click on the d box (d shortcut) type the
desired distance and press Enter to lock the mouse position in the map canvas:

Figure 12.82: Distance from point

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance entered.

You can also use the angle constraint to, for example, create another point at the same distance of the original one,

but at a particular angle from the newly added point. Click the Construction icon or with the c keyboard shortcut
to enter construction mode. Click the recently added point, and then the other one to set a direction segment. Then,
click on the d text box (d shortcut) type the desired distance and press Enter. Click the a text box (a shortcut)
type the angle you want and press Enter. The mouse position will be locked both in distance and angle.

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance and angle entered. Repeating the process, several points can be added.
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Figure 12.83: Distance and angle from points

Figure 12.84: Points at given distance and angle
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CHAPTER 13

Trabajar con catos raster

13.1 Dialogo de Propiedades Raster

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog
(see figure_raster_properties).

There are several tabs in the dialog:

• General

• Estilo

• Transparencia

• Pyramids

• Histograma

• Metadatos

• Legend

Figure 13.1: Dialogo de Propiedades Capas Ráster

Truco: Live update rendering
The Layer Styling Panel provides you with some of the common features of the Layer properties dialog and is a
good modeless widget that you can use to speed up the configuration of the layer styles and automatically view
your changes in the map canvas.
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Nota: Because properties (symbology, label, actions, default values, forms...) of embedded layers (see Anidar
proyectos) are pulled from the original project file and to avoid changes that may break this behavior, the layer
properties dialog is made unavailable for these layers.

13.1.1 Propiedades Generales

Información de la capa

The General tab displays basic information about the selected raster, including the layer source path, the display
name in the legend (which can be modified), and the number of columns, rows and no-data values of the raster.

Coordinate Reference System

Displays the layer’s Coordinate Reference System (CRS) as a PROJ.4 string. You can change the layer’s CRS,

selecting a recently used one in the drop-down list or clicking on Select CRS button (see Coordinate Reference
System Selector). Use this process only if the CRS applied to the layer is a wrong one or if none was applied.
If you wish to reproject your data into another CRS, rather use layer reprojection algorithms from Processing or
Save it into another layer.

13.1.2 Scale dependent visibility

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which the layer

will be visible. Out of this range, it’s hidden. The Set to current canvas scale button helps you use the current map
canvas scale as boundary of the range visibility. See Renderizado dependiente de la escala for more information.

13.1.3 Style Properties

Band rendering

QGIS offers four different Render types. The renderer chosen is dependent on the data type.

1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands)

2. Paletted - if a single band file comes with an indexed palette (e.g., used with a digital topographic map)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continuous palette (e.g., used with a shaded relief
map)

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map)

Color de multibanda

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. You can choose several Contrast
enhancement methods: ‘No enhancement’, ‘Stretch to MinMax’, ‘Stretch and clip to MinMax’ and ‘Clip to min
max’.

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
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Figure 13.2: Raster Style - Multiband color rendering

range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Truco: Viewing a Single Band of a Multiband Raster
If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to “Not Set”. But this is not the correct way. To display the Red band, set the image type to
‘Singleband gray’, then select Red as the band to use for Gray.

Paleta

This is the standard render option for singleband files that already include a color table, where each pixel value
is assigned to a certain color. In that case, the palette is rendered automatically. If you want to change colors
assigned to certain values, just double-click on the color and the Select color dialog appears. Also, in QGIS it’s
possible to assign a label to the color values. The label appears in the legend of the raster layer then.

Contrast enhancement

Nota: When adding GRASS rasters, the option Contrast enhancement will always be set automatically to stretch
to min max, regardless of if this is set to another value in the QGIS general options.

Unibanda gris
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Figure 13.3: Raster Style - Paletted Rendering

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Style - Singleband gray rendering

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Unibanda pseudocolor

This is a render option for single-band files, including a continuous palette. You can also create individual color
maps for the single bands here.

Three types of color interpolation are available:

1. Discreto

2. Lineal

3. Exacto
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Figure 13.5: Raster Style - Singleband pseudocolor rendering

13.1. Dialogo de Propiedades Raster 225



QGIS User Guide, Publicación 2.18

In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continuous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max val-
ues can be done with the help of the Load min/max values section. A lot of images have a few very low and high
data. These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set
from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image
can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Color de renderizado

For every Band rendering, a Color rendering is possible.

You can also achieve special rendering effects for your raster file(s) using one of the blending modes (see Modos
de Mezcla).

Further settings can be made in modifying the Brightness, the Saturation and the Contrast. You can also use a
Grayscale option, where you can choose between ‘By lightness’, ‘By luminosity’ and ‘By average’. For one hue
in the color table, you can modify the ‘Strength’.

Remuestreo

The Resampling option makes its appearance when you zoom in and out of an image. Resampling modes can
optimize the appearance of the map. They calculate a new gray value matrix through a geometric transformation.

Figure 13.6: Raster Style - Color rendering and Resampling settings

When applying the ‘Nearest neighbour’ method, the map can have a pixelated structure when zooming in. This
appearance can be improved by using the ‘Bilinear’ or ‘Cubic’ method, which cause sharp features to be blurred.
The effect is a smoother image. This method can be applied, for instance, to digital topographic raster maps.

At the bottom of the Style tab, you can see a thumbnail of the layer, its legend symbol, and the palette.
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13.1.4 Transparency Properties

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Additionally, you can enter a raster value that should be treated as NODATA in the Additional no data value option.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are necessary:

1. Load the raster file landcover.tif.

2. Open the Properties dialog by double-clicking on the raster name in the legend, or by right-clicking and
choosing Properties from the pop-up menu.

3. Select the Transparency tab.

4. From the Transparency band drop-down menu, choose ‘None’.

5. Click the Add values manually button. A new row will appear in the pixel list.

6. Enter the raster value in the ‘From’ and ‘To’ column (we use 0 here), and adjust the transparency to 20%.

7. Press the [Apply] button and have a look at the map.

You can repeat steps 5 and 6 to adjust more values with custom transparency.

As you can see, it is quite easy to set custom transparency, but it can be quite a lot of work. Therefore, you

can use the button Export to file to save your transparency list to a file. The button Import from file loads your
transparency settings and applies them to the current raster layer.

13.1.5 Pyramids Properties

Large resolution raster layers can slow navigation in QGIS. By creating lower resolution copies of the data (pyra-
mids), performance can be considerably improved, as QGIS selects the most suitable resolution to use depending
on the level of zoom.

You must have write access in the directory where the original data is stored to build pyramids.

From the Resolutions list, select resolutions for which you want to create pyramid by clicking on them.

If you choose Internal (if possible) from the Overview format drop-down menu, QGIS tries to build pyramids
internally.

Nota: Please note that building pyramids may alter the original data file, and once created they cannot be
removed. If you wish to preserve a ‘non-pyramided’ version of your raster, make a backup copy prior to building
pyramids.

If you choose External and External (Erdas Imagine) the pyramids will be created in a file next to the original
raster with the same name and a .ovr extension.

Several Resampling methods can be used to calculate the pyramids:

• Vecino más próximo

• Promedio

• Gauss

• Cúbico
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• Modo

• Ninguno

Finally, click [Build pyramids] to start the process.

Figure 13.7: Raster Pyramids

13.1.6 Histogram Properties

The Histogram tab allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram tab. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

13.1.7 Metadata Properties

The Metadata tab displays a wealth of information about the raster layer, including statistics about each band in
the current raster layer. From this tab, entries may be made for the Description, Attribution, MetadataUrl and
Properties. In Properties, statistics are gathered on a ‘need to know’ basis, so it may well be that a given layer’s
statistics have not yet been collected.

13.1.8 Propiedades de la leyenda

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel. The
idea is to have a way to quickly access some actions that are often used with the layer (setup transparency, filtering,
selection, style or other stuff...).

By default, QGIS provides transparency widget but this can be extended by plugins registering their own widgets
and assign custom actions to layers they manage.
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Figure 13.8: Histograma de Ráster

Figure 13.9: Metadatos Ráster
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13.2 Análisis raster

13.2.1 Calculadora Ráster

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_calculator). The results are written to a new raster layer with a GDAL-supported format.

Figure 13.10: Calculadora Ráster

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Conditional expressions (=, !=, <, >=, ... ) return either 0 for false or 1 for true, and
therefore can be used with other operators and functions. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.
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Ejemplos

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:

"elevation@1" * 3.28

Using a mask

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0 the conditional expression evaluates to 1, which keeps the
original value by multiplying it by 1. Otherwise the conditional expression evaluates to 0, which sets the raster
value to 0. This creates the mask on the fly.

Si desea clasificar un ráster –digamos, por ejemplo en dos clases de elevación, puede utilizar la siguiente expresión
para crear un ráster con dos valores 1 y 2 en un solo paso.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

In other words, for every cell less than 50 set its value to 1. For every cell greater than or equal 50 set its value to
2.

13.2.2 Raster Alignment

This tool is able to take several rasters as input and to align them perfectly, that means:

• reproject to the same CRS,

• remuestrea al mismo tamaño de celda y desplazamiento en la cuadrícula (grid),

• clip to a region of interest,

• reescale valores cuando sea necesario.

All rasters will be saved in another files.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools
need to Rescale values according to the cell size. The resampling method can be (see figure_raster_align_edit):

• Vecino más próximo

• Bilineal (núcleo 2x2)

• Cubic (4x4 kernel): Cubic Convolution Approximation

• Cubic B-Spline (4x4 kernel): Cubic B-Spline Approximation

• Lanczos (6x6 kernel): Lanczos windowed sinc interpolation

• Average: computes the average of all non-NODATA contributing pixels

• Mode: selects the value which appears most often of all the sampled points

• Maximum, Minimum, Mediane, First Quartile (Q1) or Third Quartile (Q3) of all non-NODATA con-
tributing pixels

Nota: Methods like maximum, minimum, mediane, first and third quartiles are available only if QGIS is built
with GDAL >= 2.0.
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Figure 13.11: Select Raster Resampling Options

In the main Align raster dialog, you can still Edit file settings or Remove an existing file from the list of raster layers.
You can also choose one or more other options (see figure_raster_align):

• Select the Reference Layer,

• Transform into a new CRS,

• Setup a different Cell size,

• Setup a different Grid Offset,

• Clip to Extent: it can be user-defined or based on a layer or the map view

• Output Size,

• Add aligned raster to the map canvas.
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Figure 13.12: Raster Alignment
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CHAPTER 14

Diseñadores de impresión

Con el diseñador de impresión se pueden crear buenos mapas y atlas que se pueden imprimir o guardar como
archivo PDF, una imagen o un archivo SVG. Esta es una manera potente para compartir información geográfica
producida con QGIS que se puede incluir en reportes o publicado.

14.1 Perspectiva general del Diseñador de impresión

El diseño de impresión ofrece crecientes capacidades de diseño e impresión. Se le permite añadir elementos a la
vista del QGIS como, etiquetas de texto, imágenes, leyendas, barras de escala, formas básicas, flechas, tablas de
atributos y marcos HTML. Puede cambiar el tamaño, grupo, alineación y posición y rotación de cada elemento
y ajustar las propiedades para crear su diseño. El diseño se puede imprimir o exportar a formatos de imagen,
PostScript, PDF o SVG (la exportación a SVG no funciona correctamente con algunas versiones recientes Qt4,
debe intentarlo y comprobar de forma individual en el sistema). Puede guardar el diseño como una plantilla y
cargarla de nuevo en otra sesión. Por último, la generación de varios mapas basados en una plantilla se puede
hacer a través del generador de atlas.

14.1.1 Ejemplo de sesión

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

To demonstrate how to create a map please follow the next instructions.

1. On the left side, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Select the Select/Move item icon to select the map on the canvas and move it a bit.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change its size.

6. Click the Item Properties panel on the left down side and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.
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7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.

8. Por último, puede guardar su diseño de impresión con el botón Guardar proyecto.

Puede añadir múltiples elementos al diseño de impresión. También es posible tener más de una vista de mapa o
leyenda o barra de escala en el lienzo, en una o varias páginas. Cada elemento tiene sus propias propiedades y, en
caso del mapa, su extensión. Si quiere borrar algún elemento del lienzo, puede hacerlo con Eliminar o la tecla
Retroceso.

14.1.2 El Administrador de diseñadores

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 14.1: EL Administrador de diseñadores

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.
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14.1.3 Menus, tools and panels of the print composer

Al abrir el Diseñador de impresión le proporciona un lienzo en blanco que representa la superficie del papel al usar
la opción de impresión . Inicialmente se encuentra botones del lado izquierdo del lienzo para añadir elementos
al mapa del diseño; el lienzo del mapa actual de QGIS, etiquetas de texto, imágenes, leyendas, barras de escala,
formas básicas, flechas, tablas de atributos y marcos HTML. En esta barra de herramientas también se encuentran
los botones de barra de herramientas para navegar, acercar zum sobre un área y desplazar la vista y los botones de
la barra de herramientas para seleccionar un elemento del diseñador del mapa y mover el contenido del elemento
del mapa.

Figure_composer_overview shows la vista inicial del Diseño de impresión se añade antes que cualquier otro
elemento.

Figure 14.2: Diseñadores de impresión

On the right beside the canvas you find two set of panels. The upper one holds the panels Items and Command
History and the lower holds the panels Composition, Item properties and Atlas generation.

• The Items panel provides a list of all map composer items added to the canvas.

• The Command history panel displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition panel allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this panel,
you can also customize settings for grid and smart guides.

14.1. Perspectiva general del Diseñador de impresión 237



QGIS User Guide, Publicación 2.18

• The Item Properties panel displays the properties for the selected item. Click the Select/Move item icon
to select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties panel and
customize the settings for the selected item (see Elementos de diseño for detailed information on each item
settings).

• The Atlas generation panel allows you to enable the generation of an atlas for the current Composer and
gives access to its parameters (see Generar un Atlas for detailed information on atlas generation usage).

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_tools.

The toolbars and the panels can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.
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Herramientas

Icono Propósito Icono Propósito

Guardar Proyecto Nuevo diseñador de impresión

Duplicar diseñador de impresión Administrador de diseñadores

Cargar de plantilla Guardar como plantilla

Imprimir o exportar como PostScript Exportar a un formato imagen

Exportar composición de impresión
como SVG

Exportar a PDF

Revertir último cambio Restaurar el último cambio

Acercamiento a toda la extensión Acercamiento a 100%

Acercamiento Alejamiento

Actualizar Vista

Desplazar Acercamiento a región específica

Seleccionar/Mover elemento en diseño
de impresión

Mover contenido dentro de un
elemento

Adicionar nuevo mapa desde tela de
mapa QGIS

Añadir imagen al diseño de impresión

|eti-
queta|

Añadir etiqueta al diseño de impresión Añadir nueva leyenda a diseño de
impresión

Añadir barra de escala a diseño de
impresión

Añadir figura básica al diseño de
impresión

Adicionar flecha a diseño de impresión Adicionar tabla de atributo a diseño
de impresión

Adicionar un marco HTML Add nodes shape to print composition

Edit a nodes shape

Agrupar elementos Desagrupar elementos del diseño de
impresión

|blo-
queado|

Bloquear Elementos Seleccionados
|desblo-
queado|

Desbloquear todos los elementos

Elevar elementos seleccionados Bajar elementos seleccionados

Mover elementos seleccionados arriba Mover elementos seleccionados abajo

Alinear elementos seleccionados a la
izquierda

Alinear elementos seleccionados a la
derecha

Align selected items center Align selected items center vertical

Alinear elementos seleccionados hacia
arriba

Align selected items bottom

Vista previa del Atlas First Feature

Previous Feature Next Feature

Último objeto espacial Imprimir Atlas

Exportar Atlas como imagen Configuración de atlas
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Table Composer 1: Print Composer Tools

Menú Diseñador

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one

• Open the Composer Manager...

• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Menú Configuración

De Configuración → Opciones del Diseñador se pueden establecer algunas opciones or plantilla que se utilizarán
por defecto durante su trabajo.

• Predeterminados de la Composición le permite especificar la fuente predeterminada a utilizar.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• La cuadrícula y las guías predeterminadas define el espaciamiento, compensar y la tolerancia de la
cuadrícula.

Menú Editar

Copy/Cut and Paste Items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Nota: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties panel.

Menú Vista

Herramientas de Navegación

To navigate in the canvas layout, the Print Composer provides some general tools:
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• Acercar zum

• Zoom Out

• Zoom Full

• Zum al 100%

• Refresh view (if you find the view in an inconsistent state)

• Show Grid behind items.

• Snap Grid to snap items on the grid.

• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

Puede también cambiar el nivel de zum con la rueda del ratón o en la lista desplegable de la barra de estado. Si
necesita cambiar a modo de panorama mientras se trabaja en el área del diseñador, puede mantenerlo con la Barra
espaciadora o la rueda del ratón. Con Ctrl+Barra espaciadora, puede cambiar temporalmente al
modo de zum, y con Ctrl+Shift+Barra espaciadora, para el modo alejar.

Ocultar y Mostrar Paneles

To maximise the space available to interact with a composition you can use View → Hide panels or press F10.

Nota: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Panel

Tamaño y configuración de página

In the Composition panel, you can define the global settings of the current composition.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
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Figure 14.3: Composition settings in the Print Composer

organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Botones de anulación de datos definidos.).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).

Configuración de exportación

You can define a resolution to use for all exported maps in Export resolution. This setting can, however, be

overridden each time you are exporting a map. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking Save world file

and select a map item in Reference map. The world file is created beside the exported map, has the same
name and contains information to georeference it easily.

Figure 14.4: Export Settings in the Print Composer
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Cuadrícula y guías

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 14.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Variables

The Variables lists all the variables available at the composition’s level (which includes all global and project’s
variables).

It also allows the user to manage composition-level variables. Click the button to add a new custom

composition-level variable. Likewise, select a custom composition-level variable from the list and click the
button to remove it.

More information on variables usage in the General Tools Variables section.

Figure 14.6: Variables editor in the Print Composer
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Command History Panel: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last change

• Restore last change

This can also be done by mouse click within the Command history panel (see figure_composer). The History
panel lists the last actions done within the composer. Just select the point you want to revert to and once you do
new action all the actions done after the selected one will be removed.

Figure 14.7: Command history in the Print Composer

Items Panel

The Items panel offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

For any selected item, you can :

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.

Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items panel and
unchecking the tickbox or you can use the icons on the toolbar.

14.2 Elementos de diseño

14.2.1 Opciones comunes en los elementos del diseñador

Composer items have a set of common properties you will find at the bottom of the Item Properties panel: Position
and size, Rotation, Frame, Background, Item ID, Variables and Rendering (See figure_composer_common).

• The Position and size dialog lets you define the size and position of the frame which contains the item. You
can also choose which Reference point will be set at the X and Y coordinates previously defined.

• The Rotation sets the rotation of the element (in degrees).
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Figure 14.8: Common Item Properties Dialogs
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• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed.

Nota:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map item
or use expressions. These are particularly helpful with atlas generation (See Botones de anulación de datos
definidos.).

Modo de representación

Ahora QGIS permite representación avanzada para elementos del Diseñador al igual que capas vectoriales y
rásters.

Figure 14.9: Modo de representación

• Blending mode: With this tool you can achieve effects which would otherwise only be achieved using
graphic rendering software. The pixels of your overlaying and underlaying items can be mixed according
to the mode set (see Modos de Mezcla for description of each effect).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item invisible in all exports. After activating this
checkbox, the item will not be included in export to PDF, print etc..

Tamaño y posición

Each item inside the Composer can be moved and resized to create a perfect layout.For both operations the first

step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while
holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the
Shift button on the keyboard while moving the mouse. If you need better precision, you can move a selected
item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by holding
Shift.
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A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items panel. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items panel and unchecking the tickbox or you can use
the icons on the toolbar.

Para cancelar la selección de un elemento, basta con hacer clic en él sosteniendo el botón Shift.

Dentro del menú Editar, se puede encontrar acciones para seleccionar todos los elementos, para borrar todas las
selecciones o para invertir la selección actual.

Alineación

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items panel. You can also raise or lower
objects in the Items panel by clicking and dragging an object’s label in this list.

Figure 14.10: Líneas auxiliares de alineación en el diseño de impresión

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_align). To use an alignment function, you first select the elements then click on the
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matching alignment icon. All selected elements will then be aligned to their common bounding box. When mov-
ing items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

Variables

The Variables lists all the variables available at the composer item’s level (which includes all global, project and
composition’s variables). Map items also include Map settings variables that provide easy access to values like
the map’s scale, extent, and so on.

In Variables, it’s also possible to manage item-level variables. Click the button to add a new custom variable.

Likewise, select any custom item-level variable from the list and click the button to remove it.

More information on variables usage in the General Tools Variables section.

14.2.2 El elemento del mapa

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties panel:

• Rectángulo es la configuración predeterminada. Solo muestra una caja vacía con un mensaje ‘El mapa será
impreso aquí’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map item by clicking on the Select/Move item button, selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select the
item and while holding the left mouse button, move to the new place and release the mouse button. After you
have found the right place for an item, you can lock the item position within the Print Composer canvas. Select

the map item and use the toolbar Lock Selected Items or the Items panel to Lock the item. A locked item can only
be selected using the Items panel. Once selected you can use the Items panel to unlock individual items. The

Unlock All Items icon will unlock all locked composer items. With the map selected, you can now adapt more
properties in the map Item Properties panel.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button.

Propiedades principales

The Main properties dialog of the map Item Properties panel provides the following functionalities (see fig-
ure_composer_map):

• The Preview drop-down menu allows you to select one of the preview modes ‘Rectangle’, ‘Cache’ and
‘Render’, as described above. If you change the view on the QGIS map canvas by changing vector or raster
properties, you can update the Print Composer view by selecting the map element and clicking the [Update
preview] button.

• The field Scale manually sets the map item scale.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map canvas can be imitated here.
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Figure 14.11: Map Item Properties Panel

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

Layers

The Layers dialog of the map item panel provides the following functionality (see figure_composer_map_layers):

Figure 14.12: Map Layers Dialog

• If you want to keep the map item constantly updated with a visibility preset, use the Follow visibility
preset and set the preset you want. Any changes applied to the preset in QGIS’s main window (using the
replace preset) will also show in the map item. In this case, the Lock styles for layers option will be disabled
because Follow visibility preset also updates the style (symbology, label, diagram) of the visibility preset
layers.
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• To lock the layers shown on a map item to the current map canvas check Lock layers. After this option is
enabled, any changes on the layers visibility in the QGIS’s main window won’t affect the Composer’s map
item. Nevertheless, style and labels of locked layers are still refreshed according to QGIS’s main window.
You can prevent this by using Lock styles for layers.

Using the button, you can lock the map item’s layers to one of the visibility presets you have prepared
in QGIS (see Panel de capas to find out how to create visibility presets). Clicking the button will show
the list of all the preset views. Select the preset you want to display. The map canvas will lock the preset

layers automatically by enabling the Lock layers. You can release the preset by unchecking the Lock

layers and press the button in the map composer’s Navigation toolbar.

Note that, unlike the Follow visibility preset, using the Lock layers option enabled and set to a preset, the
map item layers won’t be updated if the preset is changed (using the replace preset option) in QGIS’s main
window.

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Extensión

The Extents dialog of the map item panel provides the following functionalities (see fig-
ure_composer_map_extents):

Figure 14.13: Diálogo Extensión de Mapa

The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking the
[Set to map canvas extent] button. This button sets the map extent of the composer map item to the extent of
the current map view in the main QGIS application. The button [View extent in map canvas] does exactly the
opposite; it updates the extent of the map view in the QGIS application to the extent of the composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties panel (see figure_composer_map).

Cuadrículas

The Grids dialog of the map Item Properties panel provides the possibility to add several grids to a map item.

• With the and buttons you can add or remove a selected grid.

• With the and buttons you can move a grid in the list and set the drawing priority.
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Figure 14.14: Diálogo de cuadrículas del mapa

When you double-click the added grid you can give it another name.

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_grid_draw.

Figure 14.15: Draw Grid Dialog

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and its
rendering mode can be chosen. See Modo de representación. Furthermore, you can define an interval in the X and
Y directions, an X and Y offset, and the width used for the cross or line grid type.

• Hay diferentes opciones para estilos del marco que sostiene el mapa. Las siguientes opciones están
disponibles: Sin marco, Zebra, ticks interiores, ticks exteriores, Stick interior y exterior, línea de borde.

• Con el ajuste ‘Mostrar latitud solo’ y ‘Mostrar longitud solo’ en la sección de divisiones tiene la posibilidad
de evitar una mezcla de coordenadas latitud/y y longitud/x mostrados a un lado cuando trabaja con mapas
rotados o cuadrículas reproyectadas.

• Advanced rendering mode is also available for grids.

• La casilla de verificación Dibujar coordenadas le permite añadir coordenadas al marco del mapa. Se
puede elegir el formato numérico de anotación, el rango de opciones de decimal a grados, minutos y segun-
dos, con o sin subfijo y alineados o no. Se puede elegir que anotación mostrar. Las opciones son: Mostrar
todo, Mostrar latitud solo, Mostrar longitud solo o Deshabilitado. Esto es útil cuando el mapa esta rotado.
La anotación se puede dibujar dentro o fuera del marco del mapa. La dirección de la anotación se puede
definir como horizontal y vertical, ascendente vertical o descendente vertical. Finalmente, se puede definir
el tipo de letra de la anotación, el color de la letra, la distancia del marco del mapa y la precisión de las
coordenadas trazadas.
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Figure 14.16: Diálogo de marco de cuadrícula

Figure 14.17: Diálogo Coordenadas para dibujo de rejilla
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Vistas generales

The Overviews dialog of the map Item Properties panel provides the following functionalities:

Figure 14.18: Diálogo de vista general del mapa

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview is
named ‘Overview 1’ (see Figure_composer_map_overview). You can change the name when you double-click on
the overview item in the list named ‘Overview 1’ and change it to another name.

• Con el botón más y menos se puede añadir o borrar una vista general.

• Con el botón de arriba y abajo puede mover una vista general en la lista y definir la prioridad de dibujado.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• The Frame Style allows you to change the style of the overview frame.

• The Blending mode allows you to set different transparency blend modes.

• La Invertir vista general crea una máscara al rededor de las extensiones cuando activa: las extensiones
del mapa referenciado se muestran claramente, mientras que todo lo demás es mezclado con el color del
marco.

• El Centrar en vista general pone la extensión del marco de la vista general al centro de la vista general
del mapa. Sólo se puede activar un elemento de vista general para centrar, cuando ha añadido varias vistas
generales.

14.2.3 El elemento etiqueta

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties panel.

The Item Properties panel of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):
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Figure 14.19: Label Item Properties Panel

Propiedades principales

• El diálogo de las propiedades principales es donde el texto (HTML o no) o la expresión necesita llenar la
etiqueta añadida a la vista del diseñador.

• Las etiquetas pueden ser interpretadas como código HTML: check Representar como HTML. Ahora
puede insertar una URL, una imagen seleccionable que enlaza a una página web o algo más complejo.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry and records functions. At the bottom,
a preview of the expression is shown.

Apariencia

• Definir Tipo de letra al hacer clic en el botón [Tipo de letra...] o seleccionando un Color de letras un color
utilizando la herramienta de seleccion de color.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

14.2.4 El elemento leyenda

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties panel.

The Item properties panel of a legend item provides the following functionalities (see figure_composer_legend):
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Figure 14.20: Legend Item Properties Panel

Propiedades principales

The Main properties dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_ppt):

Figure 14.21: Diálogo de Propiedades de la leyenda principal

En propiedades principales se puede:

• change the title of the legend;

• set the title alignment to Left, Center or Right;

• choose which Map item the current legend will refer to in the select list;

• wrap the text of the legend title on a given character;

• use Resize to fit contents to control whether or not a legend should be automatically resized to fit its
contents. If unchecked, then the legend will never resize and instead just stick to whatever size the user has
set. Any content which doesn’t fit the size is cropped out.

Elementos de la leyenda

The Legend items dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_items):
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Figure 14.22: Legend Items Dialog

• La leyenda se actualizará automáticamente si Auto actualizar es activado. Cuando guilabel:Auto actu-
alizar es desactivado este le dará más control sobre los elementos de la leyenda. Los iconos debajo de los
elementos de la leyenda se activarán.

• La ventana de los elementos de la leyenda lista todos los elementos y le permite cambiar el orden, capas de
grupos, eliminar y restaurar elementos en la lista, editar nombres de capas y añadir un filtro.

– The item order can be changed using the and buttons or with ‘drag-and-drop’ functionality.
The order can not be changed for WMS legend graphics.

– Use the button to add a legend group.

– Use the button to add layers and button to remove groups, layers or symbol classes.

– The button is used to edit the layer, group name or title. First you need to select the legend item.
Double-clicking the item also opens the text box to rename it.

– The button adds a feature count for each class of vector layer.

– With the Filter legend by map content button, only the legend items visible in the map will be listed in the

legend. This tool remains available when Auto-update is active.

– The Filter legend by expression helps you filter which of the legend items of a layer will be displayed, i.e.
using a layer that has different legend items (e.g., from a rule-based or categorized symbology), you
can specify a boolean expression to remove from the legend tree, styles that have no feature satisfying
a condition. Note that the features are nevertheless kept and shown in the composer map item.

While the default behavior of the legend item is to mimic the Layers panel tree, displaying the same groups,
layers and classes of symbology, right-click any item offers you options to hide layer’s name or raise it as a
group or subgroup. In case you have made some changes to a layer, you can revert them by choosing Reset
to defaults from the contextual menu.

Después de cambiar la simbología en la ventana principal de QGIS se puede hacer clic en [Actualizar todo]
para adaptar los cambios en el elemento leyenda del Diseñador de Impresión.

• While generating an atlas with polygon features, you can filter out legend items that lie outside the current

atlas feature. To do that, check the Only show items inside current atlas feature option.
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Fuentes, Columnas, Símbolo

The Fonts, Columns and Symbol dialogs of the legend Item Properties panel provide the following functionalities
(see figure_composer_legend_fonts):

Figure 14.23: Diálogo de Fuentes de leyenda, Columnas y Símbolos

• Se puede cambiar la fuente del título de la leyenda, grupo, subgrupo y elementos (capa) en la leyenda. Haga
clic en un botón de categoría para abrir un diálogo Seleccionar fuente.

• Con el selector de color se dota a las etiquetas de Color, se dará el color seleccionado a todos los elementos
de la leyenda.

• Los elementos de la leyenda pueden ser organizados en varias columnas. Establece el número de columnas
en el campo Count .

– Anchura de columnas igual controla cómo deberían ser ajustadas las columnas de la leyenda.

– La opción Dividir capas permite a una capa categorizada o graduada de la leyenda repartirse en
columnas.

• You can also change the width and height of the legend symbol, set a color and a thickness in case of raster
layer symbol.

WMS LegendGraphic y espaciamiento

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties panel provide the following func-
tionalities (see figure_composer_legend_wms):

Cando se ha añadido una capa WMS y se inserta un elemento leyenda, una petición se enviará al servidor WMS
para proveer una leyenda WMS. Esta leyenda sólo se mostrará si el servidor WMS proporciona la capacidad de
GetLegendGraphic. El contenido de la leyenda WMS será proporcionado como una imagen ráster.

GráficoDeLeyenda WMS se utiliza para poder ajustar el Anchura de la leyenda y la Altura de la leyenda de la
imagen ráster de la leyenda WMS.
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Figure 14.24: Diálogos WMS LegendGraphic y espaciamiento

El espaciado alrededor del título, grupo, subgrupo, símbolo, etiqueta de icono, espacio de caja o espacio de
columna puede ser personalizado a través de este diálogo.

14.2.5 El elemento de barra de escala

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties panel.

The Item properties of a scale bar item tab provides the following functionalities (see figure_composer_scalebar):

Figure 14.25: Scale Bar Item Properties Panel

Propiedades principales

The Main properties dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_ppt):
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Figure 14.26: Scale Bar Main properties Dialog

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numérico, donde se imprime la relación de escala (por ejemplo, 1:50000).

Unidades y Segmentos

The Units and Segments dialogs of the scale bar Item Properties panel provide the following functionalities (see
figure_composer_scalebar_units):

Figure 14.27: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar.

• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Height is used to define the height of the bar.
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Mostrar

The Display dialog of the scale bar Item Properties panel provides the following functionalities (see fig-
ure_composer_scalebar_display):

Figure 14.28: Mostrar barra de escala

Se puede definir como la barra de escala se mostrará en un marco.

• Margen de caja : espacio entre texto y bordes del marco

• Margen de etiquetas : espacio entre texto y dibujo de la barra de escala

• Line width : line width of the scale bar drawing

• Estilo de unión : Esquinas al final de barra de escala en estilo biselado, redondeado o cuadrado (sólo
disponible para el estilo de barra de escala de Recuadro simple & Recuadro doble)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fuentes y colores

The Fonts and colors dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_fonts):

Figure 14.29: Scale Bar Fonts and colors Dialogs

Se puede definir el tipo de letra y los colores utilizados para la barra de escala.

• Use the [Font] button to set the font of scale bar label

• Color de letras: establecer color de letras

• Fill color: set the first fill color

• Color de relleno secundario: establece el segundo color de relleno
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• Color de marca: establece el color de las lineas de la barra de escala

Los colores sólo se utilizan para estilos de caja de escala Recuadro simple y Recuadro doble. Para seleccionar
un color se puede utilizar la lista de opciones utilizando la flecha de la lista desplegable para abrir una opción de
selección de color sencilla o la opción de selección de color más avanzada, que se inicia cuando se hace clic en el
cuadro de color en el diálogo.

14.2.6 El elemento de Tabla de Atributos

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, click and drag with the left mouse button on the Print Composer canvas to place and size the item. You can
better position and customize its appearance in the Item Properties panel.

The Item properties panel of an attribute table provides the following functionalities (see figure_composer_table):

Figure 14.30: Attribute table Item Properties Panel

Propiedades principales

The Main properties dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_ppt):

Figure 14.31: Attribute table Main properties Dialog

• For Source you can normally select only Layer features.

• With Layer you can choose from the vector layers loaded in the project.
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• In case you activated the Generate an atlas option in the Atlas generation panel, there are two additional
Source possible:

– Current atlas feature (see figure_composer_table_atlas): you won’t see any option to choose the
layer, and the table item will only show a row with the attributes from the current feature of the atlas
coverage layer.

– and Relation children (see figure_composer_table_relation): an option with the relation names will
show up. This feature can only be used if you have defined a relation using your atlas coverage layer
as parent, and the table will show the children rows of the atlas coverage layer’s current feature (for
further information about the atlas generation, see Generar un Atlas).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

Figure 14.32: Attribute table Main properties for ‘Current atlas feature’

Figure 14.33: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_select, that can be
used to change the visible contents of the table. After making changes use the [OK] button to apply changes
to the table. The upper part of the window shows the list of the attributes to display and the lower part helps
to set the way the data is sorted.

In the Columns section you can:

– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cell in the Headings column and, to change the heading, just type in a new name.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.

– El botón de [Restablecer] siempre puede ser utilizado para restaurar a la configuración de atributos
original.

En la sección Ordenar se puede:
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Figure 14.34: Attribute table Select attributes Dialog

– Añadir un atributo para ordenar la tabla con. Seleccione un atributo y establezca el clasificación a
‘Ascendente’ o ‘Descendente’ y presione el botón más. Una nueva línea se añade a la lista de orden
de clasificación.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– Use el botón menos para eliminar un atributo de la lista de orden de clasificación.

Filtrado de objetos espaciales

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_filter):

Figure 14.35: Attribute table Feature filtering Dialog

Puede:

• Define the Maximum rows to be displayed.

• Activar Eliminar filas duplicadas de la tabla para mostrar sólo registros únicos.
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• Activar Mostrar sólo objetos espaciales visibles dentro de un mapa y seleccione el correspondiente Dis-
eñador de mapa para mostrar los atributos de los objetos espaciales sólo visibles en el mapa seleccionado.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features which intersect the current atlas feature.

• Activar Filtrar con y proporciona un filtro al escribir en la línea de entrada o insertar una expresión

regular utilizando el botón de expresión dado. Unos pocos ejemplos de declaraciones de filtrado que
puede utilizar cuando se han cargado la capa de aeropuertos a partir del conjunto de datos de la muestra:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

La ultima expresión regular incluirá sólo los aeropuertos que tienen una letra ‘i’ en el campo de atributos
‘USE’.

Apariencia

The Appearance dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_appearance):

Figure 14.36: Attribute table appearance Dialog

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Dibujar cabeceras solamente, sólo dibuja la cabecera excepto si se tiene elegido ‘Sin encabezado’
por Mostrar encabezado.

– Ocultar tabla entera, sólo dibujará el fondo de la tabla. Se puede activar No dibujar el fondo si
el marco esta vacío en Marcos para ocultar la tabla completamente.
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– Mostrar mensaje establecido dibujará el encabezado y añadirá un espaciado a la celda a todas las
columnas y mostrará un mensaje como ‘Sin resultados’ que puede ser proveído en la opción Mensaje
a mostrar

• La opción Mensaje a mostrar sólo se activa cuando se ha seleccionado Mostrar mensaje establecido para
Tabla Vacía. El mensaje proporcionado se mostrará en la tabla en la primer fila, cuando el resultado es una
tabla vacía.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_background)

Figure 14.37: Attribute table Advanced Background Dialog

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Mostrar cuadrícula

The Show grid dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_grid):

Figure 14.38: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• Con Ancho de línea se puede establecer el espesor de las líneas utilizadas en la cuadrícula.

• El Color de la cuadrícula se puede establecer utilizando el diálogo de selección de color.
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Fuentes de letras y estilo de texto

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_fonts):

Figure 14.39: Attribute table Fonts and text styling Dialog

• Se puede definir el Tipo de letra y Color para Encabezado y Contenido de tabla.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_select ).

Marcos

The Frames dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_frames):

Figure 14.40: Attribute table Frames Dialog

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repetir hasta finalizar también creará tantos marcos como la opción Extender a la página siguiente,
excepto que todos los marcos tendrán el mismo tamaño.

• Utilice el botón [Añadir marco] para añadir otro marco con el mismo tamaño como el marco seleccionado.
El resultado de la tabla que no se ajusta en el primero continuará al siguiente cuando se utilice el modo de
redimensionado Utilizar marcos existentes.

• Activar No exportar página si el marco está vacío impide que la página sea exportada cuando el marco
de la tabla no tiene contenido. Esto significa que todos los demás elementos del diseñador, mapas, barras
de escala, leyendas, etc., no serán visibles en el resultado.
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• Activar No dibujar fondo si el marco está vacío impide que el fondo que se puede extraer cuando el
marco de la tabla no tiene contenido.

14.2.7 El elemento imagen

To add an image, click the Add image icon and drag a rectangle onto the Composer canvas with the left mouse
button. You can then position and customize its appearance in the image Item Properties panel.

The image Item Properties tab provides the following functionalities (see figure_composer_image):

Figure 14.41: Image Item Properties panel

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zum: Amplia la imagen al marco mientras se mantiene la relación del aspecto de la imagen.
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• Estirar: Estira la imagen para que quepa dentro del marco, ignorar la relación del aspecto.

• Cortar: Utilice este modo sólo para imágenes ráster, se establece el tamaño de la imagen al tamaño de la
imagen original sin escalar y el marco suele cortar la imagen, así sólo la parte de la imagen dentro del marco
es visible.

• El zum y el marco de redimensionado: Amplia la imagen para que se adapte al marco, entonces cambia el
tamaño del marco para adaptarse a la imagen resultante.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Modo de redimensionar seleccionado puede inhabilitar el elemento opciones ‘Ubicación’ y ‘Rotación de imagen’.
La Rotación de imagen está activo para el modo de cambio de tamaño ‘Zum’ y ‘Cortar’.

With Placement you can select the position of the image inside its frame. The Search directories area allows you
to add and remove directories with images in SVG format to the picture database. A preview of the pictures found
in the selected directories is shown in a pane and can be used to select and set the image source. It is possible to
change SVG fill/outline color and outline width when using parameterized SVG files such as those included with
QGIS. If you add a SVG file you should add the following tags in order to add support for transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

También es posible seleccionar una flecha de norte directamente. Si primero se selecciona una imagen flecha de

norte desde Directorios de búsqueda y entonces utiliza el botón de explorar del campo Origen de la imagen,
ahora se puede seleccionar una de las flechas de norte desde la lista mostrada en figure_composer_image_north.

Nota: Muchas de las flechas del norte no tienen una ‘N’ añadida, esto se hace a propósito para los idiomas que
no utilizan una ‘N’ para Norte, para que pueda utilizar otra letra.

Figure 14.42: Las flechas de norte disponibles para la selección en la biblioteca SVG proporcionada.
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14.2.8 El elemento del marco HTML

Es posible añadir un marco que muestre el contenido de un sitio web o incluso crear y poner estilo a su propia
página HTML y mostrarlo!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties panel (see
figure_composer_html).

Figure 14.43: HTML Frame, the Item Properties Panel

Fuente HTML

Como fuente HTML, se puede establecer una URL y activar el botón de radio URL o se introduce código HTML
directamente en el cuadro de texto proporcionado y activar el botón de radio Fuente.

The HTML Source dialog of the HTML frame Item Properties panel provides the following functionalities (see
figure_composer_html_ppt):

Figure 14.44: HTML frame, the HTML Source properties

• In URL you can enter the URL of a webpage you copied from your Internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• En Fuente se puede ingresar el texto en la caja de texto con algunas pestañas HTML o proporciona una
pagina completa de HTML.
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• El botón [insertar una expresión] se puede utilizar para insertar una expresión como [%Year($now)%]
en la caja de texto de origen para mostrar el año actual. En este botón sólo se activa cuando el botón de radio
Origen esta seleccionado. Después de insertar la expresión haga clic donde sea en la caja de texto antes de
actualizar el marco HTML, si no perderá la expresión.

• Activar la expresión Evaluar las expresiones QGIS en código HTML para ver el resultado de la expresión
que ha incluido, de lo contrario, verá la expresión en su lugar.

• Utilice el botón [Actualizar HTML] para actualizar los marco(s) para ver los resultados de los cambios.

Marcos

The Frames dialog of the HTML frame Item Properties panel provides the following functionalities (see fig-
ure_composer_html_frames):

Figure 14.45: HTML frame, the Frames properties

• Con Modo cambio de tamaño se puede seleccionar cómo renderizar el contenido HTML:

– Usar marcos existentes muestra el resultado en el primer marco y añade sólo marcos.

– Extender a la página siguiente crear tantos marcos sean necesarios (y páginas corresponedientes) para
renderizar el alto de la página web. Cada marco se puede mover alrededor del diseño. Si cambia el
tamaño de un marco, la página web se dividirá entre los otros marcos. El último cuadro se recortará
para ajustarse a la página web.

– Repetir en toda la página web se repetirá la parte superior izquierda de la página web en todas las
páginas de marcos del mismo tamaño.

– Repetir hasta finalizar también creará tantos marcos como la opción Extender a la página siguiente,
excepto que todos los marcos tendrán el mismo tamaño.

• Utilice el botón [Añadir marco] para añadir otros marcos con el mismo tamaño como el marco selec-
cionado. Si la página HTML no cabe en el primer marco, continuará en el siguiente marco cuando se utilice
modo cambiar tamaño o Utilice marcos existentes.

• Activar No exportar página si el marco esta vacío impide el layout del mapa sea expuesto cunado el
marco no tenga contenido. Esto significa que todos los otros elementos de diseñadores, mapas, barras de
escala, leyendas, etc. no seremos invisibles en el resultado.

• Activar No saque el fondo si el marco es empty impide que el marco HTML está elaborando si la trama
está vacía.

Usar saltos de página inteligentes y hoja de estilos de usuario

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties panel provides
the following functionalities (see figure_composer_html_breaks):

• Activar Usar saltos de página inteligentes para impedir para evitar que el contenido del marco html de
romper a mitad de camino una línea de texto por lo que continúa agradable y sencillo en el cuadro siguiente.
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Figure 14.46: HTML frame, Use smart page breaks and User stylesheet properties

• Establecer la Máxima distancia permite en el cálculo de dónde colocar los saltos de página en el html. Esta
distancia es la cantidad máxima de espacio vacío permitido en la parte inferior de un marco después de
calcular la ubicación óptima de descanso. Ajustar un valor más grande resultará en una mejor elección de
la ubicación de salto de página, pero más espacio perdido en la parte inferior de los marcos. Esto sólo se
utiliza cuando Usar saltos de página inteligentes está activado.

• Activar Hoja de estilos de usuario para aplicar estilos HTML que a menudo se proporciona en hojas de
estilo en cascada. Un ejemplo de código de estilo se proporciona a continuación para establecer el color de
la etiqueta <h1> a verde y establecer el tipo de letra y tamaño de texto incluido en las etiquetas del párrafo
<p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Utilice el botón [Actualizar HTML] para ver el resultado de la configuración de la hoja de estilo.

14.2.9 Elementos de Forma

The Arrow Item

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties panel.

Si mantiene pulsada la tecla Shift mientras coloca la flecha, esta es colocada en un ángulo de exactament 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see El elemento imagen).

Propiedades del elemento

The Arrow item properties panel allows you to configure an arrow item.

The [Line style...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default: To draw a regular arrow, gives you options to style the arrow head

• None: To draw a line without arrow head
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Figure 14.47: Arrow Item Properties Panel

• SVG Marker: To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.

• Color de línea exterior de flecha : establece el color de línea exterior de la punta de la flecha

• Arrow fill color: Set the fill color of the arrow head

• Arrow outline width: Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker: Choose an SVG image to draw at the beginning of the line

• End marker: Choose an SVG image to draw at the end of the line

• Arrow head width: Set the size of Start and/or End marker

SVG images are automatically rotated with the line. Outline and fill colors of QGIS predefined SVG images can
be changed using the corresponding options. Custom SVG may require some tags following this instruction.

Los Elementos de Forma Básica

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon, place the element holding down
the left mouse. Customize the appearance in the Item Properties panel.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

The Shape item properties panel allows you to select if you want to draw an ellipse, rectangle or triangle inside
the given frame.
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Figure 14.48: Shape Item Properties Panel

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers...

For the rectangle shape, you can set the value of the corner radius to round of the corners.

Nota: Unlike other items, you can not style the frame or the background color of the frame.

The Node-Based Shape Items

While arrow and basic shape items offer you simple and predefined geometric item to use, a node-based shape
(polygon or polyline) helps you create a custom and more advanced geometric item. You can add as many lines
or sides as you want to the item and independently and directly interact with each of its vertices.

To add a node-based shape, click the Add nodes item icon. Then perform left clicks to add nodes to your current
shape. When you’re done, a simple right click terminates the shape. Customize the appearance in the Item
Properties panel.

Figure 14.49: Nodes Shape Item Properties Panel

You can set the style of the shape using the advanced symbol style dialog available thanks to the [Change...]
button in Main properties.

A specific tool is provided to edit node-based shapes through Edit Nodes Item. Within this mode, you can select
a node by clicking on it (a marker is displayed on the selected node). A selected node can be moved either by
dragging it or by using the arrow keys. Moreover, in this mode, you are able to add nodes to an existing shape.
You just have to do a left click near a segment and if you are not too far from the shape, a node is added. Finally,
you can remove the currently selected node by hitting the DEL key.
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14.3 Crear salida

Figure_composer_output shows el diseñador de impresión con un diseño de ejemplo de impresión, incluyendo
cada tipo de elemento del mapa descrito en los apartados anteriores.

Figure 14.50: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View → Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

14.3.1 Export as Image

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in the case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.
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You can then override the print resolution (set in Composition panel) and resize exported image dimensions.

By checking Crop to content option, the images outputted by the composer will include only the area of the
composition with content. There’s also an option for margins to add around the item bounds if required.

If the composition includes a single page, then the output will be sized to include EVERYTHING on the compo-
sition. If it’s a multi-page composition, then each page will be cropped to only include the area of that page with
items.

Figure 14.51: Opciones de Exportación de Imagen

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable
this feature under the Composition Panel.

If the output format is a TIFF format, all you need to do is making sure to select the correct map item to use in

Reference map, and the output will always be a GeoTIFF. For other image formats, you also need to check

the Save world file option. With this option, the ‘Export as image’ action will create a world file along with
the exported image.

Nota: Exporting large rasters can sometimes fail, even if there seems to be enough memory. This is a problem
with the underlying Qt management of rasters.

14.3.2 Exportar como SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi_page

composition) and then can apply Crop to content option.

The SVG export options dialog also allows to:

• export map layers as svg groups:

• render map labels as outlines

Nota: Actualmente, la salida SVG es muy básica. Este no es un problema en QGIS, pero un problema con la
biblioteca Qt subyacente. Esperamos que esto se solucione en futuras versiones.

14.3.3 Exportar como PDF

The Export as PDF exports all the composition into a single PDF file.
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Figure 14.52: Opciones de Exportación de SVG

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency or
symbol effects, these cannot be printed as vectors, and the effects may be lost. Checking Print as a raster in the
Composition Panel helps to keep the effects but rasterize the composition. Note that the Force layer to render as
raster in the Rendering tab of Layer Properties dialog is a layer-level alternative that avoids global composition
rasterization.

If you need to export your layout as a georeferenced PDF, in the Composition Panel, make sure to select the

correct map item to use in Reference map.

14.3.4 Generar un Atlas

El Diseñador de impresión incluye funciones de generación que le permiten crear libros de mapas de una forma
automática. El concepto es el uso de una capa de cobertura, que contiene geometrías y campos. Para cada
geometría en la capa de cobertura, se generará una nueva salida en la que el contenido de algunos lienzos de
mapas se moverán para resaltar la geometría actual. Los campos asociados con esta geometría se pueden utilizar
dentro de etiquetas de texto.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation panel.This panel contains the following widgets (see figure_composer_atlas):

Figure 14.53: Atlas Generation Panel

• Generar un atlas, que activa o desactiva la generación del atlas.

276 Chapter 14. Diseñadores de impresión



QGIS User Guide, Publicación 2.18

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• Una área de texto opcional Filtrar con que le permitirá especificar una expresión para filtrar objetos espa-
ciales de la capa de cobertura. Si la expresión no esta vacía, solo los objetos espaciales que evalúa a True
serán seleccionados. El botón de la derecha le permitirá desplegar el constructor de expresión.

• Una opcional Ordenado por que, si es marcada le permite ordenar objetos espaciales de la capa de
cobertura. La lista asociada le permite elegir que columna se utilizará como clave de clasificación. El orden
de clasificación (ascendente o descendente) se establece mediante un botón de dos estados que muestran
una flecha hacia arriba o hacia abajo.

You also have options to set the output of the atlas:

• Una caja de texto Expresión de nombre de archivo de salida que se utiliza para generar un nombre de archivo
para cada geometría si es necesario. Se basa en expresiones. Este campo es significativo solo para presentar
múltiples archivos.

• Una Exportación a un solo archivo cuando sea posible que permita forzar la generación de un solo
archivo si es posible con el formato de salida elegido (PDF, por ejemplo). Si este campo es activado, el
valor del campo Expresión de nombre de archivo de salida no tiene sentido.

Se puede utilizar múltiples elementos de mapa con la generación de atlas; cada mapa será representado de acuerdo
a los objetos espaciales de cobertura. Para habilitar la generación de atlas para un elemento de mapa especifico, es

necesario comprobar Controlado por Atlas bajo las propiedades del elemento de un elemento mapa. Una vez
marcado se puede establecer:

• Un botón de radio Margen alrededor del objeto espacial que le permite seleccionar la cantidad de espacio
añadido alrededor de cada geometría dentro del mapa asignado. Su valor es significativo sólo cuando utiliza
el modo auto escala.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project → Project Properties → General → Project Scales to configure
these predefined scales).

• Una Escala fija que le permite cambiar entre modo auto-escala y escala fija. En el modo de escala fija,
el mapa sólo se traducirá para cada geometría de estar centrado. En el modo de auto escala, la extensión del
mapa se calcula de tal manera que cada geometría aparecerá en su totalidad.

Etiquetas

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

or, another combination:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. Both expressions
would result in the generated atlas as:
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The area of PARIS,75001 is 1.94 km2

Botones de anulación de datos definidos.

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition panel for field Presets.

Con un botón Anulación definida por datos se puede establecer dinámicamente la orientación del papel. Cuando
la altura (norte-sur) de las extensiones de una región es más grade que el ancho (este-oeste). que más bien desea
utilizar la orientación vertical en lugar de horizontal para optimizar el uso del papel.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Utilizar el botón de campo Altura para proporcionar la siguiente impresión:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use the Data Defined Override option.

Previsualizar y generar

Figure 14.54: Barra de herramienta Vista Previa del Atlas

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:
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• First feature

• Previous feature

• Next feature

• Last feature

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Crear salida for more information).
Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Truco: Print a specific atlas feature
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 15

Trabajar con datos OGC

15.1 QGIS como Cliente de Datos OGC

El Open Geospatial Consortium (OGC) es una organización internacional con miembros de más de 300 organi-
zaciones comerciales, gubernamentales, sin fines de lucro y de investigación de todo el mundo. Sus miembros
desarrollan e implementan estándares para contenido geoespacial y servicios, procesamiento de datos SIG y el
intercambio.

Al describir un modelo de datos básico para las características geográficas, un número cada vez mayor de las es-
pecificaciones son desarrollados por OGC para atender las necesidades específicas de ubicación interoperable y la
tecnología geoespacial, incluyendo SIG. Más información se puede encontrar en http://www.opengeospatial.org/.

Importar especificaciones OGC implementadas por QGIS:

• WMS — Web Map Service (Cliente WMS/WMTS)

• WMTS — Web Map Tile Service (Cliente WMS/WMTS)

• WFS — Web Feature Service (Cliente WFS y WFS-T)

• WFS-T — Web Feature Service - Transactional (Cliente WFS y WFS-T)

• WCS — Web Coverage Service (WCT Cliente)

• WPS — Web Processing Service

• CSW — Catalog Service for the Web

• SFS — Simple Features for SQL (PostGIS Layers)

• GML — Lenguaje de Marcado Generalizado

Los servicios de QGIS esta incrementando el uso para intercambiar datos geoespaciales entre diferentes imple-
mentaciones GIS y almacenes de datos. QGIS puede hacer frente a las especificaciones anteriores como un cliente,
siendo SFS (a través del apoyo del proveedor PostgreSQL / PostGIS, vea la sección PostGIS Layers).

15.1.1 Cliente WMS/WMTS

Información general de la implementación WMS

Actualmente QGIS puede actual como un cliente WMS que entiende servidores WMS 1.1, 1.1.1 y 1.3. En partic-
ular, se ha probado contra los servidores de acceso público como DEMIS.

Un servidor WMS actúa sobre las peticiones por parte del cliente (por ejemplo, QGIS) para un mapa ráster con
una extensión dada, el conjunto de capas, el estilo de simbolización y la transparencia. El servidor WMS después
consulta sus fuentes de datos locales, rásteriza el mapa y lo envía de vuelta al cliente en formato ráster. Para QGIS,
este formato sería típicamente JPEG o PNG.

WMS es genéricamente un servicio REST (Representational State Transfer) en lugar de un servicio Web en toda
regla. Como tal, puede tomar las URLs generadas por QGIS y utilizarlos en el navegador web para recuperar las
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mismas imágenes que QGIS utiliza internamente. Esto puede ser útil para la solución de problemas, ya que hay
varias marcas de servidores WMS en el mercado y ellos tienen su propia interpretación de la estándar WMS.

Las capas WMS se pueden añadir sencillamente, siempre que conozca la URL para acceder al servidor WMS, si
tiene una conexión útil a ese servidor, y el servidor entiende HTTP como mecanismo de transporte de datos.

Además, QGIS cachea sus respuestas WMS (por ejemplo, imágenes) durante 24 horas siempre que la petición
GetCapabilities no se active. La petición GetCapabilities se activa cada vez que el botón [Conectar] en el diálogo
[Añadir capa(s) del servidor WMS(T)S] se utiliza para recuperar las capacidades del servidor WMS. Esta es
una característica automática la intención de optimizar el tiempo de carga del proyecto. si un proyecto se guarda
con una capa WMS, los tiles WMS correspondientes se cargarán del cache la siguiente vez que el proyecto se abra
mientras que no sea mayor a 26h.

Información general de la implementación WMTS

QGIS también puede actuar como un cliente WMTS. WMTS es un estándar OGC para distribuir tiles de conjunto
de datos geoespaciales. Este es una manera más rápida y más eficiente de distribuir datos que WMS porque con
WMTS, el conjunto de tile es pregenerado y el cliente sólo solicita la transmisión de los tiles, no su producción.
Una petición WMS implica típicamente ambos la generación y la transmisión de los datos. Un ejemplo bien
conocido de un estándar no OGC para la visualización de datos geoespaciales de tiles es Google Maps.

Para mostrar los datos en una variedad de escalas cercanas a lo que el usuario podría querer, los conjuntos de
teselas WMTS se producen en varios niveles de escala diferentes y están disponibles para el cliente SIG para
pedirlos.

Este diagrama ejemplifica el concepto de conjunto de teselas:

Figure 15.1: Concepto de conjunto de teselas WMTS

Los dos tipos de interfaz WMTS que QGIS reconoce son a través de Key-Value-Pairs (KVP) y RESTful. Estas
dos interfaces son diferentes y es necesario especificarlos a QGIS diferente.

1. Con el fin de acceder a un servicio WMTS KVP, un usuario QGIS debe abrir la interfaz WMS/WMTS y
añadir la siguiente cadena a la URL del servicio tile WMTS:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un ejemplo de este tipo de dirección es

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Para probar la capa topo2 en este WMTS funciona muy bien. Añadir esta cadena indica que un servicio
web WMTS se va a utilizar en lugar de un servicio WMS.

2. EL servicio RESTful WMTS toma una forma diferente, una URL sencilla. EL formato recomendado por
OGC es:
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{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Este formato le ayuda a reconocer que es una dirección RESTful. Un WMTS RESTful se ac-
cede en QGIS simplemente añadiendo su dirección en la configuración del WMS en el campo de la
URL del formulario. Un ejemplo de este tipo de dirección para un caso de mapa base austriaco es
http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Nota: Se pueden encontrar aun algunos viejos servicios llamados WMS-C. Estos servicios son simi-
lares a WMTS (por ejemplo, el mismo propósito pero trabajando un poco diferente). Se pueden admin-
istrar igual que se hace con los servicios WMTS. Sólo añada ?tiled=true al final de la url. Vea
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification para mayor información acerca de esta especificación.

Cuando se lee WMTS, a menudo se puede pensar en WMS-C también.

Seleccionar servidor WMS/WMTS

La primera ves que utiliza la característica WMS en QGIS, no hay servidores definidos.

Comience haciendo clic en el botón Añadir capa WMS en la barra de herramientas, o seleccionando Capa →
Añadir capa WMS....

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some
servers to play with by clicking the [Add default servers] button. This will add two WMS demo servers for
you to use: the WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the
Layers tab, select the [New] button. Then enter the parameters to connect to your desired WMS server, as listed
in table_OGC_wms:

Nombre Un nombre para esta conexión. Este nombre se utilizará en la lista desplegable de
conexiones a servidor así que se puede distinguir de otros servidores WMS.

URL La URL del servidor provee los datos. Este debe ser un nombre de host soluble – el
mismo formato que usaría para abrir una conexión telnet o ping a un host.

Nombre de
usuario

Nombre de usuario para acceder a un servidor asegurado de WMS. Este parámetro es
opcional.

Contraseña Contraseña para una autentificación básica al servidor WMS. Este parámetro es opcional

Ignorar URI
GetMap

Ignorar URI GetMap reportada en las capacidades. Utilice un URI dado del campo
URL anterior.

Ignorar la URI
GetFeatureInfo

Ignorar la URI GetFeatureInfo reportada en las capacidades. Utilice un URI dado
del campo URL anterior.

Tabla OGC 1: Parámetros de conexión WMS

Si necesita configurar un servidor proxy para poder recibir servicios WMS de internet, puede añadir su servidor
proxy en las opciones. Elija Configuración → Opciones y haga clic en la pestaña Red. Ahí, puede añadir su

configuración de proxy y habilitarlos al ajustar Usar proxy para acceso web. Compruebe que selecciono el

tipo de proxy correcto del menú desplegable Tipo de proxy .

Una vez que la nueva conexión al servidor WMS ha sido creada, será preservado para futuras sesiones.

Truco: En las direcciones URL del servidor WMS
Asegúrese, al introducir la URL del servidor WMS, que tiene solo la base URL. Por ejemplo, no debe tener
fragmentos como request=GetCapabilities o version=1.0.0 en su URL.

Advertencia: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistema de autenticación for more details.
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Cargando capas WMS/WMTS

Una vez que haya llenado exitosamente en sus parámetros, puede utilizar el botón [Conectar] para recuperar
las capacidades del servidor seleccionado. Esto incluye la codificación de la imagen, capas, estilos de capa y
proyecciones. Como es una operación de la red, la velocidad de respuesta depende de la calidad de la conexión de
red al servidor WMS. Mientras descarga los datos desde el servidor WMS, el proceso de descarga se visualizara
en la parte inferior izquierda del dialogo WMS.

Your screen should now look a bit like figure_OGC_add_wms, which shows the response provided by the Euro-
pean Soil Portal WMS server.

Figure 15.2: El diálogo para añadir un servidor WMS, muestra las capas disponibles

Codificación de la Imagen

La sección Codificación de la imagen lista los formatos que reconoce por ambos el cliente y el servidor. Elija uno
dependiendo de sus requerimientos de precisión de imagen.

Truco: Codificación de la Imagen
Normalmente, encontrará que un servidor WMS le ofrece la opción de codificación de la imagen en JPEG o PNG.
JPEG es un formato de compresión con pérdida, mientras que PNG reproduce fielmente los datos crudos raster.

Utilizar JPEG si se espera que los datos WMS sean de naturaleza fotográfica y/o no le importa cierta perdida de
calidad de la imagen. Esta disyuntiva típicamente reduce en cinco veces la necesidad de transferencia de datos en
comparación con PNG.

Utilice PNG si desea representaciones precisas de los datos originales y no le importa el incremento de los requi-
sitos de transferencia de datos.
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Opciones

La zona Opciones del diálogo provee un campo de texto donde se puede añadir un Nombre de capa para la capa
WMS. Este nombre aparecerá en la leyenda después de cargar la capa.

Debajo del nombre de la capa, se puede definir Tamaño de la tesela, si desea establecer tamaños de tesela (por
ejemplo, 256x256) para dividir la petición WMS en múltiples peticiones.

El Límite del objeto espacial para GetFeatureInfo define los objetos espaciales del servidor a consultar.

Si se selecciona un WMS de la lista, aparece un campo con la proyección predeterminada proporcionada por el
servidor de mapas. Si el botón [Cambiar...] está activo, puede hacer clic en él y cambiar la proyección por defecto
de los WMS a otro SRC proporcionado por el servidor WMS.

Finalmente puede activar Utiliza leyenda-WMS contextual si el servidor WMS admite este objeto. Entonces
sólo la leyenda relevante para su actual extensión de vista de mapa se mostrará y así no incluirá los elementos de
la leyenda por cosas que no puede ver en el mapa actual.

Orden de la capa

La pestaña Orden de Capas lista las capas seleccionadas disponibles de la conexión actual al servidor WMS.
Puede notar que algunas capas son ampliables; esto significa que la capa se puede visualizar en una selección de
estilos de imagen.

Se puede seleccionar varias capas a la vez, pero solo una imagen de estilo por capa. Cuando varias capas son
seleccionadas, estas se combinarán en el servidor WMS y se transmitirán a QGIS una sola vez.

Truco: Ordenar capas WMS
Las capas WMS representadas por un servidor son sobrepuestas en el orden listado en la sección de Capas, desde
la parte superior a la parte inferior de la lista. Si se desea cambiar el orden de la superposición, se puede usar la
pestaña Orden de capas.

Transparencia

En esta versión de QGIS, la configuración Transferencia global de Propiedades de la capa esta codificado para
estar siempre en donde este disponible.

Truco: Transparencia de capa WMS
La disponibilidad de imagen WMS transparente depende de la codificación de la imagen utilizada: PNG y GIF
reconoce la transparencia, mientras JPEG deja sin reconocerlo.

Sistema de referencia de coordenadas

Un sistema de referencia de coordenadas (SRC) es la terminología para una proyección QGIS.

Cada capa WMS se puede representar en múltiples SRC’s, dependiendo de la capacidad del servidor WMS.

To choose a CRS, select [Change...] and a dialog similar to Diálogo SRC Personalizado will appear. The main
difference with the WMS version of the dialog is that only those CRSs supported by the WMS server will be
shown.

Busqueda del servidor

Within QGIS, you can search for WMS servers. Figure_OGC_search shows the Server Search tab with the Add
Layer(s) from a Server dialog.

Como puede ver, es posible ingresar una cadena de búsqueda en el campo de texto y golpear el botón [Búsqueda].
Después de un rato, el resultado de la búsqueda se completa automáticamente en la lista debajo del campo de
texto. Examine la lista de resultados e inspeccione sus resultados dentro de la tabla. Para visualizar los resultados,
seleccione una entrada de la tabla y pulse el botón [Añadir fila seleccionada a la lista WMS] y cambie de
nuevo a la pestaña Capas. QGIS ha actualizado automáticamente su lista de servidores y el resultado de búsqueda
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Figure 15.3: Diálogo de búsqueda de servidores WMS después de algunas palabras clave

seleccionado ya esta activada en la lista de servidores WMS guardada en la pestaña Capas. Sólo tiene que solicitar
la lista de capas haciendo clic en el botón [Conectar]. Esta opción es muy útil cuando se desea buscar mapas por
palabras clave especificas.

Básicamente, esta opción es una interfaz del API de http://geopole.org.

Conjunto de teselas

Al utilizar servicios WMTS (Cached WMS) como

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by

selecting View → Panels ( or Settings → Panels), then choosing Tile Scale Panel. This gives you the available
scales from the tile server with a nice slider docked in.

Utilizar la herramienta de Identificar objetos espaciales

Una vez que haya añadido un servidor WMS, y si alguna capa de un servidor WMS es consultable, puede entonces

utilizar la herramienta Identificar objetos espaciales para seleccionar un píxel del lienzo del mapa. Una consulta se
hace al servidor WMS por cada selección realizada. El resultado de la consulta es regresada en texto plano. El
formato de este texto es dependiente del servidor WMS particular utilizado. Selección de Formato

Si múltiples formatos de salida son reconocidos por el servidor, una lista desplegable con formatos admitidos se
añade automáticamente al diálogo de resultados identificados y el formato seleccionada puede ser almacenado en
el proyecto para la capa. Usar formato GML
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La herramienta Identificar reconoce la respuesta del servidor WMS (GetFeatureInfo) en formato GML (se llama
Objeto espacial en la GUI de QGIS en este contexto). Si el formato “Objeto espacial” es admitido por el servidor y
seleccionado, los resultados de la herramienta de identificador son objetos vectoriales, como de una capa vectorial
regular. Cuando un objeto espacial es seleccionado en el árbol, este resalta en el mapa y se puede copiar a la
papelera y pegar a otra capa vectorial. Vea el ejemplo de configuración de UMN Mapserver abajo que admite
GetFeatureInfo en formato GML.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Ver propiedades

Una vez que haya añadido un servidor WMS, puede ver sus propiedades haciendo clic derecho sobre el mismo en
la leyenda y la seleccionar Propiedades. Pestaña de Metadatos

La pestaña Metadatos muestra una gran cantidad de información acerca del servidor WMS, generalmente obtenida
de la declaración de capacidades de ese servidor. Muchas definiciones pueden ser extraídas mediante la lectura
del estándar WMS (vea OPEN-GEOSPATIAL-CONSORTIUM en Referencias bibliográficas y web), pero aquí
hay algunas definiciones útiles:

• Propiedades del servidor

– Versión WMS — La versión WMS implementada por el servidor.

– Formatos de Imagen — La lista de MIME-types que el servidor puede responder con la elaboración
del mapa. QGIS reconoce cualquier formato las bibliotecas Qt subyacentes con que fueron constru-
idas, que es típicamente por lo menos image/png y image/jpeg.

– Formato de Identificación — La lista de tipos MIME, el servidor puede responder, cuando utilice la
herramienta de Identificación. Actualmente, QGIS reconoce el tipo texto plano.

• Propiedades de la capa

– Seleccionar — Sea o no esta capa seleccionada cuando su servidor fue añadido a este proyecto.

– Visible — Si la capa seleccionada es o no visible en la leyenda (aun no utilizada en esta versión de
QGIS).

– Poder Identificar — Sea o no esta capa regresará algunos resultados cuando la herramienta de iden-
tificar se utilice en él.

– Puede ser transparente — Si esta capa puede ser representada o no con transparencia. Esta versión de
QGIS siempre usará transparencia si este es Si y la codificación de la imagen admite la transparencia.
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– ** Puede Acercar zum ** — Si en esta capa se puede o no hacer zum en el servidor. Esta versión
de QGIS asume que todas las capas WMS tienen este conjunto de Si. Capas deficientes pueden ser
presentadas de manera extraña.

– Conteo en Cascada — Los servidores WMS pueden actuar como proxy para otros servidores WMS
para obtener datos ráster de una capa. Esta entrada muestra el número de veces que se remitió la
solicitud de esta capa para ver a los servidores WMS para obtener un resultado.

– Ancho fijo, altura fija — Si esta capa o no tiene fijas las dimensiones en píxeles de origen. Esta
versión de QGIS asume que todas las capas WMS tienen este conjunto a nada. Capas deficientes
pueden ser presentadas de forma extraña.

– Recuadro delimitador WGS 84 — El recuadro delimitador de la capa, en coordenadas WGS 84.
Algunos servidores WMS no establecen esto correctamente (por ejemplo, utilizan coordenadas UTM
en su lugar). Si éste es el caso, entonces la vista inicial de la capa puede aparecer muy ‘lejana’
en QGIS. El webmaster de WMS debería ser informado de este error, que probablemente conocen
como los elementos XML de WMS LatLonBoundingBox, EX_GeographicBoundingBox o
el BoundingBox‘ de CRS:84.

– Disponible en SRC — Las proyecciones que esta capa puede representar por el servidor WMS. Éstos
se enumeran en el formato nativo de WMS.

– Disponible en estilo — Los estilos de imagen que esta capa puede representar por el servidor WMS.

Mostrar leyenda gráfica WMS en la tabla de contenido y diseñador de impresión

El proveedor de datos WMS de QGIS es capaz de mostrar una leyenda gráfica en la tabla de contenido de la
lista de capas y en el diseñador de mapas. La leyenda WMS se muestra sólo si el servidor WMS tiene capacidad
GetLegendGraphic y la capa tiene url de getCapability especificada, por lo que, además, es necesario seleccionar
un estilo para la capa.

Si hay definida una legendGraphic, ésta se mostrará debajo de la capa. Es pequeña y hay que hacer clic sobre ella
para abrirla en tamaño real (debido a una limitación de la arquitectura de QgsLegendInterface). Al hacer clic en
la leyenda de la capa se abrirá un cuadro con la leyenda a la máxima resolución.

En el diseñador de impresión, la leyenda se integrará en la dimensión original (descargada). La resolución de la
gráfica de la leyenda se puede configurar en las propiedades del elemento bajo Leyenda–> LegendGraphic WMS
para que coincida con los requisitos de impresión

La leyenda mostrará información contextual basada en su escala actual. La leyenda WMS se muestra sólo si el
servidor WMS tiene capacidad GetLegendGraphic y la capa tiene definida una url getCapability, para lo que se
debe seleccionar un estilo.

Limitaciones del cliente WMS

No es posible la funcionalidad de cliente WMS que se ha incluido en esta versión de QGIS. Algunas de las
excepciones más notables siguen.

Editar la configuración de la capa WMS

Una vez que haya completado el procedimiento de Añadir capa WMS, no se podrá cambiar la configuración. Una
solución alternativa es eliminar la capa por completo y empezar de nuevo.

**Autentificación necesaria en servidores WMS **

Actualmente, se admiten servicios WMS públicamente accesibles y garantizados. Los servidores WMS garantiza-
dos se puede acceder mediante autenticación pública. El usuario puede agregar las credenciales (opcional) cuando
agregue un servidor WMS. Vea la sección :ref: ogc-wms-servers para más detalles.

Truco: Acceso garantizado a capas OGC
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Si necesita acceder a capas protegidas mediante métodos seguros que no sean la autenticación básica, puede
utilizar InteProxy como un proxy transparente, lo que lo hace compatible con varios métodos de autenticación.
Puede encontrar más información en el manual InteProxy en http://inteproxy.wald.intevation.org.

Truco: QGIS WMS Mapserver
Desde la versión 1.7.0, QGIS tiene su propia implementación de un servidor de mapas WMS 1.3.0. Lea más sobre
esto en el capítulo QGIS como Servidor de Datos OGC.

15.1.2 WCT Cliente

Un Web Coverage Service (WCS) proporciona acceso a los datos ráster en formas que son útiles para la
representación del lado cliente, como datos de entrada en los modelos científicos, y para otros clientes. El WCS
se puede comparar con la WFS y el WMS. Como WMS y WFS instancias de servicios, un WCS permite a los
clientes elegir partes de las explotaciones de información de un servidor basado en restricciones espaciales y otros
criterios de consulta.

QGIS tiene un proveedor WCS nativo y reconoce ambas versiones 1.0 y 1,1 (que son significativamente difer-
entes), pero actualmente se prefiere 1.0, porque 1.1 tiene muchos problemas (por ejemplo, cada servidor lo imple-
menta de diferente forma con varias particularidades).

El proveedor de WCS nativo se encarga de todas las solicitudes de red y utiliza las configuraciones de red estándar
de QGIS (especialmente de proxy). También es posible seleccionar el modo de caché ( ‘siempre caché’, ‘prefer-
entemente caché’, ‘preferentemente red’, ‘siempre red’ ). El proveedor también es compatible con la selección de
tiempo de la posición, si el servidor ofrece el dominio temporal.

Advertencia: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistema de autenticación for more details.

15.1.3 Cliente WFS y WFS-T

En QGIS, una capa WFS funciona prácticamente como cualquier otra capa vectorial. Puede identificar y se-
leccionar objetos espaciales, y ver la tabla de atributos. Desde QGIS 1.6, la edición WFS-T está también de
reconocida.

En general, añadir una capa WFS es muy similar al procedimiento utilizado con WMS. La diferencia es que no
hay servidores por defecto definidos, así que tenemos que añadir la nuestra.

Cargar una capa WFS

Como un ejemplo, utilizamos el servidor WFS de DM Solutions y mostramos una capa. La URL es
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Haga clic en la herramienta Añadir capa WFS en la barra de herramientas Capas. El diálogo Añadir capa
WFS de un servidor aparecera.

2. Haga clic en [Nuevo].

3. Ingrese ‘DS Solutions’ como nombre.

4. Introducir la URL (véase más arriba).

5. Haga clic en [Aceptar].

6. Seleccione ‘DM Solutions’ de la lista desplegable Conexiones de servidor .

7. Haga clic en [Conectar]
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8. Espere a que la capa de capas este poblada.

9. Seleccione la capa Parks en la lista.

10. Haga clic en [Aplicar] para añadir la capa al mapa.

Tenga en cuenta que cualquier configuración de proxy que pueda haber establecido en sus preferencias también
son reconocidos.

In the WFS settings dialog, you can define the maximal number of features downloaded, set up the version, force
to Ignore axis orientation (WFS 1.1/WFS 2.0) and force Inverse axis orientation.

Advertencia: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project
file with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistema de autenticación for more details.

Figure 15.4: Añadir una capa WFS

Se dará cuenta el progreso de la descarga, se visualiza en la parte inferior izquierda de la ventana principal de
QGIS. Una vez cargada la capa, se puede identificar y seleccionar una provincia o dos y ver la tabla de atributos.

Nota: About differences between WFS versions
WFS 1.0.0, 1.1.0 and 2.0 are supported. Background download and progressive rendering, on-disk caching of
downloaded features and version autodetection are now supported.

Only WFS 2.0 service supports GetFeature paging.

Truco: Encontrar servidores WFS
Puede encontrar servidores WFS adicionales al utilizar Google o su buscador favorito. Hay un número de listas
con URLs publicas, algunos son mantenidos y otros no.

15.2 QGIS como Servidor de Datos OGC

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, imple-
ments advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Common Gateway
Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd). It has Python
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plugin support allowing for fast and efficient development and deployment of new features. The original develop-
ment of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For more detailed installation instructions on other platforms or distributions and more information on
working with QGIS Server, we recommend reading the QGIS Server Training Manual or server_plugins.

15.2.1 Empezando

Instalación

Debian/Ubuntu

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian Squeeze (or with negligible variations on Ubuntu 14.04). Many other OSs provide
packages for QGIS Server, too. If you have to build it all from source, please refer to the URLs given in QGIS
como Servidor de Datos OGC.

Firstly, add the following debian GIS repository:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

# Add keys
$ sudo gpg --keyserver keyserver.ubuntu.com --recv-key 3FF5FFCAD71472C4
$ sudo gpg --export --armor 3FF5FFCAD71472C4 | sudo apt-key add -

# Update package list
$ sudo apt-get update && sudo apt-get upgrade

Now, install QGIS Server:

$ sudo apt-get install qgis-server python-qgis

HTTP Server configuration

Apache

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html
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ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Now enable the virtual host and restart Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

NGINX

You can use QGIS Server with nginx.

On Debian based systems:

apt-get install nginx fcgiwrap

Introduce the following in your nginx server block configuration:

1 location ~ ^/cgi-bin/.*\.fcgi$ {
2 gzip off;
3 include fastcgi_params;
4 fastcgi_pass unix:/var/run/fcgiwrap.socket;
5

6 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
7 fastcgi_param QGIS_SERVER_LOG_FILE /logs/qgisserver.log;
8 fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
9 fastcgi_param QGIS_DEBUG 1;

10 }

As you can see from lines 6-9 you can add parameters in your location block in the form of fastcgi_param
param_name param_value, e.g. fastcgi_param DISPLAY ":99";.

The include fastcgi_params; is important as it adds the parameters from
/etc/nginx/fastcgi_params:

fastcgi_param QUERY_STRING $query_string;
fastcgi_param REQUEST_METHOD $request_method;
fastcgi_param CONTENT_TYPE $content_type;
fastcgi_param CONTENT_LENGTH $content_length;

fastcgi_param SCRIPT_NAME $fastcgi_script_name;
fastcgi_param REQUEST_URI $request_uri;
fastcgi_param DOCUMENT_URI $document_uri;
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fastcgi_param DOCUMENT_ROOT $document_root;
fastcgi_param SERVER_PROTOCOL $server_protocol;
fastcgi_param REQUEST_SCHEME $scheme;
fastcgi_param HTTPS $https if_not_empty;

fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;

fastcgi_param REMOTE_ADDR $remote_addr;
fastcgi_param REMOTE_PORT $remote_port;
fastcgi_param SERVER_ADDR $server_addr;
fastcgi_param SERVER_PORT $server_port;
fastcgi_param SERVER_NAME $server_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Prepare a project to serve

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

Advertencia: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file).
So, if you deploy a project on the server and the SVG files are not placed accordingly, the output images may
not respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to
the qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides
that points to the directory containing the SVG files (on Linux/Unix).

Capacidades WMS

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.
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Figure 15.5: Definitions for a QGIS Server WMS/WFS/WCS project
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You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Fine tuning your OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Herramientas de anotaciones section for instructions on creating annotations. For
annotations to be displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation
text dialog must be unchecked. This can be accessed by double clicking the annotation while one of the annotation
tools is active. For SVG annotations, you will need either to set the project to save absolute paths (in the General
menu of the Project → Project Properties dialog) or to manually modify the path to the SVG image so that it
represents a valid relative path.

Serve the project

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, we create a new
folder /usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a
copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Cargando capas
WMS/WMTS, Cliente WFS y WFS-T and WCT Cliente to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

15.2.2 Servicios

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.
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Web Map Service (WMS)

GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• DPI parameter: The DPI parameter can be used to specify the requested output resolution.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• IMAGE_QUALITY parameter is only used for JPEG images. By default, the JPEG compression is -1.
You can change the default per QGIS project in the OWS Server → WMS capabilities menu of the Project
→ Project Properties dialog. If you want to override it in a GetMap request you can do it using the
IMAGE_QUALITY parameter:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/jpeg&IMAGE_QUALITY=65&...

• image/png; mode= can be used to override the png format. You can choose between image/png;
mode=16bit, image/png; mode=8bit and image/png; mode=1bit. This can shrink the out-
put image size quite a bit. Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/png; mode=8bit&...

• OPACITIES parameter: Opacity can be set on layer or group level. Allowed values range from 0 (fully
transparent) to 255 (fully opaque).

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: Subsets of layers can be selected with the FILTER parameter. Syntax is basically
the same as for the QGIS subset string. However, there are some restrictions to avoid SQL injections into
databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes) A
space between each word / special character is mandatory. Allowed Keywords and special characters are
‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not allowed

Example:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: The SELECTION parameter can highlight features from one or more layers. Vec-
tor features can be selected by passing comma separated lists with feature ids in GetMap and GetPrint.

Example:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...

The following image presents the response from a GetMap request using the SELECTION option e.g.
http://myserver.com/...&SELECTION=countries:171,65. As those features id’s corre-
spond in the source dataset to France and Romania they’re highlighted in yellow.
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Figure 15.6: Server response to a GetMap request with SELECTION parameter
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It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parámetros:

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.

• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

GetFeatureInfo

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

GetPrint

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Ejemplo:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.
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• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS
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Web Feature Service (WFS)

GetFeature

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Nota:
You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable
where to find the QGIS project file. This variable will be the location where QGIS will look for the
project file. If not defined it will use the MAP parameter in the request and finally look at the server
executable directory.

the first feature, skipping none.

REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server
over the standard returned image (map). This permits the user to put emphasis or maybe add some comments
(labels) to some areas, locations etc. that are not in the standard map.

The request is in the format:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetMap
...
&HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000 5647000, 590000 5647000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name><FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5
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Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal
map:

Figure 15.7: Server response to a GetMap request with redlining parameters

You can see there are several parameters in this request:

• HIGHLIGHT_GEOM: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart
geometries. Here is an example: HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1)).
The coordinates should be in the CRS of the GetMap/GetPrint request.

• HIGHLIGHT_SYMBOL: This controls how the geometry is outlined and you can change the stroke width,
color and opacity.

• HIGHLIGHT_LABELSTRING: You can pass your labeling text to this parameter.

• HIGHLIGHT_LABELSIZE: This parameter controls the size of the label.

• HIGHLIGHT_LABELCOLOR: This parameter controls the label color.

• HIGHLIGHT_LABELBUFFERCOLOR: This parameter controls the label buffer color.

• HIGHLIGHT_LABELBUFFERSIZE: This parameter controls the label buffer size.
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15.2.3 Plugins

Instalación

To install the HelloWorld example plugin for testing the servers, you firstly have to create a directory to hold server
plugins. This will be specified in the virtual host configuration and passed on to the server through an environment
variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
# In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

HTTP Server configuration

Apache

To be able to use server plugins, FastCGI needs to know where to look. So, we have to modify the Apache
configuration file to indicate the QGIS_PLUGINPATH environment variable to FastCGI:

FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

Moreover, a basic HTTP authorization is necessary to play with the HelloWorld plugin previously introduced. So
we have to update the Apache configuration file a last time:

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

A continuación, reinicie Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Truco: If you work with a feature that has many nodes then modifying and adding a new feature will fail. In this
case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

How to use a plugin

Test the server with the HelloWorld plugin:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

Se puede echar un vistazo al GetCapabilities predeterminado del servidor QGIS en :
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities
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15.2.4 Canfiguración avanzada

Registro

To log requests sent to the server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that the server has proper permis-
sions for writing to file. File should be created automatically, just send some requests to server. If it’s not
there, check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. Available values are:

– 0 INFO (log all requests),

– 1 ADVERTENCIA,

– 2 CRITICAL (log just critical errors, suitable for production purposes).

Ejemplo:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Nota:
• When using Fcgid module use FcgidInitialEnv instead of SetEnv!

• Server logging is also enabled if executable is compiled in release mode.

Variables de entorno

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that server has proper permissions
for writing to file. File should be created automatically, just send some requests to server. If it’s not there,
check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See Registro

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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• DEFAULT_DATUM_TRANSFORM: Define datum transformations between two projections, e.g.
EPSG:21781/EPSG:2056/100001/-1;EPSG:2056/EPSG:21781/-1/100001 sets the trans-
formation between CH1903 LV03 (EPSG:21781) and CH1903 LV95 (EPSG:2056) and vice versa. You
also need to place grid shift .gsb files in the directory where proj4 stores the grid shift files, e.g. in
/usr/share/proj. You need to run crssync after you added new .gsb files and look up the ID
in the srs.db. Look at attribute coord_op_code of table tbl_datum_transform in srs.db to find the
correct entry.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

Servidor QGIS soporta:

• short name line edits to layers properties You can change this by right clicking on a layer, choose Properties
→ Metadata tab → Description → Short name.

• WMS data dialog to layer tree group (short name, title, abstract)

By right clicking on a layer group and selecting the Set Group WMS data option you will get:

Figure 15.8: Set group WMS data dialog

• short name line edits to project properties - add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method

• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

You can choose a short name for the project root by going to Project properties → OWS Server → Service
capabilities → Short name.

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups or project it is used by QGIS Sever as the layer name.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the PostgreSQL Service connection file section)
you need to make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
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AllowOverride None
.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

$ sudo su
$ mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v

• On Fedora based systems:

$ sudo su
$ mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v
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CHAPTER 16

Trabajar con datos GPS

16.1 Plugin de GPS

16.1.1 ¿Qué es GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

Nota: QGIS supports also GNSS receivers. But we keep using the term GPS in this documentation.

16.1.2 Cargando datos GPS desde archivo

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• Herramientas GPS

• Create new GPX Layer

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Datos de ejemplo for more infor-
mation about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Figure 16.1: La ventana de diálogo Herramientas GPS

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

16.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

16.1.4 Importando datos GPS

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

16.1.5 Downloading GPS data from a device

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use
the Download from GPS tab of the GPS Tools dialog (see Figure_GPS_download). Here, we select the type of
GPS device, the port that it is connected to (or USB if your GPS supports this), the feature type that you want to
download, the GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Defining new device types).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• On Linux, this is something like /dev/ttyS0 or /dev/ttyS1.

• On Windows, it is COM1 or COM2.
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Figure 16.2: The download tool

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

16.1.6 Uploading GPS data to a device

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

16.1.7 Defining new device types

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.

Once you have created a new device type, it will appear in the device lists for the download and upload tools.
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16.1.8 Download of points/tracks from GPS units

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

After that is necessary to be sure that the garmin_gps kernel module is not loaded

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (only Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Use same command (or settings if you use GPSBabel GUI) as in Windows. On Linux it maybe somehow common
to get a message like

skytraq: Too many read errors on serial port

it is just a matter to turn off and on the datalogger and try again.

BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

Nota: Se necesita instalar los controladores antes de usarlo en Windows 7. Vea el sitio del fabricante para la
descarga apropiada.

Downloading with GPSBabel, both with USB and BT returns always an error like

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1
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Ubuntu/Mint GNU/Linux

Con USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Con Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

16.2 Seguimiento de GPS en Vivo

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

There are four possible screens in this GPS tracking window:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Advertencia: If you want to record your position to the canvas, you have to create a new vector layer first
and switch it to editable status to be able to record your track.

16.2.1 Posición y atributos adicionales

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

16.2.2 Fuerza de la señal GPS

Here, you can see the signal strength of the satellites you are receiving signals from.

16.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Figure 16.3: GPS tracking position and additional attributes

Figure 16.4: GPS tracking signal strength
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Figure 16.5: GPS tracking polar window

16.2.4 Opciones GPS

In case of connection problems, you can switch between:

• Autodetect

• Internal

• Serial device

• gpsd (selecting the Host, Port and Device your GPS is connected to)

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

16.2.5 Connect to a Bluetooth GPS for live tracking

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Remember the number of the COM port assigned to the GPS connection as resulting by the Bluetooth properties.

After the GPS has been recognized, make the pairing for the connection. Usually the authorization code is 0000.
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Figure 16.6: GPS tracking options window
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Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

16.2.6 Utilizando GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Para Windows la formas más fácil es usar un servidor en medio, en este caso GPSD, de manera

sudo apt-get install gpsd

Then load the garmin_gps kernel module

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

Y finalmente conectar con la herramienta de rastreo en vivo QGIS.

16.2.7 Using BTGP-38KM datalogger (only Bluetooth)

Using GPSD (under Linux) or GPSGate (under Windows) is effortless.

16.2.8 Using BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

Para USB

The live tracking works both with GPSD

gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

Para Bluetooth

The live tracking works both with GPSD

16.2. Seguimiento de GPS en Vivo 315

http://update.gpsgate.com/install/GpsGateClient.exe


QGIS User Guide, Publicación 2.18

gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).
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Sistema de autenticación

17.1 Authentication System Overview

Figure 17.1: Anatomy of authentication system

17.1.1 Authentication database

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at <user home>/.qgis2/qgis-auth.db.

This authentication database can be moved between QGIS installations without affecting other current QGIS user
preferences, as it is completely separate from normal QGIS settings. A configuration ID (a random 7-character
alphanumeric string) is generated when initially storing a configuration to the database. This represents the con-
figuration, thereby allowing the ID to be stored in plain text application components, (such as project, plugin, or
settings files) without disclosure of its associated credentials.

Nota: The parent directory of the qgis-auth.db can be set using the following environment variable,
QGIS_AUTH_DB_DIR_PATH, or set on the command line during launch with the --authdbdirectory
option.
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17.1.2 Contraseña maestra

To store or access sensitive information within the database, a user must define a master password. A new master
password is requested and verified when initially storing any encrypted data to the database. Only when sensitive
information is accessed is the user prompted for the master password, which is then cached for the remainder of
the session (until application is quit), unless the user manually chooses an action to clear its cached value. Some
instances of using the authentication system do not require input of the master password, such as when selecting an
existing authentication configuration, or applying a configuration to a server configuration (such as when adding
a WMS layer).

Figure 17.2: Input new master password

Nota: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Managing the master password

Once set, the master password can be reset; the current master password will be needed prior to resetting. During
this process, there is an option to generate a complete backup of the current database.

Figure 17.3: Restablecer contraseña maestra

If the user forgets the master password, there is no way to retrieve or override it. There is also no means of
retrieving encrypted information without knowing the master password.

If a user inputs their existing password incorrectly three times, the dialog will offer to erase the database.

17.1.3 Configuraciones de autenticación

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).
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Figure 17.4: Password prompt after three invalid attempts

Figure 17.5: Configurations editor
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Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

Figure 17.6: Adding config from within Configuration editor

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Métodos de autenticación).

17.1.4 Métodos de autenticación

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings → Options and, in the Authentication tab, click the [Installed plugins] button.

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Nota: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.
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Figure 17.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons

Figure 17.8: Available method plugins list

Figure 17.9: Basic HTTP authentication configs
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Figure 17.10: PKI paths authentication configs

Figure 17.11: PKI PKCS#12 file paths authentication configs

Figure 17.12: Stored Identity authentication configs
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17.1.5 Master Password and Auth Config Utilities

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

Figure 17.13: Menú utilidades

• Input master password:

– Opens the master password input dialog, independent of performing any authentication database com-
mand. Clear cached master password

– Unsets the master password if it has been set via input dialog. Reset master password

– Opens a dialog to change the master password (the current password must be known) and optionally
back up the current database.

• Clear cached authentication configurations: Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password: Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations: Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database: Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 17.14: DB erase verification menu

17.1.6 Using authentication configurations

Typically, an authentication configuration is selected in a configuration dialog for a network services (such as
WMS). However, the selector widget can be embedded anywhere authentication is needed or in non-core func-
tionality, like in third-party PyQGIS or C++ plugins.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
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found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

Figure 17.15: Authentication configuration selector with no authentication

Figure 17.16: Authentication configuration selector with selected config

17.1.7 Python bindings

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Consideraciones de Seguridad concerning Python access.

17.2 User Authentication Workflows

17.2.1 Autenticación HTTP(S)

One of the most common resource connections is via HTTP(S), e.g. web mapping servers, and authentication
method plugins often work for these types of connections. Method plugins have access to the HTTP request
object and can manipulate both the request as well as its headers. This allows for many forms of internet-based
authentication. When connecting via HTTP(S) using the standard username/password authentication method will
attempt HTTP BASIC authentication upon connection.

17.2.2 Database authentication

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9.

17.2.3 PKI authentication

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.
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Figure 17.17: Generic user workflow

Figure 17.18: Configuring a WMS connection for HTTP BASIC
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Figure 17.19: Configuring a Postgres SSL-with-PKI connection

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate Manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Nota: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Autoridades

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.
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Figure 17.20: PKI configuration workflow
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Figure 17.21: Opening the Certificate Manager

Figure 17.22: Editor de autoridades
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Figure 17.23: Dialogo de Información del certificado
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You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

Figure 17.24: Saving the trust policy changes

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Advertencia: Changing the default trust policy may result in problems with secure connections.

Figure 17.25: Authorities options menu

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

Figure 17.26: Import certificates dialog
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Nota: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identidades

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

Figure 17.27: Identities editor

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

17.2.4 Handling bad layers

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.
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Figure 17.28: PEM/DER identity import

Figure 17.29: PKCS#12 identity import

Figure 17.30: Handle bad layers with authentication
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If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

Figure 17.31: Editar ID de configuración de la autenticación

17.2.5 Changing authentication config ID

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid: This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files: If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

Figure 17.32: Changing a layer’s authentication config ID (unlocked yellow text field)
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Advertencia: Changing the auth config ID is considered an advanced operation and should only be done with
full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock the
ID’s text field prior to editing the ID.

17.2.6 Soporte de Servidor QGIS

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• La base de datos de autenticación necesita estar disponible

• Authentication database’s master password needs to be available

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Nota: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing.

17.2.7 excepciones de servidor SSL

Figure 17.33: excepción de servidor SSL

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Advertencia: You should not create an SSL server configuration unless you have complete knowledge of the
entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Nota: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.
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You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 17.34: Adición manual de configuración

Once an SSL configuration is saved to the database, it can be edited or deleted.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

17.3 Consideraciones de Seguridad

Once the master password is entered, the API is open to access authentication configs in the authentication
database, similar to how Firefox works. However, in the initial implementation, no wall against PyQGIS ac-
cess has been defined. This may lead to issues where a user downloads/installs a malicious PyQGIS plugin or
standalone app that gains access to authentication credentials.

The quick solution for initial release of feature is to just not include most PyQGIS bindings for the authentication
system.
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Figure 17.35: Adicionar configuración durante un error SSL

Figure 17.36: Configuración SSL existente
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Figure 17.37: Editar una configuración SSL existente

Another simple, though not robust, fix is to add a combobox in Settings → Options → Authentication (defaults to
“never”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Such an option’s setting would need to be saved in a location non-accessible to Python, e.g. the authentication
database, and encrypted with the master password.

• Another option may be to track which plugins the user has specifically

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

17.3.1 Limitaciones

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
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ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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CHAPTER 18

Integracion GRASS SIG

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Ref-
erencias bibliográficas y web). The integration consists of two parts: provider and plugin. The provider allows
to browse, manage and visualize GRASS raster and vector layers. The plugin can be used to create new GRASS
locations and mapsets, change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data
with more than 400 GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and
give some examples of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

18.1 Conjuntos de datos demostración

As an example, we will use the QGIS Alaska dataset (see section Datos de ejemplo). It includes
a small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS ‘Alaska’ dataset qgis_sample_data.zip from
http://qgis.org/downloads/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

18.2 Cargar capas ráster y vectorial de GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Truco: Cargando datos GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

18.3 Importar datos dentro de una UBICACIÓN DE GRASS medi-
ante arrastrar y soltar

This section gives an example of how to import raster and vector data into a GRASS mapset.
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1. In QGIS browser navigate to the mapset you want to import data into.

2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The import may take some time for larger layers, you will see
animated icon in front of new layer item until the import finishes.

When raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS
and the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab
in Opciones GRASS.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

18.4 Managing GRASS data in QGIS Browser

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

18.5 Opciones GRASS

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

18.6 Iniciar el complemento GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the GRASS menu (Plugins → GRASS) when you start the GRASS
plugin:

• Abrir directorio de mapas

• Nuevo directorio de mapas

• Cerrar directorio de mapas

• Abrir herramientas de GRASS

• Mostrar región actual de GRASS

• GRASS Options
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18.7 Abrir directorio de mapas

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.

18.8 LOCALIZACIÓN y DIRECTORIO DE MAPA GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Referencias bibliográficas y web). In
order to analyse vector and raster layers with GRASS modules, you generally have to import them into a GRASS
LOCATION. (This is not strictly true – with the GRASS modules r.external and v.external you can
create read-only links to external GDAL/OGR-supported datasets without importing them. This is not the usual
way for beginners to work with GRASS, therefore this functionality will not be described here.)

Figure 18.1: Datos GRASS en la LOCALIZACIÓN alaska

18.9 Importar datos dentro de una LOCALIZACIÓN DE GRASS

See section Importar datos dentro de una UBICACIÓN DE GRASS mediante arrastrar y soltar to find how data
can be easily imported by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Datos de ejemplo).

1. Inicie QGIS y asegúrese que el complemento GRASS está cargado.

2. En la barra de herramientas de GRASS, haga clic en el icono Abrir directorio de mapas para que aparezca el
asistente DIRECTORIO DE MAPA.

3. Seleccione como base de datos GRASS la carpeta grassdata en el conjunto de datos Alaska de QGIS,
como LOCALIZACIÓN ‘alaska’, como DIRECTORIO DE MAPA ‘demo’ y haga clic en [Aceptar].
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4. Ahora haga clic en el icono Abrir herramientas de GRASS. El diálogo de la caja de herramientas de GRASS
(vea la sección La caja de herramientas GRASS) aparece.

5. Para importar el mapa ráster landcover.img, haga clic en el modulo r.in.gdal en la pestaña
Árbol de módulos. Este modulo GRASS le permite importar archivos ráster GDAL-admitidos en un
LOCALIZACIÓN de GRASS. El diálogo del módulo para que r.in.gdal aparezca.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. Como nombre de salida del ráster, defina landcover_grass y haga clic en [Ejecutar].
en la pestaña Salida, y vea el comando GRASS actualmente ejecutado r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass.

8. Cuando dice Finalizado con éxito, haga clic en [Ver salida]. La capa ráster landcover_grass está
ahora importado en GRASS y se visualizará en el lienzo QGIS.

9. Para importar el archivo vector GML lakes.gml, haga clic en el modulo v.in.ogr en la pestaña Ár-
bol de módulos. Este modulo GRASS le permite importar archivos vectoriales OGR-admitidos en una
LOCAZACIÓN de GRASS. El diálogo del modulo para que v.in.ogr aparezca.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. Como nombre de salida del vector, define lakes_grass y haga clic en [Ejecutar]. No tiene que pre-
ocuparse por las otras opciones en este ejemplo. En la pestaña Salida se ve el comando GRASS ejecutado
actualmente v.in.ogr -o dsn=/path/to/lakes.gml output=lakes\_grass.

12. Cuando dice Finalizado con éxito, haga clic en [Ver salida]. La capa vectorial lakes_grass ahora es
importada a GRASS y se visualizará en el lienzo de QGIS.

18.9.1 Crear una nueva LOCALIZACIÓN GRASS

As an example, here is the sample GRASS LOCATION alaska, which is projected in the Albers Equal Area
projection using feet as units. This sample GRASS LOCATION alaska will be used for all examples and exer-
cises in the following GRASS-related sections. It is useful to download and install the dataset on your computer
(see Datos de ejemplo).

1. Inicie QGIS y asegúrese que el complemento GRASS está cargado.

2. Visualize the alaska.shp shapefile (see section Loading a layer from a file) from the QGIS Alaska
dataset (see Datos de ejemplo).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Seleccione un conjunto de datos GRASS existente (GISDBASE) la carpeta grassdata, o cree una para la
nueva LOCALIZACIÓN utilizando un administrador de archivos en su computadores. A continuación haga
clic en [Siguiente].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Añadir un
nuevo DIRECTORIO DE MAPA) or to create a new LOCATION altogether. Select Create new location
(see figure_grass_new_location).

6. Escriba un nombre para la LOZALIZACIÓN – usemos ‘alaska’ y haga clic en [Siguiente].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. Estamos usando la proyección Albers Equal Area Alaska (pies). Puesto que nos ha tocado saber que está
representado por el EPSG ID 2964, ingresamos en el cuadro de búsqueda. (Nota: Si desea repetir este
proceso para otra LOCALIZACIÓN y proyección y no ha memorizado el EPSG ID, haga clic en el icono

SRC actual en la esquina inferior derecha de la barra de estado (vea sección Trabajar con Proyecciones)).

9. En Filtrar, inserte 2964 para seleccionar la proyección.

10. Clic [Siguiente].
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11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Clic [Siguiente].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Referencias bibliográficas y web).

14. Revise el resumen para asegurarse que es correcto y haga clic en [Finalizar]

15. La nueva LOCALIZACIÓN, ‘alaska’, y los dos DIRECTORIO DE MAPAS, ‘demo’ y ‘PERMANENT’,
son creados. El conjunto de trabajo abierto actualmente es ‘demo’, como se ha definido.

16. Tenga en cuenta que algunas de las herramientas en la barra de herramientas de GRASS que estaban inhab-
ilitadas ahora están habilitadas.

Figure 18.2: Cree una nueva LOCALIZACIÓN GRASS o un nuevo DIRECTORIO DE MAPA en QGIS

Si eso parecía como una gran cantidad de pasos, en realidad no es tan malo y una forma muy rápida de crear
una LOCALIZACIÓN. La LOCALIZACIÓN ‘alaska’ ahora está listo para la importación de datos (vea la sección
Importar datos dentro de una LOCALIZACIÓN DE GRASS). También puede utilizar los datos ya existentes vec-
toriales y ráster en el ejemplo LOCALIZACIÓN ‘alaska’ de GRASS, incluido en el conjunto de datos ‘Alaska’ de
QGIS Datos de ejemplo, ya pasar a la sección El modelo de datos vectoriales de GRASS.

18.9.2 Añadir un nuevo DIRECTORIO DE MAPA

Un usuario sólo tiene acceso de escritura a un DIRECTORIO DE MAPA GRASS que él o ella crearon. Esto
significa que además de acceder a su propio DIRECTORIO DE MAPA, se pueden leer mapas de otros usuar-
ios’ DIRECTORIO DE MAPAS (y ellos pueden leer los tuyos), pero sólo puede modificar o eliminar su propio
DIRECTORIO DE MAPA.

Todos los DIRECTORIO DE MAPAS incluyen un archivo WIND que almacena los valores de las coordenadas de
los límites actuales y la resolución ráster actualmente seleccionado (vea Neteler & Mitasova 2008 en Referencias
bibliográficas y web, y la sección La herramienta de región GRASS).

1. Inicie QGIS y asegúrese que el complemento GRASS está cargado.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Seleccione la base de datos GRASS (GISDBASE) la carpeta grassdata con la LOCALIZACIÓN
‘alaska’, donde queremos añadir otro DIRECTORIO DE MAPA llamado ‘test’.

4. Clic [Siguiente].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_new_location) and
click [Next].
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6. Introduzca el nombre text para el nuevo DIRECTORIO DE MAPA. A continuación en el asistente, se ve
una lista de un existente DIRECTORIO DE MAPAS y titulares correspondientes.

7. Haga clic en [Siguiente], valide el resumen para asegurarse que todo es correcto y haga clic en [Finalizar]

18.10 El modelo de datos vectoriales de GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.

Además de los límites y centroides, un mapa vectorial también puede contener puntos y líneas. Todos estos
elementos geométricos se pueden mezclar en una vector y serán representados en diferentes denominadas ‘capas’
dentro de un mapa vectorial GRASS. Por lo que en GRASS, una capa no es un mapa vectorial o ráster pero un
nivel dentro de una capa vectorial. Esto es importante para distinguir cuidadosamente. (aunque es imposible
mezclar elementos, es inusual e incluso en GRASS, sólo se utiliza en casos especiales como análisis de redes
vectoriales. Usualmente, se debe preferir almacenar diferentes elementos geométricos en diferentes capas.)

Es posible almacenar varias ‘capas’ en un conjunto de datos vectoriales. Por ejemplo, campos, bosques y lagos se
pueden almacenar en un vector. Un bosque y lago adyacente pueden compartir el mismo límite, pero tienen tablas
de atributos separados. También es posible adjuntar atributos a límites. Un ejemplo podría ser el caso donde los
límites entre un lago y un bosque es una carretera, por lo que puede tener una tabla de atributos diferente.

La ‘capa’ del objeto espacial es definido por la ‘capa’ dentro de GRASS. ‘Capa’ es el número que define si hay más
de una capa dentro del conjunto de datos (por ejemplo, si la geometría es bosque o lago). Por ahora, sólo puede
ser un número. En el futuro, GRASS también implementara nombres como campos en la interfaz de usuario.

Los atributos se pueden almacenar dentro de la LOCALIZACIÓN en GRASS como dBase o SQLite3 o en tablas
de base de datos externa, por ejemplo, PostgreSQL, MySQL, Oracle, etc.

Los atributos en la tabla de base de datos están enlazadas a los elementos geométricos utilizando un valor ‘cate-
goría’.

‘Categoría’ (llave, ID) es un entero adjunto a la geometría primitiva, y se utiliza como el enlace a una columna
llave en la tabla de base de datos.

Truco: Aprendizaje del modelo vectorial GRASS
La mejor forma de aprender el modelo vectorial GRASS y sus capacidades es descargar uno de
los muchos tutoriales de GRASS donde el modelo vectorial se describe más profundo. Vea
http://grass.osgeo.org/documentation/manuals/ para más información, libros y tutoriales en varios idiomas.

18.11 Crear una nueva capa vectorial GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• Nueva Capa de Puntos

• Nueva Capa de Líneas

• Nueva capa de polígonos

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

344 Chapter 18. Integracion GRASS SIG

http://grass.osgeo.org/documentation/manuals/


QGIS User Guide, Publicación 2.18

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creating new vector layers).

18.12 Digitalizar y editar una capa vectorial GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complejidad del modelo GRASS

– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Advertencia: All the changes done during editing are immediately written to vector map and related attribute
tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Barra de herramientas

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Icono Herramienta Propósito

Nuevo punto Digitalizar un nuevo punto

Nueva línea Digitalizar nueva línea

Nuevo límite Digitalizar nuevo borde

Nuevo centroide Digitalizar nuevo centroide (etiqueta de área existente)

Nuevo Contorno Cerrado Digitalizar nuevo borde cerrado

Table GRASS Digitizing: GRASS Digitizing Tools

Truco: Digitalizando polígonos en GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Categoría

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
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one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Atributos

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.

If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Truco: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Calculadora de
Campos), and there are features without category which you don’t want to update (typically boundaries), you can
filter them out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Truco: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’ which has no
meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Truco: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible because the
renderer is based on that column.

Autoensamblado

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Truco: Use layer’s CRS also for canvas when editing.

Limitaciones

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and macOS only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Truco: Editar permisos de GRASS
Debe ser el propietario del DIRECTORIO DE MAPA de GRASS que desee editar. Es imposible editar capas de
datos en un DIRECTORIO DE MAPA que no sea suyo, incluso si tiene permisos de escritura.

346 Chapter 18. Integracion GRASS SIG



QGIS User Guide, Publicación 2.18

18.13 La herramienta de región GRASS

La definición de la región (ajuste una ventana de trabajo espacial) en GRASS es importante para trabajar con
capas ráster. Análisis vectorial esta por defecto no limitado a cualquier definición de región definida. Pero todas
los rásters recién creados tendrán la extensión espacial y resolución de la región GRASS definida actualmente,
independientemente de su extensión y resolución original. La región GRASS actual es almacenada en el archivo
$LOCALIZACIÓN/$DIRECTORIO DE MAPA/WIND, y define los límites norte, sur, este y oeste, número de
columnas y filas, resolución espacial horizontal y vertical.

Es posible prender y apagar la visualización de la región GRASS en el lienzo de QGIS utilizando el botón
Mostrar región actual de GRASS.

The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

El modulo GRASS g.region proporciona muchos más parámetros para definir una extensión de región apropi-
ada y resolución para su análisis ráster. Se puede utilizar estos parámetros con la caja de herramientas GRASS,
descrito en la sección La caja de herramientas GRASS.

18.14 La caja de herramientas GRASS

La caja Abrir herramientas GRASS proporciona funcionalidades de modulo GRASS para trabajar con datos dentro
un LOCALIZACIÓN GRASS seleccionada y DIRECTORIO DE MAPA. Para utilizar la caja de herramientas
GRASS necesita abrir una LOCALIZACIÓN y DIRECTORIO DE MAPA que tiene permisos de escritura para
(normalmente se concede si ha creado el DIRECTORIO DE MAPA). Esto es necesario, porque las capas ráster y
vector creadas durante análisis necesitan estar escritos a la LOCALIZACIÓN y DIRECTORIO DE MAPA actual-
mente

Figure 18.3: Caja de herramienta GRASS y módulo
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18.14.1 Trabajando con módulos GRASS

La consola GRASS dentro de la caja de herramientas proporciona acceso a casi todo (más de 300) los módulos
GRASS en una interfaz de línea de comando. Para ofrecer un entorno de trabajo más fácil de usar, cerca de 200 de
los módulos de GRASS disponibles y funcionalidades también son proporcionados por diálogos gráficos dentro
de la caja de herramientas del complemento GRASS.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.18 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

También es posible personalizar el contenido de la caja de herramientas GRASS. Este procedimiento se describe
en la sección Personalizar la caja de herramientas GRASS.

As shown in figure_grass_toolbox, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

Al hacer clic en un icono de modulo gráfico, una nueva pestaña se añadirá al diálogo de Caja de herramientas,
proporciona tres nuevas sub-pestañas Opciones, Salida y Manual.

Opciones

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 18.4: Opciones del módulo de la caja de herramientas GRASS

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Salida

La pestaña Salida proporciona información acerca del estado de salida del módulo. Cuando haga clic en botón
[Ejecutar], el módulo cambia a la pestaña de Salida y verá información acerca del proceso de análisis. Si todo
funciona bien finalmente verá un mensaje Finalizado con éxito

Manual
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Figure 18.5: Salida del módulo de la caja de herramientas GRASS

Figure 18.6: Módulo Manual de la caja de herramientas GRASS
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La pestaña Manual muestra la página de ayuda HTML del modulo GRASS. Se puede utilizar para comprobar
otros parámetros de los módulos y las banderas o para obtener un conocimiento más profundo acerca de la final-
idad del módulo. Al final de cada página del manual del módulo, se ven otros enlaces al Índice de ayuda
principal, al Índice temático y al Índice completo. Estos enlaces proporcionar información de
ejemplo como el modulo g.manual.

Truco: Mostrar resultados inmediatamente
Si desea mostrar sus resultados de cálculo inmediatamente en su lienzo de mapa, se puede utilizar el botón ‘Ver
Salida’ en la parte inferior de la pestaña de módulo.

18.14.2 Ejemplos del módulo GRASS

Los siguientes ejemplos demostrarán el poder de algunos módulos GRASS.

Crear curvas de nivel

El primer ejemplo crea un mapa de curvas de nivel vectoriales de un ráster de elevación (DEM). Aquí, se asume
que se tiene LOCALIZACIÓN Alaska configurado como se explica en la sección Importar datos dentro de una
LOCALIZACIÓN DE GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Ahora abra la caja de herramientas con el botón Abrir herramientas de GRASS.

• En la lista de categorías de herramientas, haga doble clic Ráster → Administración de superficie→ Generar
curvas de nivel vectoriales.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Trabajando con
módulos GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Escriba en Nombre de salida del mapa vectorial el nombre ctour_100.

• Haga clic en [Ejecutar] para iniciar el proceso. Espere varios momentos hasta que el mensaje
Finalizado con éxito aparezca en la ventana de salida. A continuación haga clic en [Ver Salida] y
[Cerrar].

Dado que esta es una región grande, tomará un tiempo para mostrarla. Después de que termine la presentación,
puede abrir la ventana de propiedades de la capa para cambiar el color de línea así el contorno aparece claramente
sobre el ráster de elevación, como en El Dialogo de las Propiedades del Vector.

El siguiente acercamiento a una pequeña y montañosa área en el centro de Alaska. Al acercarse, se puede observar
que las curvas de nivel tienen esquinas afiladas. GRASS ofrece la herramienta v.generalize para alterar ligera-
mente mapas vectoriales, manteniendo su forma general. La herramienta utiliza varios algoritmos diferentes con
propósitos diferentes. Algunos de los algoritmos (es decir, Douglas Peucker y Vertex Reduction) simplificar la
línea mediante la eliminación de algunos de los vértices. El vector resultante se carga más rápido. Este proceso es
útil cuando se tiene un vector muy detallado, pero va a crear un mapa de escala muy pequeña, por lo que el detalle
es innecesario.

Truco: La herramienta de simplificar
Note that QGIS has a Vector → Geometry Tools → Simplify geometries tool that works just like the GRASS
v.generalize Douglas-Peuker algorithm.

Sin embargo, el proposito de este ejemplo es diferente. Las líneas de curvas de nivel creadas por r.contour
tiene ángulos agudos que deben ser suavizados. Entre el algoritmo v.generalize hay Chaiken’s, lo que hace
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precisamente eso (también astillas de Hermite). Tenga en cuenta que estos algoritmos se pueden añadir vértices
adicionales al vector, haciendo que se cargue más lentamente

• Abra la caja de herramientas GRASS y haga doble clic en las categorías Vectorial → Desarrollar mapa →
Generalización,

• Compruebe que el vector ‘ctour_100’ aparece como el Nombre del vector de entrada.

• De la lista de algoritmos, elija Chaiken’s. Deje todas las otras opciones en su predeterminado y de-
splasece hacia abajo a la última fila para ingresar en el campo Nombre del mapa vectorial de salida
‘ctour_100_smooth’, y haga clic en [Ejecutar].

• El proceso toma varios minutos. Una vez que aparece Finalizo con éxito en la ventana de salida,
haga clic [Ver Salida] y a continuación [Cerrar].

• Se puede cambiar el color del vector para que se muestre claramente sobre el fondo del ráster y para con-
trastar con las curvas de nivel originales. Se dará cuenta de que las nuevas curvas de nivel tienen esquinas
más suaves que el original durante su estancia fiel a la original de forma general.

Figure 18.7: Módulo GRASS v.generalize para suavizar un mapa vectorial

Truco: Otros usos de r.contour
El proceso descrito anteriormente se puede utilizar en otras situaciones equivalentes. Si tiene un mapa ráster de
datos de precipitación, por ejemplo, entonces el mismo método se utilizará para crear un mapa vectorial de líneas
isoyetas (lluvia constante).

Crear un efecto sombreado de relieve 3-D

Varios métodos se utilizan para mostrar capas de elevación y da un efecto #-D a mapas. El uso de líneas de
curvas de nivel, como se mostro anteriormente, es un método popular regularmente elejido para producir mapas
topológicos. El efecto de sombreado se crea de un ráster (elevación) DEM calculando primero la pendiente y el
aspecto de cada celda, entonces simula la posición del sol en el cielo y da un valor de reflectancia a cada celda. De
este modo se obtienen pendientes frente al sol iluminadas; las pendientes orientadas lejos del sol(en la sombra) se
oscurecen.

• Comience este ejemplo cargando el ráster de elevación gtopo30. Inicie la caja de herramientas GRASS y
bajo la categoría ráster, haga doble clic para abrir Análisis espacial → Análisis del terreno.

• A continuación haga clic en r.shaded.relief para abrir el módulo.

• Cambie el ángulo del azimut 270 a 315

• Ingrese gtopo30_shade para el nuevo ráster de mapa de sombras y haga clic en [Ejecutar].
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• Cuando el proceso finalice, añada el ráster de mapa de sombras al mapa. Debe verlo desplegado en escala
de grises.

• Para ver ambos sombreados y los colores de la gtopo30‘ juntos, mueva el mapa de sombreado abajo del mapa
gtopo30 en la tabla de contenido, a continuación abra la ventana Propiedades de gtopo30, cambie a la
pestaña de Transparencia y establezca su nivel de transparencia a cerca de 25%.

Ahora debe tener la elevación gtopo30 con su mapa de color y ajuste de transparencia mostrado arriba el mapa
de sombras en escala de grises. Con el fin de ver los efectos visuales en el mapa de sombras, apague el mapa
gtopo30_shade, a continuación, vuelva a encenderla.

Utilizar la consola de GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Figure 18.8: La consola de GRASS, módulo r.shaded.relief

El modulo r.shaded.relief puede tomar un parámetro zmult, que multiplica los valores de elevación relativas a
las unidades de las coordenadas X-Y por lo que el efecto de sombreado es incluso más pronunciado.
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• Cargue el ráster de elevación gtopo30 como antes, a continuación inicie la caja de herramientas GRASS
y haga clic en la consola GRASS. En la ventana de la consola, escriba el comando r.shaded.relief
map=gtopo30 shade=gtopo30_shade2 azimuth=315 zmult=3 y presione [Enter].

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• Como se explicó anteriormente, mueva ráster del relieve sombreado a bajo del ráster gtopo30 en la tabla
de contenido, entonces valide la transparecia de la capa coloreada gtopo30. Debe ver que el efecto 3-D
destaca más fuertemente comparada con el primer mapa de relieve sombreado.

Figure 18.9: Mostrar relieve sombreado creado con el módulo de GRASS r.shaded.relief

Estadísticas de ráster en un mapa vectorial

El siguiente ejemplo muestra como un módulo GRASS puede agregar datos ráster y añadir columnas de una
estadística para cada polígono en un mapa vectorial.

• De nuevo utilice los datos de Alaska, referirse a Importar datos dentro de una LOCALIZACIÓN DE GRASS
para importar los arboles de archivos shape del directorio shapefiles en GRASS.

• Ahora un paso intermedio es necesario: los centroides se deben añadir al mapa de árboles importado para
que sea una zona de GRASS completa del vector (incluyendo ambos límites y centroides).

• De la caja de herramientas, elija Vectorial → Desarrollar mapa -> Administrar objetos espaciales, y abra
el modulo v.centroids.

• Introduzca como el Mapa vectorial de salida ‘forest_areas’ y ejecute el módulo.

• Ahora cargue el vector forest_areas y muestre los tipos de bosque - caducifolio, árbol de hoja perenne,
mixto - en diferentes colores: En la ventana Propiedades de la capa, la pestaña Simbología, elija de Tipo de

leyenda ‘Valor único’ y establezca el Campo de clasificación a ‘VEGDESC’. (Consulte la explicación
de la pestaña de simbología en Propiedades de Estilo de la sección vectorial.)

• A continuación vuelva a abrir la caja de herramientas de GRASS y abra Vectorial → Actualizacion vectorial
por otros mapas.

• Haga clic en el modulo v.rast.stats. Ingrese gtopo30 y forest_areas.

• Sólo un parámetro más es necesario: Ingrese Prefijo de columna elev, y haga clic en [Ejecutar]. Este es
una operación pesada computacionalmente, que se ejecutará por un largo tiempo (probablemente más de
dos horas).

• Finalmente, abra la tabla de atributos forest_areas, y verifique que varias de las nuevas columnas se
han añadido, incluyendo elev_min, elev_max, elev_mean, etc., para cada polígono de bosque.
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18.14.3 Personalizar la caja de herramientas GRASS

Casi todos los módulos de GRASS se pueden añadir a la caja de herramientas de GRASS. Una interfaz XML se
proporciona para analizar los archivos XML muy sencillos que configuran la apariencia y los parámetros de los
módulos dentro de la caja de herramientas.

Un ejemplo del archivo XML para generar el módulo v.buffer (v.buffer.qgm) luce como esto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

El analizador lee esta definición y crea una nueva pestaña dentro de la caja de herramientas cuando
selecciona un modulo. Una descripción más detallada para añadir nuevos módulos, cambie el grupo
de un modulo, etc., se puede encontrar en la wiki de QGIS en http://hub.qgis.org/projects/quantum-
gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 19

QGIS Standalone Browser

QGIS Browser is available as a standalone application and as a panel in QGIS Desktop. It lets you easily navigate
in your filesystem and manage geodata. You can have access to common vector files (e.g., ESRI shapefiles
or MapInfo files), databases (e.g., PostGIS, Oracle, SpatiaLite or MS SQL Spatial) and OWS/WCS|WMS|WFS
connections. You can also view GRASS data (to get the data into QGIS, see Integracion GRASS SIG).

QGIS Browser Panel description is available at The Browser Panel section so only the standalone browser is
treated below.

Like the Browser panel, the standalone Browser helps you navigate through your filesystem and manage geodata.
It also helps you preview or create them and open them in a QGIS project by drag-and-drop.

Comienzar el Navegador QGIS

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

Figure 19.1: QGIS Browser as a standalone application
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In figure_browser_standalone_metadata, you can see the enhanced functionality of the standalone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Propiedades de metadatos). With the Preview tab,
you can have a look at your files without importing them into your QGIS project. It’s also possible to preview the
attributes of your files in the Attributes tab.

356 Chapter 19. QGIS Standalone Browser



CHAPTER 20

Entorno de trabajo de procesamiento de QGIS

20.1 Introducción

Este capítulo introduce al marco de procesamiento de QGIS, un entorno de geoprosesamiento que se puede utilizar
para llamar algoritmos nativos o de terceros de QGIS, haciendo su tarea de análisis espacial más productivo y fácil
de lograr.

En las siguientes secciones, revisaremos cómo usar los elementos gráficos de este sistema y sacar el máximo
provecho de cada uno de ellos.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item. (You will see more than four entries. The remaining ones are not used to execute algorithms and will be
explained later in this chapter).

• The Toolbox. The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

Figure 20.1: Caja de Herramientas de Procesamiento
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• The Graphical modeler. Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

Figure 20.2: Procesamiento del modelador

• The History manager. All actions performed using any of the aforementioned elements are stored in a
history file and can be later easily reproduced using the history manager.

Figure 20.3: El historial del procesamiento

• The Batch processing interface. This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

En las siguientes secciones, revisaremos cada uno de los elementos a detalle.

Nota: About Vector Menu

Some processing algorithms can be accessed via the Vector menu which lists some tools from the processing
framework but also from plugins.
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Figure 20.4: Interfaz de procesamiento por lote

20.2 Menu Vectorial

Vector menu provides a one-stop resource for many common vector-based GIS tasks. It provides a growing suite
of spatial data management and analysis functions that are both fast and functional. These features are part of
the processing framework. Note that some plugins can add other features so, in this chapter, only default features
from processing framework will be listed.

Processing framework is automatically installed and, like any plugin, can be enabled and disabled using the Plugin
Manager (see El diálogo de complementos). When enabled, the Processing plugin adds a Vector menu to QGIS,
providing functions ranging from Analysis and Research Tools to Geometry and Geoprocessing Tools, as well as
several useful Data Management Tools.

See Entorno de trabajo de procesamiento de QGIS for more information about the processing framework.
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20.2.1 Herramientas de análisis

Icon Herramienta Propósito

Matrix de distancia Measure distances between two point layers, and output results as a) Square
distance matrix, b) Linear distance matrix, or c) Summary of distances. Can limit
distances to the k nearest features.

Sum line length Calculate the total sum of line lengths for each polygon of a polygon vector layer.

Points in polygon Count the number of points that occur in each polygon of an input polygon
vector layer.

List unique values List all unique values in an input vector layer field.

Estadísticas básicas
para campos de
texto

Compute basic statistics (mean, std dev, N, sum, CV) on an input text field.

Basic statistics for
numeric field

Compute basic statistics (mean, std dev, N, sum, CV) on an input numeric field

Análisis del vecino
más próximo

Compute nearest neighbor statistics to assess the level of clustering in a point
vector layer.

Mean coordinate(s) Compute either the normal or weighted mean center of an entire vector layer, or
multiple features based on a unique ID field.

Line intersections Locate intersections between lines, and output results as a point shapefile. Useful
for locating road or stream intersections, ignores line intersections with length >
0.

Table tools 1: Default tools in Analysis group

20.2.2 Herramientas de investigación

Icon Herramienta Propósito

Selección aleatoria Randomly select n number of features, or n percentage of features.

Random selection
within subsets

Randomly select features within subsets based on a unique ID field.

Random points inside
polygons

Generate pseudo-random points over a polygon layer (variable number of
point or fixed number of point).

Puntos aleatorios en
la extensión

Generate pseudo-random points over a given extent.

Random points in
layer bounds

Generate pseudo-random points over bounds of a given input layer.

Regular points Generate a regular grid of points over a specified region and export them as a
point shapefile.

Cuadrícula vectorial Generar una cuadrícula de línea o polígono en base aun espaciado de
cuadrícula especificada.

Seleccionar por
localización

Seleccionar entidades en función de su ubicación con respecto a otra capa para
formar una nueva selección, o sumar o restar de la selección actual.

Polígono a partir de
extensión de la capa

Create a single rectangular polygon layer from the extent of an input raster or
vector layer.

Table Tools 2: Default tools in Research group
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20.2.3 Geoprocessing tools

Icon Herramienta Propósito

Convex hull(s) Create minimum convex hull(s) for an input layer, or based on an ID
field.

Buffer with * fixed
distance * distance field

Create buffer(s) around features * based on fixed distance * based on
distance field

Intersect Overlay layers such that output contains areas where both layers
intersect.

Unión Overlay layers such that output contains intersecting and
non-intersecting areas.

Symmetrical difference Overlay layers such that output contains those areas of the input and
difference layers that do not intersect.

Cortar Overlay layers such that output contains areas that intersect the clip
layer.

Deferencia Overlay layers such that output contains areas not intersecting the clip
layer.

Disolver Merge features based on input field. All features with identical input
values are combined to form one single feature.

Eliminate sliver polygons Merges selected features with the neighboring polygon with the largest
area or largest common boundary.

Table Tools 3: Default tools in Geoprocessing group
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20.2.4 Geometry tools

Icon Herramienta Propósito

Check
geometry
validity

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have pretty
different behavior. Another tools exists which shows different result as well:
Topology Checker plugin and ‘must not have invalid geometries’ rule.

Export/Add
geometry
columns

Add vector layer geometry info to point (XCOORD, YCOORD), line (LENGTH), or
polygon (AREA, PERIMETER) layer.

Polygon
centroids

Calculate the true centroids for each polygon in an input polygon layer.

Triangulación
de Delaunay

Calculate and output (as polygons) the Delaunay triangulation of an input point
vector layer.

Polígonos
Voronoi

Calculate Voronoi polygons of an input point vector layer.

Simplify
geometry

Generalize lines or polygons with a modified Douglas-Peucker algorithm.

Densificar
geometrías

Densify lines or polygons by adding vertices.

Multipartes a
partes sencillas

Convert multipart features to multiple singlepart features. Creates simple polygons
and lines.

Singleparts to
multipart

Merge multiple features to a single multipart feature based on a unique ID field.

Polygons to
lines

Convert polygons to lines, multipart polygons to multiple singlepart lines.

Lines to
polygons

Convert lines to polygons, multipart lines to multiple singlepart polygons.

Extract nodes Extract nodes from line and polygon layers and output them as points.

Table Tools 4: Default tools in Geometry group

Nota: The Simplify geometry tool can be used to remove duplicate nodes in line and polygon geometries. Just set
the Simplify tolerance parameter to 0 and this will do the trick.
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20.2.5 Data management tools

Icon Herramienta Propósito

Define current
projection

Specify the CRS for shapefiles whose CRS has not been defined.

Unir atributos
por
localización

Join additional attributes to vector layer based on spatial relationship. Attributes from
one vector layer are appended to the attribute table of another layer and exported as a
shapefile.

Split vector
layer

Split input layer into multiple separate layers based on input field.

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer type
(point, line, area).

Create spatial
index

Create a spatial index for OGR- supported formats.

Table Tools 5: Default tools in Data management group

20.3 La caja de herramientas

La Caja de herramientas es el principal elemento de procesamiento de la interfaz gráfica de usuario, y el que más
se suele usar en el trabajo diario. Muestra un listado de todos los algoritmos disponibles agrupados en diferentes
bloques, y es el punto de acceso para ejecutarlos, bien haciéndolo como un proceso único o bien como un proceso
por lotes que realice varias ejecuciones del mismo algoritmo con diferentes conjuntos de entradas.

Figure 20.5: Caja de Herramientas de Procesamiento

The toolbox contains all the available algorithms, divided into so-called “Providers”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.
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By default, only providers that do not rely on third-party applications (that is, those that only require QGIS
elements to be run) are active. Algorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

En la parte superior de la caja de herramientas, hay una caja de texto. Para reducir el número de algoritmos que
se muestran en la caja de herramientas y que resulte más fácil encontrar el que se necesita, se puede introducir
cualquier palabra o frase en esa caja de texto. Según se va escribiendo, el número de algorimos que se muestra se
va reduciendo a sólo aquellos que contienen el texto introducido en su nombre.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

Figure 20.6: Processing Toolbox showing search results

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

Para ejecutar un algoritmo, basta con hacer doble click sobre su nombre en la caja de herramientas.

20.3.1 El cuadro de diálogo de algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the ‘Polygon centroids’ algorithm).

This dialog is used to set the input values that the algorithm needs to be executed. It shows a list of input values
and configuration parameters to be set. It of course has a different content, depending on the requirements of the
algorithm to be executed, and is created automatically based on those requirements.

Aunque el número y el tipo de parámetro dependen de las características del algoritmo, la estructura es similar
para todos ellos. Los parámetros encontrados en la tabla pueden ser de uno de los siguientes tipos.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.
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Figure 20.7: Processing Toolbox showing search results

Figure 20.8: Diálogo de parámetros
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• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see an iterator button by each vector layer selector, as shown in the figure below.

Figure 20.9: Vector iterator button

Si el algoritmo contiene varios de ellos, será capaz de cambiar cada uno de ellos. Si el botón correspondiente
a una entrada vectorial se cambia, el algoritmo será ejecutado iterativamente en cada uno de sus elementos,
en lugar de sólo una vez para toda la capa, produciendo mayor cantidad de salidas como veces que se ejecuta
el algoritmo. Esto permite la automatización del proceso cuando todas las características de una capa tienen
que ser procesados por separado.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a spin box. You will find a button by its side. Clicking on it, you will
open the expression builder that allows you to enter a mathematical expression, so you can use it as a handy
calculator. Some useful variables related to data loaded into QGIS can be added to your expression, so you
can select a value derived from any of these variables, such as the cell size of a layer or the northernmost
coordinate of another one.

Figure 20.10: Entrada basada en expresión

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A coordinate reference system. You can type the EPSG code directly in the text box, or select it from the
CRS selection dialog that appears when you click on the button on the right-hand side.
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• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you three options:

– to select the value from a layer or the current canvas extent,

– to define it by dragging directly onto the map canvas, or

– to use the minimum coverage from all input layers.

Figure 20.11: Selector de extensión

Si se selecciona la primera opción, se verá una ventana como la siguiente.

Figure 20.12: Lista de Extensión

Si se selecciona la segunda opción, la ventana de parámetros se ocultará, para que se pueda definir el rectán-
gulo haciendo click y arrastrando dentro del lienzo. Una vez hecho esto, el cuadro de diálogo reaparecerá,
con los valores correspondientes ya rellenos en en cuadro de texto.

Figure 20.13: Arrastrar Extensión

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Click en el botón del lado derecho para ver la tabla y editar sus valores.

Dependiendo del algoritmo, el número de filas que pueden ser modificadas o no al utilizar los botones del
lado derecho de la ventana.

Along with the Parameters tab, you will find another tab named Log. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.
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Figure 20.14: Selección Múltiple

Figure 20.15: Tabla Fija
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On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

Un comentario sobre proyecciones

Algorithms that are run from the processing framework — this is also true for most of the external applications
whose algorithms are exposed through it — do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Tenga en cuenta que, debido a las capacidades de reproyección al vuelo en QGIS, aunque dos capas pueden parecer
superponerse y emparejan, eso no puede ser cierto si sus coordenadas originales se utilizan sin reproyectarlos en
un sistema de coordenadas común. Esa reproyección debe hacerse manualmente, y luego los archivos resultantes
se debe utilizar como entrada para el algoritmo. Además, tenga en cuenta que el proceso de reproyección se puede
llevar a cabo con los algoritmos que están disponibles en el marco de procesamiento en sí.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

Si intenta ejecutar un algoritmo utilizando como entrada dos o más capas con SRC diferentes, se mostrará un
diálogo de advertencia.

Aún se puede ejecutar el algoritmo, pero en la mayoría de los casos se producirán resultados incorrectos, como
capas vacias debido a que las capas de entrada no se solapan.

20.3.2 Resultados generados por algoritmos

Los tipos de resultados que se pueden generar cor un algoritmo son los siguientes:

• Una capa ráster.

• Una capa vectorial.

• Una tabla

• Un archivo HTML (usado para salidas de texto y salidas gráficas).

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

20.3. La caja de herramientas 369



QGIS User Guide, Publicación 2.18

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

Se puede establecer una carpeta predeterminada para objetos de datos de salida. Vaya al diálogo de configuración
(se puede abrir desde el menú Procesos), y en el grupo General, se encuentra un parámetro denominado: guil-
abel: Carpeta de salida. Esta carpeta de salida se utiliza como la ruta predeterminada en caso de que se escriba
simplemente un nombre de archivo sin ruta de acceso (es decir, myfile.shp) al ejecutar un algoritmo.

Al ejecutar un algoritmo que utiliza una capa vectorial en modo iterativo, la ruta del archivo introducido se utiliza
como la ruta de la base para todos los archivos generados, los cuales se denominan utilizando el nombre base y
añadiendo un número que representa el índice de la iteración. La extensión del archivo (y el formato) se utiliza
para todos los archivos generados.

Aparte de capas ráster y tablas, los algoritmos también generan gráficos y texto como archivos HTML. Estos
resultados se muestran al final de la ejecución del algoritmo en un nuevo cuadro de diálogo. Este diálogo se
quedará con los resultados producidos por cualquier algoritmo durante la sesión actual, y puede ser mostrado en
cualquier momento seleccionando Procesos → Visor de resultados del menú principal de QGIS.

Algunas aplicaciones externas pueden tener archivos (sin restricciones de extensión particulares) como de salida,
pero no pertenece a ninguna de las categorías anteriores. Esos archivos de salida no serán procesadas por QGIS
(abierto o incluido en el proyecto actual de QGIS), ya que la mayor parte del tiempo que corresponden a formatos
de archivo o elementos no compatibles con QGIS. Esto es, por ejemplo, en el caso de archivos LAS utilizados
para datos LiDAR. Los archivos se crean, pero no se ve nada nuevo en su sesión de trabajo en QGIS.

Para todos los otros tipos de salida, encontrará una casilla de verificación que se puede utilizar para decirle al
algoritmo si se debe cargar el archivo una vez que se genera por el algoritmo o no. Por defecto, se abren todos los
archivos.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

20.3.3 Configurar el entorno de trabajo de procesamiento

Como se ha mencionado, el menú de configuración permite el acceso a un nuevo diálogo donde se puede configurar
cómo funcionan los algoritmos. Los parámetros de configuración están estructurados en bloques separados que se
pueden seleccionar en la parte izquierda del cuadro de diálogo.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by Processing and added to the QGIS canvas, it
will be rendered with that style.

Rendering styles can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles for outputs. You will see a dialog like the
one shown next.

Figure 20.16: Estilos de Representación
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Seleccionar el archivo de estilo (.qml) que se desee para cada salida y presionar [Aceptar].

Otras parámetros de configuración se en listan en el grupo General a continuación:

• Utilizar nombre de archivo como nombre de capa. El nombre de cada capa resultante creado por un al-
goritmo se define por el propio algoritmo. En algunos casos, un nombre fijo podría ser utilizado, lo que
significa que el mismo nombre de salida será utilizada, no importa que capa de entrada se utiliza. En otros
casos, el nombre podría depender del nombre de la capa de entrada o algunos de los parámetros utilizados
para ejecutar el algoritmo. Si esta casilla de verificación está marcada, el nombre se toma del nombre de
archivo de salida en su lugar. Tenga en cuenta que, si la salida se guarda en un archivo temporal, el nombre
de archivo de este suele ser largo y sin sentido, destinada a evitar la colisión con otros nombres de archivos
ya existentes.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Utilice sólo objetos espaciales seleccionados. Si se selecciona esta opción, cada vez que se utiliza una capa
vectorial como entrada para un algoritmo, sólo se utilizan sus objetos espaciales seleccionados. Si la capa
no tiene elementos seleccionadas, se utilizarán todos los objetos.

• :Archivo script pre-ejecución y Archivo script post-ejecución. Estos parámetros se refieren a scripts escritos
utilizando la funcionalidad de secuencias de comandos de procesamiento, y se explican en la sección de
secuencias de comandos de cobertura y la consola.

Aparte del bloque General en el diálogo de configuración, también encontrará un bloque para los proveedores de
algoritmo. Cada entrada en este bloque contiene un elemento :guilabel: Activar que se puede utilizar para hacer
que algoritmos aparezcan o no en la caja de herramientas. Además, algunos proveedores de algoritmos tienen
sus propios elementos de configuración, que explicaremos más adelante en la cobertura de los proveedores de
algoritmos particulares.

20.4 El administrador del historial

20.4.1 El historial del procesamiento

Cada vez que ejecutas un algoritmo, la información acerca del proceso es almacenado en el administrador de la
historia. Junto con los parámetros usados, la fecha y hora de la ejecución también se guardan.

De esta manera, es fácil rastrear y controlar todo el trabajo que se ha desarrollado usando la caja de herramientas
de procesado, y fácil reproducirlo.

El administrador del historial es un conjunto de entradas de registros agrupados de acuerdo a su fecha de ejecución,
por lo que es más fácil encontrar información sobre un algoritmo ejecutado en cualquier momento en particular.

Información del proceso se mantiene como una expresión de línea de comandos, incluso si el algoritmo fue lanzado
desde la caja de herramientas. Esto hace que sea también útil para aquellos que están aprendiendo cómo utilizar la
interfaz de línea de comandos, ya que se pueden llamar un algoritmo usando la caja de herramientas y compruebe
el administrados del historial para ver cómo ese mismo algoritmo podría ser llamado desde la línea de comandos.

Parte de la navegación por las entradas en el registro, también puede volver a ejecutar los procesos al hacer doble
clic en la entrada correspondiente.

20.4.2 El registro de procesamiento

El diálogo de historia solo contiene las llamadas de ejecución, pero no la información producida por el algoritmo
cuando se ejecuta. Esa información se escribe en el registro de QGIS, en una pestaña Procesamiento

Los algoritmos de terceros se ejecutan normalmente llamando su interfaz de línea de comandos, que se comunica
con el usuario vía consola. Aunque la consola no se muestra, una copia completa de la misma se escribe en el
registro cada vez que ejecuta uno de esos algoritmos. Para evitar llenar el registro con esa información, se puede
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Figure 20.17: Historial

desactivar para cada proveedor, buscando la opción correspondiente en la entrada del proveedor de diálogo de
configuración.

Algunos algoritmos, incluso si pueden producir un resultado con los datos de entrada dados , puede añadir comen-
tarios o información adicional al registro, si detectan problemas potenciales con los datos, con el fin de advertirle.
Asegúrese de revisar esos mensajes en el registro si se esta teniendo resultados inesperados.

20.5 Modelador gráfico

El “modelador gráfico” le permite crear modelos complejos usando una interfaz simple y fácil de usar. Cuando
trabajas con SIG, la mayoría de los operaciones de análisis no están aislados, en cambio son parte de una cadena
de operaciones. Usando un modelador gráfico, esa cadena de procesos se pueden envolver en un solo proceso,
para que sea mas conveniente de ejecutarlo como un solo proceso más adelante en un conjunto diferente de las
entradas. Sin importar cuantos pasos o diferentes algoritmos están involucrados, un modelo se ejecuta como un
solo algoritmo, así ahorrando tiempo y esfuerzo, especialmente para modelos mas grande.

El modelador puede ser abierto desde el menu de procesamiento

El modelador tiene un cambas funcional donde la estructura del modelo y el flujo de trabajo que representa se
puede ver. En la parte izquierda de la ventana, un panel con dos pestañas se pueden utilizar para agregar nuevos
elementos al modelo.

Crear un modelo requiere dos pasos:

1. “Definición de entradas no necesarias”. Estas entradas se agregaran a la ventana de parámetros, asi el
usuario puede poner sus valores cuando se ejecutan los modelos. El modelo en si es un algoritmo, asi la
ventana de parámetros de genera automáticamente como pasa con todos los algoritmos disponibles en el
marco de referencia del procesador.

2. “Definición de un flujo de trabajo”. Usando los datos entrantes de un modelo, el flujo de trabajo se define
por algoritmos adicionales y seleccionando como se utilizan las entradas o salidas generados por otros
almoritmos que ya estan en el modelo.

20.5.1 Definir entradas

El primer paso de crear un modelo es definir las entradas que se necesitan. Los siguientes elemenos se encuentran
en la pestaña en el lado izquierdo de la ventana de modelos.

• Capa Raster

• Capa Vector
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Figure 20.18: Modelador

• Cadena

• Campo de la tabla

• Tabla

• Extensión

• NUmero

• Boolean

• Archivo

Haga doble clic en cualquiera de estos elementos, un diálogo se muestra para definir sus características. Depende
de los parámetros en si. EL diálogo podría contener sólo un elemento básico (la descripción, que es la que el
usuario verá al ejecutar el modelo) o más de ellos. Por ejemplo, al añadir un valor numérico, como se puede ver
en la siguiente figura, parte de la descripción del parámetro, tiene que establecer un valor y un rango de valores
validos.

Figure 20.19: Model Parameters Definition

Para cada entrada adicional, un nuevo elemento se agrega al canvas modelador.
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Figure 20.20: Model Parameters in canvas

También puede añadir entradas al arrastrar el tipo de entrada de la lista y soltarlo en la vista del modelador, en la
posición donde dese ubicarla.

20.5.2 Definicion del flujo de trabajo.

Una vez que se ha definido las entradas, es tiempo para definir los algoritmos que se les aplica. Los algoritmos
se peuden encontrar en la pestaña Algorithms , agupados de una manera parecida a como estan en la caja de
herramientas.

Figure 20.21: Model Inputs

Para añadir un algoritmo a un modelo, haga doble clic en su nombre o arrastre y suéltelo, al igual que se hace
cuando añade entradas. Un diálogo de ejecución aparecerá, con un contenido similar a una encontrada en el
panel de ejecución que se muestra cuando ejecutan el algoritmo de la caja de herramientas. La que se muestra a
continuación corresponde al algoritmo ‘Índice de convergencia’ de SAGA.

Como se puede ver, existen algunas diferencias. En lugar de la caja de salida de archivo que se utiliza para
establecer la ruta del archivo para capas y tablas de salida, una caja de texto simple se utiliza aquí. Si la capa
generada por el algoritmo es sólo un resultado temporal que será utilizado como la entrada de otro algoritmo y
no debe ser mantenida como resultado final, simplemente no modificar ese cuadro de texto. No escribir nada en
él significa que el resultado es definitivo y el texto que se proporciona es la descripción de la salida, que será la
salida que el usuario verá cuando se ejecute el modelo.

Seleccionar el valor de cada parámetro también es un poco diferente, ya que hay diferencias importantes entre
contexto del modelador y de la caja de herramientas. Vamos a ver cómo introducir los valores para cada tipo de
parámetro

• Las capas (ráster o vectorial) y tablas. Estos se seleccionan de una lista, pero en este caso, los posibles
valores no son las capas o tablas actualmente cargadas en QGIS, sino la lista de modelos de entrada del tipo
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Figure 20.22: Model Algorithm parameters

correspondiente, u otras capas o tablas generadas por algoritmos ya añadidos al modelo.

• Los valores numéricos. Los valores literales se pueden introducir directamente en la caja de texto. Pero
esta caja de texto también es una lista que se puede utilizar para seleccionar cualquiera de las entradas de
valor numérico del modelo. En este caso, el parámetro tomará el valor introducido por el usuario cuando se
ejecuta el modelo.

• Cadena. Como en el caso de valores numéricos, cadenas literales se pueden escribir, o una cadena de entrada
se puede seleccionar.

• Campo de tabla. Los campos de la tabla padre o capa no se pueden conocer en tiempo de diseño, ya
que dependen de la selección del usuario cada vez que el modelo es ejecutado. Para establecer el valor
de este parámetro, escriba el nombre de un campo directamente en la caja de texto, o utilice la lista para
seleccionar una entrada de campo de la tabla ya agregado al modelo. La validez del campo seleccionado
será comprobada en tiempo de ejecución.

En todos los casos, se encontrará un parámetro adicional llamado Algoritmos padres que no esta disponible cuando
llama al algoritmo de la caja de herramientas. Este parámetro permite definir el orden en que se ejecuten los
algoritmos definiendo explícitamente un algoritmo como padre de la actual, lo que obligará al padre a ser ejecutado
antes del actual.

Cuando se utiliza la salida de un algoritmo anterior como la entrada de su algoritmo, que establece de forma
implícita el algoritmo anterior como padre del actual (y coloca la flecha correspondiente en la vista del modelador).
Sin embargo, en algunos casos, un algoritmo puede depender de otro, incluso si no se utiliza ningún objeto de
salida de la misma (por ejemplo, un algoritmo que ejecuta una sentencia de SQL en una base de datos PostGIS y
otro que importa una capa en la misma base de datos) . En ese caso, basta con seleccionar el algoritmo anterior en
el parámetro Algoritmos padres y los dos pasos se ejecutarán en el orden correcto.

Una vez que a todos los parámetros se les han asignados valores validos, haga clic en [Aceptar] y el algoritmo
se añadirá a la vista. Será enlazado a todos los otros elementos en la vista, si los algoritmos o entradas, eso
proporciona objetos que se utilizan como entrada de ese algoritmo.

Los elementos se pueden arrastrar a una diferente posición dentro de la vista, para cambiar la forma de la estructura
del modulo se muestra y hace más claro e intuitivo. Enlaces entre los elementos se actualizan automáticamente.
Se puede acercar y alejar utilizando la rueda del ratón.

Se puede correr su algoritmo en cualquier momento haciendo clic en el botón [Ejecutar]. Sin embargo, con el fin

20.5. Modelador gráfico 375



QGIS User Guide, Publicación 2.18

de utilizar el algoritmo de la caja de texto, se tiene que guardar y cerrar el diálogo del modelador, para permitir
que la caja de herramientas actualice su contenido.

20.5.3 Guardar y cargar modelos.

Utilice el botón actual [Guardar] para guardar el modelo actual y el botón [Abrir] para abrir cualquier modelo
previamente guardado. Los modelos se guardan con la extensión .model. Si el modelo ha sido previamente
guardado desde la ventana del modelador, no se le pedirá un nombre de archivo. Dado que ya existe un archivo
asociado con ese modelo, el mismo archivo se utilizará para guardar cualquier subsiguiente.

Antes de guardar un modelo, tienes que entrar el nombre y el grupo, utilizando las cajas de texto en la parte
superior de la ventana.

Los modelos guardados en la carpeta modelos (la carpeta predeterminada cuando se le pide un nombre de
archivo para guardar el modelo) aparecerá en la caja de herramientas en la rama correspondiente. Cuando se
invoca la caja de herramientas, que busca en la carpeta modelos de archivos con la extensión .model y carga
los modelos que contienen. Puesto que un modelo es en sí mismo un algoritmo, este se puede añadir a la caja de
herramientas al igual que cualquier otro algoritmo.

La carpeta de los modelos se puede configurar desde el diálogo Procesos, bajo el grupo Modelador.

Se puede cargar modelos desde la carpeta models que no solo aparece en la caja de herramientas sino tambien
en el arbol de argoritmos en la pestaña Algorithms de la ventana modeladora.

20.5.4 Editar un modelo.

Puedes editar un modelo que actualmente estar creando, redefiniendo el flujo de trabajo y la relacion entre los
algoritmos y las entradas que definen el modelo en si.

Si haces click derecho en un algoritmo en el cambas representado en el modelo, puedes ver el menu de contexto
parecido a lo siguiente:

Figure 20.23: Click derecho en el modelador

Seleccionando la opción Remove va a causar que el algoritmo seleccionado se elimine. Un algoritmo se puede
eliminar solo si no hay otros algoritmas dependiendo de este. Eso es, si ninguna salida del algoritmo se utiliza en
uno diferente de salida. Si intentar elimiar el algoritmo donde hay dependencia, un mensaje de advertencia como
el que se ve abajo va a salir.

Figure 20.24: No se puede borrar el algoritmo

Seleccionando la opción Editar mostrara los parámetros de dialogo del algoritmo, para que puedas cambiar las
entradas y los valores de los parámetros. No todos los elementos de entrada disponibles en le modelo van a

376 Chapter 20. Entorno de trabajo de procesamiento de QGIS



QGIS User Guide, Publicación 2.18

aparecer en el caso de entradas disponibles. Las capas o valores generados en pasos mas avanzados en el flujo de
trabajo por el modelo no van a estar disponibles si ellos causan una dependencia circular.

Seleccionar valores nuevos y luego hacer click en el boton de [OK] como es usual. Las conecciones entre ele-
mentos de modelos cambian de acuerdo con el ambas de modelar.

Un modelo se puede ejecutar parcialmente, desactivando algunos de sus algoritmos. Para hacer eso, seleccione
la opción Desactivar en el menú contextual que aparece cuando hace clic derecho en un elemento del algoritmo.
El algoritmo seleccionado, y todos los que están en ella se mostrarán en gris y no se ejecutarán como parte del
modelo.

Figure 20.25: Modelo con algoritmos desactivados

Cuando haga clic en un algoritmo que no este activo, verá en su lugar una opción del menú Activar que puede
utilizar para activarlo de nuevo.

20.5.5 Editando archivos de ayuda y meta informacion de modelos

Puedes documentar tus modelos del modelador en si. Solo hacer click en el boton de **[Edit model help]* y un
dialogo paresido al siguiente va a aparecer.

Figure 20.26: Edición de Ayuda

En el lado derecho, verá una página HTML simple, creado mediante la descripción de los parámetros de entrada
y salidas del algoritmo, junto con algunos elementos adicionales como una descripción general del modelo o su
autor. La primera vez que se abre el editor de ayuda, todas estas descripciones están vacíos, pero se pueden editar
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utilizando los elementos en la parte izquierda del cuadro de diálogo. Seleccione un elemento en la parte superior
y luego escriba su descripción en el cuadro de texto de abajo.

Modelo de ayuda se guarda como parte de un modelo en si.

20.5.6 Exportando un modelo como un script Python

Como veremos en un capítulo posterior, los algoritmos de procesamiento pueden ser llamados desde la consola
de Python de QGIS y los nuevos algoritmos de procesamiento se pueden crear también utilizando Python. Una
forma rápida de crear un script Python es para crear un modelo y después exportarlo como un archivo Python.

Para hacerlo, haga clic en el botón Exportar como script Python. Seleccione el archivo de salida en el diálogo de
selección de archivos y Procesamiento escribirá en los comandos de Python que realiza las mismas operaciones
definidas en el modelo actual.

20.5.7 Acerca de algoritmos disponibles

Puede notar que algunos algoritmos que pueden ser ejecutados desde la caja de herramientas no aparecen en la
lista de algoritmos disponibles cuando se está diseñando un modelo. Para ser incluidos en un modelo, un algoritmo
debe tener una semántica correcta, de modo que sea adecuadamente enlazado a los otros en el flujo de trabajo. Si
un algoritmo no tiene tal bien definida la semántica (por ejemplo, si el número de capas de salida no puede ser
conocido de antemano), entonces no es posible utilizarlo dentro de un modelo, y por lo tanto, no aparece en el
lista de algoritmos que se puede encontrar en el diálogo modelador.

Además, se verán algunos algoritmos en el modelador que no se encuentran en la caja de herramientas. Estos
algoritmos están destinados a ser utilizados exclusivamente como parte de un modelo, y que no son de interés
en un contexto diferente. El algoritmo de ‘Calculadora’ es un ejemplo de ello. Es simplemente una calculadora
aritmética simple que se puede utilizar para modificar valores numéricos (introducidos por el usuario o generados
por algún otro algoritmo). Esta herramienta es muy útil dentro de un modelo, pero fuera de ese contexto, no tiene
demasiado sentido.

20.6 La interfaz de procesamiento por lotes

20.6.1 Introducción

Todos los algoritmos (incluyendo modelos) se pueden ejecutar como un proceso por lotes. Es decir, que se pueden
ejecutar utilizando no sólo un único conjunto de insumos, sino varios de ellos y ejecutar el algoritmo tantas veces
sea necesario. Esto es útil al procesar grandes cantidades de datos, ya que no es necesario poner en marcha el
algoritmo muchas veces desde la caja de herramientas.

Para ejecutar un algoritmo como un proceso por lotes, haga clic en su nombre en la caja de herramientas y
seleccionar la opción Ejecutar como proceso por lotes en el menú emergente que aparecerá.

Figure 20.27: Batch Processing from right-click

Si tiene que ejecutar el diálogo del algoritmo abierto, también puede iniciar la interfaz de procesamiento por lotes
desde allí, haga clic en el botón Ejecutar como proceso por lotes....
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Figure 20.28: diálogo de procesamiento por lotes de algoritmo

20.6.2 La tabla de parámetros

La ejecución de un proceso por lotes es similar a la realización de una sola ejecución de un algoritmo. Los valores
de los parámetros tienen que ser definidos, pero en este caso no sólo necesitan un valor único para cada parámetro,
sino un conjunto de ellos en su lugar, una por cada vez que el algoritmo tiene que ser ejecutado. Los valores se
introducen mediante una tabla como la que se muestra a continuación.

Figure 20.29: Procesamiento por Lotes

Cada línea de esta tabla representa una sola ejecución del algoritmo, y cada celda contiene el valor de uno de
los parámetros. Es similar al diálogo de los parámetros que se ve cuando se ejecuta un algoritmo de la caja de
herramientas, pero con una disposición diferente.

Por defecto, la tabla contiene sólo dos filas. Puede agregar o quitar filas utilizando los botones de la parte inferior
de la ventana.

Una vez que el tamaño de la tabla se ha establecido, este tiene que ser llenado con los valores deseados.
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20.6.3 Llenado de la tabla de parámetros

Para la mayoría de los parámetros, establecen el valor es trivial. Sólo tienes que escribir el valor o seleccionarlo
de la lista de opciones disponibles, dependiendo del tipo de parámetro.

Los nombres de archivo para los objetos de datos de entrada se introducen escribiendo directamente o, más conve-

nientemente, al hacer clic en el botón en la parte derecha de la celda, que muestra un menú contextual con
dos opciones: una para selección de capas actualmente abiertas y otra para seleccionar del sistema de archivos.
Esta segunda opción, cuando seleccione, muestra un diálogo de selección de archivos típico. Múltiples archivos
se pueden seleccionar a la vez. Si el parámetro de entrada representa un solo objeto de datos y varios archivos
se seleccionan, cada uno de ellos serán puestos en una fila separada, añadiendo otras nuevas si es necesario.
Si el parámetro representa una entrada múltiple, se añadirán todos los archivos seleccionados a una sola celda,
separados por punto y coma (;).

Identificadores de capa se pueden introducir directamente en el cuadro de texto del parámetro. Puede introducir la
ruta completa a un archivo o el nombre de una capa que está cargado actualmente en el proyecto de QGIS actual.
El nombre de la capa se resolverá de forma automática a su ruta de origen. Tenga en cuenta que, si varias capas
tienen el mismo nombre, esto podría causar resultados inesperados debido a la ambigüedad.

Los objetos de datos de salida siempre se guardan en un archivo y, a diferencia de cuando se ejecuta un algoritmo
de la caja de herramientas, guardar en un archivo temporal o base de datos no está permitido. Puede escribir el
nombre directamente o utilizar el diálogo de selector de archivos que aparece al hacer clic en el botón que lo
acompaña.

Una ves que seleccione el archivo, un nuevo diálogo se mostrará para permitir la terminación automática de otras
celdas en la misma columna (mismo parámetro).

Figure 20.30: Guardar Procesamiento por lotes

Si se selecciona el valor por defecto (‘No autocompletar’), se acaba de poner el nombre del archivo seleccionado
en la celda seleccionada de la tabla de parámetros. Si se selecciona cualquiera de las otras opciones, todas las
celdas debajo de la seleccionada será automáticamente llenado basado en un criterio definido. De esta manera, es
mucho más fácil llenar la tabla, y el proceso por lotes se puede definir con menos esfuerzo.

El llenado automático puede hacerse por simple adición de los números correlativos a la ruta del archivo selec-
cionado, o al añadir el valor de otro campo en la misma fila. Esto es particularmente útil para nombrar a los objetos
de datos de salida de acuerdo con los de entrada.

20.6.4 Ejecutar el proceso por lotes

Para ejecutar el proceso por lotes una vez que haya introducido todos los valores necesarios, simplemente haga
clic en [Aceptar]. El progreso de la tarea por lotes global se mostrará en la barra de progreso en la parte inferior
del diálogo

20.7 Utilizar algoritmos de procesamiento desde la consola

La consola permite a los usuarios avanzados incrementar su productividad y realizar operaciones complejas que
no se pueden realizar utilizando cualquiera de los otros elementos de la GUI del marco de procesamiento. Mod-
elos que involucran varios algoritmos se pueden definir mediante la interfaz de línea de comandos y operaciones
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Figure 20.31: Ruta de archivo de procesamiento por lotes

adicionales tales como bucles y sentencias condicionales que se pueden añadir para crear flujos de trabajo más
flexibles y potentes.

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

El código se puede ejecutar desde la consola de Python, incluso si no especifica ningún método de procesamiento,
se puede convertir en un nuevo algoritmo que más tarde puede llamar desde la caja de herramientas, el mode-
lador gráfico o algún otro componente, tal como lo hace con cualquier otro algoritmo. De hecho, algunos de los
algoritmos que se pueden encontrar en la caja de herramientas son sencillas secuencias de comandos.

En esta sección, veremos como utilizar algoritmos de procesado desde la consola de Python de QGIS, y también
cómo escribir algoritmos utilizando Python.

20.7.1 Invocando algoritmos desde la consola de Python

Lo primero que tiene que hacer es importar las funciones de procesamiento con la siguiente línea:

>>> import processing

Ahora, hay básicamente solo una cosa (interesante) que puede hacer con eso desde la consola: ejecutar un
algoritmo. Eso se hace utilizando el método runalg()‘, que toma el nombre del algoritmo a
ejecutar como su primer parámetro, y luego un número variable de parámetros
adicionales dependiendo de los requisitos del algoritmo. Así lo primero
que necesita saber es el nombre del algoritmo a ejecutar. Ese no es el
nombre que se ve en la caja de herramientas, si no más bien un nombre de
linea de comando única. Para encontrar el nombre correcto de su algoritmo,
se puede utilizar el método ‘‘algslist(). Escribir la siguiente línea en su consola:

>>> processing.alglist()

Veras algo como esto:

Accumulated Cost (Anisotropic)-------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)---------->saga:accumulatedcost(isotropic)
Add Coordinates to points------------->saga:addcoordinatestopoints
Add Grid Values to Points------------->saga:addgridvaluestopoints
Add Grid Values to Shapes------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points------>saga:addpolygonattributestopoints
Aggregate----------------------------->saga:aggregate
Aggregate Point Observations---------->saga:aggregatepointobservations
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Aggregation Index--------------------->saga:aggregationindex
Analytical Hierarchy Process---------->saga:analyticalhierarchyprocess
Analytical Hillshading---------------->saga:analyticalhillshading
Average With Mask 1------------------->saga:averagewithmask1
Average With Mask 2------------------->saga:averagewithmask2
Average With Thereshold 1------------->saga:averagewiththereshold1
Average With Thereshold 2------------->saga:averagewiththereshold2
Average With Thereshold 3------------->saga:averagewiththereshold3
B-Spline Approximation---------------->saga:b-splineapproximation
...

Esa es una lista de todos los algoritmos disponibles, ordenada alfabéticamente, junto con sus nombres de linea de
comandos correspondientes.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)-------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient----------->saga:downslopedistancegradient
Relative Heights and Slope Positions-->saga:relativeheightsandslopepositions
Slope Length-------------------------->saga:slopelength
Slope, Aspect, Curvature-------------->saga:slopeaspectcurvature
Upslope Area-------------------------->saga:upslopearea
Vegetation Index[slope based]--------->saga:vegetationindex[slopebased]

El resultado podría cambiar dependiendo de los algoritmos que se tienen disponibles.

Ahora es más fácil encontrar el algoritmo que se busca y el nombre de línea de comando, en este caso
saga:slopeaspectcurvature.

Una vez que se conoce el nombre de línea de comandos del algoritmo, el siguiente paso es determinar la sintaxis
correcta para ejecutarlo. Eso significa saber que parámetros se necesitan y el orden en el que tienen para pasarlos
cuando se llame al método runalg(). Hay un método para describir un algoritmo a detalle, que se puede utilizar
para obtener una lista de los parámetros que requiere un algoritmo y las salidas que va a generar. Para obtener
esta información, se puede utilizar el método alghelp (name_of_the_algorithm). Utilice el nombre de
línea de comandos del algoritmo, no el nombre descriptivo completo.

Llamar al método con saga:slopeaspectcurvature como parámetro, se obtiene la siguiente descripción:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Ahora se tiene todo lo necesario para ejecutar cualquier algoritmo. Como ya hemos mencionado, sólo hay un solo
comando para ejecutar algoritmos: runalg(). Su sintaxis es la siguiente:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

La lista de parámetros y salidas para añadir dependen del algoritmo que se desean ejecutar, y es exactamente la
lista que el método alghelp() le da, en el mismo orden que se muestra.

Dependiendo del tipo de parámetro, los valores se introducen de manera diferente. La siguiente lista da una rápida
revisión de cómo introducir los valores para cada tipo de parámetro de entrada.

• La capa ráster, vectorial o tabla. Sólo tiene que utilizar una cadena con el nombre que identifique los datos
del objeto a utilizar (el nombre que tiene en la tabla QGIS de contenido) o un nombre de archivo (Si no
abre la capa correspondiente, se abrirá pero no se añadirá al lienzo del mapa). Si tiene una instancia de un
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objeto de QGIS que represente la capa, también puede pasarlo como parámetro. Si la entrada es opcional y
no quiere utilizar cualquier objeto de dato, utilice None.

• Selección. Si un algoritmo tiene un parámetro de selección, el valor de ese parámetro debe ser intro-
ducido mediante un valor entero. Para conocer las opciones disponibles, se puede utilizar el comando
algoptions(), como se muestra en el siguiente ejemplo

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

En este caso, el algoritmo tiene uno de tales parámetros, con siete opciones. Tenga en cuenta que ordenar
en base cero.

• La entrada múltiple. El valor es una cadena con descriptores de entrada separadas por punto y coma (;).
Como en el caso de capas individuales o tablas, cada descriptor de entrada se puede el nombre del objeto de
datos, o su ruta de archivo.

• El campo de la tabla de XXX. Utilice una cadena con el nombre del campo a usar. Este parámetro es
sensible a mayúsculas y minúsculas.

• Tabla fija. Escribir la lista de todas las tablas de valores separadas por comas (,) y cerrar entre comillas
("). Los valores que empiezan en la fila superior y van de izquierda a derecha. También se puede utilizar
un arreglo 2-D de valores que representen la tabla.

• SRC. Introduzca el número del código EPSG del SRC deseado.

• Extensión. Se debe utilizar una cadena con valores de xmin, xmax, ymin y ymax‘ separados por
comas (,‘‘).

Los parámetros boolean, archivo, cadena y numéricos no necesitan alguna explicación adicional.

Los parámetros de entrada tales como valores string, booleanos o numericos tienen valores predeterminados. Para
utilizarlos, especificar None en la entrada del parámetro correspondiente.

Para objetos de datos de salida, escriba la ruta del archivo que se utilizará para guardarlo, del mismo modo que se
hace desde la caja de herramientas. Si desea guardar el resultado a un archivo temporal, use None. La extensión
del archivo determina el formato de archivo. Si se ingresa la extensión no reconocida por el algoritmo, el formato
de archivo predeterminado par el tipo de salida se utilizará, y su extensión correspondiente anexa a la ruta del
archivo dado.

A diferencia de cuando un algoritmo se ejecuta desde la caja de herramientas, las salidas no se añaden a la vista
del mapa si se ejecuta el mismo algoritmo desde la consola de Python. Si desea añadir una salida a la vista del
mapa, tiene que hacerlo por si mismo después de ejecutar el algoritmo. Para ello, puede utilizar los comandos de
la API QGIS, o, aún más fácil, utilice uno de los métodos prácticos previstos para tales tareas.

El método runalg regresa un diccionario con los nombres de salida (los que se muestran en la descripción del
algoritmo) como llaves y la ruta del archivo de esas salidas como valores. Se pueden cargar esas capas al pasar las
rutas de archivo correspondientes al método load().

20.7.2 Funciones adicionales para manipular datos

Además de las funciones que se utilizan para llamar algoritmos, que importan el paquete procesos también
importará algunas funciones adicionales que hacen que sea más fácil trabajar con datos, particularmente datos
vectoriales. Ellos son sólo funciones de confort que envuelven algunas funciones del API de QGIS, por lo general
con una sintaxis menos compleja. Estas funciones se deben utilizar en el desarrollo de nuevos algoritmos, ya que
hacen que sea más fácil de operar con datos de entrada.
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Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Regresa un objeto QGIS (una capa o tabla) del objeto pasado, que puede ser un
nombre de archivo o el nombre de un objeto en la lista de capas de QGIS.

• values(layer, fields): Regresa los valores en la tabla de atributos de una capa vectorial, para los
campos pasados. Los campos se pueden pasar como nombres de campos o como indices de archivos de base
cero. Devuelve un diccionario de listas, con el identificador del campo pasado como llaves. Se considera la
selección existente.

• features(layer): Devuelve un iterador sobre las características de una capa vectorial, considerando
la selección existente.

• uniqueValues(layer, field): Devuelve una lista de valores únicos para un atributo dado. Los
atributos se pueden pasar como un nombre de campo o indice de campo de base cero. Se considera la
selección existente.

20.7.3 Crear scripts y ejecurarlos desde le Caja de Herramientas

Puede crear sus propios algoritmos escribiendo código Python y añadiendo unas pocas líneas extras para sum-
inistrar información adicional necesaria para definir la semántica del algoritmo. Se puede encontrar en el menú
guilabel:Crear nuevo script bajo el grupo Herramientas en el bloque de algoritmos Script de la caja de herramien-
tas. Haga doble clic en él para abrir el diálogo de edición de script. Eso es donde debe escribir su código. Guarde
el script en la carpeta scripts (la carpeta predeterminada cuando abre el diálogo del archivo guardado) con la
extensión .py automáticamente crea el algoritmo correspondiente.

El nombre del algoritmo (el que podrá ver en la caja de herramientas) se crea a partir del nombre de archivo, la
eliminación su extensión y la sustitución de guiones bajos con espacios en blanco.

Vamos a echar un vistazo a el siguiente código, que calcula el Índice de Humedad topográfica (TWI) directamente
de un DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Como puede ver, el calculo implica tres algoritmos, todos ellos provenientes de SAGA. El último que calcula el
TWI, pero se necesita una capa de pendientes y una capa de acumulación de flujo. No tenemos estas capas, pero
ya tenemos el DEM, podemos calcularlas llamando a los algoritmos SAGA correspondientes.

La parte del código donde este procesamiento se lleva a cabo no es difícil de entender si ha leído las secciones an-
teriores de este capítulo. Las primeras líneas, sin embargo, necesitan alguna explicación adicional. Proporcionan
la información que se necesita para convertir su código en un algoritmo que se puede ejecutar desde cualquiera de
los componentes GUI, como la caja de herramientas o el modelador gráfico.

Estas líneas comienzan con un doble símbolo de comentario en Python (##) y tiene la siguiente estructura:

[parameter_name]=[parameter_type] [optional_values]

Aquí esta una lista de todos los tipos de parámetros que se admiten en scripts de procesamiento, su sintaxis y
algunos ejemplos.

• ráster. Una capa ráster.

• vector. Una capa vectorial.

• table. Una tabla.
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• número. Un valor numérico. Un valor por defecto debe ser proporcionado. Por ejemplo, depth=number
2.4.

• string. Una cadena de texto. Como en el caso de valores numéricos, por defecto se debe añadir un valor.
Por ejemplo, name=string Victor.

• boolean. Un valor boolean. Añade True o False después para establecer el valor predeterminado. Por
ejemplo, verbose=boolean True.

• ráster múltiple. Un conjunto de capas ráster de entrada.

• Vector múltiple. Un conjunto de capas vectoriales de entrada.

• Campo. Un campo es la tabla de atributos de una capa vectorial. El nombre de la capa se tiene que añadir de-
spués de la etiqueta Campo. Por ejemplo, si ha declarado una vectorial de entrada con mylayer=vector,
podría utilizar myfield=field mylayer para añadir un campo de esa capa como parámetro.

• folder. Una carpeta.

• file. A nombre de archivo.

El nombre del parámetro es el nombre que se mostrará al usuario cuando ejecuta el algoritmo, y también el nombre
de variable a utilizar en la secuencia de código. El valor introducido por el usuario para ese parámetro se asignará
a la variable con ese nombre.

Cuando muestra el nombre del parámetro al usuario, el nombre será editado para mejorar su apariencia, en susti-
tución de guiones bajos con espacios. Así, por ejemplo, si desea que el usuario vea un parámetro llamado Un
valor numérico, puede utilizar el nombre de la variable A_numerical_value.

Los valores de capas y tablas son cadenas que contienen la ruta del archivo del objeto correspondiente. Para con-
vertirlos en un objeto QGIS, puede utilizar la función processing.getObjectFromUri(). Las múltiples
entradas también tienen un valor de cadena, que contiene las rutas de los archivos a todos los objetos selecciona-
dos, separados por punto y coma (;).

Las salidas están definidas en una manera similar, utilizando los siguientes etiquetas:

• ráster de salida

• vector de salida

• tabla de salida

• html de salida

• archivo de salida

• número de salida

• texto de salida

El valor asignado a las variables de salida es siempre una cadena con una ruta de archivo. Corresponderá a una
ruta de archivo temporal en caso de que el usuario no haya introducido ningún nombre de archivo de salida.

Cuando declare una salida, el algoritmo intentará agregarlo a QGIS una vez que este terminado. Esa es la razón,
por la cual el método runalg() no carga las capas que produce, la capa final TWI será cargada (utilizando el
caso de nuestro ejemplo anterior), ya que se guarda en el archivo introducido por el usuario, que es el valor de la
salida correspondiente.

No utilice el método load() en sus algoritmos de script, sino sólo cuando se trabaja con la línea de la consola. Si
una capa es creada como salida de un algoritmo, debe ser declarada como tal. De lo contrario, usted no será capaz
de utilizar correctamente el algoritmo en el modelador, ya que su sintaxis (según la definición de las etiquetas
explicadas anteriormente) no coincidirá con lo que crea realmente el algoritmo.

Salidas ocultas (números y cadenas) no tienen un valor. En cambio, tiene que asignar un valor a los mismos. Para
ello, basta con establecer el valor de una variable con el nombre que utilizó para declarar la salida. Por ejemplo,
si ha utilizado esta declaración,

##average=output number
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La siguiente linea establecerá el valor de salida a 5:

average = 5

Además de las etiquetas para los parámetros y resultados, también puede definir el grupo en las que se muestra el
algoritmo, utilizando la etiqueta grupo.

Si su algoritmo toma mucho tiempo para procesar, es una buen idea informar al usuario. Se tiene una global lla-
mada progreso disponible, con dos métodos posibles: setText(text) y setPercentage(percent)
para modificar el texto y la barra de progreso.

Varios ejemplos son proporcionados. Por favor, consulte con ellos para ver ejemplos reales de cómo crear algorit-
mos utilizando las clases del marco de procesamiento. Haga clic derecho en cualquier script y seleccione Editar
script para editar su código o sólo para verlo.

20.7.4 Documentación de las secuencias de comandos

Al igual que en el caso de los modelos, puede crear documentación adicional para sus scripts, para explicar qué
hacen y como utilizarlos. En el diálogo de edición de scripts, encontrará un botón [Editor de ayuda]. Haga clic
en él y le llevará al diálogo de editor de ayuda. Compruebe la sección acerca del modelador gráfico para conocer
más sobre este diálogo y cómo utilizarlo.

Los archivos de ayuda se guardan en el mismo folder como el script mismo, añadiendo la extensión .help
al nombre del archivo. Tenga en cuenta que puede editar la ayuda de su script antes de guardarlo la primera
vez. Si después cierra el diálogo de edición de script sin guardarlo (es decir, descartarlo), el contenido de la
ayuda que escribió se perderá. Si su script ya fue guardado y tiene asociado un nombre de archivo, se guardara
automáticamente.

20.7.5 Pre y post-ejecución de la secuencia de comandos hooks

Los scripts también pueden ser utilizados para establecer ganchos pre- y post ejecuciones, que se ejecutan antes y
después de la ejecución de un algoritmo. Esto se puede utilizar para automatizar tareas que deben realizarse cada
vez que se ejecuta un algoritmo.

La sintaxis es idéntica a la que se ha explicado anteriormente, pero una variable global adicional llamada alg está
disponible, lo que representa el algoritmo que acaba de ser (o está a punto de ser) ejecutado.

En el grupo General del cuadro de diálogo de configuración de procesamiento se encuentran dos entradas llamadas
Script preejecución y el :guilabel: Script postejecución donde el nombre de archivo de los scripts a ser ejecutados
en cada caso se pueden introducir.

20.8 Escribir nuevos algoritmos de procesamiento como scripts
python

Puede crear sus propios algoritmos escribiendo el código Python correspondiente y añadiendo algunas líneas
adicionales para suministrar la información adicional necesaria para definir la semántica del algoritmo. Puede
encontrar un menú Crear nuevo script bajo el grupo Herramientas en el bloque de algoritmos Script de la caja
de herramientas. Haga doble clic en él para abrir el diálogo de edición de script. Ahí es donde se debe escribir
el código. Guardar el script desde allí en la carpeta scripts (el predeterminado cuando se abre el diálogo de
guardar archivo), con la extensión .py, creará automáticamente el algoritmo correspondiente.

El nombre del algoritmo (el que podrá ver en la caja de herramientas) se crea a partir del nombre de archivo,
elimine su extensión y sustituya los guiones bajos con espacios en blanco.

Vamos a tener el siguiente código, que calcula el Índice de Humedad Topográfico (TWI) directamente desde un
DEM
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##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Como se puede ver, se trata de 3 algoritmos, todos ellos procedentes de SAGA. El último de ellos calcula el TWI,
pero necesita una capa de pendiente y una capa de acumulación de flujo. Nosotros no tenemos estos, pero ya
tenemos el DEM, podemos calcularlos llamando a los algoritmos de SAGA correspondientes.

La parte del código donde este procesamiento se lleva a cabo no es difícil de entender si has leído el capítulo
anterior. Las primeras líneas, sin embargo, necesitan una explicación adicional. Proporcionan la información que
se necesita para convertir su código en un algoritmo que se pueda ejecutar desde cualquiera de los componentes
GUI, como la caja de herramientas o el modelador gráfico.

Estas líneas comienzan con un doble símbolo de comentario en Python (##) y tiene la siguiente estructura

[parameter_name]=[parameter_type] [optional_values]

Aquí esta una lista de todos los tipos de parámetros que se admiten en scripts de procesamiento, su sintaxis y
algunos ejemplos.

• raster. Una capa ráster

• vector. Una capa vectorial

• table. Una tabla

• number. Un valor numérico. Un valor predeterminado debe ser proporcionado. Por ejemplo,
depth=number 2.4

• string. Una cadena de texto. Como en el caso de los valores numéricos, un valor predeterminado se debe
añadir. Por ejemplo, name=string Victor

• longstring. Igual que el string, pero un cuadro de texto más grande se mostrará, por lo que es más
adecuado para cadenas largas, como para un script esperando un pequeño fragmento de código.

• boolean. Un valor boolean. Añade True o False después para establecer el valor predeterminado. Por
ejemplo, verbose=boolean True.

• multiple raster. Un conjunto de capas ráster de entrada.

• multiple vector‘. Un conjunto de capas vectoriales de entrada.

• field. Un campo en la tabla de atruibutos de una capa vectorial. El nombre de la capa se tiene
que añadir después de la etiqueta field. Por ejemplo, si ha declarado una vectorial de entrada con
mylayer=vector, podría utilizar myfield=field mylayer para añadir un campo de esa capa
como parámetro.

• extent. Una extensión espacial definida por xmin, xmax, ymin, ymax

• folder. Una carpeta

• file. Un nombre de archivo

• crs. Un Sistema de Referencia de Coordenadas

• selection. Un menú desplegable que permite al usuario seleccionar desde una lista prepoblada. Por
ejemplo units=selection sq_km;sq_miles;sq_degrees

• name. Nombre del script. Este se desplegará como el nombre del algoritmo en la caja de herramientas de
procesado. Por ejemplo El nombre de mi algoritmo=name

• group. EL nombre de la carpeta donde el script aparece en la caja de herramientas de procesado. Por
ejemplo, añadir Utils=groups poner el script dentro de la carpeta Utils, dentro del los Scripts.
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El nombre del parámetro es el nombre que se mostrará al usuario cuando ejecute el algoritmo, y también el nombre
de la variable a utilizar en el código del script. El valor introducido por el usuario para ese parámetro será asignado
a una variable con ese nombre.

Cuando muestra el nombre del parámetro al usuario, el nombre será editado para mejorar su apariencia, en susti-
tución de guiones bajos con espacios. Así, por ejemplo, si desea que el usuario vea un parámetro llamado Un
valor numérico, puede utilizar el nombre de la variable A_numerical_value.

Los valores de capas y tablas son cadenas que contienen la ruta del archivo del objeto correspondiente. Para con-
vertirlos en un objeto QGIS, puede utilizar la función processing.getObjectFromUri(). Las múltiples
entradas también tienen un valor de cadena, que contiene las rutas de los archivos a todos los objetos selecciona-
dos, separados por punto y coma (;).

Las salidas son definidas en una manera similar, utilizando las siguientes etiquetas:

• ráster de salida

• vector de salida

• tabla de salida

• html de salida

• archivo de salida

• número de salida

• texto de salida

• Extensión de salida

El valor asignado a las variables de salida es siempre una cadena con una ruta de archivo. Corresponderá a una
ruta de archivo temporal en el caso de que el usuario no ha introducido ningún nombre de archivo de salida.

Además de las etiquetas para los parámetros y resultados, también puede definir el grupo en las que se muestra el
algoritmo, utilizando la etiqueta group.

La última etiqueta que se puede utilizar en su cabecera guión es ##nomodeler. Utilice que cuando no quiere
que su algoritmo se muestra en la ventana modelador. Esto se debe utilizar para los algoritmos que no tienen una
sintaxis clara (por ejemplo, si el número de capas que se crearon no se conoce de antemano, en tiempo de diseño),
que los hacen inadecuados para el modelador gráfico

20.8.1 Manipulación de datos producidos por el algoritmo

Cuando se declara una representación de salida, una capa (raster, vector o tabla), el algoritmo intentará agregarlo
a QGIS una vez que esté terminado. Esa es la razón por la cual, aunque el método runalg() no carga las capas
que produce, la capa final TWI se cargará, ya que se guarda en el archivo introducido por el usuario, que es el
valor de la salida correspondiente.

No utilice el método load() en sus algoritmos de script, sino sólo cuando se trabaja con la línea de la consola.
Si se crea una capa como salida de un algoritmo, que debe ser declarada como tal. De lo contrario, usted no
será capaz de utilizar correctamente el algoritmo en el modelador, ya que su sintaxis (según la definición de las
etiquetas se ha explicado anteriormente) no coincidirá con lo que crea realmente el algoritmo.

Salidas ocultas (números y cadenas) no tienen un valor. En cambio, es quien tiene que asignar un valor a los
mismos. Para ello, acaba de establecer el valor de una variable con el nombre que utilizó para declarar la salida.
Por ejemplo, si ha usado esta declaración,

##average=output number

En la siguiente línea se establezerá el valor de la salida a 5:

average = 5
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20.8.2 La comunicación con el usuario

Si su algoritmo toma mucho tiempo para procesar, es una buen idea informar al usuario. Se tiene un nombre global
progreso disponible, con dos métodos disponibles: setText(text) y setPercentage(percent)
para modificar el texto y la barra de progreso.

Si tiene información para proporcionar al usuario, no relacionada al progreso del algoritmo, se puede utilizar el
método setInfo(text), también del objeto progreso.

Si su script tiene algún problema, la forma correcta de propagación es plantear una excepción de tipo
GeoAlgorithmExecutionException(). Se puede pasar un mensaje como argumento al constructor de la
excepción. El procesamiento se hará cargo de la manipulación y comunicación con el usuario, dependiendo desde
donde se este ejecutando el algoritmo (Caja de herramientas, modelador, consola Python...)

20.8.3 Documentando sus scripts

Al igual que en el caso de los modelos, se pueden crear documentación adicional para su script, para explicar qué
hacen y cómo utilizarlos. En el diálogo de edición de scripts, encontrará un botón ** [Ayudar en la edición de
scripts] **. Haga clic en él y le llevará al cuadro de diálogo de edición de ayuda. Compruebe el capítulo sobre el
modelador gráfica para saber más acerca de este cuadro de diálogo y cómo usarlo.

Los archivos de ayuda se guardan en la misma capa como el script mismo, añadiendo la extensión .help al
nombre del archivo. Tenga en cuenta que puede editar la ayuda de su script antes de guardarlo la primera vez. Si
después cierra el diálogo de edición de script sin guardarlo (es decir, descartarlo), el contenido de la ayuda que
escribió se perderá. Si su script ya fue guardado y tiene asociado un nombre de archivo, se guardara automática-
mente.

20.8.4 Scripts de ejemplo

Varios ejemplos están disponibles en la colección en línea de scripts, que pueden acceder al seleccionarlo la
herramienta Obtener script de la colección de script en línea bajo la entrada Scripts/herramientas en la caja de
herramientas.

Figure 20.32: Procesando Obtener scripts

Por favor, compruebe con ellos para ver ejemplos reales de cómo crear algoritmos que utilizan las clases de la
arquitectura de procesamiento. Puede hacer clic derecho sobre cualquier algoritmo de secuencia de comandos y
seleccione Editar script para editar su código o simplemente para verlo.

20.8.5 Las mejores practivas al escribir scripts de algoritmos

Aquí esta un resumen rápido de ideas a considerar cuando crea su propio script de algoritmos y especialemente,
si se desea compartir con otros usuarios de QGIS. Siguiendo estas sencillas reglas asegurará la consistencia entre
los diferentes elementos de procesamiento, tales como la caja de herramientas, el modelador o la interfaz de
procesamiento por lotes.

• No cargar la capa resultante. Deje al Procesamiento manejar sus resultados y cargue sus capas si es nece-
sario.

• Declarar siempre las salidas de su algoritmo creado. Evitar cosas tales como declarar una salida y luego
usando el nombre de archivo de destino establecido para esa salida para crear una colección de ellos. Eso
romperá la semántica correcta del algoritmo y hará que sea imposible usar de forma segura en el modelador.
Si usted tiene que escribir un algoritmo así, asegúrese de agregar la etiqueta ##nomodeler.
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• No mostrar cajas de mensaje o utilice algún elemento GUI desde el script. Si desea comunicarse con el
usuario, utilice el método setInfo() o lance GeoAlgorithmExecutionException

• Como una regla de oro, no olvide que su algoritmo puede ser ejecutado en un contexto que no sea la caja de
herramientas de procesamiento.

20.8.6 Pre y post ejecución de ganchos de scripts

Los scripts también pueden ser utilizados para establecer ganchos pre y post ejecución, que se ejecutan antes y
después de un algoritmo. Esto se puede utilizar para automatizar tareas que deben realizarse cada vez que se
ejecuta un algoritmo.

La sintaxis es idéntica a la que se ha explicado anteriormente, pero una variable global adicional llamada alg esta
disponible, lo que representa el algoritmo que acaba de ser (o esta a punto de ser) ejecutado.

En el grupo General del cuadro de diálogo de configuración de procesamiento se encuentran dos entradas llamadas
Archivo de script de pre-ejecución y el script :guilabel: Archivo script post-ejecución donde el nombre de archivo
de los scripts que deben ejecutarse en cada caso se pueden introducir.

20.9 Configurar aplicaciones externas

El entorno de procesamiento se puede extender el uso de aplicaciones adicionales. Actualmente, SAGA, GRASS,
OTB (Orfeo Toolbox) y R son reconocidos, junto con algunas otras aplicaciones de línea de comandos que pro-
porcionan funcionalidades de análisis de datos espaciales. Los algoritmos que dependen de una aplicación externa
son administrados por su propio proveedor de algoritmos.

Esta sección le mostrará cómo configurar el entorno de procesamiento para incluir estas aplicaciones adicionales,
y le explicará algunas de las características particulares de los algoritmos basados en ellos. Una vez que haya
configurado correctamente el sistema, usted será capaz de ejecutar algoritmos externos de cualquier componente,
como la caja de herramientas o el modelador gráfico, tal como lo hace con cualquier otro geoalgoritmo.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.

20.9.1 Aclaración para los usuarios de Windows

Si no es un usuario avanzado y está ejecutando QGIS en Windows, podría no estar interesado en leer el resto de
este capítulo. Asegure que la instalación de QGIS en su sistema utiliza el instalador independiente. Esto instalará
automáticamente SAGA, GRASS y OTB en su sistema y configurarlos para que se pueden ejecutar desde QGIS.
Todos los algoritmos estarán listas para ser ejecutados sin necesidad de alguna configuración adicional. Si va a
instalar mediante la aplicación OSGeo4W, asegúrese de seleccionar SAGA, OTB para la instalación.

Si quiere saber más sobre cómo funcionan estos proveedores, o si quiere utilizar algún algoritmo que no se en-
cuentre en la Caja de Herramientas simplificada (como los scripts de R), siga leyendo.

20.9.2 Aclaración respecto a los formatos de archivos

Cuando se utiliza un software externo, la apertura de un archivo en QGIS no significa que se puede abrir y procesar
bien en ese otro software. En la mayoría de los casos, otro software puede leer lo que ha abierto en QGIS, pero
en algunos casos, eso puede no ser cierto. Al utilizar las bases de datos o formatos de archivo poco comunes, ya
sea para capas raster o vectoriales, podrían surgir problemas. Si eso sucede, trate de utilizar formatos de archivo
conocidos que este seguro que ambos programas entiendan, y comprobar la salida de la consola (en el historico y
el diálogo de registro) para saber más acerca de lo que va mal.
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Utilizar capas raster de GRASS es, por ejemplo, uno de los casos en los que pueden existir problemas y no
completarse el trabajo si se invoca un algoritmo externo que use dicha capa como entrada. Por este motivo, estas
capas no aparecerán como disponibles para los algoritmos.

Debe, sin embargo, no encontrar ningún problema en absoluto con las capas vectoriales, ya que QGIS convierte
automáticamente desde el formato de archivo original a uno aceptado por la aplicación externa antes de pasar la
capa a la misma. Esto suma tiempo de procesamiento adicional, que podría ser significativo si la capa tiene un
tamaño grande, así que no se sorprenda si se necesita más tiempo para procesar una capa de una conexión de DB
que lo hace para procesar una de un tamaño similar almacenada en un archivo de shape.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

20.9.3 Nota referente a las seleccion de capas vectoriales

Las aplicaciones externas pueden también ser conscientes de las selecciones que existen en capas vectoriales den-
tro QGIS. Sin embargo, eso requiere reescribir todas las capas vectoriales de entrada, al igual que si originalmente
estuvieran en un formato no compatible con la aplicación externa. Sólo cuando no existe ninguna selección o la
opción *Utilizar sólo objetos espaciales seleccionados * no está activada en la configuración general de proce-
samiento, puede una capa ser directamente pasada a una aplicación externa.

En otros casos sólo es necesario exportar un conjunto de características seleccionadas, lo que hará que los tiempos
de ejecución sean mayores.

20.9.4 SAGA

Los algoritmos de SAGA pueden ser ejecutados desde QGIS si se tiene SAGA instalado en su sistema y se puede
configurar correctamente el entorno de procesamiento para que pueda encontrar ejecutables SAGA. En particular,
se necesita la línea de comandos SAGA ejecutable para ejecutar algoritmos SAGA.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

En este caso, no hay necesidad de configurar la ruta al ejecutable de SAGA, y no se verán esas carpetas. En su
lugar, debe asegurarse de que SAGA está correctamente instalado y se añade su carpeta a la variable de entorno
PATH. Sólo tiene que abrir una consola y escribir saga_cmd para comprobar que el sistema puede encontrar
donde se encuentran los archivos binarios de SAGA.

Sobre las limitaciones del sistema de cuadrícula de SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).
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La definición de este sistema de cuadrícula común es controlado por el usuario, y se encontrará varios parámetros
en el grupo SAGA de la ventana de configuración para hacerlo. Hay dos formas de establecer el sistema de
cuadrícula de destino.

• Establecerlo manualmente. se define la extensión estableciendo los valores de los siguientes parámetros:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Notice that QGIS will resample input layers to that extent, even if they do not overlap with it.

• Ajuste de forma automática a partir de capas de entrada. Para seleccionar esta opción, simplemente marque
la opción Utilizar el sistema de cuadrícula mínima para remuestreo. Todos los demás ajustes se ignoran y
la medida mínima que cubre todas las capas de entrada que se utilizarán. El tamaño de celda de la capa de
destino es el máximo de todos los tamaños celulares de las capas de entrada.

Para los algoritmos que no utilizan múltiples capas raster, o para aquellos que no necesitan un único sistema de
cuadrícula de entrada, no se realizará un remuestreo antes de invocar SAG y dichos parámetros no son utilizados.

Limitaciones para las capas multibanda

A diferencia de QGIS, SAGA no tiene soporte para capas multibanda. Si desea utilizar una capa multibanda (como
un RGB o imagen multiespectral), primero hay que dividirlo en imágenes de un sola banda. Para ello, se puede
utilizar el algoritmo ‘imagen SAGA/Grid - Herramientas/Dividir’ (que crea tres imágenes de una imagen RGB) o
el algoritmo ‘banda SAGA/Grid - Herramientas / Extracto’ (para extraer una sola banda).

Limitaciones en el tamaño de celda

SAGA asume que las capas ráster tienen el mismo tamaño de celda en el eje X y Y. Si se está trabajando con
una capa con diferentes valores para el tamaño de celda horizontal y vertical, es posible que obtenga resultados
inesperados. En este caso, se añadirá una advertencia al registro de procesamiento, lo que indica que una capa de
entrada podría no ser adecuada para ser procesada por SAGA.

Registro

Cuando QGIS llama a SAGA, lo hace utilizando su interfaz de linea de comandos, pasando así de un conjunto de
comandos para realizar todas las operaciones necesarias. SAGA muestra su progreso al escribir información a la
consola, que incluye el porcentaje de procesamiento ya realizado junto con el contenido adicional. Esta salida se
filtra y utiliza para actualizar la barra de proceso mientras el algoritmo se ejecuta.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

La mayoría del resto de proveedores que utilizan una aplicación externa y la invocan a través de la línea de
comandos tienen opciones similares, de forma que las podrá encontrar también en otros lugares de la lista de
ajustes de procesamiento.

20.9.5 R. Creating R scripts

La integración R en QGIS es diferente al de SAGA y es que no hay un conjunto predefinido de algoritmos que
pueda ejecutar (a excepción de algunos ejemplos). En su lugar, debe escribir sus scripts y llamar a los comandos
R, al igual que lo haría desde R, y de una manera muy similar a lo que vimos en la sección dedicada a scripts de
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procesamiento. En esta sección se muestra la sintaxis para usar y llamar a los comandos de R QGIS y cómo usar
en QGIS los objetos (capas, tablas) en ellos.

Lo primero que tienes que hacer, como vimos en el caso de SAGA, es decirle a QGIS donde se encuentran los
archivos binarios R. Se puede hacer esto mediante la entrada :guilabel: Carpeta de R en el diálogo de configuración
de procesamiento. Una vez establecido ese parámetro, se puede empezar a crear y ejecutar sus propios scripts de
R.

Nota: for Windows user, usually the R executable file is in the C:\Program Files\R\R-3.2 folder. Add
just the folder and NOT the binary!

De nuevo, esto es diferente en Linux, dónde sólo hay que asegurarse de que el directorio de R está correctamente
incluido en la variable de entorno PATH. Si R puede iniciarse simplemente escribiendo R en una consola, entonces
la configuración es correcta.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

Los archivos de script de R tienen la extensión .rsx, y crearlos es bastante sencillo si sólo tiene un conocimiento
básico de la sintaxis y script de R. Deben ser almacenados en la carpeta de scripts de R. Se puede establecer esta
carpeta en el grupo de ajustes R (disponible desde el diálogo de Configuración de procesamiento), al igual que se
hace con la carpeta para scripts de procesamiento regular.

Vamos a echar un vistazo a un archivo de script muy simple, que llama al método R spsample para crear una
cuadricula al azar dentro de los límites de los polígonos en una capa de polígono dada. Este método pertenece al
paquete maptools. Dado que casi todos los algoritmos que pueden gustar incorporar a QGIS utilizará o generará
datos espaciales, el conocimiento de paquetes espaciales como maptools y sobretodo sp es obligatoria.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

Cuando se declara un parámetro de entrada, QGIS usa esa información con dos finalidades: crear la interfaz de
usuario que solicita al usuario el valor de dicho parámetro y crear la variable correspondiente en R que se pueda
usar después como entrada para los comandos en R.

In el ejemplo anterior, estamos declarando un tipo de entrada vector llamado polyg. Al ejecutar el algoritmo,
QGIS abrirá en R la capa seleccionada por el usuario y almacenarlo en una variable llamada polyg‘. Así el nombre
de uno de los parámetros también es el nombre de la variable que se puede utilizar en R para acceder el valor de
ese parámetro (así, se debe evitar utilizar palabras de R reservadas como nombres de parámetros).

Los elementos espaciales como las capas vectoriales y ráster se leen utilizando los comandos readOGR() y
brick() (no tiene que preocuparse acerca de cómo agregar estos comandos a su archivo de descripción - QGIS
lo hará), y se almacenan como objetos Spatial*DataFrame. Los campos de la tabla se almacenan como
cadenas que contienen el nombre del campo seleccionado.

Las tablas se abren con el comando read.csv(). Sin una tabla introducida por el usuario no esta en formato
CSV, será convertirá antes de importarlo en R.

Además, los ráster se pueden leer con el comando readGDAL()‘ en lugar de ‘‘brick() utilizando el
##usereadgdal.

Si se es un usuario avanzado y no quiere QGIS para crear el objeto que representado la capa, puede utilizar la
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etiqueta ##passfilenames para indicar que prefiere una cadena con el nombre de archivo en su lugar. En este
caso, le corresponde abrir el archivo antes de realizar cualquier operación sobre los datos que contiene.

Con la información anterior, se puede comprender la primera línea de nuestro primer script de ejemplo (la primera
línea que no comienza con un comentario de Python).

pts=spsample(polyg,numpoints,type="random")

La variable polygon ya contiene un objeto SpatialPolygonsDataFrame, por lo que se puede utilizar para
llamar al método spsample, al igual que numpoints, que indica el número de puntos a añadir a la rejilla de
ejemplo creada.

Como hemos declarado una salida de tipo vectorial llamada salida, tenemos que crear una vari-
able llamada salida y almacenar un objeto Spatial*DataFrame en ella (en este caso, un
SpatialPointsDataFrame). Se puede utilizar cualquier nombre para sus variables intermedias. Sólo
asegúrese de que la variable almacena su resultado final y que tiene el mismo nombre que utilizó al declararla, y
que contiene un valor adecuado.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

Si ha utilizado la opción #passfilenames, las salidas se generan utilizando el paquete raster (mediante
writeRaster()), incluso cuando no se utiliza para las entradas.

Si el algoritmo no genera ninguna capa, sino más bien en su lugar regresa un texto en la consola, tiene que indicar
lo que desea que la consola mostrará una vez finalizada la ejecución. Para ello, basta con iniciar la línea de
comandos que producen los resultados que desea imprimir con el signo > ‘(‘mayor’). La salida de todas las otras
líneas no se mostrará. Por ejemplo, aquí está el archivo de descripción de un algoritmo que realiza una prueba
normalmente en un determinado campo (columna) de los atributos de una capa vectorial:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

La salida de la última línea se imprime, pero la salida de la primera no (y tampoco están las salida de otras líneas
de comando agregadas automáticamente por QGIS).

Si su algoritmo crea algún tipo de gráficos (utilizando el método plot()), añada la siguiente línea:

##showplots

Esto provocará que QGIS redireccione todas las salidas de gráficas R a un archivo temporal, que se abrirá una vez
que terminé la ejecución de R.

Tanto los resultados gráficos como de consola, se mostrará en el gesto de resultados de procesamiento.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Nota: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.
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20.9.6 GRASS

Configurar GRASS no es muy diferente de la configuración de SAGA. En primer lugar, la ruta de la carpeta
GRASS debe ser definido, pero solo si se ejecuta en Windows. Adicionalmente, un interprete de comandos
(usualmente msys.exe, que se puede encontrar en la mayoría de distribuciones GRASS para Windows) tiene
que ser definido y establecer la ruta también.

Por defecto, el marco de procesamiento intenta configurar el conector de GRASS para utilizar la distribución
GRASS que se incluye junto con QGIS. Esto debería funcionar sin problemas en la mayoría de los sistemas, pero
si tiene problemas, puede que tenga que configurar el conector GRASS manualmente. Además, si usted desea
utilizar una instalación diferente de GRASS, puede cambiar esta configuración y seleccionar la carpeta donde está
instalada la otra versión. GRASS 6.4 es necesaria para que los algoritmos funcione correctamente.

Si se utiliza Linux, hay que asegurarse de que GRASS está correctamente instalado y que se puede ejecutar sin
problemas desde una consola.

Los algoritmos de GRASS utilizan una región para cálculos. Esta región se puede definir manualmente utilizando
valores similares a los encontrados en la configuración de SAGA, o automáticamente tomara la extensión mínima
que cubre todas las capas de entrada utilizadas para ejecutar el algoritmo cada vez. Si el último enfoque es
el comportamiento que prefiere, simplemente marque la opción Utilizar la región de cobertura mínima en los
parámetros de configuración de GRASS.

20.9.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

20.9.8 Caja de Herramientas de Orfeo

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Entonces, configurar la ruta al directorio donde las aplicaciones de línea de comandos y las librerías de OTB se
encuentran instaladas:

• Normalmente, el directorio de aplicaciones de OTB apunta a ‘/usr/lib/otb/applications‘‘ y el directorio
con los programas de línea de comandos de OTB es ‘/usr/bin‘‘.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.

20.9.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
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file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.

TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Nota: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Instalando TauDEM bajo Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Nota: Si quiere usar TauDEM 5.0.6

Instalando TauDEM bajo Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Nota: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Abrir el archivo linearpart.h , y después de la línea

#include "mpi.h"

añadir una nueva linea con

#include <stdint.h>

y obtendrá

#include "mpi.h"
#include <stdint.h>
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Guardar los cambios y cerrar el archivo. Ahora abir tiffIO.h, buscar la línea #include "stdint.h" y
sustituir las comillas ("") con <>, para obtener

#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configurar proveedor TauDEM

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Nota: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.

20.10 La línea de órdenes de QGIS

El procesado incluye una herramienta practica que le permite ejecutar algoritmos sin tener que utilizar la caja de
herramientas, pero tan solo escribir el nombre del algoritmo que se desee ejecutar.

Esta herramienta es conocida como Línea de órdenes GQIS, y esto es solo una sencilla caja de texto con autocom-
pletado donde se escribe el nombre del comando que se desee ejecutar.

La línea de órdenes se inicia del menú Procesamiento o, mas practico, al presionar Shift + Ctrl + M (puede
cambiar ese atajo de teclado en la configuración de QGIS si prefiere definir uno diferente). Para cerrarlo sólo
presione ESC. Ademas de ejecutar algoritmos de procesado, la línea de órdenes da acceso a la mayoría de las
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Figure 20.33: La línea de órdenes de QGIS

funcionalidades en QGIS, lo que significa que le da una forma práctica y eficaz de ejecutar tareas QGIS y le
permite controlar QGIS con un uso reducido de botones y menús.

Además, la línea de órdenes es configurable, así que puede agregar sus comandos personalizados y ellos tienen sólo
unas pocas teclas de distancia, por lo que es una herramienta de gran alcance para ayudarle a ser más productivo
en su trabajo diario con QGIS.

20.10.1 Comandos disponibles

Los comandos disponibles en la línea de órdenes caen en la siguiente categoría:

• Algoritmos de procesado. Estos se muestran como Algoritmo de procesamiento: <nombre
del algoritmo>.

• Los elementos del menú. Estos se muestran como Menu item: <Texto de entrada del
menú>. Todos los elementos de los menús disponibles desde la interfaz de QGIS están disponibles, in-
cluso si se incluyen en un submenú.

• Funciones Python. Puede crear funciones cortas en Python que serán entonces incluidas en la lista de
comandos disponibles. Ellos se muestran como Function: <nombre de la función>.

Para ejecutar cualquiera de los anteriores, inicie escribiendo y a continuación, seleccione el elemento de la lista de
comandos disponibles que aparecen después de filtrar toda la lista de comandos con el texto que ha introducido.

En caso de llamar a una función de Python, puede seleccionar la entrada en la lista, que tiene
el prefijo Function: (por ejemplo, Function: removeall), o simplemente escribir
directamente el nombre de la función (‘‘removeall en el ejemplo anterior). No hay necesi-
dad de añadir espacios después del nombre de la función.

20.10.2 Crear funciones personalizadas

Las funciones personalizadas se añaden al introducir el código correspondiente de Python en el archivo
commands.py que se encuentra en el directorio .qgis2/processing/commander en su carpeta de
usuario. Es solo un archivo Python simple donde puede añadir las funciones que necesite.

El archivo es creado con unas pocas funciones de ejemplo la primera vez que se abre la línea de órdenes. Si no
ha lanzado la línea de órdenes, puede crear el archivo usted mismo. Para editar el archivo de comandos, utilice su
editor de texto favorito. También puede utilizar un editor incorporado llamando al comando edit desde la línea
de órdenes. Se abrirá el editor con el archivo de comandos, y se podrá editar directamente y luego guardar los
cambios.

Por ejemplo, puede añadir la siguiente función, la cual borre todas las capa:

from qgis.gui import *

def removeall():
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mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Una vez que se haya añadido la función, estará disponible en la línea de órdenes, y puede invocarlo escribiendo
removeall. No hay necesidad de hacer algo más aparte de escribir la función en sí.

Las funciones pueden recibir parámetros. Añadir *args a la definición de su función para recibir argumentos.
Cuando llame a la función desde la línea de órdenes, los parámetros tienen que ser pasados separados por espacios.

Aquí esta un ejemplo de una función que carga una capa y toma un parámetro con el nombre del archivo de la
capa cargada.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in ;file:/home/myuser/points.shp, type in the Commander text box:

load /home/myuser/points.shp

20.10. La línea de órdenes de QGIS 399



QGIS User Guide, Publicación 2.18

400 Chapter 20. Entorno de trabajo de procesamiento de QGIS



CHAPTER 21

Complementos

21.1 Consola Python de QGIS

As you will see later in this chapter, QGIS has been designed with a plugin architecture. Plugins can be written in
Python, a very famous language in the geospatial world.

QGIS brings a Python API (see PyQGIS Developer Cookbook for some code sample) to let the user interact with
its objects (layers, feature or interface). QGIS also has a Python console.

The QGIS Python Console is an interactive shell for the python command executions. It also has a python file
editor that allows you to edit and save your python scripts. Both console and editor are based on PyQScintilla2
package. To open the console go to Plugins → Python Console (Ctrl+Alt+P).

21.1.1 The Interactive Console

The interactive console is composed of a toolbar, an input area and an output one.

Barra de herramietas

The toolbar proposes the following tools:

• Clear console to wipe the output area;

• Import class: Processing, PyQt4.QtCore or PyQt4.QtGui class;

• Run command available in the input area: same as pressing Enter;

• Show editor: toggles El Editor de código visibility;

• Options...;

• Help....

Consola

The console main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4
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– QScintilla2

– osgeo-gdal-ogr

• Ctrl+Alt+Space to view the auto-completion list if enabled in the Opciones;

• Execute code snippets from the input area by typing and pressing Enter or Run Command;

• Execute code snippets from the output area using the Enter selected from the contextual menu or pressing
Ctrl+E;

• Browse the command history from the input area using the Up and Down arrow keys and execute the
command you want;

• Ctrl+Shift+Space to view the command history: double-clicking a row will execute the command.
The Command History dialog can also be accessed from context menu of input area;

• Save and clear the command history. The history will be saved into the file
~/.qgis2/console_history.txt;

• Open QGIS API documentation by typing _api;

• Open PyQGIS Cookbook by typing _pyqgis.

Truco: Reuse executed commands from the output panel
You can execute code snippets from the output panel by selecting some text and pressing Ctrl+E. No matter if
selected text contains the interpreter prompt (>>>, ...).

Figure 21.1: The Python Console

21.1.2 El Editor de código

Use the Show editor button to enable the editor widget. It allows editing and saving Python files and offers
advanced functionalities to manage your code (comment and uncomment code, check syntax, share the code via
codepad.org and much more). Main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4

– QScintilla2

– osgeo-gdal-ogr
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• Ctrl+Space to view the auto-completion list.

• Sharing code snippets via codepad.org.

• Ctrl+4 Syntax check.

• Search bar (open it with the default Desktop Environement shorcut, usually Ctrl+F):

– Use the default Desktop Environment shortcut to find next/previous (Ctrl+G and Shift+Ctrl+G);

– Automatically find first match when typing in find box;

– Set initial find string to selection when opening find;

– Pressing Esc closes the find bar.

• Object inspector: a class and function browser;

• Go to an object definition with a mouse click (from Object inspector);

• Execute code snippets with the Enter selected command;

• Execute the whole script with the Run script command (this creates a byte-compiled file with the extension
.pyc).

Nota: Running partially or totally a script from the Code Editor outputs the result in the Console output area.

Figure 21.2: The Python Console editor

21.1.3 Opciones

Accessible either from the Console toolbar or the contextual menu of Console output panel or Code Editor, this
adds further settings to manage and control the Python console behavior:

• Autocompletion: If checked the code completion is enabled. You can get autocompletion from current
document, from installed APIs and both from APIs and current document.

• Autocompletion threshold: Sets the threshold to display the autocompletion list (in chars typed).

• Automatic parentheses insertion: If checked enables the autoclosing for bracket.

• Auto-save script before running: Allows you to save automatically the script to be executed in order to
avoid to save it after any modification. This action will store a temporary file into the temporary system
directory that will be automatically deleted after running.
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• Using preloaded APIs file: You can choose whether use the preload APIs file or load some APIs files saved
on your system.

• Using prepared APIs file: If checked the *.pap file will be used for code completion. To generate a
prepared APIs file you have to load at least an *.api file and then compile it by clicking on [Compile
Apis...] button.

Truco: Save the options
To save the state of console’s widgets you have to close the Python Console from the close button. This allows
you to save the geometry to be restored to the next start.

21.2 Complementos de QGIS

QGIS has been designed with a plugin architecture. This allows many new features and functions to be easily
added to the application. Some of the features in QGIS are actually implemented as plugins.

21.2.1 Core and External plugins

QGIS plugins are implemented either as Core Plugins or External Plugins.

Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS distribu-
tion. They are written in one of two languages: C++ or Python.

Most of External Plugins are currently written in Python. They are stored either in the ‘Official’ QGIS Repository
at http://plugins.qgis.org/plugins/ or in external repositories and are maintained by the individual authors. Detailed
documentation about the usage, minimum QGIS version, home page, authors,and other important information
are provided for the plugins in the Official repository. For other external repositories, documentation might be
available with the external plugins themselves. External plugins documentation is not included in this manual.

To install or activate a plugin, go to Plugins → Manage and install plugins....

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user). On some platforms (e.g., macOS), the .qgis2 folder is hid-
den by default.

Paths to Custom C++ plugins libraries can also be added under Settings → Options → System.

Nota: According to the plugin manager settings, QGIS main interface can display a blue link in the status bar to
inform you that there are updates for your installed plugins or new plugins available.

21.2.2 El diálogo de complementos

Los menús en el diálogo Complementos permiten al usuario instalar, desinstalar y actualizar complementos en
diferentes formas. Cada complemento tiene algunos metadatos desplegados en el panel derecho:

• information on whether the plugin is experimental

• descripción

• rating vote(s) (you can vote for your preferred plugin!)

• etiquetas

• some useful links to the home page, tracker and code repository

• autor(es)

• versión disponible
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At the top of the dialog, a Search function helps you find any plugin using metadata information (author, name,

description...). It is available in nearly every menu (except Settings).

The All tab

In the All tab, all the available plugins are listed, including both core and external plugins. Use [Upgrade
all] to look for new versions of the plugins. Furthermore, you can use [Install plugin] if a plugin is listed but
not installed, [Uninstall plugin] as well as [Reinstall plugin] if a plugin is installed. An installed plugin can be
temporarily de/activated using the checkbox.

Figure 21.3: The All tab

The Installed tab

In Installed tab, you can find only the installed plugins. The external plugins can be uninstalled and reinstalled
using the [Uninstall plugin] and [Reinstall plugin] buttons. You can [Upgrade all] here as well.

The Not installed tab

The Not installed tab lists all plugins available that are not installed. You can use the [Install plugin] button
to implement a plugin into QGIS.

The Upgradeable and New tabs

The Upgradeable and New tabs are enabled when new plugins are added to the repository or a new version

of an installed plugin is released. If you activated Show also experimental plugins in the Settings menu,
those also appear in the list giving you opportunity to early test upcoming tools.

Installation can be done with the [Install plugin], [Upgrade plugin] or [Upgrade all] buttons.
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Figure 21.4: The Installed tab

Figure 21.5: The Not installed tab
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Figure 21.6: The Upgradeable tab

The Invalid tab

The Invalid tab lists all installed plugins that are currently broken for any reason (missing dependency, errors
while loading, incompatible functions with QGIS version...). You can try the [Reinstall plugin] button to fix
an invalidated plugin but most of the times the fix will be elsewhere (install some libraries, look for another
compatible plugin or help to upgrade the broken one).

The Settings tab

In the Settings tab, you can use the following options:

• Comprobar actualizaciones al inicio. Siempre que un nuevo complemento o actualización de comple-
mento esta disponible, QGIS informará ‘cada vez que se inicia QGIS’, ‘una vez al día’, ‘cada 3 días’, ‘cada
semana’, ‘cada 2 semanas’ o ‘cada mes’.

• Mostrar también los complementos experimentales. QGIS mostrará complementos en etapas tempranas
de desarrollo, que son generalmente inadecuados para su uso en producción.

• Show also deprecated plugins. Because they use functions that are no longer available in QGIS, these
plugins are set deprecated and generally unsuitable for production use. They appear among invalid plugins
list.

Para añadir un repositorio de un autor externo, haga clic [Añadir...] en la sección Repositorios de complementos.
Si no desea uno o más de los repositorios añadidos, se pueden deshabilitar con el botón [Editar...], o eliminar
completamente con el botón [Borrar]

The default QGIS repository is an open repository and you don’t need any authentication to access it. You can
however deploy your own plugin repository and require an authentication (basic authentication, PKI). You can get
more information on QGIS authentication support in Autenticación chapter.
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Figure 21.7: The Invalid tab

Figure 21.8: The Settings tab
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21.3 Usar complementos básicos de QGIS

Icono Complemento Descripción Manual de referencia

Captura de
coordenadas

Captura de coordenadas del ratón en
diferentes SRC

Complemento Captura de
coordenadas

DB Manager Administrar su base de datos dentro
de QGIS

Complemento administrador
de BBDD

Conversor
DXF2Shp

Convertir de archivo DXF a formato
SHP

Complemento Conversor
DxfaShp

eVis Herramienta de visualización de
eventos

Complemento Visualización
de Eventos

Herramientas
GDAL

Funcionalidad ráster GDAL Complemento Herramientas
de GDAL

Comprobador de
Geometría

Verificar y reparar errores en
geometrías vectoriales

Complemento Comprobador
de geometría

Ajustador de
Geometría

Ajustar geometrías a una capa de
referencia

Complemento Ajuste de
geometrías

Georreferenciador
GDAL

Georeferenciación de rásteres con
GDAL

Complemento
Georreferenciador

Herramientas de
GPS

Herramientas para cargar e importar
datos GPS

Plugin de GPS

GRASS Funcionalidad GRASS Integracion GRASS SIG

Mapa de calor Crear mapa de calor de un capa de
puntos de entrada.

Complemento Mapa de calor

Complemento de
interpolación

Interpolación en base a vétices de una
capa vectorial

Complemento de
interpolación

Metasearch
Catalog Client

Interact with metadata catalog
services (CSW)

Cliente de Catálogo de
metasearch

Edición fuera de
línea

Edición fuera de línea y
sincronización con la base de datos

Complemento Edición fuera
de linea

Georaster Espacial
de Oracle

Acceso a Georasters Espaciales de
Oracle

Complemento GeoRaster
espacial de Oracle

Administrar
complementos

Administrar complementos núcleo y
externos

El diálogo de complementos

|geoproce-
samiento|

Procesamiento Entorno de trabajo de procesado de
datos espaciales

Entorno de trabajo de
procesamiento de QGIS

Análisis del terreno
ráster

Calcular entidades geomorfológica de
un DEMs

Complemento Análisis de
Terreno

Complemento
Grafo de rutas

Análisis de la ruta más corta Complemento Grafo de rutas

Consulta espacial Consulta espacial en vectores Complemento Consulta
espacial

Comprobador de
Topología

Encontrar errores topológicos en
capas vectoriales

topología

Estadísticas de
zona

Calcular estadísticas de ráster para
polígonos.

Complemento de Estadísticas
de zona
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21.4 Complemento Captura de coordenadas

El complemento de captura de coordenadas es fácil de usar y proporciona la capacidad de mostrar coordenadas en
la vista del mapa para dos sistemas de referencia de coordenadas (SRC).

Figure 21.9: Complemento Captura de coordenadas

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, macOS) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Pulse en la casilla de verificación Activar transformación de SRC al vuelo y seleccione un sistema de
coordenadas proyectadas de su elección (vea también Trabajar con Proyecciones)

3. Activate the coordinate capture plugin in the Plugin Manager (see El diálogo de complementos) and ensure

that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled.
The coordinate capture dialog appears as shown in Figure figure_coordinate_capture. Alternatively, you can

also go to Vector → Coordinate Capture and see if Coordinate Capture is enabled.

4. Haga clic en el icono Pulse para seleccionar el SRC a usar para la visualización de coordenadas y elija un SRC diferente al
que seleccionó anteriormente.

5. Para empezar a capturar coordenadas, pulse [Comenzar captura]. Ahora puede hacer clic en cualquier
lugar de la vista del mapa y el complemento mostrará las coordenadas en ambos SRC seleccionados.

6. Para habilitar el seguimiento de coordenadas del ratón, pulse el icono Seguimiento del ratón.

7. También se pueden copiar las coordenadas seleccionadas al portapapeles.

21.5 Complemento administrador de BBDD

The DB Manager Plugin is officially part of the QGIS core and is intended to be the main tool to integrate and
manage spatial database formats supported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, Virtual

layers) in one user interface. The DB Manager Plugin provides several features. You can drag layers from the
QGIS Browser into the DB Manager, and it will import your layer into your spatial database. You can drag and
drop tables between spatial databases and they will get imported.

El menú Base de datos permite conectar a una base de datos existente, para iniciar la ventana de SQL y para
finalizar el componente de Administrador de BBDD. Una vez que este conectado a la base de datos existente, los
menús Esquema y Tabla aparecerá de forma adicional.

EL menú Esquema incluye herramientas para crear y eliminar (vaciar) esquemas y, si la topología esta disponible
(e.j., PostGIS 2), iniciar un TopoViewer.

El menú Tabla permite crear y editar tablas y eliminar tablas y vistas. También es posible vaciar tablas y moverlas
de un esquema a otro. Como función adicional, se puede realizar un VACUUM y luego un ANALYZE para cada
tabla seleccionada. VACUUM simplemente recupera espacio y hace que este disponible para reusarlo. ANALYZE
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Figure 21.10: Diálogo del complemento administrador de BBDD
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actualiza las estadisticas para determinar la forma más eficiente de ejecutar una consulta. Finalmente, se pueden
importar capas/archivos, si estan cargados en QGIS o existen en el sistema de archivos. Y se puede exportar tablas
de la base de datos a archivo vectorial con la función “Exportar archivo”.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

Si se está conectado a una base de datos, la ventana principal del Administrador de BBDD ofrece tres pestañas.
La pestaña Info proporciona información acerca de la tabla y su geometría, así como de los campos existentes,
limitaciones e índices. También permite que ejecute Vacuum Analyze y crear índices espaciales en una tabla
seleccionada, si no está ya hecho. La pestaña de Tabla muestra todos los atributos y la pestaña Vista preliminar
representa las geometrías como vista previa.

21.5.1 Trabajar con la ventana SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

Figure 21.11: Executing SQL queries in the DB Manager SQL window

Nota: The SQL Window can also be used to create Virtual Layers. In that case, instead of selecting a database,
select QGIS Layers under Virtual Layers before opening the SQL Window. See Creating virtual layers for
instructions on the SQL syntax to use.

21.6 Complemento Conversor DxfaShp

El complemento Conversor DxfaShp se puede usar para convertir datos vectoriales del formato DXF a archivo
shape. Requiere que se especifiquen los siguientes parámetros antes de ejecutarlo:
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Figure 21.12: Complemento Conversor DxfaShp

• Archivo DXF de entrada: Introduzca la ruta al archivo DXF a convertir.

• Archivo shp de salida: Introduzca el nombre deseado para el archivo shape a crear.

• Tipo de archivo de salida: Especificar el tipo de geometría del archivo de salida. Actualmente los tipos
soportados son polilíneas, polígonos y puntos.

• Exportar etiquetas de texto: Cuando esta casilla de verificación esta habilitada, se creará una capa de
puntos adicional, y la tabla DBF asociada contendrá información sobre los campos “texto” que se encuentran
en el archivo DXF y las cadenas de texto en sí.

21.6.1 Usar el complemento

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see El diálogo de complementos) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape.

2. Introduzca el archivo DXF de entrada, un nombre para el archivo shape de salida y el tipo de archivo shape.

3. Habilitar la casilla de verificación Exportar etiquetas de texto si desea crear una capa extra de puntos
con etiquetas.

4. Hacer clic en [Aceptar]

21.7 Complemento Visualización de Eventos

(En esta sección se deriva de Horning, N., K, Koy, P. Ersts. 2009. eVis (v1.1.0) Guía de Usuario.
Museo Americano de Historia Natural, Centro para la Biodiversidad y Conservación. Disponible de
http://biodiversityinformatics.amnh.org/, y realizado bajo GNU FDL.)

El mecanismo de información sobre biodiversidad en el Museo Americano de Historia Natural(AMNH) Centro
para la Biodiversidad y la Conservación (CBC) ha desarrollado la herramienta de visualización de eventos (eVis),
otra herramienta de software para añadir al suite de monitoreo de conservación y herramienta de apoyo a las
decisiones para guiar un área protegida y la planificación del paisaje. Este complemento permite a los usuarios
enlazar fácilmente la geocodificación (es decir., se hacer referencia con latitud y longitud o coordenadas X y Y)
de fotografías, y otros documentos de apoyo, a los datos vectoriales en QGIS.

eVis ahora esta instalado automáticamente y habilitado en nuevas versiones de QGIS, y como todos los demás
complementos, se puede habilitar y deshabilitar utilizando el Administrador de Complementos (ver El diálogo de
complementos).
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El complemento de visualización de eventos se compone de tres módulos: la ‘Herramienta para conexión a la base
de datos’, ‘Herramienta de ID evento’, y el ‘Eventos del navegador’. Estos trabajan juntos para permitir la visual-
ización de fotografías geocodificadas y otros documentos que están vinculados a objetos espaciales almacenados
en archivo de vectores, base de datos o hojas de cálculo.

21.7.1 Explorador de Eventos

El módulo del explorador de eventos proporciona la funcionalidad para desplegar fotografías geocodificadas que
están enlazadas con objetos espaciales vectoriales en la ventada de mapa de QGIS. Datos específicos por ejemplo,
pueden ser desde un archivo vectorial que se pueden ingresar mediante QGIS o puede ser a partir del resultado de
una consulta de base de datos. El objeto espacial vectorial debe tener información de atributos asociados con él
para describir la ubicación y el nombre del archivo que contiene la fotografía y opcionalmente la dirección de la
brújula de la cámara que se indico cuando fue adquirida la imagen . Su capa vectorial debe estar cargada en QGIS
antes de ejercitar el explorador de eventos.

Iniciar el módulo de Explorador de eventos

Para poner en marcha el modulo Explorador de Eventos, haga clic en Base de datos→ eVis → Explorador de
Eventos eVis. Esto abrirá la ventana Explorador de Eventos Genérico.

La ventana Explorador de eventos tiene tres pestañas desplegadas en la parte superior de la ventana. La pestaña Vi-
sualizar se utiliza para ver las fotografías y los datos de sus atributos asociados. La pestaña Opciones proporciona
un número de ajustes para controlar el funcionamiento del complemento eVis. Por último, la pestaña Config-
uración de aplicaciones externas se utiliza para mantener una tabla de extensiones de archivos y su aplicación
asociada para permitir a eVis desplegar documentos que no sean imágenes.

Comprender la ventana Visualizar

Para ver la ventana Visualizar, haga clic en la pestaña Visualizar en la ventana Explorador de Eventos. La ventana
Visualizar se utiliza para visualizar las fotografías geocodificadas y los atributos asociados a ellas.

1. Ventana de Visualizar: Una ventana donde la fotografía aparece.

2. Botón de Acercar zoom: Acercar zoom para ver más detalle. Si la imagen completa no puede ser visual-
izada en la ventana de visualizar, las barras de desplazamiento aparecerán en del lado izquierdo e inferior
de la ventana para permitirle desplazarse por la imagen.

3. Botón de Alejar zoom: Alejar zoom para ver más área.

4. Botón Zum general: Despliega la fotografía completa.

5. Ventana de información de atributos: Toda la información de atributos del punto asociado con la foto que
se está viendo se muestra aquí. Si el tipo de archivo al que hace referencia del registro mostrado no es una
imagen sino un tipo de archivo definido en la pestaña Configurar aplicaciones externas cuando haga doble
clic en el valor del campo que contiene la ruta al archivo se abrirá la aplicación para ver u oír el contenido
del archivo. Si se reconoce la extensión del archivo los datos de los atributos se mostrarán en verde.

6. Botones de Navegación: Utiliza el botón anterior y siguiente para cargar el objeto anterior o siguiente
cuando mas de un objeto espacial esta seleccionado.

Comprender la ventana de Opciones

1. Ruta del archivo: Una lista desplegable para especificar el campo de atributo que contiene la ruta del
directorio o URL para las fotografías u otros documentos que se muestran. Si la ubicación es una ruta
relativa, entonces la casilla de verificacion debe hacer clic. LA ruta base para una ruta relativa puede ser
introducida en la caja de texto Ruta Base a continuación. La información sobre las diferentes opciones
para especificar la ubicación del archivo se indica en la sección Especificar la ubicación y nombre de la
fotografía a continuación.

21.7. Complemento Visualización de Eventos 415



QGIS User Guide, Publicación 2.18

Figure 21.13: La ventana de eVis visualizar
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Figure 21.14: La ventana de eVis Opciones
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2. Rumbo de la brújula: Una lista desplegable para especificar el campo de atributo que contiene el rumbo
de la brújula asociado con las fotografías que se muestran. Si la información del rumbo de la brújula esta
disponible, es necesario hacer clic en casilla de verificación a continuación el título del menú desplegable.

3. Desplazamiento de la brújula: El desplazamiento de la brújula se puede utilizar para compensar la de-
clinación (para ajustar los rodamientos recolectados usando cojinetes magnéticos para el rumbo del norte
verdadero). Haga clic en el botón de radio Manual para ingresar el desplazamiento en la caja de texto
o haga clic en el botón de radio De atributo para seleccionar el campo del atributo que contiene los de-
splazamientos. Para ambas opciones, declinaciones del este deben introducirse utilizando valores positivos,
y declinaciones al oeste deben utilizar valores negativos.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_options (A) will
be appended.

5. Sustituir la ruta: Si esta casilla de verificación esta marcada, solo el nombre del archivo de A se anexará a
la ruta base.

6. Aplicar regla a todos los documentos: Si se marco, las mismas reglas de ruta que están definidas para
las fotografías se utilizarán para los documentos sin imagen, tales como películas, documentos de texto
y archivos de sonido. Si no se marca, las reglas de ruta sólo se aplicarán a las fotografías, y los otros
documentos ignorarán el parámetro de la ruta base.

7. Recordar ajustes: Si la casilla de verificación es marcada, los valores de los parámetros asociados se
guardarán para la siguiente sesión cuando la ventana se cierra o cuando el botón [Guardar] de abajo sea
presionado.

8. Restablecer: Restablecer los valores en esta línea a la configuración predeterminada.

9. Restaurar los valores predeterminados: Esto restablecerá todos los campos a su configuración predeter-
minada. Tiene el mismo efecto hacer clic en todos los botones de [Restablecer].

10. Guardar: Esto guardará los ajustes sin cerrar el panel Opciones.

Comprender la ventana de Configurar aplicaciones externas

Figure 21.15: La ventana de eVis Aplicaciones externas

1. Tabla de referencia de archivo: Una tabla contiene los tipos de archivo que se pueden abrir utilizando
eVis. Cada tipo de archivo necesita una extensión de archivo y la ruta de una aplicación que pueda abrir ese
tipo de archivo. Esto proporciona la capacidad de abrir una amplia gama de archivos tales como películas,
grabaciones sonoras y documentos de texto en lugar de solo imágenes.

2. Añadir nuevo tipo de archivo: Añadir un nuevo tipo de archivo con una única extensión y la ruta para la
aplicación que puede abrirlo.

3. Borrar la fila actual: Borrar el tipo de archivo destacado en la tabla y definido por una extensión de archivo
y una ruta a una aplicación asociada.
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21.7.2 Especificar la ubicación y nombre de la fotografía

La ubicación y nombre de la fotografía se pueda almacenar utilizando una ruta relativa o absoluta, o una URL,
si la fotografía esta disponible en el servidor web. Ejemplos de los diferentes enfoques están listados en la tabla
evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

21.7.3 Especificar la ubicación y nombre de otros documentos soportados

Los documentos de apoyo tales como documentos de texto, videos, y clips de sonido también se pueden visualizar
o reproducir por eVis. Para ello, es necesario añadir una entrada en el archivo de tabla de referencia que se puede
acceder desde la ventana Configurar Aplicaciones Externas ‘ en el :guilabel:‘Generic Event Browser que coincide
con la extensión de archivo a una aplicación que se puede utilizar para abrir el archivo. También es necesario
disponer de la ruta o URL para el archivo en la tabla de atributos de la capa vectorial. Una regla adicional que
puede ser utilizada para las direcciones URL que no contienen una extensión de archivo para el documento que
desea abrir es especificar la extensión del archivo antes de la URL. El formato es — file extension:URL.
La URL es precedida por la extensión de archivo y dos puntos; esto es particularmente útil para el acceso a los
mismos a partir de los wikis y otros sitios web que utilizan una base de datos para gestionar las páginas web (véase
Table evis_examples).

21.7.4 Utilizar el Explorador de eventos

Cuando la ventana :guilabel: Navegador de Eventos se abre, una fotografía aparecerá en la pantalla si el documento
se hace referencia en la tabla de atributos de archivo vectorial es una imagen y si la información de la ubicación
del archivo en la ventana Opciones es correctamente establecida. Si se espera una fotografía y no aparece, será
necesario ajustar los parámetros en la ventana :guilabel: Opciones.

Si un documento de apoyo (o una imagen que no tiene una extensión de archivo reconocido por eVis) se hace
referencia en la tabla de atributos, el campo que contiene la ruta del archivo se resaltará en verde en la ventana de
información de atributos si esa extensión de archivo se define en el archivo de la tabla de referencia se encuentra
en la ventana Configurar Aplicaciones Externas. Para abrir el documento, haga doble clic en la línea verde
resaltado en la ventana de información de atributos. Si un documento de apoyo se hace referencia en la ventana
de información de atributos y la ruta del archivo no está resaltado en verde, entonces será necesario añadir una
entrada para la extensión de nombre de archivo del archivo en la ventana Configurar Aplicaciones Externas. Si la
ruta del archivo se resalta en verde, pero no se abre al hacer doble clic, será necesario ajustar los parámetros en la
ventana :guilabel: Opciones por lo que el archivo puede ser localizado por eVis.

Si no se proporciona una brújula en la ventana :guilabel: Opciones, un asterisco rojo se mostrará en la parte
superior de la característica de vector que se asocia con la fotografía que se muestra. Si se proporciona una
brújula, a continuación, aparecerá una flecha apuntando en la dirección indicada por el valor en el campo de
visualización de brújula en la ventana :guilabel: Navegador de Eventos. La flecha estará centrado sobre el punto
que se asocia con la fotografía u otro documento.

Para cerrar la ventana Explorador de eventos, haga clic en el botón [Cerrar] de la ventana Visualizar.

21.7.5 Herramienta ID evento

El módulo ‘Evento ID’ le permite mostrar una fotografía al hacer clic en un objeto espacial mostrado en la ventana
de mapa de QGIS. El objeto espacial vectorial debe tener información de atributos asociada a él para describir la
ubicación y nombre del archivo que contiene la fotografía y, opcionalmente, la dirección de la brújula de la
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cámara que se estableció cuando fue adquirida la imagen. Esta capa debe cargarse en QGIS antes de ejecutar la
herramienta ‘Evento ID’

Iniciar el módulo ID evento

Para iniciar el módulo ‘Evento ID’, haga clic en el icono Evento ID o haga clic en Base de datos→ eVis →
Herramienta de ID de evento eVis. Esto hará que el cursor cambie a una flecha con una ‘i’ en la parte superior de
la misma que significa que la herramienta de ID de evento está activa.

Para ver las fotografías enlazadas a los elementos vectoriales en la capa vectorial activa mostrada en la ventana del
mapa de QGIS, mueva el cursor del Event ID sobre el objeto espacial y entonces haga clic con el ratón. Después
haga clic sobre el objeto espacial, la ventana Explorador de eventos se abre y las fotografías en o cerca del lugar
seleccionado están disponibles para desplegarse en el explorador. Si más de una fotografía esta disponible, y
puede recorrer las diferentes características utilizando los botones [Anterior] y [Siguiente]. Los otros controles
se describen en la sección Explorador de Eventos de esta guía.

21.7.6 Conexión a base de datos

El módulo ‘Conexión a base de datos’ proporciona herramientas para conectar a y consultar una base de datos u
otros recursos ODBC, tales como una hoja de cálculo.

eVis puede conectar directamente a los siguientes tipos de base de datos: PostgreSQL, MySQL, y SQLite; también
puede leer desde conexiones ODBC (por ejemplo, MS Access). Al leer desde una base de datos ODBC (por
ejemplo una hoja de Excel), es necesario configurar su driver ODBC para el sistema operativo que esté utilizando

Iniciar el módulo de Conexión a base de datos

Para iniciar el módulo ‘Conexión a base de datos’, haga clic en el icono apropiado Conexión a base de datos eVis o
haga clic en Base de datos → eVis → Conexión a base de datos eVis. Esto abrirá la ventana Conexión a base
de datos. La ventana tiene tres pestañas: Consultas predefinidas, Conexión a base de datos, y Consulta SQL. La
ventana Consola de salida en la parte inferior de la ventana, muestra el estado de las acciones iniciadas por las
diferentes secciones de este módulo.

Conectar a una base de datos

Haga clic en la pestaña Conexión a la base de datos para abrir la interfaz de conexión a base de datos. A contin-

uación, utilice la lista desplegable Tipo de base de datos para seleccionar el tipo de base de datos al que
desea conectarse. Si una contraseña o nombre de usuario es necesario, esa información puede ser ingresada en las
cajas de texto Nombre de usuario y Contraseña

Introduzca el host de base de datos en el cuadro de texto :guilabel: Host de Base de Datos. Esta opción no está
disponible si ha seleccionado ‘MS Access’ como el tipo de base de datos. Si la base de datos reside en su equipo,
usted debe seleccionar “localhost”.

Introducir el nombre de la base de datos en la caja de texto Nombre de la base de datos. Si seleccionó ‘ODBC’
como el tipo de base de datos, es necesario introducir el nombre de la fuente de datos.

Cuando todos los parámetros están llenos, haga clic en el botón [Conectar]. Si la conexión es satisfactoria, un
mensaje se escribirá en la ventana Consola de salida, inicia que la conexión fue establecida. Si una conexión no
se establece, se necesita comprobar los parámetros correctos fueron insertados anteriormente.

1. Tipo de base de datos: Una lista desplegable para especificar el tipo de base de datos que se utilizará.

2. Host de la base de datos: El nombre del host de la base de datos.

3. Puerto: El numero de puerto si una un tipo de base de datos MySQL o PostgreSQL es seleccionado.

4. Nombre de la base de datos: EL nombre de la base de datos.
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Figure 21.16: La ventana de conexión a base de datos eVis

5. Conectar: Un botón para conectar a la base de datos utilizando los parámetros definidos anteriormente.

6. Salidas a la Consola: La ventana de consola donde los mensajes relacionados a procesos son mostrados.

7. Nombre del Usuario: Nombre del usuario para utilizar cuando una base de datos este protegida con con-
traseña.

8. Contraseña: Para usar cuando la base de datos esta protegida con contraseña.

9. Consultas predefinidas: Pestaña para abrir la ventana “Consultas Predefinidas”.

10. Conexión a base de datos: Pestaña para abrir la ventana “Conexión a base de datos”.

11. Consulta SQL: Pestaña para abrir la ventana “Consulta SQL”.

12. Ayuda: Muestra la ayuda en línea.

13. Aceptar: Cierra la ventana principal “Conexión a Base de datos”

Ejecutar consultas SQL

Se utilizan consultas SQL para extraer información de una base de datos o un recurso ODBC. En eVis, la salida
de estas consultas es una capa vectorial añadida a la ventana de mapa de QGIS. Haga clic en la pestaña Consulta
SQL para mostrar la interfaz de consulta SQL. Los comandos SQL se pueden introducir en esta ventana de texto.
Un tutorial útil sobre comandos SQL está disponible en http://www.w3schools.com/sql. Por ejemplo, para extraer
todos los datos de una hoja de cálculo de un archivo Excel, select * from [sheet1$] donde sheet1 es
el nombre de la hoja de cálculo.

Haga clic en el botón [Ejecutar Consulta] para ejecutar el comando. Si la consulta es satisfactoria, una ventana
Selección de archivo de base de datos se mostrará. Si la consulta no es satisfactoria, aparecerá un mensaje de error
en la ventana Consola de salida.
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En la ventana Selección de archivo de base de datos, introduzca el nombre de la capa que será creada de los
resultados de la consulta en la caja de texto Nombre de la nueva capa

Figure 21.17: La pestaña Consulta SQL de eVis

1. Ventana de texto de consulta SQL: Una pantalla para consultas tipo SQL.

2. Ejecutar consulta: El botón para ejecutar la consulta introducida en la Consulta SQL.

3. Consola de salida: La consola de salida donde se muestran los mensajes relacionados con el procesamiento.

4. Ayuda: Muestra la ayuda en línea.

5. Aceptar: Cierra la ventana principal Conexión a base de datos.

Utilice la lista desplegable Coordenada X Coordenada Y para seleccionar los campos de la base de
datos que almacena las coordenadas X (o longitud) y Y (o latitud). Hacer clic en el botón [Aceptar] hace que la
capa vectorial creada a partir de la consulta SQL se muestre en la ventana de mapa de QGIS.

Para guardar este archivo vectorial y usarlo en el futuro, se puede utilizar el comando de QGIS ‘Guardar como...’
que se accede haciendo clic derecho sobre el nombre de la capa en la leyenda del mapa de QGIS y después
seleccione ‘Guardar como...’

Truco: Crear una capa vectorial de una Hoja de cálculo de Microsoft Excel
Al crear una capa vectorial de una hoja de cálculo Microsoft Excel, es posible ver que los ceros no deseados (“0”)
hayan sido insertados en las filas de la tabla de atributos debajo de datos válidos. Esto puede ser causado por la
supresión de los valores de estas celdas en Excel utilizando la tecla Espacio. Para corregir este problema, es
necesario abrir el archivo de Excel (que necesita para cerrar QGIS si está conectado al archivo, que le permite
editarlo) y luego usar Edición → Borrar para eliminar las filas en blanco del archivo. Para evitar este problema,
puede simplemente eliminar varias filas en la hoja de Excel usando Edición → Borrar antes de guardar el archivo.
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Ejecutar consultas predefinidas

Con las consultas predefinidas, se pueden seleccionar consultas escritas previamente almacenadas en un archivo
de formato XML. Esto es particularmente útil, si no esta familiarizado con comandos SQL. Haga clic en la pestaña
Consultas predefinidas para visualizar la interfaz de consultas predefinidas.

Para cargar un conjunto de consultas predefinidas, haga clic en el icono Abrir archivo. Este abrirá la ventana Abrir
archivo, que se utiliza para localizar el archivo que contiene las consultas SQL. Cuando se cargan las consultas,
sus títulos definidos en el archivo XML aparecerán en el menú desplegable situado justo debajo del icono
Abrir archivo. La descripción completa de la consulta se mostrará en la ventana de texto en el menú desplegable.

Seleccione la consulta que desee ejecutar del menú desplegable y después haga clic en la pestaña Consulta SQL
para ver las consultas que se han estado cargando en la ventana de consultas. Si es la primera vez puede ejecutar
una consulta predefinida o esta cambiando a base de datos, necesita estar seguro para conectarse a la base de datos.

Haga clic en el botón [Ejecutar consulta] en la pestaña Consulta SQL para ejecutar el comando. Si la consulta
es satisfactoria, una ventana Selección de archivo de base de datos se mostrará. Si la consulta no es satisfactoria,
aparecerá un mensaje de error en la ventana Consola de salida

Figure 21.18: La pestaña de eVis Consultas predefinidas

1. Abrir Archivo: Iniciar el archivo “Abrir Archivo” navegar para buscar el archivo XML manteniendo las
consultas predefinidas.

2. Consultas predefinidas: Una lista desplegable con todas las consultas definidas por el archivo XML de
consultas predefinidas.

3. Descripción de consulta: Una descripción corta de la consulta. Esta descripción es del archivo XML de
consultas predefinidas.

4. Consola de salida: La consola de salida donde se muestran los mensajes relacionados con el procesamiento.

5. Ayuda: Muestra la ayuda en línea.
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6. Aceptar: Cierra la ventana principal “Conexión a Base de datos”

El formato XML para consultas predefinidas eVis

Las etiquetas XML leídas por eVis

Etiquetas Descripción
Consulta Definir el inicio y fin de una sentencia de consulta.
Descripción
corta

Una descripción corta de la consulta que aparece en el menú desplegable de eVis.

Descripción Una descripción más detallada de la consulta desplegada en la ventana de texto de consulta
predefinida.

Tipo de base
de datos

El tipo de la base de datos, definido en el menú desplegable de Tipo de base de datos en la
pestaña de Conexión a base de datos.

Puerto El puerto como se define en el cuadro de texto Puerto en la pestaña de Conexión a base de
datos.

Nombre de la
base de datos

El nombre de la base de datos como se define en el cuadro de texto en la pestaña de
Conexión a base de datos.

Nombre de
usuario

El nombre de usuario de la base de datos como se define en el cuadro de texto Nombre de
usuario en la pestaña de Conexión a base de datos.

databasepass-
word

La contraseña de la base de datos como se define en el cuadro de texto Contraseña en la
pestaña Conexión a base de datos.

Sentencia sql El comando SQL
autoconectar Una bandera (“verdadero” o “falso”) para especificar si las etiquetas anteriores deben

utilizarse para conectarse automáticamente a la base de datos sin ejecutar la rutina de
conexión de base de datos en la solapa Conexión de Base de Datos.

Se muestra un archivo XML de ejemplo completo con tres preguntas a continuación:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
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<query>
<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

21.8 Complemento Herramientas de GDAL

21.8.1 ¿Qué son las herramientas GDAL?

El complemento de herramientas GDAL ofrece una GUI para la colección de herramientas en Geospatial Data
Abstraction Library, http://gdal.osgeo.org. Estas son las herramientas de gestión ráster para consultar, re-proyecto,
urdimbre y combinar una amplia variedad de formatos ráster. También se incluyen herramientas para crear una
capa (vector) del contorno, o un relieve sombreado de un ráster MDT, y para hacer una VRT (Virtual Raster Tile
en formato XML) a partir de una colección de uno o más archivos ráster. Estas herramientas están disponibles
cuando se instala el complemento y es activado.

La biblioteca GDAL

La librería GDAL consiste en un conjunto de programas de línea de comandos, cada uno con una larga lista
de opciones. Los usuarios cómodos con la ejecución de comandos desde la terminal pueden preferir la línea
de comandos, con acceso a todo el conjunto de opciones. El complemento de Herramientas GDAL ofrece una
interfaz fácil de las herramientas, exponiendo las opciones más populares.

21.8.2 Lista de Herramientas GDAL

Figure 21.19: La lista del menú Herramientas GDAL
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Projecciones

Warp
(Reproject)

Esta utilidad es una imagen de mosaicos, reproyección y utilidad deformación. El programa
puede reproyectar a cualquier proyección apoyada, y también se puede aplicar GCPs
almacenados con la imagen si la imagen es “crudo” con información de control. Para obtener
más información, se puede leer en el sitio web GDAL http://www.gdal.org/gdalwarp.html

Assign
projection

Esta herramienta le permite asignar proyección a rásters que ya tengan una referencia
geográfica, que le falte la información de la proyección. También con su ayuda, es posible
alterar las definiciones de proyección existentes. Ambos archivos simples y el modo por lotes
son compatibles. Para obtener más información, por favor visite la página de utilidad en el
sitio GDAL http://www.gdal.org/gdalwarp.html.

Extract
projection

Esta utilidad te ayuda a extraer información de la proyección de un archivo de entrada. Si
desea extraer información de un directorio completo, puede usar el modo por lotes. Este crea
ambos archivos .prj and .wld

Conversión

Ras-
terizar

Este programa fusiona geometrías vectoriales (puntos, líneas y polígonos) en la banda(s) ráster de
una imagen raster. Los vectores se leen de formatos vectoriales reconocidos por OGR. Tenga en
cuenta que los datos vectoriales debe estar en el mismo sistema de coordenadas como los datos
ráster; en la reproyección al vuelo no se proporciona. Para obtener más información, consulte
http://www.gdal.org/gdal_rasterize.html.

Poly-
gonize

Esta utilidad crea polígonos vectoriales para todas las regiones conectadas de píxeles del ráster
que comparte un valor de píxel en común. Cada polígono se crea con un atributo que indica el
valor de píxel de dicho polígono. La utilidad crea el vector de salida de origen de datos si no
existe ya, predeterminado a el formato de archivo shape de ESRI. Ver también
http://www.gdal.org/gdal_polygonize.html.

Translate
Esta utilidad se puede utilizar para convertir los datos ráster entre diferentes formatos, lo que
podría llevar a cabo algunas operaciones como subconjuntos, remuestreo, y reescalar píxeles en el
proceso. Para obtener más información se puede leer en http://www.gdal.org/gdal_translate.html.

RGB
a PCT

Esta utilidad calculará una tabla de pseudocolor óptima para una imagen RGB determinada,
utilizando un algoritmo de corte medio de un histograma RGB downsampled. Luego se convierte
la imagen en una imagen pseudocoloreada usando la tabla de colores. Esta conversión utiliza
Floyd-Steinberg (difusión de errores) para maximizar la imagen de salida de calidad visual. La
utilidad también se describe en http://www.gdal.org/rgb2pct.html.

PCT
a RGB

Esta utilidad convertirá una banda pseudocolor en el archivo de entrada en un archivo RGB de
salida del formato deseado. Para mayor información, vea http://www.gdal.org/pct2rgb.html.

Extracción

Con-
tour

Este programa genera un archivo vectorial de curvas de nivel del modelo del terreno ráster (MDT).
En http://www.gdal.org/gdal_contour.html, se puede encontrar más información.

Clip-
per

Esta utilidad le permite que acorte rásteres (extraer un subconjunto) utilizando una extensión
seleccionada o en base a límites de la capa de máscara.. Más información se puede encontrar en
http://www.gdal.org/gdal_translate.html.
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Análisis

Filtrado Esta utilidad elimina polígonos ráster más pequeños que un tamaño umbral previsto (en
píxeles) y los reemplaza con el valor del píxel del polígono vecino más grande. El
resultado se puede escribir de nuevo a la banda del ráster existente, o copiado en un nuevo
archivo. Para mayor información, vea http://www.gdal.org/gdal_sieve.html.

Casi Negro Esta utilidad escaneará una imagen y tratar de establecer todos los píxeles que son casi
negros (o casi blancos) alrededor del borde para exactamente negro (o blanco). Esto se
utiliza a menudo para “arreglar” comprimir pérdidas de fotos aéreas de modo que los
píxeles de color se pueden tratar como transparentes cuando se hace el mosaico. También
vea http://www.gdal.org/nearblack.html.

Rellenar sin
datos

Esta utilidad rellena regiones de ráster seleccionadas (generalmente áreas sin datos) por
interpolación de píxeles válidos alrededor de los bordes de las áreas. En
http://www.gdal.org/gdal_fillnodata.html, se puede encontrar más información.

Proximidad Esta utilidad genera un mapa ráster de proximidad que indica la distancia desde el centro
de cada píxel al centro del píxel más cercano identificado como un píxel objetivo. Los
pixeles objetivo son los del ráster fuente para la cual el valor de píxel del ráster está en el
conjunto de valores de píxel objetivo. Para obtener más información, consulte
http://www.gdal.org/gdal_proximity.html.

Cuadrícula
(Interpolación)

Esta utilidad crea una cuadrícula regular (ráster) a partir de los datos dispersos leídos
desde la fuente de datos OGR. Los datos de entrada serán interpolados para rellenar nodos
de la cuadrícula con los valores, y puede elegir entre varios métodos de interpolación. La
utilidad también se describe en el el sitio web GDAL, http://www.gdal.org/gdal_grid.html.

MDT(Modelos
de Terreno)

Herramientas para analizar y visualizar DEMs. Esto puede crear un relieve sombreado,
pendiente, orientación, color de relieve y un indice de irregularidad del terreno, un indice
de posición topográfica y un mapa de irregularidad de algún ráster de elevación
reconocido GDAL. Para mayor información , vea http://www.gdal.org/gdaldem.html.

Miscelánea

Construir
ráster virtual
(Catálogo)

Este programa crea un VRT (Conjunto de datos virtual) que es un mosaico de la lista
de conjunto de datos GDAL de entrada. Vea también
http://www.gdal.org/gdalbuildvrt.html.

Merge Esta utilidad automáticamente hará el mosaico un conjunto de imágenes. Todas las
imágenes deben estar en el mismo sistema de coordenadas y tener un número
correspondiente de bandas, pero pueden ser superpuestas, y en diferentes resoluciones.
En áreas de superposición, la última imagen se copiará en las anteriores. La utilidad
también se describe en http://www.gdal.org/gdal_merge.html.

Información Esta utilidad muestra diversa información acerca de un conjunto de datos ráster
GDAL-implementado. En http://www.gdal.org/gdalinfo.html, puede encontrar más
información.

Generar vistas
generales

La utilidad gdaladdo se puede utilizar para construir o reconstruir las vistas generales
para los formatos más compatibles con un de varios algoritmos de disminución de
resolución. Para obtener más información, vea http://www.gdal.org/gdaladdo.html.

Tile Index Esta utilidad crea un archivo shape con un registro para cada archivo de entrada ráster,
un atributo contiene el nombre del archivo y una geometría de polígono delineando el
ráster. Vea también http://www.gdal.org/gdaltindex.html.
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Configuración de herramientas GDAL

Utilice este diálogo para integrar las variables GDAL.

21.9 Complemento Comprobador de geometría

Geometry Checker is a powerful core plugin to check and fix the geometry validity of a layer. The Geometry
Checker dialog show differents grouped settings in the first tab (Settings):

• Input vector layer: to select the layer to check. A Only selected features checkbox can filter the geometry
to the one selected.

• Geometry validity: give to the user the choice between Self intersections, Duplicate nodes, Polygon with
less than 3 nodes.

• Allowed geometry types: to allow only some geometry types like point, multipoint, line, multiline, polygon
and multipolygon.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

The Geometry Checker Plugin can find the following errors:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons

The following figure shows the different checks made by the plugin.
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Figure 21.20: El complemento Comprobador de geometría
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Figure 21.21: The Differents checks supported by the plugin
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You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:

• Combinar con el polígono adyacente con el borde compartido más largo,

• Merge with neighboring polygon with largest area,

• Merge with neighboring polygon identical attribute value,if any, or leave as it

• Borrar objeto espacial

• No action

Truco: Corregir multiples errores
You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

Finally, you can choose which attribute to use when merging features by attribute value.

21.10 Complemento Ajuste de geometrías

La herramienta Ajuste de geometrías permite alinear de forma automática los bordes y vértices de una capa
vectorial a los bordes y vértices de una segunda capa, utilizando una tolerancia definida por el usuario.

La interfaz de abajo muestra la configuración de este complemento. El usuario debe seleccionar la capa a modificar
(ver input vector layer) y la :guilabel:‘reference layers a la que ajustar. La Maximum snapping distance (map
units) permite cambiar la tolerancia de ajuste.

Puede ajustar solo los objetos seleccionados marcando la Only selected features.

Output vector layer le permite elegir entre Modifying input layer o Create a new layer.

Figure 21.22: El complemento Ajuste de geometrías
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21.11 Complemento Georreferenciador

El complemento Georreferenciador es una herramienta para generar archivos de referencia de ráster. Permite
referenciar los ráster a sistemas de coordenadas geográficas o proyectadas mediante la creación de un nuevo
GeoTiff o añadiendo un archivo de referencia a la imagen existente. El enfoque básico para georreferenciar un
ráster es localizar puntos del ráster para los que se puedan determinar con precisión las coordenadas.

Características
Icono Propósito Icono Propósito

Abrir ráster Comenzar georreferenciado

Generar script de GDAL Cargar puntos PCT

Guardar puntos PCT como Configuración de la transformación

Añadir punto Borrar punto

Mover punto PCT Desplazar

Acercar zum Alejar zum

Zum a la capa Zum anterior

Zum siguiente Enlazar georreferenciador a QGIS

Enlazar QGIS a georreferenciador Estiramiento total del histograma

Estiramiento local del histograma

Table Georeferencer: Georeferencer Tools

21.11.1 Procedimiento habitual

Como coordenadas X e Y (GMS (gg mm ss.ss), GG (gg.gg) o coordenadas proyectadas (mmmm.mm)), que
correspondan al punto seleccionado en la imagen, se pueden usar dos procedimientos alternativos:

• El propio ráster a veces proporciona cruces con coordenadas “escritas” sobre la imagen. En este caso se
pueden introducir las coordenadas manualmente.

• Utilizar capas ya georreferenciadas. Estos pueden ser datos vectoriales o ráster que contengan los mismos
objetos/entidades que la imagen que desea georreferenciar y con la proyección que desee para su imagen.
En este caso puede introducir las coordenadas haciendo clic en el conjunto de datos de referencia cargado
en el lienzo del mapa de QGIS.

El procedimiento habitual para georreferenciar una imagen consiste en seleccionar múltiples puntos en el ráster,
especificando sus coordenadas, y elegir un tipo de transformación adecuado. Sobre la base de los parámetros y
datos de entrada, el complemento calculará los parámetros del archivo de referencia. Cuantas más coordenadas
suministre, mejor será el resultado.

The first step is to start QGIS, load the Georeferencer Plugin (see El diálogo de complementos) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_dialog.

Para este ejemplo usaremos una hoja topográfica de Dakota del Sur del SDGS. Más tarde se puede visualizar
junto con los datos de la localización spearfish60 de GRASS. Puede descargar la hoja topográfica aquí:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Introducir puntos de control sobre el terreno (PCT)

1. Para empezar a georreferenciar un ráster no referenciado, debemos cargarlo utilizando el botón . El
ráster aparecerá en la zona de trabajo principal del diálogo. Una vez que el ráster esté cargado, podemos
empezar a introducir los puntos de referencia.
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Figure 21.23: Diálogo del complemento Georreferenciador

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_add_points). For this procedure you have three options:

• Hacer clic en un punto de la imagen ráster e introducir las coordenadas X e Y manualmente.

• Haga clic en un punto de la imagen ráster y elija el botón Desde lienzo del mapa para añadir las coorde-
nadas X e Y con la ayuda de un mapa ya georreferenciado cargado en el lienzo del mapa de QGIS.

• Con el botón , puede mover los GCP en ambas ventanas, Si están en un lugar incorrecto.

3. Continuar introduciendo puntos. Debe tener por lo menos cuatro puntos y cuantas más coordenadas pueda
proporcionar mejor será el resultado. Existen herramientas adicionales en el cuadro de diálogo del comple-
mento para hacer zum o desplazar la zona de trabajo con el fin de localizar un conjunto relevante de puntos
PCT.

Figure 21.24: Add points to the raster image

Los puntos que se añaden al mapa se almacenarán en un archivo de texto separado ([nombre del
archivo].points) generalmente junto con la imagen ráster. Esto nos permite reabrir el complemento Georef-
erenciador en una fecha posterior y añadir nuevos puntos o eliminar los ya existentes para optimizar el resultado.
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El archivo de puntos contiene los valores de los puntos de la forma: mapX, mapY, pixelX, pixelY. Puede

utilizar los botones Cargar puntos PCT y Guardar puntos PCT como para gestionar los archivos.

Definir la configuración de la transformación

Después de añadir los PCT a la imagen ráster, debe definir la configuración de la transformación para el proceso
de georreferenciación.

Figure 21.25: Defining the georeferencer transformation settings

Algoritmos de transformación disponibles

Dependiendo del número de puntos de control sobre el terreno que haya capturado, es posible que desee utilizar
diferentes algoritmos de transformación. La elección del algoritmo de transformación también depende del tipo
y la calidad de los datos de entrada y la cantidad de distorsión geométrica que está dispuesto a introducir en el
resultado final.

Actualmente están disponibles los siguientes Tipos de transformación:

• El algoritmo Lineal se utiliza para crear un archivo de referencia y es diferente de los otros algoritmos, ya
que realmente no trasforma el ráster. Este algoritmo probablemente no será suficiente si se trata de material
escaneado.

• La trasformación Helmert realiza un escalado sencillo y trasformaciones de rotación.

• Los algoritmos Polinomial 1-3 son algunos de los algoritmos más utilizados introducidos para que coinci-
dan los puntos de control sobre el terreno de origen y destino. El algoritmo polinomial más ampliamente
utilizado es la transformación polinomial de segundo orden, que permite cierta curvatura. La transforma-
ción polinomial de primer orden (afín) preserva la colinealidad y permite escalado, traslación y rotación
solamente.
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• El algoritmo Thin Plate Spline (TPS) es un método de georreferenciación más moderno, que es capaz de
introducir deformaciones locales en los datos. Este algoritmo es útil cuando se georreferencian originales
de muy baja calidad.

• La trasformación Proyectiva es una rotación lineal y traducción de coordenadas.

Definir el método de remuestreo

El tipo de remuestreo que elija probablemente dependerá de los datos de entrada y el objetivo último del ejercicio.
Si no se desea cambiar las estadísticas de la imagen, es posible que desee elegir “Vecino más próximo”, mientras
que un ‘Remuestreo cúbico’ probablemente proporcionará un resultado más suavizado.

Es posible elegir entre cinco diferentes métodos de remuestreo:

1. Vecino más próximo

2. Lineal

3. Cúbica

4. Spline cúbica

5. Lanczos

Definir la configuración de la trasformación

Hay varias opciones que deben definirse para el ráster de salida georreferenciado.

• La casilla de verificación checkbox| Crear archivo de referencia esta disponible solo si se decide utilizar
la transformación lineal, porque esto quiere decir que la imagen ráster no será transformada realmente. En
este caso, el campo Ráster de salida no se activa, porque solo se creará el nuevo archivo de referencia.

• Para todos los otros tipos de transformación hay que definir un Ráster de salida. Por omisión se creará un
nuevo archivo ([nombre de archivo] _modificado) en la misma carpeta junto con la imagen ráster original.

• Como siguiente paso, tiene que definir el SRE de destino (Sistema de Referencia Espacial) para la imagen
georeferenciada (vea Trabajar con Proyecciones).

• Si lo desea, puede generar un mapa en pdf y también un informe en pdf. El informe incluye información
acerca de los parámetros de trasformación utilizados, una imagen de los residuos y una lista con todos los
PCT y sus errores RMS.

• Además, puede activar la casilla de verificación Establecer resolución de destino y definir la resolución
del píxel del archivo de salida. Por omisión la resolución horizontal y vertical es 1.

• Se puede activar la casilla Usar 0 para transparencia cuando sea necesario, si los píxeles con valor
0 deben visualizarse trasparentes. En nuestra hoja topográfica de ejemplo todas las áreas blancas serían
transparentes.

• Finalmente, Cargar en QGIS cuando esté hecho cargar el ráster de salida automáticamente en la vista
de mapa del QGIS cuando la transformación este hecha.

Mostrar y adaptar las propiedades del ráster

Clicking on the Raster properties option in the Settings menu opens the Layer properties dialog of the raster file
that you want to georeference.
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Configurar el georreferenciador

• Se puede definir si desea mostrar coordenadas GCP y/o IDs.

• Como unidades residuales se pueden elegir píxeles y unidades del mapa.

• Para el informe PDF puede definir un margen izquierdo y derecho y también puede establecer el tamaño del
papel para el mapa PDF.

• Finalmente, puede activar Mostrar la ventana del Georeferenciador adosada.

Ejecutar la transformación

Después de que todos los GCPs hayan sido recopilados y se hayan definido todos los ajustes de transformación,

sólo presione el botón Comenzar georeferenciación para crear el nuevo ráster georreferenciado.

21.12 Complemento Mapa de calor

El complemento Mapa de calor usa Estimación de Densidad de Kernel para crear un ráster de densidad (mapa de
calor) de una capa de puntos de entrada. La densidad se calcula con base al número de puntos en una ubicación,
de forma que un mayor número de puntos agrupados resulta en valores mayores. Los mapas de calor permiten
una fácil identificación de los “puntos calientes” y la agrupación de los puntos.

21.12.1 Activar el complemento Mapa de calor

En primer lugar este complemento núcleo necesita ser activado utilizando el Administrador de Complementos

(véase El diálogo de complementos). Después de activarlo, el icono de mapa de calor se puede encontrar en
la barra de herramientas de Ráster, y bajo el menú Ráster → Mapa de calor.

Seleccione el menú Ver → Barras de herramientas → Ráster para mostrar la barra de herramientas Ráster, si no
está visible.

21.12.2 Usar el complemento de Mapa de calor

Clicking the Heatmap tool button opens the Heatmap plugin dialog (see figure_heatmap_settings).

El diálogo tiene las siguientes opciones:

• Capa de puntos de entrada: Lista todas las capas vectoriales de puntos del proyecto actual y se usa para
seleccionar la capa a analizar.

• Ráster de salida: Permite usar el botón para seleccionar la carpeta y el nombre de archivo del ráster
de salida que genera el complemento Mapa de calor. La extensión del archivo no es necesaria.

• Formato de salida: Selecciona el formato de salida. Aunque se pueden elegir todos los formatos soportados
por GDAL, en la mayoría de los casos GeoTIFF es el mejor formato a elegir.

• Radio: Se usa para especificar el radio de búsqueda del mapa de calor (o ancho de banda del kernel) en
metros o unidades del mapa. El radio especifica la distancia alrededor de un punto a la que se notará la
influencia del punto. Los valores más altos dan lugar a un mayor suavizado, mientras que los valores más
pequeños pueden mostrar detalles y variación más finos en la densidad de puntos.

Cuando la casilla de verificación Avanzado está marcada, hay disponibles opciones adicionales:
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• Filas y Columnas: Utilizado para cambiar las dimensiones del ráster de salida. Estos valores también
están ligados a los valores de Tamaño X de celda y Tamaño Y de celda. Incrementar el número de
filas y columnas disminuirá el tamaño de la celda e incrementará el tamaño del archivo de salida. Los
valores en Filas y Columnas también están vinculados, por lo que duplicar el número de filas duplicará
automáticamente el número de columnas y el tamaño de las celdas también se reducirá a la mitad. ¡El área
geográfica del ráster de salida seguirá siendo el mismo!

• Tamaño X de celda y Tamaño Y de celda: Controlan el tamaño geográfico de cada píxel en el ráster de
salida. Cambiar estos valores también cambiará el número de filas y columnas en el ráster de salida.

• Forma del kernel: La forma del kernel controla la proporción en la que la influencia de un punto disminuye
a medida que aumenta la distancia desde el punto. Los diferentes kernels disminuyen en distintas propor-
ciones, por lo que un kernel triweight da mayor peso a las entidades más próximas al punto de lo que hace
el kernel Epanechnikov. En consecuencia, triweight da como resultado puntos calientes “más afilados” y
Epanechnikov da puntos calientes “más suaves”. Hay disponible una serie de funciones estándar del kernel
en QGIS, que se describen e ilustran en Wikipedia.

• Relación de decadencia: Se puede utilizar con kernel Triangulares para un mayor control de cómo dismin-
uye el calor de una entidad con la distancia a la misma.

– Un valor de 0 (= mínimo) indica que el calor estará concentrado en el centro del radio dado y se
extinguirá por completo en el borde.

– Un valor de 0.5 indica que a los píxeles del borde del radio se les dará la mitad del calor que a los
píxeles del centro del radio de búsqueda.

– Un valor de 1 significa que el calor se distribuye uniformemente por todo el círculo del radio de
búsqueda. (Esto es equivalente al kernel ‘Uniforme’.)

– Un valor mayor que 1 indica que el calor es mayor hacia el borde del radio de búsqueda que en el
centro.

La capa de puntos de entrada también puede tener campos de atributos que pueden afectar la forma en que influyen
en el mapa de calor:

• Usar radio a partir de campo: Establece el radio de búsqueda para cada entidad a partir de un campo de
atributos de la capa de entrada.

• Usar peso a partir de campo: Permite ponderar las entidades de entrada por un campo de atributos. Esto
se puede utilizar para aumentar la influencia que ciertas entidades tienen en el mapa de calor resultante.

Cuando se especifica un nombre para el archivo ráster de salida se puede utilizar el botón [Aceptar] para crear el
mapa de calor.

21.12.3 Tutorial: crear un mapa de calor

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see Datos
de ejemplo). Another excellent QGIS tutorial on making heatmaps can be found at http://www.qgistutorials.com.

In Figure_Heatmap_data, the airports of Alaska are shown.

1. Select the Heatmap tool button to open the Heatmap dialog (see Figure_Heatmap_settings).

2. En el campo Capa de puntos de entrada , seleccione airports de la lista de capas de puntos
cargadas en el proyecto actual.

3. Especifique un nombre para el archivo de salida haciendo clic en el botón próximo al campo Ráster
de salida. Escriba el nombre del archivo heatmap_airports (no es necesaria la extensión de archivo).

4. Deje el Formato de salida como el formato predeterminado, GeoTIFF.

5. Cambie el Radio a 1000000 metros.

6. Click on [OK] to create and load the airports heatmap (see Figure_Heatmap_created).

21.12. Complemento Mapa de calor 437

http://en.wikipedia.org/wiki/Kernel_(statistics)#Kernel_functions_in_common_use
http://www.qgistutorials.com/en/docs/creating_heatmaps.html


QGIS User Guide, Publicación 2.18

Figure 21.26: Aeropuertos de Alaska

Figure 21.27: El diálogo del mapa de calor
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QGIS generará el mapa de calor y añadirá el resultado a la ventana del mapa. Por omisión, el mapa de calor está
sombreado en escala de grises, con las zonas más claras mostrando una mayor concentración de aeropuertos. Al
mapa de calor se le puede aplicar ahora un estilo en QGIS para mejorar su apariencia.

Figure 21.28: Después de cargar el mapa de calor se ve como una superficie gris

1. Abra el diálogo de propiedades de la capa heatmap_airports (seleccione la capa
heatmap_airports, abra el menú contextual con el botón derecho del ratón y seleccione Propiedades).

2. Seleccione la pestaña Estilo.

3. Cambiar el Tipo de representación a ‘Pseudocolor de una sola banda’.

4. Seleccionar una adecuada Mapa de color map , por ejemplo YlOrRed.

5. Haga clic en el botón [Cargar] para recabar los valores mínimo y máximo del ráster, después pulse el botón
[Clasificar].

6. Pulse [Aceptar] para actualizar la capa.

The final result is shown in Figure_Heatmap_styled.

21.13 Complemento de interpolación

The Interpolation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation). The plugin requires the following parameters to be specified before running:

• Capas vectoriales de entrada: Especificar las capas vectorial(es) de puntos de entrada a partir de una lista
de capas de puntos cargadas. Si se especifican varias capas, entonces se usarán los datos de todas ellas
para la interpolación. Nota: es posible insertar lineas o polígonos como restricción para la triangulación,

especificando “puntos”, “líneas de estructura” o “líneas de ruptura” en el cuadro combinado Tipo .

• Atributo de interpolación: Seleccionar la columna de atributos a usar para la interpolación o habilitar la

casilla Usar coordenada-Z para usar los valores Z almacenados en la capa.
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Figure 21.29: Estilo de mapa de calor de aeropuertos de Alaska

• Método Interpolación: Seleccionar el método de interpolación. Esto puede ser ‘Red Irregular triangulada
(TIN)’ o ‘Distancia Inversa Ponderada (IDW)’. Con el método TIN puede crear una superficie formada por
triángulos de puntos vecinos más cercanos. Para ello, circunferencias circunscritas alrededor de puntos de
muestra seleccionados se crean y sus intersecciones están conectados a una red de no superposición y tan
compacto como sea posibles de triángulos. Las superficies resultantes no son lisas. Cuando se utiliza el
método IDW los puntos de muestreo se ponderan durante la interpolación de tal manera que la influencia de
un punto en relación con otros disminuye con la distancia desde el punto desconocido que desea crear. El
método de interpolación IDW también tiene algunas desventajas: la calidad del resultado de la interpolación
puede disminuir, si la distribución de puntos de datos de la muestra es desigual. Por otra parte, los valores
máximos y mínimos en la superficie interpolada sólo pueden ocurrir en los puntos de datos de la muestra.
Esto a menudo resulta en pequeños picos y pozos alrededor de los puntos de datos de la muestra.

• Configurar método de interpolación: Configurar el método de interpolación que ha elegido. Para
el método TIN se puede elegir entre Lineal y Clough Toucher (cúbico). Se puede guardar también la
triangulación en formato de archivo shape. Para la interpolación IDW se puede establecer el coeficiente de
distancia.

• Número de columnas/filas: Especificar el número de filasy columnas para el archivo ráster de salida.

• Archivo de salida: Especifica un nombre para el fichero ráster de salida.

• Añadir el resultado al proyecto para cargar el resultado en la vista del mapa.

Tenga en cuenta que el uso de líneas como las limitaciones para la interpolación de la triangulación (método TIN).
También se puede usar ‘líneas de estructura’ o ‘líneas de rotura’. Al usar ‘líneas de rotura’ se producen roturas en
la superficie mientras utiliza ‘líneas de estructura’ se producen roturas continuas. La triangulación es modificada
por ambos métodos tales que no cruza una línea de borde de línea de rotura o estructura.

21.13.1 Usar el complemento

1. Comenzar QGIS y cargar una capa vectorial de puntos (ej. elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see El diálogo de complementos) and click on the
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Figure 21.30: Complemento de interpolación

Raster → Interpolation → Interpolation menu, which appears in the QGIS menu bar. The Interpolation
plugin dialog appears as shown in Figure_interpolation.

3. Seleccione una capa de entrada (ej. elevp ) y una columna (ej. ELEV) para interpolación.

4. Seleccionar un método de interpolación( ej. ‘Red Irregular Triangulada (Triangulated Irregular Network-
TIN)’) y especificar un tamaño de celda de 5000 así como el nombre del archivo ráster de salida
(ej.:file:elevation_tin).

5. Pulse [Aceptar].

21.14 Cliente de Catálogo de metasearch

21.14.1 Introducción

MetaSearch is a QGIS plugin to interact with metadata catalog services, supporting the OGC Catalog Service for
the Web (CSW) standard.

MetaSearch provides an easy and intuitive approach and user-friendly interface to searching metadata catalogs
within QGIS.

21.14.2 Instalación

Búsqueda Meta se incluye de forma predeterminada con QGIS 2.0 y superior. Se incluyen todas las dependencias
dentro de MetaSearch.

Install MetaSearch from the QGIS plugin manager, or manually from http://plugins.qgis.org/plugins/MetaSearch.

21.14.3 Working with Metadata Catalogs in QGIS

CSW (Catalog Service for the Web)

CSW (Catalog Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines common
interfaces to discover, browse and query metadata about data, services, and other potential resources.
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Figure 21.31: Search and results of Services in Metasearch
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inicio

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Managing Catalog Services

Figure 21.32: Managing Catalog Services

The Services tab allows the user to manage all available catalog services. MetaSearch provides a default list of
Catalog Services, which can be added by pressing [Add default services] button.

To all listed Catalog Service entries, click the dropdown select box.

To add a Catalog Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalog Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalog Service entry, select the entry you would like to delete and click the [Delete] button. You will
be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="https://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
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<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalog Service such as service iden-
tification, service provider and contact information. If you would like to view the raw XML response, click the
[GetCapabilities response] button. A separate window will open displaying Capabilities XML.

Searching Catalog Services

Figure 21.33: Searching catalog services

The Search tab allows the user to query Catalog Services for data and services, set various search parameters and
view results.

The following search parameters are available:

• Keywords: free text search keywords;

• From: the Catalog Service to perform the query against;

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, Ymax, and Ymin. Click [Set
global] to do a global search, click [Map extent] to do a search on the visible area only or manually enter
custom values as desired.
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Clicking the [Search] button will search the selected Metadata Catalog. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Clicking a result will provides the following options:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map;

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser;

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialog will then appear.

Figure 21.34: Metadata record display

Configuración

You can fine tune MetaSearch with the following settings:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name;

• Results paging: when searching metadata catalogs, the number of results to show per page. Default value is
10;

• Timeout: when searching metadata catalogs, the number of seconds for blocking connection attempt. De-
fault value is 10.
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Figure 21.35: Metasearch setting

21.15 Complemento Edición fuera de linea

Para la recolección de datos, es una situación común para trabajar con un ordenador portátil o una línea de teléfono
celular en el campo. A su regreso a la red, los cambios tienen que ser sincronizados con el origen de datos principal
(ej., una base de datos PostGIS). Si varias personas están trabajando simultáneamente en los mismos conjuntos de
datos, es difícil fusionar los cambios a mano, incluso si la gente no cambia los mismo elementos.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.

21.15.1 Usar el complemento

• Open a project with some vector layers (e.g., from a PostGIS or WFS-T datasource).

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• You can check Only synchronize selected features if a selection is present allowing the offline editing to
only save and work on a subset. It can be invaluable in case of large layers.

• Editar las capas fuera de linea.

• Después de ser conectada de nuevo, actualizar los cambios usando Base de datos→ Edición fuera de línea

→ Sincronizar.

21.16 Complemento GeoRaster espacial de Oracle

En las bases de datos de Oracle, los datos raster se pueden almacenar como objetos SDO_GEORASTER

disponibles con la extensión de Oracle Spatial. En QGIS, el complemento GeoRaster espacial de Oracle Spatial es ad-
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Figure 21.36: Crear un proyecto fuera de linea de capas PostGIS o WFS

mitido por GDAL y depende de que tenga instalado y funcionando en su equipo el producto de bases de datos de
Oracle. Aunque Oracle es software propietario, proporciona de forma gratuita su software con fines de desarrollo
y prueba. Aquí hay un ejemplo de cómo cargar imágenes raster a GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Esto cargará el raster en la tabla predeterminada GDAL_IMPORT, como una columna llamada “RASTER”

21.16.1 Administrar conexiones

En primer lugar, se debe habilitar el complemento Oracle GeoRaster usando el Administrador de complementos
(vea El diálogo de complementos). La primera vez que se cargue un GeoRaster en QGIS, debe crear una conexión
a la base de datos de Oracle que contiene los datos. Para hacer esto, inicie haciendo clic en el botón de la barra de

herramientas Añadir capa de Oracle GeoRaster – esto abrirá la ventana del cuadro de diálogo Seleccionar GeoRaster
de Oracle Spatial. Haga clic en [Nuevo] para abrir la ventana del cuadro de diálogo, y especifique los parámetros
de conexión (vea Figure_oracle_raster_connection):

• Nombre: Introduzca un nombre para al conexión a la base de datos.

• Instancia de la base de datos: Introduzca el nombre de la base de datos a la que desea conectarse.

• Nombre de usuario: Especificar su nombre de usuario que usará para acceder a la base de datos.

• Contraseña: Proporcionar la contraseña asociada con su usuario que es requerida para el acceso a la base
de datos.

Ahora, regrese a la ventana del cuadro de diálogo principal Oracle Spatial GeoRaster (vea Fig-
ure_oracle_raster_selection), utilice la lista desplegable para elegir una conexión, y utilice el botón [Conectar]
para establecer la conexión. También se puede [Editar] al abrir el cuadro de diálogo anterior y realizar los cambios
a la información de conexión, o use el botón [Borrar] para eliminarla de la lista desplegable.

21.16.2 Seleccionar un GeoRaster

Una vez que la conexión se ha establecido, la ventana de subconjuntos de datos mostrará los nombres de todas las
tablas que contengan columnas GeoRaster en esa base de datos en el formato de un nombre del subconjunto de
datos GDAL.
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Figure 21.37: Crear dialogo de conexión de Oracle

Haga clic en uno de los subconjuntos de datos listados y después haga en [Seleccionar] para elegir el nombre de
la tabla. Ahora se mostrará otra lista de subconjuntos de datos con los nombres de las columnas del GeoRaster en
la tabla. Normalmente es una lista corta, ya que la mayoría de los usuarios no tendrán mas de una o dos columnas
de GeoRaster en la misma tabla.

Clic sobre uno de los subconjuntos de datos en listados y después sobre [Seleccionar] para elegir una de las
combinaciones tabla/columna. El dialogo mostrará ahora todos los registros que contengan objetos GeoRaster.
Note que la lista de subconjunto de datos mostrará ahora las parejas de tablas de datos raster e Id de raster.

En cualquier momento, la entrada seleccionada se puede ser editar para ir directamente a un GeoRaster conocido
o para regresar al inicio y seleccionar otro nombre de tabla.

Figure 21.38: Diálogo de selección de GeoRaster de Oracle

La entrada de datos seleccionados también puede usarse para introducir una cláusula WHERE al final de
la cadena de identificación (ej. geor:scott/tiger@orcl,gdal_import,raster,geoid=). Vea
http://www.gdal.org/frmt_georaster.html para mayor información.
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21.16.3 Mostrar GeoRaster

Finalmente, al seleccionar un GeoRaster de la lista de tablas de datos raster e Ids ráster, la imagen ráster se cargará
en QGIS.

El dialogo Seleccionar GeoRaster espacial de Oracle puede cerrarse ahora y la siguiente ocasión en que se abra
mantendrá la misma conexión y mostrará la misma lista previa de subconjuntos de datos, haciendo muy fácil abrir
otra imagen del mismo contexto.

Nota: Los GeoRaster que contienen pirámides se mostrarán mucho más rápido, pero las pirámides se deben
generar fuera de QGIS usando PL/SQL o gdaladdo.

Lo siguiente es un ejemplo usando gdaladdo:

$ gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Este es un ejemplo usando PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

21.17 Complemento Análisis de Terreno

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain).

Descripción del análisis:

• Pendiente: Calcula el ángulo de la pendiente de cada celda en grados (basado en primer orden estimación
derivada).

• Orientación: Exposición (iniciar con 0 para la dirección norte, en grados antihorario).

• Mapa de sombras: Crea un mapa de sombra utilizando luz y sombra para proveer un aspecto más tridi-
mencional para un mapa de relieve sombreado. El mapa de salida es una banda gris individual que refleja
el valor gris de los píxeles.

• Índice de irregularidad: Una medición cuantitativa de la heterogeneidad del terreno tal como se describe
por Riley et al. (1999). Se calcula para cada lugar con un resumen de los cambios en la elevación dentro de
la cuadrícula de 3x3 píxeles.

• Relieve: Crea un mapa de relieve sombreado de los datos digitales de elevación. Implementado es un
método para elegir los colores de elevación mediante el análisis de distribución de frecuencia. EL mapa de
salida es una color multibanda con tres bandas que reflejan los valores RGB del relieve sombreado.

21.17.1 Usar el complemento

1. Inicie QGIS y cargue la capa ráster gtopo30 de la ubicación de ejemplo de GRASS.

2. Cargar el complemento de Análisis de Terreno en el Administrador de Complementos (vea El diálogo de
complementos).
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Figure 21.39: Complemento de Modelado de Terreno (Cálculo de la pendiente)

3. Select an analysis method from the menu (e.g., Raster → Terrain Analysis → Slope). The Slope dialog
appears as shown in Figure_raster_terrain.

4. Especificar una ruta , y un tipo de archivo de salida

5. Haga clic en [Aceptar].

21.18 Complemento Grafo de rutas

El Grafo de rutas es un complemento en C++ para QGIS que calcula la ruta más corta entre dos puntos en una
capa de polilínea y traza esta ruta sobre la red de carreteras.

Figure 21.40: Complemento Grafo de rutas

Características principales:

• Calcula la ruta, así como la longitud y el tiempo de viaje.
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• Optimiza la longitud o el tiempo de viaje.

• Exporta la ruta a una capa vectorial.

• Resalta la dirección de las carreteras (esto es lento y se utiliza principalmente para fines de depuración y
para pruebas de configuración)

Como una capa de carreteras, se puede utilizar cualquier capa vectorial de polilínea en cualquier formato admitido
por QGIS. Dos líneas con un punto en común se consideran conectadas. Tenga en cuenta que es necesario usar el
SRC de la capa como SRC del proyecto mientras edita una capa de carreteras. Esto debido al hecho de recalcular
las coordenadas entre diferentes SRC’s introduce algunos errores que pueden resultar en discontinuidades, incluso
cuando se utiliza el ‘autoensamblado’.

En la tabla de atributos de la capa, se pueden usar los siguientes campos:

• Velocidad en una sección de la carretera (campo numérico).

• Dirección (cualquier tipo que se pueda convertir en texto). Las direcciones de avance y retroceso correspon-
den a una carretera de un solo sentido, ambas direcciones indican una carretera de doble sentidos.

Si algunos campos no tienen ningún valor o no existen, se usan los valores predeterminados. Puede cambiar lo
predeterminado y algunas configuraciones del complemento en el diálogo de configuración del complemento.

21.18.1 Usar el componente

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_settings).

Figure 21.41: Configuración del complemento Grafo de rutas

Después de configurar Unidad de tiempo, Unidad de distancia y Tolerancia de topología, puede seleccionar la
capa vectorial en la pestaña Capa de transporte. Aquí también puede seleccionar el Campo de sentido y el Campo
de velocidad. En la pestaña Configuración predeterminada, puede establecer el Sentido para el calculo.

Finalmente, en el panel Ruta más corta, seleccione un punto de Inicio y un punto Final en la capa de red de
carreteras y pulse [Calcular].
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21.19 Complemento Consulta espacial

El Complemento Consulta espacial permite hacer una consulta espacial (ej., seleccionar objetos espaciales) en una capa
de destino con referencia a otra capa. La funcionalidad con base en la librería de GEOS y depende de la capa de
rasgos de origen seleccionado.

Operadores posibles son:

• Contiene

• Igual

• Solapa

• Cruzar

• Intersecta

• Está inconexo

• Toca

• Dentro

21.19.1 Usar el complemento

Como un ejemplo, queremos encontrar regiones en el conjunto de datos de Alaska que contenga aeropuertos. Los
siguientes pasos son necesarios:

1. Inicie QGIS y cargue las capas vectoriales regions.shp y airports.shp.

2. Cargue el complemento de Consulta espacial en el Administrador de Complementos (vea El diálogo de

complementos) y haga clic en el icono Consulta espacial, que aparece en el menú de la barra de herramientas
de QGIS. El diálogo de complemento aparece.

3. Seleccione la capa regions como la capa origen y airports como la capa de entidades de referencia.

4. Seleccione ‘Contiene’ como operador y haga clic en [Aplicar].

Now you get a list of feature IDs from the query and you have several options, as shown in figure_spatial_query.

• Haga clic sobre Crear capa con lista de elementos.

• Seleccione un ID de la lista y haga clic sobre Crear capa con selección.

• Seleccione ‘Eliminar de la selección actual’ en el campo Y utilizar el resultado para .

• Se puede Zum al elemento o desplegar Registro de mensajes.

• Además en ID’s de los objetos de resultado con las opciones ‘Origen inválido’ y ‘Referencia inválida’ se
puede tener una vista de los objetos espaciales con errores geométricos. Estos objetos no se utilizan para la
consulta.

21.20 Complemento Comprobador de topología.

La topología describe las relaciones entre puntos, líneas y polígonos que representa los objetos espaciales de una
región geográfica. Con el complemento de Comprobador de Topología, puede revisar sus archivos vectoriales y
verificar la topología con varias reglas topológicas. Estas reglas comprueban con relaciones espaciales si su objeto
espacial es ‘Equal’, ‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’, o son ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’
o ‘Within’ el uno al otro. Depende de sus preguntas individuales que reglas topológicas que se aplican a los
datos vectoriales (por ejemplo, normalmente no aceptará overshoots en capas de líneas, pero si ellos representan
callejones sin salida que no eliminará de su capa vectorial).
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Figure 21.42: Análisis de consulta espacial - las regiones contienen aeropuertos

Figure 21.43: El complemento de Comprobador de Topología
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QGIS tiene una característica de edición topológica integrada, que es ideal para la creación de nuevas funciones sin
errores. Pero los errores de datos existentes y los errores inducidos son difíciles de encontrar. Este complemento
le ayuda a encontrar cada error a través de una lista de reglas.

Es muy simple crear reglas topológicas con el complemento Comprobador de topología.

En capa de puntos las siguientes reglas están disponibles:

• Must be covered by: Aquí puede elegir una capa vectorial de su proyecto. Los puntos que no están
cubiertos por la capa vectorial dada se produce en el campo ‘Error’.

• Must be covered by endpoints of: Aquí puede elegir una capa de líneas de su proyecto.

• Debe estar dentro de: Aquí puede elegir una capa de polígono de su proyecto. Los puntos deben estar
dentro de un polígono. Por otra parte, QGIS escribe un ‘Error’ del punto.

• Must not have duplicates: Siempre que un punto se representa dos o más veces, se producirá el campo
‘Error’.

• Must not have invalid geometries: Comprobar si las geometrías son validas.

• Must not have multi-part-geometries: Todos los puntos multi-parte se escriben en el campo ‘Error’.

En Capas de líneas, las siguientes reglas están disponibles:

• End points must be covered by: Aquí se puede seleccionar una capa de puntos de su proyecto.

• Must not have dangles: Este mostrará los overshoots en la capa de líneas.

• Must not have duplicates: Siempre que un objeto línea es representado una o dos veces, se producirá en el
campo ‘Error’.

• Must not have invalid geometries: Comprobar si las geometrías son validas.

• Must not have multi-part geometries: A veces, una geometría es en realidad una colección de simples
(una sola pieza) geometrías. Una geometría de este tipo se denomina de geometría multiparte. Si contiene
sólo un tipo de geometría simple, lo llamamos multi-punto, multi-línea o multi-polígono. Todas las líneas
de multi-partes se escriben en el campo ‘Error’.

• No debe tener pseudos: Un punto final de geometría de línea debe conectarse a los puntos finales de otras
dos geometrías. Si el extremo está conectado al punto final de una sola otra geometría, el punto final se
llama nodo pseudo.

En capas de polígonos, las siguientes reglas están disponibles:

• Must contain: La capa de polígonos debe contener al menos un punto de la geometría de la segunda capa.

• Must not have duplicates: Los polígonos de la misma capa no deben tener geometrías idénticas. Cada vez
que una entidad de polígono se represente dos veces o más se producirá en el campo ‘Error’.

• Must not have gaps: Los polígonos adyacentes no deben formar espacios entre ellos. Los límites adminis-
trativos podrían mencionarse como ejemplo (polígonos de los estados de Estados Unidos no tienen espacios
entre ellos ...).

• Must not have invalid geometries: Comprobar si las geometrías con validas. Algunas de las reglas que
definen si una geometría es valida son:

– Anillos de polígonos deben cerrarse.

– Los anillos que definen agujeros deben estar dentro de los anillos que definen los límites exteriores.

– Los anillos no deben intersectarse (Ni pueden tocarse o cruzarse entre si)

– Los anillos no puede tocar otros anillos, excepto en un punto.

• Must not have multi-part geometries: A veces, una geometría es en realidad una colección geometrías
sencillas (parte sencilla). Una geometría de este tipo se denomina de geometría multi-parte. Si contiene
sólo un tipo de geometría simple, lo llamamos multi-punto, multi-líneas o multi-polígono. Por ejemplo, un
país que consta de múltiples islas se puede representar como un multi-polígono.

• Must not overlap: Los polígonos adyacentes no deben de compartir un área en común.
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• Must not overlap with: Los polígonos adyacentes de una capa no deben compartir un área con los polí-
gonos de otra.

21.21 Complemento de Estadísticas de zona

With the Zonal statistics plugin, you can analyze the results of a thematic classification. It allows you
to calculate several values of the pixels of a raster layer with the help of a polygonal vector layer (see fig-
ure_zonal_statistics). Choosing a color band, the plugin generates output columns in the vector layer with an
user-defined prefix and calculates for each polygon, statistics on pixels that are within. The available statistics are
:

• Count: to count the number of pixels

• Sum: to sum the pixel values

• Mean: to get the mean of pixel values

• Median: to get the median of pixel values

• StDev: to get the standard deviation of pixel values

• Min: to get the minimum of pixel values

• Max: to get the maximum of pixel values

• Range: to get the range (max - min) of pixel values

• Minority: to get the less represented pixel value

• Majority: to get the most represented pixel value

• Variety: to count the number of distinct pixel values

Figure 21.44: Diálogo de Estadísticas de zona
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CHAPTER 22

Ayuda y apoyo

22.1 Listas de correos

QGIS está en desarrollo activo y como tal, no siempre funciona como se espera. La forma preferida de obtener
ayuda es uniéndose a la lista de correo qgis-users. Sus preguntas llegarán a un público más amplio y las respuestas
beneficiarán a otros.

22.1.1 Usuarios de QGIS

La lista de correo se utiliza para discutir sobre QGIS en general además de preguntas especificas relacionadas con
su instalación y utilización. Puedes suscribirse a la lista de correos de usuarios qgis al visitar el siguiente enlace:
http://lists.osgeo.org/mailman/listinfo/qgis-user

22.1.2 Desarrolladores QGIS

If you are a developer facing problems of a more technical nature, you may want to join the qgis-developer mailing
list. This list is also a place where people can chime in and collect and discuss QGIS related UX (User Experience)
/ usability issues. It’s here: http://lists.osgeo.org/mailman/listinfo/qgis-developer

22.1.3 QGIS Community Team

Esta lista se ocupa de temas como la documentación, ayuda de contexto, guía para el usuario, páginas
web. blog, listas de correos, foros y trabajos de traducción. Si además quisieras trabajar en la guía
para el usuario, esta lista es un buen punto de partida para preguntar. Puedes suscribirte a esta lista en:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

22.1.4 QGIS Translations

Esta lista se encarga de los esfuerzos de traducción. Si quiere trabajar en la traducción del sitio web, de los
manuales o de la interfaz gráfica de usuario (GUI), esta lista es un buen punto de partida para responder a tus
preguntas. Puedes suscribirte a esta lista en: http://lists.osgeo.org/mailman/listinfo/qgis-tr

22.1.5 QGIS Project Steering Committee (PSC)

Se utiliza esta lista para discutir los asuntos del Comité Directivo relacionados con la gestión y dirección general
de QGIS. Puede suscribirse a esta lista en: http://lists.osgeo.org/mailman/listinfo/qgis-psc
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22.1.6 QGIS User groups

In order to locally promote QGIS and contribute to its development, some QGIS communities are orga-
nized into QGIS User Groups. These groups are places to discuss local topics, organize regional or na-
tional user meetings, organize sponsoring of features... The list of current user groups is available at
http://qgis.org/en/site/forusers/usergroups.html

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences.

22.2 IRC

También mantenemos una presencia en IRC - visítenos uniéndose al canal #qgis en irc.freenode.net. Por favor,
espere una respuesta a su pregunta, la mayoría de gente en el canal están haciendo otras cosas y puede tomar un
tiempo para que noten su pregunta. Si se ha perdido una discusión en IRC, ¡no hay problema! Registramos toda
discusión, así que puede fácilmente ponerse al día. Sólo tiene que ir a http://qgis.org/irclogs y leer los IRC-logs.

Apoyo comercial para QGIS también esta disponible. Revisar la página web http://qgis.org/en/commercial-
support.html para mayor información.

22.3 Rastreador de Errores

Mientras que la lista de correo de usuarios de QGIS es útil en general para el tipo de preguntas “¿Cómo hago
XYZ en QGIS?, puede que desee notificarnos sobre errores en QGIS. Puede enviar informes de errores utilizando
el rastreador de errores QGIS en http://hub.qgis.org/projects/quantum-gis/issues. Al crear un nuevo ticket para un
error, proporcione una dirección de correo electrónico en la que podamos ponernos en contacto con usted para
obtener información adicional.

Por favor, tenga en cuenta que su error no siempre puede disfrutar de la prioridad que podría esperar (depende de
su gravedad). Algunos errores pueden requerir de significativo esfuerzo por parte del desarrollador para remediar,
y la mano de obra no siempre está disponible para esto.

Se pueden presentar las solicitudes de funciones utilizando el mismo sistema de ticket de errores. Asegúrate de
seleccionar el tipo «Función».

Si ha encontrado un error y lo corrige, puede enviar una solicitud de extracción en el proyecto Github QGIS
(preferida) o un parche también. El encantador sistema de entradas http://hub.qgis.org/projects/quantum-gis/issues
también tiene este tipo. Compruebe la casilla Parche suministrado y adjunte el parche antes de enviar su
error . Uno de los desarrolladores lo revisará y lo aplicará a QGIS. Por favor, no se alarme si su parche no se aplica
de inmediato - los desarrolladores pueden estar vinculados con otros compromisos.

Tenga en cuenta que si proporciona una solicitud de extracción, su cambio sería más probable que se fusione en
el código fuente!

22.4 Blog

La comunidad QGIS también corre un weblog en http://planet.qgis.org/planet/, que tiene algunos artículos intere-
santes para usuarios y desarrolladores también proporcionados por otros blogs de la comunidad. ¡Se le invita a
contribuir con su propio blog QGIS!

22.5 Plugins

La página web http://plugins.qgis.org proporciona el portal web de complementos QGIS oficial. Aquí, encontrará
una lista de todos los complementos de QGIS estables y experimentales disponibles a través del ‘Repositorio de
complementos de QGIS oficial’.
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22.6 Wiki

Por último, mantenemos un sitio web en WIKI http://hub.qgis.org/projects/quantum-gis/wiki donde se puede en-
contrar una variedad de información útil relacionada con el desarrollo de QGIS, planes de lanzamiento, los enlaces
para descargar sitios, mensaje- consejos de traducción y más. ¡Compruébelo, hay algunas cosas en el interior!
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CHAPTER 23

Colaboradores

QGIS is an open source project developed by a team of dedicated volunteers and organisations. We strive to be
a welcoming community for people of all race, creed, gender and walks of life. At any moment, you can get
involved.

23.1 Authors

Below are listed people who dedicate their time and energy to write, review, and update the whole QGIS docu-
mentation.

Tara Athan Radim Blazek K. Koy Godofredo Contreras Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Denis Rouzaud Tyler Mitchell Claudia A. Engel Lars Luthman
Otto Dassau Brendan Morely David Willis Jürgen E. Fischer Yoichi Kayama
Alex Bruy Anita Graser Victor Olaya Marco Hugentobler Gary E. Sherman
Tim Sutton Larissa Junek Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Alessandro Pasotti Hien Tran-Quang
Andy Schmid Arnaud Morvan Akgar Gumbira Giovanni Allegri Diethard Jansen
Andy Allan Matthias Kuhn Chris Berkhout Carson J.Q. Farmer Steven Cordwell
Eric Goddard Frank Sokolic Luca Casagrande Harrissou Sant-anna Saber Razmjooei
Ilkka Rinne Jacob Lanstorp Ujaval Gandhi Jean-Roc Morreale Salvatore Larosa
João Gaspar Joshua Arnott Thomas Gratier Marco Bernasocchi Marie Silvestre
Ko Nagase Larry Shaffer Luigi Pirelli Konstantinos Nikolaou Maning Sambale
Manel Clos Mattheo Ghetta Bernhard Ströbl Luca Manganelli Nathan Woodrow
Nick Bearman Paul Blottière Vincent Picavet Maximilian Krambach René-Luc D’Hont
Tom Chadwin Patrick Sunter Nyall Dawson Milo Van der Linden Paolo Cavallini
Paolo Corti Hugo Mercier Gavin Macaulay Stefan Blumentrath Nicholas Duggan
David Adler Vincent Mora Tudor Barascu QGIS Koran Translator Stéphane Brunner
Jaka Kranjc Tom Kralidis Zoltan Siki Sebastian Dietrich Uros Preloznik
Dick Groskamp Mezene Worku Alexandre Busquets Dominic Keller Andre Mano
ajazepk icephale Andrei GiordanoPezzola zstadler
Ramon embelding

23.2 Traductores

QGIS is a multi-language application and as is, also publishes a documentation translated into several lan-
guages. Many other languages are being translated and would be released as soon as they reach a reason-
able percentage of translation. If you wish to help improving a language or request a new one, please see
http://qgis.org/en/site/getinvolved/index.html.

The current translations are made possible thanks to:
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idioma Colaboradores
Bahasian
Indonesian

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar, Trias
Aditya

Chinese
(Tradi-
tional)

Calvin Ngei, Zhang Jun, Richard Xie

Dutch Carlo van Rijswijk, Dick Groskamp, Diethard Jansen, Raymond Nijssen, Richard
Duivenvoorde, Willem Hoffman

Finnish Matti Mäntynen, Kari Mikkonen
French Arnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille,

Harrissou Sant-anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-André
Saia, Marie Silvestre, Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric
Ribreux, Mehdi Semchaoui, Michael Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal
Obstetar, Robin Prest, Rod Bera, Stéphane Henriod, Stéphane Possamai, sylther, Sylvain
Badey, Sylvain Maillard, Vincent Picavet, Xavier Tardieu, Yann Leveille-Menez, yoda89

Galician Xan Vieiro
German Jürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho
Hindi Harish Kumar Solanki
Italian Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca

Delucchi, Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele
Ferretti, Roberto Angeletti, Paolo Cavallini, Stefano Campus

Japanese Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura,
Yoichi Kayama

Korean OSGeo Korean Chapter
Polish Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot,

Michał Kułach, Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek,
Tomasz Paul

Portuguese Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro
Infantini, Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Portuguese
(Brasil)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio
de Sá Pereira Filho, Sidney Schaberle Goveia

Romanian Alex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Lonut Losifescu-Enescu, Sorin Călinică,
Tudor Bărăscu

Russian Alexander Bruy, Artem Popov
Spanish Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul

Kauffmann
Ucraniano Alexander Bruy
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CHAPTER 24

Apéndice

24.1 GNU General Public License

Versión 2, Junio de 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Se permite a todos copiar y distribuir copias exactas de este documento de licencia, aunque no se permite su
cambio.

Preámbulo

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt excepciones para GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code of this program
with the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-
commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use
the same license as Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file, you may extend this
exception to your version of the file, but you are not obligated to do so. If you do not wish to do so, delete this
exception statement from your version.

24.2 Licencia de Documentación Libre de GNU

Versión 1.3, 3 de Noviembre de 2008

Derechos Reservados 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

http://fsf.org/

Se permite a todos copiar y distribuir copias exactas de este documento de licencia, aunque no se permite su
cambio.

Preámbulo

El propósito de esta Licencia es permitir que un manual, libro de texto, u otro documento escrito sea “libre”
en el sentido de libertad: asegurar a todo el mundo la libertad efectiva de copiarlo y redistribuirlo, con o sin
odificaciones, de manera comercial o no. En segundo término, esta Licencia proporciona al autor y al editor
una manera de obtener reconocimiento por su trabajo, sin que se le considere responsable de las modificaciones
realizadas por otros.
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Esta Licencia es de tipo “copyleft”, lo que significa que los trabajos derivados del documento deben a su vez ser
libres en el mismo sentido. Complementa la Licencia Pública General de GNU, que es una licencia tipo copyleft
diseñada para el software libre.

Hemos diseñado esta Licencia para usarla en manuales de software libre, ya que el software libre necesita docu-
mentación libre: un programa libre debe venir con manuales que ofrezcan la mismas libertades que el software.
Pero esta licencia no se limita a manuales de software; puede usarse para cualquier texto, sin tener en cuenta su
temática o si se publica como libro impreso o no. Recomendamos esta licencia principalmente para trabajos cuyo
fin sea instructivo o de referencia.

1. DEFINICIONES Y APLICABILIDAD

Esta Licencia se aplica a cualquier manual u otro trabajo, en cualquier soporte, que contenga una nota del propi-
etario de los derechos de autor que indique que puede ser distribuido bajo los términos de esta Licencia. Tal nota
garantiza en cualquier lugar del mundo, sin pago de derechos y sin límite de tiempo, el uso de dicho trabajo según
las condiciones aquí estipuladas. En adelante la palabra Documento se referirá a cualquiera de dichos manuales
o trabajos. Cualquier persona es un licenciatario y será referido como “Usted”. Usted acepta la licencia si copia.
modifica o distribuye el trabajo de cualquier modo que requiera permiso según la ley de propiedad intelectual.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

Una “Sección Secundaria” es un apéndice con título o una sección preliminar del Documento que trata exclusi-
vamente de la relación entre los autores o editores y el tema general del Documento (o temas relacionados) pero
que no contiene nada que entre directamente en dicho tema general (por ejemplo, si el Documento es en parte un
texto de matemáticas, una Sección Secundaria puede no explicar nada de matemáticas). La relación puede ser una
conexión histórica con el tema o temas relacionados, o una opinión legal, comercial, filosófica, ética o política
acerca de ellos.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

Los “Textos de Cubierta” son ciertos pasajes cortos de texto que se listan como Textos de Cubierta Delantera o
Textos de Cubierta Trasera en la nota que indica que el documento es liberado bajo esta Licencia. Un Texto de
Cubierta delantera puede tener como mucho 5 palabras, y uno de Cubierta Trasera puede tener hasta 25 palabras.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Como ejemplos de formatos adecuados para copias Transparentes están ASCII puro sin marcaje, formato de
entrada de Texinfo, formato de entrada de LaTeX, SGML o XML usando una DTD disponible públicamente,
y HTML, PostScript o PDF simples, que sigan los estándares y diseñados para que los modifiquen personas.
Ejemplos de formatos de imagen transparentes son PNG, XCF y JPG. Los formatos Opacos incluyen formatos
propietarios que pueden ser leídos y editados únicamente en procesadores de palabras propietarios, SGML o
XML para los cuáles las DTD y/o herramientas de procesamiento no estén ampliamente disponibles, y HTML,
PostScript o PDF generados por algunos procesadores de palabras sólo como salida.

La “Portada” significa, en un libro impreso, la página de título, más las páginas siguientes que sean necesarias
para mantener legiblemente el material que esta Licencia requiere en la portada. Para trabajos en formatos que no
tienen página de portada como tal, Portada significa el texto cercano a la aparición más prominente del título del
trabajo, precediendo el comienzo del cuerpo del texto.

El “Editor” se refiere a cualquier persona o entidad que distribuya copias del Documento a el público.

Una sección “Titulada XYZ” significa una parte del Documento cuyo título es precisamente XYZ o contiene
XYZ entre paréntesis, a continuación de texto que traduce XYZ a otro idioma (aquí XYZ se refiere a nombres
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de sección específicos mencionados más abajo, como “Agradecimientos”, “Dedicatorias”, “Aprobaciones” o
“Historia”). “Conservar el Título” de tal sección cuando se modifica el Documento significa que permanece una
sección “Titulada XYZ” según esta definición.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. COPIA LITERAL

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

Usted también puede prestar copias, bajo las mismas condiciones establecidas anteriormente, y puede exhibir
copias públicamente.

3. COPIADO EN CANTIDAD

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

Si los textos requeridos para la cubierta son muy voluminosos para que ajusten legiblemente, debe colocar los
primeros (tantos como sea razonable colocar) en la verdadera cubierta y situar el resto en páginas adyacentes.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICACIONES

Puede copiar y distribuir una Versión Modificada del Documento bajo las condiciones de las secciones 2 y 3
anteriores, siempre que usted libere la Versión Modificada bajo esta misma Licencia, con la Versión Modificada
haciendo el rol del Documento, por lo tanto dando licencia de distribución y modificación de la Versión Modificada
a quienquiera posea una copia de la misma. Además, debe hacer lo siguiente en la Versión Modificada:

1. Usar en la Portada (y en las cubiertas, si hay alguna) un título distinto al del Documento y de sus versiones
anteriores (que deberían, si hay alguna, estar listadas en la sección de Historia del Documento). Puede usar
el mismo título de versiones anteriores al original siempre y cuando quien las publicó originalmente otorgue
permiso.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. Mostrar en la Portada como editor el nombre del editor de la Versión Modificada.

4. Preservar todas las notas de derechos de autor del Documento.
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5. Agregue una nota de derechos reservados apropiada para sus modificaciones adyacente a las otras notas de
derechos reservados.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.

7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Incluir una copia sin modificación de esta Licencia.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Conservar todas las Secciones Invariantes del Documento, sin alterar su texto ni sus títulos. Números de
sección o el equivalente no son considerados parte de los títulos de la sección.

13. Borrar cualquier sección titulada Aprobaciones. Tales secciones no pueden estar incluidas en las Versiones
Modificadas.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Conservar todas las Limitaciones de Garantía.

Si la Versión Modificada incluye secciones o apéndices nuevos que califiquen como Secciones Secundarias y
contienen material no copiado del Documento, puede opcionalmente designar algunas o todas esas secciones
como invariantes. Para hacerlo, añada sus títulos a la lista de Secciones Invariantes en la nota de licencia de la
Versión Modificada. Tales títulos deben ser distintos de cualquier otro título de sección.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

Puede añadir un pasaje de hasta cinco palabras como Texto de Cubierta Delantera y un pasaje de hasta 25 palabras
como Texto de Cubierta Trasera en la Versión Modificada. Una entidad solo puede añadir (o hacer que se añada)
un pasaje al Texto de Cubierta Delantera y uno al de Cubierta Trasera. Si el Documento ya incluye un textos de
cubiertas añadidos previamente por usted o por la misma entidad que usted representa, usted no puede añadir otro;
pero puede reemplazar el anterior, con permiso explícito del editor que agregó el texto anterior.

Con esta Licencia ni el/los autor(es) ni el/los editor(es) del Documento dan permiso para usar sus nombres para
publicidad ni para asegurar o implicar aprobación de cualquier Versión Modificada.

5. COMBINACIÓN DE DOCUMENTOS

Usted puede combinar el Documento con otros documentos liberados bajo esta Licencia, bajo los términos
definidos en la sección 4 anterior para versiones modificadas, siempre que incluya en la combinación todas las
Secciones Invariantes de todos los documentos originales, sin modificar, listadas todas como Secciones Invariantes
del trabajo combinado en su nota de licencia. Así mismo debe incluir la Limitación de Garantía.

El trabajo combinado necesita contener solamente una copia de esta Licencia, y puede reemplazar varias Secciones
Invariantes idénticas por una sola copia. Si hay varias Secciones Invariantes con el mismo nombre pero con
contenidos diferentes, haga el título de cada una de estas secciones único añadiéndole al final del mismo, entre
paréntesis, el nombre del autor o editor original de esa sección, si es conocido, o si no, un número único. Haga
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el mismo ajuste a los títulos de sección en la lista de Secciones Invariantes de la nota de licencia del trabajo
combinado.

En la combinación, debe combinar cualquier sección Titulada “Historia” de los documentos originales, formando
una sección Titulada “Historia”; de la misma forma combine cualquier sección Titulada “Agradecimientos”, y
cualquier sección Titulada “Dedicatorias”. Debe borrar todas las secciones tituladas “Aprobaciones”.

6. COLECCIONES DE DOCUMENTOS

You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

Puede extraer un solo documento de una de tales colecciones y distribuirlo individualmente bajo esta Licencia,
siempre que inserte una copia de esta Licencia en el documento extraído, y siga esta Licencia en todos los demás
aspectos relativos a la copia literal de dicho documento.

7. AGREGACIÓN CON TRABAJOS INDEPENDIENTES

Una recopilación que conste del Documento o sus derivados y de otros documentos o trabajos separados e inde-
pendientes, en cualquier soporte de almacenamiento o distribución, se denomina un “agregado” si el copyright
resultante de la compilación no se usa para limitar los derechos de los usuarios de la misma más allá de lo que los
de los trabajos individuales permiten. Cuando el Documento se incluye en un agregado, esta Licencia no se aplica
a otros trabajos del agregado que no sean en sí mismos derivados del Documento.

Si el requisito de la sección 3 sobre el Texto de Cubierta es aplicable a estas copias del Documento y el Documento
es menor que la mitad del agregado entero, los Textos de Cubierta del Documento pueden colocarse en cubiertas
que enmarquen solamente el Documento dentro del agregado, o el equivalente electrónico de las cubiertas si el
documento está en forma electrónica. En caso contrario deben aparecer en cubiertas impresas enmarcando todo el
agregado.

8. TRADUCCIÓN

La Traducción es considerada como un tipo de modificación, por lo que usted puede distribuir traducciones del
Documento bajo los términos de la sección 4. El reemplazo las Secciones Invariantes con traducciones requiere
permiso especial de los dueños de derecho de autor, pero usted puede añadir traducciones de algunas o todas las
Secciones Invariantes a las versiones originales de las mismas. Puede incluir una traducción de esta Licencia, de
todas las notas de licencia del documento, así como de las Limitaciones de Garantía, siempre que incluya también
la versión en Inglés de esta Licencia y las versiones originales de las notas de licencia y Limitaciones de Garantía.
En caso de desacuerdo entre la traducción y la versión original en Inglés de esta Licencia, la nota de licencia o la
limitación de garantía, la versión original en Inglés prevalecerá.

Si una sección del Documento está Titulada “Agradecimientos”, “Dedicatorias” o “Historia” el requisito (sección
4) de Conservar su Título (Sección 1) requerirá, típicamente, cambiar su título.

9. TERMINACIÓN

Usted no puede copiar, modificar, sublicenciar o distribuir el Documento salvo por lo permitido expresamente
bajo esta Licencia. Cualquier intento en otra manera de copia, modificación, sublicenciamiento, o distribución de
él es nulo, y dará por terminados automáticamente sus derechos bajo esa Licencia.

Sin embargo, si usted cesa toda violación a esta Licencia, entonces su licenca proveniente de un titular de copyright
queda restaurada (a) provisionalmente, a menos y hasta que el titular del copyright explicita y finalmente termine
su licencia, y (b) permanentemente, si el titual del copyright falla en notificarle de la violación por algún medio
razonable en un tiempo menor a 60 días después del cese.

Además, su licencia proveniente de un titular del copyright particular queda restaurada permanentemente si el
titular del copyright lo notifica de la violación por algún método razonable, es la primera vez que usted ha recibido
aviso de la violación de esta Licencia (para cualquier trabajo) de ese titular del copyright, y usted remedia la
violación en un tiempo menor a 30 días después de recibir dicho aviso.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.
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10. REVISIONES FUTURAS DE ESTA LICENCIA

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RENOVACIÓN DE LICENCIAS

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” significa la licencia Creative Commons Attribution-Share Alike 3.0 (Reconocimiento-Compartir
bajo la misma licencia 3.0 de Creative Commons) publicada por Creative Commons Corporation, una corporación
sin fines de lucro con base en San Francisco, California, así como versiones futuras copyleft de esa licencia
publicada por esa misma organización.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

APÉNDICE: Cómo usar esta Licencia para sus documentos

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Si tiene Secciones Invariantes, Textos de Cubierta Delantera y Textos de Cubierta Trasera, reemplace la frase “sin
... Trasera” por esto:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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Marcdores, 57
Marco HTML, 268
Medición

Ángulos, 49
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Valores predeterminados, 156
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WCS, 281
WCS (Servicio de Cobertura Web), 289
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